
Shading
Version 6.5



Legal Notices

Maya®, Version 6.5

© Copyright 2005 Alias Systems Corp. ("Alias"). All rights reserved.

Graph Layout Toolkit

© Copyright 1992-1997 Tom Sawyer Software, Berkeley, California. All rights

reserved.

All documentation ("Documentation") is copyrighted ©2005 Alias and contains proprietary and confidential information of Alias. The 

Documentation is protected by national and international intellectual property laws and treaties. All rights reserved. Use of the 

Documentation is subject to the terms of the license agreement that governs the use of the software product to which the 

documentation pertains (the "Software"). The authorized licensee of the Software is hereby authorized to print no more than one (1) 

hardcopy of any Documentation provided in digital format per valid license of the Software held by such licensee. Except for the 

foregoing, the Documentation may not be translated, copied or duplicated in any form (physically or electronically), in whole or in part, 

without the prior written consent of Alias.

Alias, the swirl logo and Maya are registered trademarks and the Maya logo, Conductors, Trax, IPR, Maya Shockwave 3D Exporter 

and MEL are trademarks of Alias in the United States and/or other countries worldwide. FBX is a registered trademark of Systèmes 

Alias Québec Inc. SGI, IRIX, Open GL and Silicon Graphics are registered trademarks of Silicon Graphics, Inc. in the United States 

and/or other countries worldwide. mental ray and mental images are registered trademarks of mental images GmbH & CO. KG. in the 

United States and/or other countries. Lingo, Macromedia, Director, Shockwave and Macromedia Flash are trademarks or registered 

trademarks of Macromedia, Inc. Wacom is a trademark of Wacom Co., Ltd. NVidia is a registered trademark and Gforce is a 

trademark of NVidia Corporation. Linux is a registered trademark of Linus Torvalds. Intel and Pentium are registered trademarks of 

Intel Corporation. Red Hat is a registered trademark of Red Hat, Inc. ActiveX, Microsoft and Windows are either registered 

trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. Mac, Macintosh and QuickTime are 

trademarks of Apple Computer, Inc., registered in the United States and other countries. Adobe, Adobe Illustrator, Photoshop and 

Acrobat are either registered trademarks or trademarks of Adobe Systems Incorporated. UNIX is a registered trademark, licensed 

exclusively through X/Open Company, Ltd. AutoCAD, Discreet Logic, Inferno and Flame are either registered trademarks or 

trademarks of Autodesk, Inc. in the USA and/or other countries. OpenFlight is a registered trademark of MultiGen Inc. Java is a 

registered trademark of Sun Microsystems, Inc. RenderMan is a registered trademark of Pixar Corporation. Softimage is either a 

registered trademark or trademark of Avid Technology, Inc. in the United States and/or other countries. Unigraphics is a registered 

trademark of UGS PLM Solutions Inc. 

CATIA is a registered trademark of Dassault Systèmes SA.

All other trademarks mentioned herein are the property of their respective owners.

All images © Copyright Alias unless otherwise noted. All rights reserved. 

ALIAS  210 KING STREET EAST TORONTO, CANADA M5A 1J7



Table of Contents
Table of Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

1 About shading and texturing surfaces. . . . . . . . . . . . . . . . . . 17

About Surface shading  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Surface texture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Shading networks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Shading networks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Render nodes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Render node attributes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

Render node connections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

Maya materials  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Surface, displacement, volumetric materials . . . . . . . . . . . . . . . . . . . . 25

Layered shaders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

Double-sided shaded surfaces. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Maya textures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

2D and 3D textures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Procedural textures. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

File textures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Photoshop file texture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Texture filtering. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Mapping and positioning textures  . . . . . . . . . . . . . . . . . . . 33

Texture mapping. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Mapping methods. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

2D and 3D texture positioning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Texture placement vs. label mapping. . . . . . . . . . . . . . . . . . . . . . . . . . 38

Transferring surface information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

mental ray for Maya shaders . . . . . . . . . . . . . . . . . . . . . . . . 39

mental ray for Maya Shaders  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

mental ray shader connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Phenomena . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Custom mental ray text  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Custom vertex data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Advanced information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Shading

3



Table of Contents
How do I? Build shading networks  . . . . . . . . . . . . . . . . . . . . . . . 58
Open and customize Hypershade  . . . . . . . . . . . . . . . . . . . . 58

Open and navigate Hypershade  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Show top and bottom level tabs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

Filter nodes in Hypershade tabs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

Hide shape and transform nodes in Hypershade. . . . . . . . . . . . . . . . . 61

Create Hypershade tabs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Hide, resize or customize the Create bar  . . . . . . . . . . . . . . . . . . . . . . . 63

Organize render nodes with Hypershade sorting bins  . . . . . . . . . . . . 65

Change default connection line colors . . . . . . . . . . . . . . . . . . . . . . . . . 67

Create nodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

Create a node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

Duplicate a node . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Delete a node and its network . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Import and export shading networks . . . . . . . . . . . . . . . . . . . . . . . . . . 70

Connect nodes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

Show node connections. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

Connect render nodes using their default connections. . . . . . . . . . . . 71

Connect default output to a specific input attribute  . . . . . . . . . . . . . . 72

Connect render nodes by dragging existing connection lines . . . . . . 72

Connect render nodes using the Connection Editor  . . . . . . . . . . . . . . 73

Change existing render node attribute connections . . . . . . . . . . . . . . 74

Delete a render node connection  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Adjust node attributes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Adjust node attributes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Animate a node attribute . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Work with shader libraries  . . . . . . . . . . . . . . . . . . . . . . . . . 78

View the Shader Library Gallery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

Assign a shading group from the Shader Library . . . . . . . . . . . . . . . . 78

Create and assign materials to surfaces  . . . . . . . . . . 79
Create a material. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

Assign existing materials to surfaces . . . . . . . . . . . . . . . . . . . . . . . . . . 79

Layer shaders  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81
Shading 

4



Table of Contents
Create double-sided shaded surfaces . . . . . . . . . . . . . . . . . . . . . . . . . . 81

Map and position textures . . . . . . . . . . . . . . . . . . . . . 84
Map a 2D or 3D texture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

Position 2D textures and labels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

Position 3D textures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

Use a layered texture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

Create Texture Reference Object  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

Convert a texture or shading network to a File Texture  . . . . . . . . . . . 91

Transfer surface information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

Use Photoshop files as textures in Maya . . . . . . . . . . 92
Use PSD files as textures in Maya. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 92

Create a PSD file with layer sets from within Maya. . . . . . . . . . . . . . . 93

Sketch out guidelines (“lipstick”) for paint application. . . . . . . . . . . . 95

Update PSD textures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 96

Test textures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97
Test textures (and texture ranges)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 97

Disable the initial load of a file texture image . . . . . . . . . . . . . . . . . . . 98

Work with mental ray shaders . . . . . . . . . . . . . . . . . . 99
Use a custom-made mental ray for Maya shader in Maya . . . . . . . . . 99

Write a shader declaration file. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 99

Edit the maya.rayrc file. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 100

Load shaders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

Use a mental ray for Maya shader  . . . . . . . . . . . . . . . . . . . . . . . . . . . 104

Specify light parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Work with phenomenon  . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Build Phenomena . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

Use a Phenomenon in a scene  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

Work with Custom mental ray text . . . . . . . . . . . . . . . . . . 107

Assign custom text to an object or shader . . . . . . . . . . . . . . . . . . . . . 107

Assign text to entities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

What went 

wrong?

Maya materials and textures . . . . . . . . . . . . . . . . . . . . . . .  108

Troubleshoot:Movies don’t play on Image Plane  . . . . . . . . . . . . . . . 108

Troubleshoot:NURBS surface blend renders incorrectly  . . . . . . . . . 108
Shading

5



Table of Contents
Troubleshoot:Warped textures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109

Troubleshoot:Can’t see the place2Dtexture swatch  . . . . . . . . . . . . . 109

Troubleshoot:Animated objects swim through 3D texture . . . . . . . . 109

Troubleshoot:When I move a referenced object, the texture swims 109

Troubleshoot:Movies files are slow to load . . . . . . . . . . . . . . . . . . . . 110

Troubleshoot:Textures on deforming surfaces . . . . . . . . . . . . . . . . . 110

mental ray for Maya shaders . . . . . . . . . . . . . . . . . . . . . . .  112

Troubleshoot:Crash or render abort . . . . . . . . . . . . . . . . . . . . . . . . . . 112

Troubleshoot:Node factory errors in Script Editor  . . . . . . . . . . . . . . 112

Troubleshoot:Error messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 112

Troubleshoot:Cannot find main function . . . . . . . . . . . . . . . . . . . . . . 112

Troubleshoot:Cannot open input file "shader.lib" . . . . . . . . . . . . . . . 113

Reference Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  113

Window > Rendering Editors > mental ray > Shader Manager . . . . 113

Rendering menu set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  113

Lighting/shading. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  113

Lighting/shading > Material Attributes  . . . . . . . . . . . . . . . . . . . . . . . 113

Lighting/shading > Assign New Material . . . . . . . . . . . . . . . . . . . . . . 114

Lighting/shading > Assign Existing Material . . . . . . . . . . . . . . . . . . . 114

Lighting/shading > Transfer Surface Information . . . . . . . . . . . . . . . 114

Texturing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  117

Texturing > Create Texture Reference Object   . . . . . . . . . . . . . . . . . 117

Texturing > Delete Texture Reference Object  . . . . . . . . . . . . . . . . . . 117

Texturing > Select Texture Reference Object  . . . . . . . . . . . . . . . . . . 117

Texturing > NURBS Texture Placement Tool  . . . . . . . . . . . . . . . . . . 117

Texturing > Create PSD Texture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 118

Texturing > Update PSD Texture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

Windows and Editors  . . . . . . . . . . . . . . . . . . . . . . . . 120
Connection Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  120

Connection Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

Hypershade  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122

Hypershade . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
Shading 

6



Table of Contents
Hypershade menu bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  127

File > Import (Hypershade)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

File > Import Selected Scene Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

File > Import Selected Image Files . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

File > Export Selected Network . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Edit > Delete (Hypershade)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Edit > Delete Unused Nodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Edit > Delete Duplicate Shading Networks  . . . . . . . . . . . . . . . . . . . . 127

Edit > Delete All by Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Edit > Revert Selected Swatches  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Edit > Select All by Type  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Edit > Select Objects with Materials . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Edit > Select Materials from Objects  . . . . . . . . . . . . . . . . . . . . . . . . . 128

Edit > Duplicate (Hypershade)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Edit > Convert to File Texture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128

Edit > Create PSD Texture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131

Edit > Update PSD Texture  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 131

Edit > Test Texture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132

Edit > Render Texture Range  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 132

View > Frame All  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

View > Frame Selected  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

Create > Create Render Node . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

Tabs > Create New Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136

Tabs > Move Tab Up, Down, Left, Right  . . . . . . . . . . . . . . . . . . . . . . 136

Tabs > Rename Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136

Tabs > Remove Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136

Tabs > Revert to Default Tabs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 136

Tabs > Current Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 137

Graph > Graph Materials on Selected Objects  . . . . . . . . . . . . . . . . . 138

Graph > Clear Graph  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

Graph > Input Connections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

Graph > Output Connections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138

Graph > Input and Output Connections . . . . . . . . . . . . . . . . . . . . . . . 139

Graph > Show Previous Graph . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139
Shading

7



Table of Contents
Graph > Show Next Graph  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

Graph > Add Selected to Graph  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

Graph > Remove Selected from Graph  . . . . . . . . . . . . . . . . . . . . . . . 139

Graph > Rearrange Graph . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 139

Window > Attribute Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Window > Attribute Spread Sheet  . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Window > Connection Editor  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Window > Connect Selected . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Options > Create Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Options > Bins Sort Shading Node Only . . . . . . . . . . . . . . . . . . . . . . 140

Options > Display (Work Area Only)  . . . . . . . . . . . . . . . . . . . . . . . . . 140

Options > Keep Swatches at Current Resolution  . . . . . . . . . . . . . . . 141

Options > Clear Before Graphing . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141

Hypershade toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  141

Hypershade toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141

Windows and editors  . . . . . . . . . . . . . . . . . . . . . . . . 142
mental ray Custom text editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

Nodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143
Material nodes - Maya software. . . . . . . . . . . . . . . . . . . . .  143

Surface materials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  143

Overview of surface materials . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143

Common surface material attributes  . . . . . . . . . . . . . . . . . . . . . . . . . 143

Common surface material Specular Shading attributes . . . . . . . . . . 148

Anisotropic  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

Blinn . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151

Lambert . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153

Layered Shader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 153

Ocean Shader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154

Phong. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154

Phong E . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155

Ramp Shader. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155

Shading Map . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162

Surface Shader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163
Shading 

8



Table of Contents
Use Background . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 163

Shared surface material attributes  . . . . . . . . . . . . . . . . . . . . . . . . . . . 165

Displacement material . . . . . . . . . . . . . . . . . . . . . . . . . . . .  174

Displacement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174

Volumetric materials . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  175

Overview of volumetric materials . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175

Environment Fog  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175

Volume Fog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182

Light Fog . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184

Particle Cloud  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185

Volume Shader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189

Fluid Shape . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189

Common Volumetric material attributes  . . . . . . . . . . . . . . . . . . . . . . 190

Shading group node . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  191

Shading group node. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191

Texture nodes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  193

Overview of texture nodes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193

2D textures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  193

Bulge  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194

Checker  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194

Cloth. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194

File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196

Fluid Texture 2D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200

Fractal  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200

Grid  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202

Mountain . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202

Movie . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204

Noise  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204

Ocean . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207

Ramp . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207

Water . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210

Shared 2D texture attributes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214

3D textures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  216

Brownian . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
Shading

9



Table of Contents
Cloud . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216

Crater . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 218

Fluid Texture 3D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 219

Granite . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 219

Leather . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 220

Marble . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 222

Rock . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 223

Snow  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 224

Solid Fractal. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225

Stucco  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227

Volume Noise . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227

Wood . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230

Shared 3D texture attributes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 233

Environment textures. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  236

Common Environment texture attributes. . . . . . . . . . . . . . . . . . . . . . 236

Env Ball  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 236

Env Chrome. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238

Env Cube . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240

Env Sky  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240

Env Sphere  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 246

Other textures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  247

Layered texture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247

Placement nodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  249

Place 2d Texture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 249

Texture Map  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 252

mental ray for Maya shaders . . . . . . . . . . . . . . . . . . . . . . .  253

mental ray for Maya nodes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253

2 Surface Relief. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275

About Surface relief . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275

Bump maps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275

Displacement maps  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 276

mental ray for Maya displacement . . . . . . . . . . . . . . . . . . . . . . . . . . . 278

Feature-based displacement . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 278
Shading 

10



Table of Contents
How Do I? Apply colors, shading, and textures . . . . . . . . . . . . . 279
Connect a texture as a displacement map . . . . . . . . . . . . . . . . . . . . . 279

Set displacement map tessellation . . . . . . . . . . . . . . . . . . 281

Connect a displacement map  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281

Preview the displacement results . . . . . . . . . . . . . . . . . . . . . . . . . . . . 282

Adjust displacement sampling rates. . . . . . . . . . . . . . . . . . . . . . . . . . 282

Convert a displacement to polygons  . . . . . . . . . . . . . . . . . . . . . . . . . 282

Change bounding box scale  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283

What went 

wrong?

Bumps and displacements . . . . . . . . . . . . . . . . . . . . . . . . .  284

Troubleshoot:Displacement textures ‘pop’  . . . . . . . . . . . . . . . . . . . . 284

Troubleshoot:My blurred file texture looks crisp, not blurred . . . . . 284

Reference Nodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284
Feature-based displacement map attributes  . . . . . . . . . . . . . . . . . . . 284

3 Backgrounds  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289

About Backgrounds  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
Backgrounds . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289

Basic color and texture backgrounds . . . . . . . . . . . . . . . . . . . . . . . . . 289

Image file backgrounds  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 290

How Do I? Create backgrounds . . . . . . . . . . . . . . . . . . . . . . . . . 293
Create a basic color background . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293

Create a texture background . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 293

Create, edit, or position an image plane. . . . . . . . . . . . . . . . . . . . . . . 293

Create a static image file background. . . . . . . . . . . . . . . . . . . . . . . . . 295

Create an animated image file background . . . . . . . . . . . . . . . . . . . . 295

Create a 3D image file background . . . . . . . . . . . . . . . . . . . . . . . . . . . 296

Size and position an image file background  . . . . . . . . . . . . . . . . . . . 297

Remove or hide a background. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 298

What went 
wrong?

Backgrounds  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  298

Troubleshoot:Grainy or jagged background image. . . . . . . . . . . . . . 298

Reference Nodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  299

Image Planes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  299
Shading

11



Table of Contents
Image plane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 299

4 Reflection and Environment. . . . . . . . . . . . . . . . . . . . . . . . . 311

About Reflection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311
True reflections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311

Simulated reflections . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 311

How Do I? Create reflections . . . . . . . . . . . . . . . . . . . . . . . . . . . 312
Create true reflections  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 312

Simulate reflections with Env Ball. . . . . . . . . . . . . . . . . . . . . . . . . . . . 314

Simulate reflections with Env Cube  . . . . . . . . . . . . . . . . . . . . . . . . . . 315

Simulate reflections with Env Sphere. . . . . . . . . . . . . . . . . . . . . . . . . 316

What went 

wrong?

Maya materials and textures . . . . . . . . . . . . . . . . . . . . . . .  317

Troubleshoot:Cube maps swap front and back images  . . . . . . . . . . 317

5 Atmosphere . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 319

About Fog, smoke, dust, and silt  . . . . . . . . . . . . . . . . . . . . 319

How Do I? Create fog, smoke or dust  . . . . . . . . . . . . . . . . . . . . 319
Simulate fog, smoke, or dust. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 319

Change the visual effect of fog, smoke, or dust . . . . . . . . . . . . . . . . . 320

What went 

wrong?

Fog, smoke, and dust . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  322

Troubleshoot:Environment Fog problems . . . . . . . . . . . . . . . . . . . . . 322

Reference Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 324
Create. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  324

Create > Volume primitives . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 324

6 Baking textures and Prelighting  . . . . . . . . . . . . . . . . . . . . . 327

About Baking illumination and color . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 327

Baking to textures and vertices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 328

Baking with global illumination. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 328

Bake-sets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 329

How do I? Bake textures and vertices with mental ray for Maya . . . .  330

Create lightmaps by baking textures and vertices. . . . . . . . . . . . . . . 330
Shading 

12



Table of Contents
Create a bake-set. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 331

Adjust bake-set attributes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 332

Assign objects to existing bake-sets . . . . . . . . . . . . . . . . . . . . . . . . . . 332

Create a Bake-set tab in Hypershade  . . . . . . . . . . . . . . . . . . . . . . . . . 333

What went 
wrong?

Troubleshoot Global illumination baking limitations  . . . . . . . . . . . . 333

Troubleshoot 32 bit TIFF and IFF images are black and 

have no color information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333

Reference Menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 334
Rendering menu set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  334

Lighting/shading. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  334

Lighting/shading > Assign New Bake Set  . . . . . . . . . . . . . . . . . . . . . 334

Lighting/shading > Assign Existing Bake Set  . . . . . . . . . . . . . . . . . . 334

Lighting/shading > Batch Bake (mental ray)  . . . . . . . . . . . . . . . . . . . 334

Nodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 335
Bake-set nodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  335

Texture Bake set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 335

Vertex Bake-set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 338

7 Render node utilities  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 341

About Render node utilities  . . . . . . . . . . . . . . . . . . . . . . . . 341

How do I? Use General utilities  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 343

Use the Bump 2d utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 343

Use the Bump 3d utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 345

Use the Clear Coat utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 345

Use the Condition utility. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346

Use the Height Field utility. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 346

Use the Light Info utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 347

Use the Multiply Divide utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 347

Use the Plus Minus Average utility . . . . . . . . . . . . . . . . . . . . . . . . . . . 348

Use the Projection utility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 348

Use the Stencil utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 349

Use the Reverse utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 350

Use the Sampler Info utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 351
Shading

13



Table of Contents
Use the Set Range utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 353

Use the Vector Product utility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354

Use Color Utilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 355

Use the Blend Colors utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 355

Use the Clamp colors utility. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 357

Use the Contrast utility. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 358

Use the Gamma Correct utility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 358

Use the Remap Value, Remap Color, or Remap Hsv utilities . . . . . . 359

Use Switch utilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360

Use the Single Switch utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360

Use the Double Switch utility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 362

Use the Triple Switch utility. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 365

Reference Nodes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 368
General utilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  368

Array Mapper  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 368

Bump 2d  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 369

Bump 3d  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 370

Clear Coat  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 371

Condition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 372

Height Field . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 374

Light Info . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 375

Multiply Divide  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 377

Plus Minus Average . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 379

Projection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 381

Stencil  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 386

Reverse  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 388

Sampler Info . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 388

Set Range  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 390

Vector Product. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 390

Color utilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  392

Blend Colors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392

Clamp. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392

Contrast . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 392
Shading 

14



Table of Contents
Gamma Correct. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 393

Luminance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 394

Remap Value . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 394

Remap Color . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 395

Remap HSV . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 396

RGB to HSV . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397

Surf. Luminance . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397

Switch Utilities  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  397

Single Switch  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 397

Double Switch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 398

Triple Switch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 400

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 401
Shading

15



Table of Contents
Shading 

16



1 About shading and 
texturing surfaces
About Surface shading

In the real world, what an object is made of is one of two main factors that 
determine the appearance of its surface (the other is light). This is because 
when light hits the objects, some of the light is absorbed and some of it is 
reflected. The smoother the object, the shinier it is; the rougher the object, 
the more matte it is. 

In Maya, the appearance of a surface is defined by how it’s shaded. Surface 
shading is a combination of the basic material of an object and any 
textures that are applied to it. 

In Maya, materials (also called shaders) define an object’s substance. Some 
of the most basic attributes of materials include color, transparency, and 
shine. For more information on materials in Maya, see ”Maya materials” 
on page 25.

Factors beyond basic color, transparency, and shine that determine the 
appearance of an object’s surface (such as more complex color, 
transparency, shine, surface relief, reflection, or atmosphere) are defined 
by textures. For more information on textures, see ”Maya textures” on 
page 27.

Surface texture

In visual arts, a texture is any kind of surface detail, both visual and 
tactile. In Maya, you create surface detail with textures connected to the 
material of objects as texture maps. (Materials define a the basic substance 
of an object; see ”Surface shading” on page 17 for more details.)

For more information on texture maps, see ”Texture mapping” on 
page 33.

Image by Danny Mousses
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1 | About shading and texturing surfaces
About > Surface texture
Factors beyond basic color, transparency, and shine (see below) that 
determine the appearance of an object’s surface include: 

• Surface relief. See ”Surface relief” on page 275 for more information.

• Whether or not the surface casts or catches reflections. See 
”Reflection” on page 311 for more information. (Objects typcially 
reflect backgrounds or environments; see ”Backgrounds” on page 289 
for more information.)

• Atmosphere. See ”Fog, smoke, dust, and silt” on page 319 for more 
information.  

You can also bake illumination and color to a texture that you can later 
apply to objects in a scene. See ”Baking illumination and color” on 
page 327.

Color 

You can work with color in Maya in so many different ways. Here are 
some of the most common: 

• Change the basic color of an object by adjusting the color attribute of a 
material applied to the object. To find out more about material node 
attributes, see ”Render node attributes” on page 23. 

• Apply a texture as a color map to the material’s color attribute. 

• For more information about texture mapping, see ”Texture 
mapping” on page 33.

• To map a 2D or 3D texture, see ”Map and position textures” on 
page 84.

• Use a Ramp Shader for extra control over the way color changes with 
light and view angle. You can simulate a variety of exotic materials 
and tweak traditional shading in subtle ways. For a description of the 
Ramp Shader, see ”Ramp Shader” on page 155.

• Expand, enhance, or manipulate colors in applied textures using the 
Color utilities. For example, you can blend colors, adjust contrast, and 
convert HSV to RGB. For a description of each of the color utilities 
and what you can use them for, see ”Color utilities” on page 392.

Transparency

You can work with the transparency of an object in the following ways:

• Change the transparency level of an object adjusting the transparency 
attribute of a material applied to the object. To find out more about 
material node attributes, see ”Render node attributes” on page 23. 
Shading
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About > Surface texture
• Apply a texture as a transparency map to the material’s transparency 
attribute to designate which areas of an object are opaque, transparent 
or semi-transparent. 

• For more information about texture mapping, see ”Texture 
mapping” on page 33.

• To map a 2D or 3D texture, see ”Map and position textures” on 
page 84.

Specular highlight (shine)

You can work with the shininess of objects in your scene in the following 
ways: 

• Change the intensity and size of the specular highlights of an object by 
adjusting the Specular Shading attributes of a material applied to the 
object. To find out more about material node attributes, see ”Render 
node attributes” on page 23 and ”Common surface material Specular 
Shading attributes” on page 148. 

• Apply a texture as a specularity map to the material’s Specular Color 
attribute to designate which areas of an object shine (and the color of 
the highlights). 

• For more information about texture mapping, see ”Texture 
mapping” on page 33.

• To map a 2D or 3D texture, see ”Map and position textures” on 
page 84.

What are specular highlights?

Some surfaces are shinier than others (for example a wet fish has a shinier 
surface than a dry leaf). Depending on how shiny a surface is, it reflects 
light in different ways. 

Note Only materials with specular attributes (Anisotropic, Blinn, 
Phong, and PhongE) have surface highlights. The specular 
highlight is the white shiny glow on the material.

Anisotropic Blinn Phong PhongE
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About > Surface texture
Shiny objects reflect light directly; matte objects diffuse light. Specular 
highlights show the places on the object where the light sources are 
reflected at consistent angles; reflections on an object show, among other 
things, light bounced from surrounding objects.

Specular highlights depend directly on the view (camera), not the position 
of the light, like diffuse shading does. 

Highlights

The size of a specular highlight on a surface makes the surface look either 
flat or shiny. 

Highlight color

You can control the color of highlights on surfaces. 

Reflections

You can control the degree of reflectivity as well as other surface properties 
like refracted color. 

Tip The Blinn material is recommended for shiny surfaces in 
animations. Highlights on other specular materials, like 
Phong and PhongE, may flicker when animated.
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About > Shading networks
Shading networks

Shading networks

A shading network is a collection of connected rendering nodes that defines 
how colors and textures contribute (usually with lights) to the final look of 
surfaces (materials). A shading network typically consists of any number 
of connected rendering nodes plugged into a shading group node. (For 
more information about render nodes, see ”Render nodes” on page 22.)

A good portion of your time building shading networks is spent 
connecting node attributes to each other and adjusting node attributes to 
describe what a surface should look like and how it should be positioned.

To build shading networks, see ”Build shading networks” on page 58.

Importing shading networks

By default, when you import a file more than once into Maya, the 
geometry and shading networks are duplicated. These redundant shading 
networks and reassignment of geometry inflate the scene size and load 
time, and clutter your working scene. You can prevent the duplication of a 
shading network (unless, of course, you need it) when you import a scene, 
or you can delete any duplicated network from within your working 
scene.  

To prevent redundant shading networks on import, when you import a 
scene (File > Import > ), turn on Remove Duplicate Shading Networks.

To delete a redundant shading network, in Hypershade, select Edit > 
Delete Duplicate Shading Networks. 

Shading group node

Shading networks are designed as a data flow network, where data 
streams from the left side of the network toward a final shaded result that 
emerges from the right node. The right most node (which is not always 
visible by default; click the Input and Output Connections button in the 
Hypershade to see it) is the Shading Group for that particular network. 

The shading network is a
a collection of connected 
nodes.

Shading group node
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About > Render nodes
The Shading Group is a collection of materials, textures, and lights that 
efficiently describe all the necessary attributes required to shade or render 
an image. 

All of the nodes connected upstream (that is, farther to the left of the 
node) of the shading group contribute to the final look of surfaces in the 
scene. Adjusting any node’s attributes or connections causes a 
downstream (that is, farther to the right) reaction that can be seen in the 
final rendered image. To learn more about these input and output 
connections, see ”Show node connections” on page 70.

For a description of the Shading Group node’s attributes, see ”Shading 
group node” on page 191.

Shader network libraries

Maya ships with a library of shader networks. To install the shader 
library, if it is not installed by default, see the Installation and Licensing 
guide. To view and work with shader network libraries, see ”Work with 
shader libraries” on page 78.

Maya also ships with a number of mental ray shading networks (mental 
ray for Maya must be loaded to see them in the Hypershade). To create 
and load mental ray for Maya shading networks, see ”Work with mental 
ray shaders” on page 99.

Render nodes

Render nodes are the individual components you interconnect to use as 
building blocks to produce all rendering effects. Like all other nodes in 
Maya, you can animate or map render nodes to other nodes’ parameters. 
For more information on Maya nodes, see “Nodes and attributes” in the 
Basics guide.

Texture nodes, placement nodes, and material nodes along with their 
input and output connections (attributes) define all aspects of the final 
rendered images, from surfaces to lights and shadows. 

• To learn more about material nodes, see ”Surface, displacement, 
volumetric materials” on page 25.

• To learn more about texture nodes, see ”Texture nodes” on page 193.

• To learn more about placement nodes, see ”2D and 3D texture 
positioning” on page 36.

You can connect nodes to create the effects you want. You can also share 
nodes to create visual relationships, and to make rendering more efficient. 
For example, two objects can share a single texture so that both objects 
appear the same, but less memory and, or processing is required. 
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About > Render node attributes
You can see and work with rendering nodes and shading networks in the 
Hypershade. To learn more about the Hypershade, see ”Hypershade” on 
page 122.

Render node attributes

A node attribute describes one aspect of the node. So, when you adjust an 
attribute of a node, you adjust one aspect of its description. For example, 
you can change the color attribute from red to blue. Or, you can change an 
opaque object to transparent by adjusting the transparency attribute. 

Although you can interactively adjust some attributes, typically you verify 
and enter precise numerical values using the Attribute Editor or display 
and adjust node attributes in the Attribute Spreadsheet or the Channel 
Box. (Only some attributes are displayed in the Channel Box. All 
attributes are displayed in Attribute Editor and Attribute Spreadsheet. To 
find out more about general editors such as the Attributes Editor and the 
Attribute spreadsheet, see ”Attribute Editor” on page 193 in the Basics 
guide.)

To adjust render node attributes, see ”Adjust node attributes” on page 75.

A material node’s attributes 
Shading

23



1 | About shading and texturing surfaces
About > Render node connections
Render node connections

Connections between node attributes are shown by colored arrowed lines 
in the Hypershade. The connection lines between nodes indicate what 
type of data flows through the connection. Depending on the types of 
nodes and connections used, different information is passed. That is, 
values may be of color, distance, position, angle or object ID.

Some information can come as a single value (for example, OutAlpha is a 
single value) or as triple (for example, an RGB value or an XYZ value). 
Triple connections are represented by green connection lines. Single, 
double, triple, data, and array data each have an assigned default color.

You can customize the colors and their meanings. To change default 
connection line colors, see ”Change default connection line colors” on 
page 67.

To connect render nodes, see ”Connect nodes” on page 70.

Note mental ray for Maya expects only certain connections to be 
made to the message attribute in the Attribute Editor. See 
”mental ray shader connections” on page 41 for more 
details.

Tip When you point to one of the lines that connects two nodes 
by their attributes, and information appears about the 
connection. To show and hide node connections, see ”Show 
node connections” on page 70.
Shading

24



1 | About shading and texturing surfaces

About > Surface, displacement, volumetric materials
The Connection Editor

Each node has a default attribute and a list of commonly connected 
attributes that lets you make node connections interactively (dragging and 
dropping in Hypershade). The Connection Editor, however, is the best 
tool for fine-tuning a shading network and for making non-default 
connections. 
 

The Connection Editor shows node network information in a side-by-side 
layout so that you can view two connected nodes in a node network. You 
can quickly and easily traverse from node to node and show a node’s 
outputs or inputs. This helps to facilitate connections, meaning you can 
make connections in either direction in a node network. 

For more information on the Connection Editor, see ”Connection Editor” 
on page 120.

To connect nodes with the Connection Editor, see ”Connect render nodes 
using the Connection Editor” on page 73. 

Maya materials

Surface, displacement, volumetric materials 

Though 3D surfaces in Maya respond to light similarly to those in the real 
world, there are important differences in the way that surfaces and lights 
interact in computer graphics software. Material nodes are a type of 
render node (see ”Render nodes” on page 22) that, when applied to an 
object, let you define how the object’s surface appears when rendered. 

See also ”Surface shading” on page 17.

In Maya, material nodes define how surfaces react to light. (The term 
shader is often used to describe the role played by a material node, 
especially in mental ray for Maya.) Maya contains several types of 
material nodes that help you simulate the real-world qualities or 
behaviors of surfaces to light: Surface material nodes, Displacement 
material nodes, and Volumetric material (atmosphere) nodes. 

You can set a material’s attributes, such as color, specularity, reflectivity, 
transparency, and surface detail of scene elements to create a wide variety 
of realistic images. For a detailed description of Maya’s materials, their 
attributes, and guidelines on how to change them, see ”Material nodes - 
Maya software” on page 143.

Note Some utility nodes can connect to a material’s attributes 
only through ”The Connection Editor” on page 25. 
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Surface material

Surface materials represent the types of surfaces onto which you can map 
textures. Attributes such as shininess, matte, reflectivity, glossiness, and so 
on, vary among the different types of materials in Maya. For example, if 
the texture requires a shiny surface, such as chrome, use a Phong material 
rather than something like a Lambert.

For a detailed description of a surface material’s attributes, see ”Surface 
materials” on page 143. 

Displacement material

The displacement material lets you use an image to specify surface relief 
on objects in your scene. To find out more about surface relief, see 
”Surface relief” on page 275.

Volumetric material (atmosphere)

In the real world, when you photograph an object, it is usually within an 
atmosphere (air) and is surrounded by other objects (background). 

Volumetric materials describe the physical appearance of phenomena 
which occupy a volume of space (for example, fog, smoke, dust or other 
fine particles). You can raytrace volumetric materials and produce effects 
such as displaying light fog through mirror reflections and refractions.

For a description of volumetric materials see ”Volumetric materials” on 
page 175. 

To use volumetric materials, see ”Simulate fog, smoke, or dust” on 
page 319.

Layered shaders

You can layer shaders when you want to use more than one material for 
an object. Layered shaders let you create the appearance of variations in 
the material qualities of the surface by combining two or more material 
nodes that each have their own qualities. Layered shaders render more 
slowly than other materials, so consider using Layered textures instead to 
achieve similar results. 

To use a layered shader, see ”Layer shaders” on page 81.

Note When you first create an object, Maya’s assigns a special 
version of the Lambert material (a surface material) by 
default. 
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About > Double-sided shaded surfaces
For a description of the Layered Shader node’s attributes, see ”Layered 
Shader” on page 153.

Layered textures with the Layered Shader node

The Layered Shader has an attribute called compositing flag that causes the 
shader type to layer materials or layer textures. You can use this to layer 
textures with the Layered Shader node. However, using the Layered 
Texture node is recommended because you can set many more options. 
See ”Layered textures” on page 28 for more information.

If you choose the texture option for the compositing flag, you must plug 
the whole network into a material (for example, Phong or Blinn).

For a description of this flag, see the Layered Shader node’s attributes in 
”Layered Shader” on page 153.

Double-sided shaded surfaces

Double-sided shading lets you shade a surface with one material on one 
side and a different material on the other side. This is the only way you 
can apply more than one material to a NURBS surface. You use both the 
Condition and Sampler info utility to create this effect. For more 
information on these utility nodes, see ”General utilities” on page 368.

To create double-sided shaded surfaces, see ”Create double-sided shaded 
surfaces” on page 81.

Maya textures

2D and 3D textures

Texture nodes are a type of render node that, when mapped to the 
material of an object, let you define how the object’s surface appears when 
rendered. For more info on render nodes, see ”Render nodes” on page 22.

Texture node(s) (with the material node(s)) feed into the Shading Group 
node, which tells the renderer how to shade the surface. For more 
information on Maya’s Shading Group node, see ”Shading group node” 
on page 21.

Texture nodes are procedural textures generated by Maya or bitmap 
images imported into Maya (see ”Procedural textures” on page 29) that 
you can use as texture maps for material attributes. Texture maps on 
various attributes such as color, bump, and specularity affect the 
appearance of the material. For more information about texture maps, see 
”Texture mapping” on page 33.
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2D textures

2D textures wrap around an object, like gift wrapping, or stick to a flat 
surface, like wallpaper.

• For a detailed description of Maya’s 2D textures, see ”2D textures” on 
page 193.

• To map a 2D texture see, ”Map a 2D or 3D texture” on page 84.

• To position a mapped 2D texture on an object see, ”Position 2D 
textures and labels” on page 85.

3D textures

3D textures project through objects, like veins in marble or wood. 

With a 3D texture, objects appear to be carved out of a substance, such as 
rock or wood. You can scale, rotate and move 3D textures interactively in 
a scene view to achieve the desired results.

• For a detailed description of Maya’s 3D textures, see ”3D textures” on 
page 216.

• To map a 3D texture see, ”Map a 2D or 3D texture” on page 84.

• To position a mapped 3D texture on an object see, ”Position 3D 
textures” on page 86.

Environment textures

Environment textures are commonly used either as backgrounds for 
objects in your scene or as reflection maps. 

For more information on simulating reflections with environment maps, 
see ”Reflection” on page 311.

For a detailed description of Maya’s Environment textures, see 
”Environment textures” on page 236.

Layered textures

There are two ways to layer textures in Maya: using the Layered Shader 
with the texture compositing flag (see ”Layered shaders” on page 26), or 
with the Layered Texture Node. 

Though the workflow for using the Layered Texture node is similar to the 
Layered Shader, using the Layered Texture node is recommended because 
you can set many blend modes. 

To use the Layered Texture Node to layer textures, see ”Use a layered 
texture” on page 88.
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Procedural textures

Procedural textures are generated by Maya. In fact, all of Maya’s 2D 
textures (except for file and movie) and 3D textures are procedural 
textures.

Procedural textures are 2D or 3D plots of mathematical functions (called 
procedures) that have no limitation in resolution (size). You can adjust 
attributes for different aspects of a procedural texture to create different 
looks. 2D procedural textures operate much like 2D file textures in that 
they attach themselves to the UV coordinates of the geometry. 3D 
procedural textures ignore UV coordinates.

File textures

File textures are bitmaps scanned from photographs, taken with a digital 
camera, or painted in a 2D or 3D paint package that you bring into Maya 
to use as a bitmap. File textures filter better than most procedural textures 
and can result in better image quality.

HDR images as file textures (mental ray for Maya)

mental ray for Maya supports High-Dynamic Range (HDR) images as file 
textures. 

For more information about HDR images, see ”High Dynamic Range 
Imaging (HDRI)” on page 31 in the Lighting guide. 

Considerations for creating file textures

Animated file textures

To use a sequence of image files to create an animated file texture, the file 
extensions must be separated from the basename and, or the extension by 
periods. For examples, see ”Image Name” on page 198.

Note You can render an entire branch of a shading network to 
use the illumination, shadow, shading, and textures as a file 
texture (texture map) for the following reasons: 

• To reduce rendering time of particularly complex 
networks or if mental ray's high-profile global 
illumination features are involved. 

• To obtain lighting effects that would be difficult to 
achieve in other ways. 

For more information see ”Baking illumination and color” 
on page 327
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File textures for hardware rendering 

In general, when rendering with file textures, take into consideration how 
much space the texture takes up in screen space. Larger textures (in one or 
both dimensions) use a lot of memory and take longer to render because 
the hardware renderer must spend more time reducing their size. Try to 
keep textures as small as possible when rendering. This substantially 
decreases rendering time and memory usage and may result in better 
quality (fewer aliasing problems and texture crawling).

Tileable file texture images

Like any other texture, you map a file texture to an attribute of a material 
(shader). You can map file textures as a tileable (repeating) image where 
the opposing edges of the texture line up. 

Procedural textures are tileable by default, but if you want to tile (repeat) 
file textures, you must make sure edges match properly to prevent seams. 
To make sure edges match properly, you can use an image editing 
package to offset the image, then touch up light or dark areas in the offset 
tile.

A tileable bitmap image is one that can be broken down into smaller 
pieces. Tileable images load faster and easier by the renderer, saving 
valuable rendering time. For more information on how to reduce the load 
on RAM during render time by converting your textures to Block Ordered 
Textures (tiles), see ”Cache texture tiles using BOT (block ordered texture)” on 
page 141 in the Rendering guide.

Note Using “.” to delineate animated file texture names, may 
cause the wrong frame to be used for texture mapping. 

Maya parsable, animated file textures should be of the form 
XXX.ext.###, where XXX is the filename, ext is an optional 
file extension (.sgi, .tif, .iff, and so on), and ### is the 
frame number. 

It is also possible to use file textures of the form 
XXX.###.ext. We do not support XXX###.ext (without the 
“.” between XXX and ###), nor XXX.YYY.###.ext (but 
XXX_YYY.###.ext is fine).

Note On Mac OS X, file textures larger than 1K are not 
supported.
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Square vs. non-square bitmap images

You want your texture to fit your model perfectly, as though the texture 
has been painted on. You could measure the surface to which the texture 
is attached. However, because Maya is more efficient if it scales any non-
square texture into a square texture, using a square image to begin with is 
recommended. If the object you are texturing is not square, for example, a 
lamp pole, place your texture in a black square. 

Photoshop file texture

(For Maya Software, Maya Hardware, and mental ray renderers.)

Photoshop files (version 6.0+) are supported, facilitating simple painting 
workflows in the following ways: 

• You can use any existing Photoshop file as a texture in Maya, 
anywhere you would normally apply a texture. 

Paint layers in layer sets in 
Photoshop

...and see them in Maya

UV snapshots help 
you paint accurately
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• You can convert a PSD file with layer sets to a Layered Texture in 
Maya to help visualize and work with the individual layer sets.

• You can create a layered PSD file from within Maya in order to paint 
multiple channels (color, bump, specular, and so on) separately on an 
object, in Adobe Photoshop. 

• You can use Maya’s 3D Paint Tool to sketch out (“lipstick”) an object 
to act as guidelines for the areas on the Photoshop image that should 
be painted, useful when UVs are inappropriate or unavailable to be 
used as a guideline. 

• At anytime, you can modify a PSD file in Photoshop, then update 
(refresh) the image in Maya to see the modifications immediately. 

Related topics

”Use PSD files as textures in Maya” on page 92

”Create a PSD file with layer sets from within Maya” on page 93

”Sketch out guidelines (“lipstick”) for paint application” on page 95

”Update PSD textures” on page 96

Texture filtering

Texture filtering is an anti-aliasing technique used to refine file textures, 
reduce flickering, or to achieve special effects. The File texture’s Filter 
attributes (see ”File” on page 196) scale the size of the filter and let you 
specify the amount of blur in the texture map.

If a texture map image is too sharp, it may reveal aliasing (staircase) 
effects in the final rendered image. By default, Filter is set to a value of 1.0 
to help prevent such aliasing effects.

The effect of Filter is related directly to eye space. As the object moves 
further away from the eye, the more the texture blurs.

Multipixel filter plug-ins

(For Maya software renderer only.)

Multipixel filters process the entire rendered image to help eliminate 
artifacts, such as aliasing or jagged edges in rendered images, or roping or 
flicking in rendered animations. You can choose from a few different 
types of multipixel filters or you can create and use your own plug-in. 

To create and use your own plug-in, see ”Create and load a plug-in 
multipixel filter” on page 103 in the Rendering guide.
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Mapping and positioning textures

Texture mapping

Maya has a number of textures that you can map onto objects. For more 
information on these textures, see ”2D and 3D textures” on page 27.

To apply a texture to an object you map (connect) it to the attributes of an 
object’s material. (Textures and materials are render nodes. Render node 
attributes describe how the node appears and behaves; for more 
information, see ”Render nodes” on page 22.) The attributes to which the 
texture is connected determines how the texture is used and therefore 
how it affects the final results. 

For example, if you connect Maya’s 2D black and white Checker texture to 
the color attribute of an object’s material, you have applied a color map; 
the checkered pattern determines which parts of the object appear black 
and which appear white (or other colors if you adjust the texture’s color 
attributes). 

To map a texture, see ”Map and position textures” on page 84.

If you connect the black and white Checker texture to the transparency 
attribute, you have applied a transparency map; the checkered pattern 
determines which parts of the object are opaque and which are 
transparent.

A Checker texture 
connected to the 
Color attribute of a 
sphere’s material. 

This is a color map. 

The same map with 
the Checker 
texture’s color 
attributes adjusted. 

A Checker texture 
connected to the 
Transparency 
attribute of a sphere’s 
material. 

This is a 
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For a description of how textures stick to materials of objects, see 
”Mapping methods” on page 35.

Commonly used texture maps

To map a texture, see ”Map and position textures” on page 84.

Color maps

By mapping a texture to the Color attribute of an object’s material, you 
create a color map which describes the color of the object. 

To learn more about how you can work with color in Maya, see ”Color” 
on page 18.

Transparency maps

By mapping a texture to the Transparency attribute of an object’s material, 
you create a transparency map which lets you make parts of an object 
opaque, semi-transparent, or entirely transparent. 

To learn more about how you can work with transparency in Maya, see 
”Transparency” on page 18.

Specularity maps

By mapping a texture to the Specularity attribute of an object’s material, 
you create a specularity map which lets you describe how shine appears 
on objects (by controlling highlight). 

To learn more about how you can work with highlight in Maya, see 
”Specular highlight (shine)” on page 19.

Reflection maps

By mapping a texture to the Reflection attribute of an object’s material, 
you create a reflection map which lets you describe how an object reflects 
its surroundings. 

To learn more about how you can work with reflection in Maya, see 
”Reflection” on page 311.

Bump maps 

By mapping a texture to the Bump attribute of an object’s material, you 
create a bump map which lets you add the illusion of surface bump detail 
to a surface. 

To learn more about bump maps in Maya, see ”Bump maps” on page 275.
Shading

34



1 | About shading and texturing surfaces

About > Mapping methods
Displacement maps

Displacement maps let you add true dimension to a surface at render 
time, a process which may reduce or eliminate the need for you to create 
complex models. 

To learn more about how you can work with displacement maps, see 
”Displacement maps” on page 276.

Mapping methods

Normal mapping (default)

When you map a 2D texture, you can choose the mapping technique Maya 
uses to apply the texture to the object: normal, projection, or stencil. 
Mapping techniques determine the relationship between the texture and 
the surface. By default, textures are mapped as a normal map.

The texture is mapped to the UV space of the surface and is sized and 
positioned depending on the UV parameterization of each surface. See the 
Polygonal Modeling guide for more details.

The shading network for a Normal 2D texture map is made up of the file 
texture node and the place2Dtexture node that defines the texture’s 
placement.

Normal mapping Projection mapping
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Projection mapping

This mapping technique projects the texture through 3D space like a slide 
projector.

When you create a projected 2D texture, it behaves like a 3d texture (it has 
height, width, and depth).

The shading network for a Projection 2D texture map is made up of the 
file texture node and a Projection node that defines the texture’s 
placement.

Stencil mapping

This technique lets you use either a mask file or a color key to remove part 
of the texture. If your label is not square, project the texture as a stencil to 
knock out the label using either a mask file or by color keying the texture. 
Then use the texture's Color Balance > Default Color to set or map the 
color behind the label.

The shading network for a Stencil 2D texture map is made up of the 
texture and a Stencil node that defines the masking, and two 
place2Dtexture nodes: one for the texture, and one for the stencil.

2D and 3D texture positioning

2D texture positioning

A 2D placement node in a shading network defines a texture's positioning 
and orientation within the UV space of the geometry. 

The 2D placement can result directly from the surface's UV space or 
indirectly through a projection node (if the texture is projection mapped). 

You can scale (repeat), move (position) or rotate a place2Dtexture to 
change how the texture appears on the surface to which it is mapped. 
Other values, such as coverage and default color let you specify how 
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much of the surface area is covered by the texture frame and the color of 
the border that surrounds the texture (which happens only if the coverage 
is set to less than 1), respectively. 

• To position 2D textures, see ”Position 2D textures and labels” on 
page 85.

• For a description of the place2dtexture node, see ”Place 2d Texture” 
on page 249.

• To change the default operation of the place2dtexture from label 
mapping to surface placement (which adjusts the contents of the label 
instead), see ”Texture placement vs. label mapping” on page 38.

Shared 2D texture node placement

Different textures can connect to one place2Dtexture node so that they are 
positioned identically. Edits to the place2dtexture node affect all of the 
textures to which it is connected. Sharing textures with color, bump, 
specularity, and other maps that need precise placement is recommended.

To learn about node connections, see ”Render node connections” on 
page 24.

3D texture positioning

A 3D placement node defines a 3D texture or Environment texture’s 
positioning and orientation in world space. 3D placement nodes make it 
easier to texture multiple surfaces as if they were one. 

You can reposition 3D textures with numerical precision in the 
place3dtexture node’s Attribute Editor, or you can use manipulators to 
reposition textures or labels interactively. 

Maya provides two methods to place 3D textures on NURBS surfaces—
Interactive Placement or Fit to group bbox (bounding box). Select the 
method most suitable for your needs. Sometimes using both methods 
works best.

When you create a 3D texture or project a texture onto an object (rather 
than apply it as a normal or as a stencil), a cube-shaped icon appears in 
the scene that corresponds to the size, scale, and location of the texture on 
the surface. Especially for animated or deforming objects, you must 
maintain the correct positioning of the texture on the object. (If the object 
is animated, you could parent the 3D icon to the geometry, for example.)

To position 3D textures, see ”Position 3D textures” on page 86.
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Texture placement vs. label mapping

By default, the Texture Placement tool is set for Label Mapping, which lets 
you stretch, shrink, move, and rotate the texture as if it were a label. You 
can change set the tool for Surface Placement, which lets you stretch, 
shrink, move, and rotate the texture as if it were wallpaper.

In both cases, wrap U and wrap V control the tiling of the texture in 
horizontal and vertical directions (based on the UV coordinates on the 
object).

To change the Texture Placement Tool, double-click the Texture Placement 
Tool icon in the toolbar, or select 
Texturing > NURBS Texture Placement Tool > .

Surface placement

When you drag the manipulator handles, the attribute settings for Repeat 
UV, Offset, and Rotate UV change in the place2dTexture’s Attribute 
Editor. This lets you stretch, shrink, move, and rotate the texture as if it 
were wallpaper.

Label mapping

When you drag the manipulator handles, the attribute settings for 
Coverage, Translate Frame, and Rotate Frame change in the 
place2dTexture’s Attribute Editor. This lets you stretch, shrink, move, and 
rotate the texture as if it were a label.

As you middle-
drag the small 
boxes...

... these attribute settings change
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Transferring surface information

You can transfer surface characteristics from one surface to a texture map 
on another. The most common application of this tool is in the creation of 
high-performance, real-time models where some surface detail cannot be 
adequately represented within the polygon limit required. 

You can create a higher-detail (non-real-time) model that defines the 
desired details, then transfer the details across onto the real-time model in 
the form of a map (for example, a normal map). See ”Transfer surface 
information” on page 91.

mental ray for Maya shaders

mental ray for Maya Shaders

mental ray for Maya Shading nodes, such as materials, textures, and 
lights, allow you to expand the effects achievable when you render with 
mental ray for Maya. 

mental ray for Maya shaders include the Maya Base shaders and Custom 
Shaders and Phenomena. 

Note To use this, the Transfer Surface Informationplug-in 
must be loaded. See ”To load the Transfer Surface 
Information plug-in” on page 91.

As you middle-
drag the small 
boxes...

... these attribute settings change
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Maya base shaders

Maya comes with a collection of mental ray for Maya base shaders that 
you can assemble into  a wide variety of shading networks. You can use 
the Maya base shaders exclusively or combine them with the standard 
Maya (or mental ray) shaders. 

You use them the same way you do Maya materials, textures, lights, 
cameras, and so on. You can achieve sophisticated photorealistic and non-
photorealistic looks with them. 

For a complete description of Maya base shaders, see ”mental ray for 
Maya nodes” on page 253.

Custom shaders

Custom shaders are custom-coded mental ray shaders that let you create 
looks over and above those that can be achieved with the standard mental 
ray for Maya Base shaders. You (or third-party developers) can create 
them in C or C++ language, then process them into modes that you can 
see and use in Maya.

A collection of custom shaders (one or more) make up a Custom Shader 
Library. Custom shaders are typically distributed in custom shader 
libraries. To see a particular custom shader in Maya, you must load the 
shader library that contains that custom shader. See ”Load shaders” on 
page 101

Custom shader libraries

Custom shaders are distributed in custom shader libraries. To see a 
particular custom shader in Maya, you must load the shader library that 
contains that custom shader. A custom shader library consists of two files:

• a declaration file (for example, mayabase.mi) that contains 
descriptions of the interfaces of the shaders

• a library file (for example mayabase.so or mayabase.dll) that 
contains the actual implementations of the shaders

The Node Factory (see ”The Node Factory” on page 42) creates the Maya-
type nodes from your custom shader declarations. These nodes work just 
like regular Maya nodes: you can use them to build shading networks; 
you can save, load, and export them; you can write your own Attribute 
Editor templates; and you can provide icons, swatches, and help files. See 
the devkit for more information and examples.
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mental ray shader connections

The following mental ray shader parameter types are recognized as 
message attribute by Maya: light, geometry, color texture, scalar texture, 
vector texture, lightprofile, shader. 

Though it is possible to connect any node to these attributes, you should 
make only those connections that Maya expects, otherwise a crash or 
rendering abort may occur. That is, if you drag a node to the message 
attribute in the Attribute editor, the message attribute of the source node 
will be connected to the attribute (for example node1.message > 
mrShaderNode.shader), but only the following connections are recognized 
and will work in Maya: 

• light : light transform node. For example, pointLight1.message > 
dgs_material1.lights[0] 

• geometry : geometry shader. For example, mib_geo_sphere1.message 
> mib_geo_instance1.object 

• shader : mental ray shader. For example, mib_illum_phong1.message 
> mib_geo_instance.material 

• color texture, scalar texture, vector texture: mentalrayTexture node. 
For example, mentalrayTexture1.message > mib_texture_lookup1.tex. 
The button next to a color/scalar/vector texture attribute in the 
shader's attribute editor will create a new mentalrayTexture node, and 
connect it to the attribute. 

• lightprofile : mentalrayLightProfile node. For example, 
mentalrayLightProfile1.message -> mib_light_photometric.profile. 
The button next to a lightprofile attribute in the shader's attribute 
editor will create a new mentalrayLightProfile node, and connect it to 
the attribute.

Phenomena

Phenomena are mental ray for Maya components that look and behave 
like shaders but, unlike custom shaders, they require no programming 
knowledge of C or C++ code to create. 

By exporting an assembled shading network (or portions of it) and 
designated attributes, you create a Phenomenon, a single node that you 
can then use just like a regular shader: you can build shading networks 
with them; save, load, and export them; write your own Attribute Editor 
templates; and provide icon, swatches, and help files. See the devkit for 
more information and examples.

Phenomena: 
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• Provide you with a simpler way of creating complex looks for objects 
other than creating custom shaders.

• Can be created during the earlier phases of production and then 
optimized or coded into custom shaders for later stages of the 
production. 

• Let you restrict simplify the number and type of adjustable attributes 
made available to Maya artists. This provides you with a unified 
pallet and more control over the looks that can be achieved. 

Previously generated phenomena

In order for the Node Factory to find and generate in Maya previously 
exported Phenomena, you need to:

• Export the file (for example, my_phenomenon.mi) to the directory 
specified in the environment variable: MI_CUSTOM_SHADER_PATH. The 
default value of this environment variable is: C:\Program 
Files\Alias\Maya6.5\mentalray\include.

• Specify to the Node Factory to generate the node at every Maya 
startup. To do this, you must edit the maya.rayrc file, located (by 
default, for example) in C:\Program Files\Alias\Maya6.5\mentalray

• Add the following line:
mi "{MAYABASE}/include/my_phenomenon.mi" 

The Node Factory

The Node Factory is a special part of mental ray for Maya that creates 
Maya-type nodes from custom shader declarations and Phenomena 
declarations. (When you export an assembled shading network to be used 
a Phenomenon, the network is exported to the .mi declaration file.)

The Node Factory parses the declaration and packs it into a single node—
a shader or Phenomenon, depending on what you are creating. 

To see each node type being created in the Script Editor, set option Var 
miFactoryVerbosity to 4 or higher. 

 Successfully created node types are available in Create Node window 
(Hypershade > Create Node window > Create mental ray nodes), either in 
the Miscellaneous section or one of the other sections (if the appropriate 
flag was set when you wrote the shader or exported the Phenomenon). 

The Node Factory Parser

The Node Factory parser accepts any valid mental ray shader or 
Phenomenon declarations and special extensions. Messages are written to 
the Script Editor to inform you about parsing progress and any errors that 
have occurred. 
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Parsing error messages

The parser prints the name of the file it is processing. If an error occurs, 
the line number and a hint of what the parser actually expected are 
written. 
 

Unrecoverable errors occur only if the syntax of parts of a shader or 
phenomenon declaration is wrong. The parser is unable to recognize, for 
example, commas in the parameter lists are missing. In such a case, the 
declaration is discarded. 

Naming guidelines

• Attribute names and short names must be unique per node. For 
example, children of different compounds must not have the same 
name or short name. 

• Node type names and IDs must be unique. 

Syntax extensions for Maya specials

You can provide additional parameters for each attribute on a node, and 
the node itself. Because there are no counterparts for these parameters in 
mental ray's scene description language, the Factory parser has been 
extended beyond the standard mental ray syntax to recognize certain 
keywords that can be given on a per attribute or per shader or 
phenomenon basis. 

Add additional attributes with keywords

You can provide additional parameters for each attribute on a node, and 
the node itself by including keywords in the .ni declaration file. 

These keywords must be prefixed with #: so that the declaration files are 
still accepted by the standard mental ray parser; these keywords are 
ignored by the standard mental ray parser (but not the Node Factory 
parser) because they are recognized as comments. Special comments in 
wrong places or syntactically wrong #: comments cause parse errors, 
which are written to the Script Editor. 

Note The Factory Node parser does not understand the full 
mental ray syntax, so parsing errors frequently occur within 
Phenomenon declarations when unknown shader 
requirements or commands are encountered. The parser 
recovers from these errors without harm and proceeds. 
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Where to put keywords and what to write

Such #: comments can appear in two places: after a shader parameter or 
phenomenon parameter or in the requirement section of a declaration. 

• After a parameter, the following syntax is valid: 

default scalar [scalar [scalar]] 
max scalar [scalar [scalar]] 
min scalar [scalar [scalar]] 
shortname "string" 
softmax scalar 
softmin scalar 

• In a declaration's requirement section, the following is syntactically 
correct: 

nodeid integer

If none of these additional keywords are provided, the default is zero; the 
min/max and softmin/softmax are undefined; and the short name is 
uniquely assigned by counting attributes on nodes. Likewise unique node 
IDs are determined by counting nodes. 

For attributes, not every keyword makes sense for every attribute type. 
The following is supported by Maya and thus by the Node Factory: 

Short names

Short names can be given to every attribute. The Factory appends R,G,B to 
color children names/short names and X,Y,Z to vector children names/
short names. 

Example 1 (of 2): 

declare shader
vector #: shortname "ov"
"multiplyDivide" (

integer "operation", #: default 1 min 0 max 2

mental ray 
type

Maya 
type

default min/
max

soft min/
max

boolean boolean 0/1

color float3 3 scalars

integer long 1 integer 1 integer 1 integer

scalar float 1 scalar 1 scalar 1 scalar

vector float3 3 scalars 3 scalars
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vector "input1", #: default 1. 1. 1.
vector "input2" #: default 1. 1. 1.
)

#:
#: nodeid 6894 # This is the node ID for binary Maya files.
#:
version 1

end declare

Example 2 (of 2): 

declare shader
struct {

color "outColor", #: shortname "oc"
scalar "outAlpha" #: shortname "oa"

} "ramp" (
array struct "colorEntryList" {

scalar "position",
#: default 1.

color "color"
#: default 0.8 0.8 0.8

},
#: shortname "cel" # compound's short name

scalar "uWave",
#: shortname "uw"
#: default    0.5
#: softmin   1E-5 softmax 1
#: min    1.0E-05 max     1

scalar "vWave",
scalar "noise",
scalar "noiseFreq",
scalar "hueNoise",
scalar "satNoise",
scalar "valNoise",
scalar "hueNoiseFreq",
scalar "satNoiseFreq",
scalar "valNoiseFreq",
# Inherited from Texture2d
vector "uvCoord",

#: shortname "uv"
vector "uvFilterSize",
scalar "filter",
scalar "filterOffset",
boolean "invert",

#: default 0
boolean "alphaIsLuminance",

#: default 1
color "colorGain",

#: default 1.0 0.8 0.8
#: min 0.1 0.1 0.1 max 0.5 0.5 0.5
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color "colorOffset",
scalar "alphaGain",

#: shortname "ag"
scalar "alphaOffset",

#: shortname "ao"
color "defaultColor"
)

#:
#: nodeid 6895 # Node ID for binary Maya files
#:
apply texture
version 2

end declare

The Factory parser syntax vs. the mental ray parser 
syntax

Details about what the Factory parser does not accept, but mental ray's 
parser does: 

• Missing zeros before the dot in a scalar value are not supported. 
Instead of .5 you should write 0.5. Missing zeros after the decimal are 
supported, so 5. is acceptable. 

• There must be no comma after the last parameter in the input 
parameter list of a shader declaration. mental ray accepts 

     declare shader
     vector
     "reverse" (

vector "input",
)

     end declare

The Factory parser reports a syntax error at the comma. 

Hooks

The Factory creates Maya nodes from mental ray shader declarations. 
Once created, each such node represents a custom mental ray shader (a 
shader definition, to be precise). It can conveniently be used with various 
Maya scene entities.

Message attribute

The following mental ray shader parameter types are registered as 
message attribute by node factory: light, geometry, color texture, 
scalar texture, vector texture, lightprofile, shader. 
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Though it is possible to connect any node to these attributes (if you 
drag a node to the message attr in the Attribute editor, the message 
attribute of the source node is connected to the attribute. For example 
node1.message -> mrShaderNode.shader), you should make a proper 
connection. Otherwise, it may lead to crash or rendering abort. 

The following are expected to be connected to each mental ray shader 
parameter type. 

• light : light transform node. For example, pointLight1.message -> 
dgs_material1.lights[0] 

• geometry : geometry shader. For example, 
mib_geo_sphere1.message -> mib_geo_instance1.object 

• shader : mental ray shader. For example, 
mib_illum_phong1.message -> mib_geo_instance.material 

• color texture, scalar texture, vector texture: mentalrayTexture 
node. For example, mentalrayTexture1.message -> 
mib_texture_lookup1.tex  The button next to a color/scalar/vector 
texture attribute in the shader's attribute editor will create a new 
mentalrayTexture node, and connect it to the attribute. 

• lightprofile : mentalrayLightProfile node. For example, 
mentalrayLightProfile1.message -> mib_light_photometric.profile 
The button next to a lightprofile attribute in the shader's attribute 
editor will create a new mentalrayLightProfile node, and connect 
it to the attribute.

Materials

Custom materials may be specified in the shading group node.  In the 
Attribute Editor, go to the mental ray section of the shading engine 
created along with this shader. Turn on Suppress all Maya shaders 
and connect the desired custom shaders to the corresponding 
attributes. The shading engine is now going to be exported as a 
mental ray material. You may still assign it to Maya objects in the 
usual ways. 

Lights

You may specify a custom light shader in the mental ray section of 
any Maya point, spot or directional light. Turn on Suppress all Maya 
shaders and connect your light shader. On export, this overrides the 
default Maya shader while other properties of the light (orientation, 
spot cone angle, and so on) are preserved. 

Cameras

Provide your own output, volume, lens, and environment shaders in 
the AE mental ray section of any camera shape node. Currently you 
cannot specify more than one output shader. 
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Transforms

It is possible to override a shape node attached to a transform with a 
custom geometry shader. Just turn on Enable geometry shader in the 
mental ray tab of Maya's transform nodes. Ideally, the transform node 
should have a single shape child. 

Textures

The mental ray texture node should be used. mental ray Texture can 
be created from the Attribute Editor of a shader with “color texture, 
scalar texture, vector texture” parameter, and will be connected to the 
shader.

Custom mental ray text

mental images .mi files are created with the mental images scene 
description language, which can be either an ASCII or binary file. 

In mental ray for Maya, you can write and insert a text-only integration of 
custom mental ray shaders within Maya. It allows creation of special-
purpose Maya nodes that hold customized mental images (.mi) text. 

You can assign these nodes to certain Maya scene entities with the help of 
the Custom Text Editor and special custom text controls. 

The mi file generated with mental ray for Maya can contain customized 
versions of: camera output statements including lens, volume, and 
environment shaders, light shaders, material shaders, texture or utility 
shaders, and object definitions. Furthermore, text can be generated that is 
written at certain stages of the export. 

To work with mental ”Work with Custom mental ray text” on page 107.

Customize Scene Entities

The mental ray for Maya plug-in provides a proprietary type of node, the 
mentalrayText node. It comes with a simple user interface that allows 
editing ASCII text. For more information, see ”Work with Custom mental 
ray text” on page 107.

You can connect these nodes to other nodes in the scene in certain 
situations using the Custom Text Editor. 

The mentalrayText node assignment to Maya nodes is done on a .mi Text 
in the Extra Attributes section. mental ray for Maya checks for this new 
attribute when traversing the scene and shader graphs. If it has been 
found, the contents of the connected mentalrayText is written without 
further checks.
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Dependent on the text mode attribute, the custom text is appended, 
prefixed, or completely replaces existing text in the generated .mi text. 

The Maya renderer ignores these extra attributes and can render the scene 
safely as usual. On the other hand, the changed scene may not render any 
more with mental ray because of broken dependencies between lights, 
objects, and materials. See ”General Notes” on page 51.

The scene needs to be saved as a Maya Binary (.mb) file in order for the 
text nodes and its connections to be preserved. 

CustomText Editor control group support

The Custom Text Editor contains two rows of drop-down lists and buttons 
that are dimmed by default.

When selecting objects or shaders in Maya the Custom Text Editor is 
updated according to the selected entity and enables the appropriate 
control if the current selection allows creation and assignment of custom 
.mi text. 

The two control groups support: 

• custom shader text

It is enabled when selecting any light, any camera, any shading group, 
except the initial variants, any shader, except Maya’s default lambert1 
and particleCloud1. 

• custom object text

It is enabled when a mesh or NURBS shape is selected. If a direct 
transform of a shape is selected, the underlying shape is automatically 
determined and used.

Custom Text Variables

The custom text can make use of special placeholder characters or strings 
that are recognized during translation. They are replaced by actual values 
on export. Right now, there is just one such variable supported: the at sign 
(@) is a placeholder for the current frame number. 

Warning

The translation of such entities has been disabled by default 
for interactive preview rendering due to several 
unpredictable issues. It is enabled for the .mi file export to 
create customized scene files for external rendering. 
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What happens when assigning text to entities

When creating a custom text node and assigning it to the selected node in 
the scene the Attribute Editor is updated. 

The option menu lists all the available text nodes that were previously 
created. By selecting a new entry in this option menu the text assignment 
of the current scene entity is replaced with this newly chosen text node. 
Saving the scene to a Maya file also stores all the existing text nodes, both 
connected and unconnected. Custom text nodes have to be deleted by 
standard Maya methods, as the Custom Text Editor doesn't provide a way 
to do it. 

Types of text assignments

Camera Output and Shaders

The text node assigned to a camera adapts the first output statement that 
is created by the plug-in. Thus, customized image files and framebuffers 
can be created. Furthermore lens, volume and environment shaders can be 
added. The other camera parameters are unaffected and is still written 
according to the settings set in Maya. 

Light Shaders

The text node assigned to a light affects the original light shader output. 
The light parameters remain unchanged and are written as usual. Using 
alternatives to standard Maya light shaders break illumination of Maya 
materials since they depend on special light dependency nodes. 

Material Shaders

A custom text node assigned to a shading group affects the export of 
mental ray materials. If text is applied in replace mode the connected 
surface, volume, and displace shaders won't be exported at all. Otherwise, 
those shaders are written as usual, including their own dependent nodes. 

The custom text editor prefixes the name of the currently selected entity 
with &out;material to inform about its intended use. 

Other Shaders

Text nodes can also be assigned to any other shading node that is 
supported in the translation process. The editor enables the controls in 
case such a supported node was selected, and prefixes the type of the 
node to the name of the selected entity. This relates to all texture and 
utility nodes. Using this feature, graphs of custom text nodes can be 
created and exported. mental ray for Maya ensures proper export of the 
graph, where leaf nodes get exported before dependent nodes, even if 
they contain custom text. This way, custom text itself can contain 
references to nodes down the graph. There is one limitation: custom text is 
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expected to not use any shaders that return structures. In connections, 
they are always written with only their node name—not appended with 
names of output plugs for example, .outColor. 

Object Definitions

Custom text assigned to shape nodes affects the complete object definition 
except the object's name and its flags. In text replacement mode, the flags 
are written according to the settings in Maya, but can further be adapted 
in the custom text. Also, the exported object is tagged by default, thus the 
custom object definition should use a material tag number instead of a 
material name. 

The actual material is assigned in the instance statement, which gives a list 
of materials, one for every tag number. This way, different instances of the 
same object, and even polygons out of a mesh object, can get different 
materials. 

General Notes

• Unfortunately, the custom text functionality does not prevent you 
from creating invalid mi scenes that don't render any more or produce 
unexpected results. Therefore, great care should be taken to avoid 
undesired custom text.

• Text is printed in the .mi file without any further indentation. This is 
required for certain mi commands that are expected to start at the first 
column of a line. 

• The $include statement can be used anywhere in custom text to take 
the actual mi text from external files (this statement has to start in the 
first column of the line), but note that the actual inclusion is resolved 
at render time on the render host. 

• The original names of the Maya entities stay untouched and cannot be 
changed with custom mi text. 

• Placing comments around the text (starting with #) makes the 
identification of the custom parts in the .mi file much easier. 

• When a custom text node has been assigned to a Maya node, the 
newly created attribute mi text appears in the Extra Attributes section 
of that object’s Attribute Editor. Clicking the button in the text field 
displays the appropriate text field. 

• When using references to light in custom shader text, the Maya light 
names should be used. 
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Limitations

The non-deletable default lambert1, particleCloud1, initialShadingGroup, 
and initialParticleSE nodes deny storage of the extra text assignment if the 
scene is saved to a Maya file and later restored because they are handled 
in a non-standard way. The text nodes are stored, but the connection to 
these nodes are lost and has to be repeated. Any other Maya surface node 
saves and restores as expected. 

The custom text nodes support limited animation. When exporting an 
animation, the regular node attributes are checked for changes from frame 
to frame, and the node gets incrementally exported in every subsequent 
frame. This happens even if custom text is attached. 

No checks for the correctness of the mi syntax and the use of valid name 
references in the custom text can be made.

A custom text node that contains empty text and is not going to be 
appended but is connected to an entity removes the output of the shader 
or object to which it belongs.

Scenes containing both customized text and standard Maya nodes can't be 
expected to successfully render with mental ray anymore, especially when 
using customized light nodes, due to limitations with Maya light 
dependencies.

Custom text is expected to not use any shaders which return structures. In 
connections they are always written with only their node name—not 
appended with names of output plugs for example, .outColor. 

Custom vertex data

For polygon meshes, mental ray for Maya checks for additional custom 
attributes with the fixed prefix "miCustomTex". 

All characters after this prefix are considered the custom data's name, for 
example MyData for the attribute name "miCustomTexMyData". These 
data attributes are recognized and translated to additional mental ray 
texture spaces if they meet the following requirements: 

• their type is one of (in MEL): 

• Int32Array

• doubleArray

• vectorArray

• pointArray

• respectively (in Maya API): 

• MFnIntArrayData

• MFnDoubleArrayData
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• MFnVectorArrayData

• MFnPointArrayData

• the number of array data elements exactly matches the number of 
vertices in the mesh object

These array attributes can be created either by MEL or the Maya API. 
They should contain values when processing starts, otherwise they are 
ignored. 

The data elements of the array attribute is attached to the mesh vertices in 
the presented order. According to the data type, they occupy one or more 
texture spaces in mental ray. This implies a data type conversion to 
floating point format in any case. It also ensures that the vertex data are 
automatically be interpolated for the current intersection point on a 
triangle. 

The information about the texture space that is actually used for a certain 
custom array is still missing. In the current mental ray for Maya, exactly 
one texture space is reserved for texturing by default. But meshes can hold 
more than one UV space. Therefore, all custom vertex data start at an 
arbitrary texture space offset. If more than one custom array is attached to 
a mesh, the order of the attributes as listed on the node determines the 
texture space sequence in mental ray. 

This actual layout of the data needs to be supplied to the shaders that 
want to make use of it. Two ways are currently implemented: user data 
and custom text replacement. The user data approach attaches a user data 
block to the mesh object in mental ray. This can be retrieved in shaders. 
The declaration of the data block maya_vertexdata is contained in the 
mayabase.mi declaration file. 

Maya 
type

number 
of 
elements

mental ray texture access

int 1 tex_list[i].x

double 1 tex_list[i].x

vector 3 tex_list[i].x, tex_list[i].y, tex_list[i].z

point 4 tex_list[i].x, tex_list[i].y, tex_list[i].z, tex_list[i+1].x
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If custom text is applied to the material of the mesh, a special placeholder 
syntax allows convenient parameter value assignment. The following 
placeholders are supported (examples assume custom data of type vector 
with name "MyData" found as first custom attribute): 

Example

This is a complete example of custom vertex data and a custom text 
shader connected to a mesh with the following custom attributes: 

• miCustomTexMyInt (Int32Array), 

• miCustomTexMyDouble (doubleArray), 

• miCustomTexMyVector (vectorArray), 

• miCustomTexMyPoint (pointArray). 

The custom text connected to the material looks like this: 

int "$MyInt"
int offset "$MyIntOffset"
int type "$MyIntType"
int size "$MyIntSize"
double "$MyDouble"
double offset "$MyDoubleOffset"
double type "$MyDoubleType"
double size "$MyDoubleSize"
vector "$MyVector"
vector offset "$MyVectorOffset"
vector type "$MyVectorType"

placeholder replaced by example

$<name> texture space index $MyData -> 1

$<name>Offset texture space index $MyDataOffset -> 1

 $<name>Size number of used texture 
components

 $MyDataSize -> 3

$<name>Type custom data type, 1 - int, 

2 - double, 3 - vector, 4 - 
point

 $MyDataType -> 3

Note The placeholders are case sensitive. The use of the special 
dollar sign ($) for other than the placeholder names should 
be avoided.
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vector size "$MyVectorSize"
point "$MyPoint"
point offset "$MyPointOffset"
point type "$MyPointType"
point size "$MyPointSize"
"offsets" [$MyInt $MyDouble $MyVector $MyPoint]
"sizes" [$MyIntSize $MyDoubleSize $MyVectorSize $MyPointSize]
"types" [$MyIntType $MyDoubleType $MyVectorType $MyPointType]

In the exported .mi file the text has changed to: 

int "1"
int offset "1"
int type "1"
int size "1"
double "2"
double offset "2"
double type "2"
double size "1"
vector "3"
vector offset "3"
vector type "3"
vector size "3"
point "4"
point offset "4"
point type "4"
point size "4"
"offsets" [1 2 3 4]
"sizes" [1 1 3 4]
"types" [1 2 3 4]

The exported user data block on the polygon mesh shows up as:

data "plane:vxdata"
"maya_vertexdata" (

"magic" 1298749048,
"data" [{

"name" "Int",
"type" 1,
"size" 1,
"offset" 1
},{
"name" "Double",
"type" 2,
"size" 1,
"offset" 2
},{
"name" "Vector",
"type" 3,
"size" 3,
"offset" 3
},{
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"name" "Point",
"type" 4,
"size" 4,
"offset" 4
}

]
)

Using either the placeholder syntax or the user data block, custom shaders 
can be written that can safely retrieve the custom data at the appropriate 
places. 

Advanced information

The following information is for advanced users of mental ray and mental 
ray for Maya.

Custom nodes

The following node types are added to Maya after loading the plug-in and 
opening one of the mental ray editors: 

• mentalrayItemsList 

• mentalrayGlobals 

• mentalrayOptions 

• mentalrayFramebuffer 

• mentalrayCurveApprox 

• mentalrayDisplaceApprox 

• mentalraySurfaceApprox 

• mentalraySubdivApprox 

• mentalrayPhenomenon 

• mentalrayText 

Nodes of these types are under control of mental ray for Maya and the 
user interface extensions. With the help of specialized editors the 
attributes of these nodes can be manipulated and custom connections can 
be made. 

The mentalrayOptions and mentalrayFramebuffer nodes are used to hold 
most of the settings and properties to control the rendering options of 
mental ray. A number of convenient presets are available to start with. 
New nodes can be created within the Render Global Settings window. 
Their values are initialized to the default settings of mental ray for Maya, 
if appropriate. Existing nodes can be deleted as usual in Maya; they are 
removed from the UI the next time the Render Global Settings window 
are forced to update. 
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The mentalrayOptions node is the main entry for manipulating quality, 
performance, and features of mental ray. 

The mentalrayFramebuffer node determines the output properties of the 
final image, like resolution, aspect, data type and image format. This way, 
any information of a rendered framebuffer can be saved to an output file. 
It's important to note that the Maya camera carries other attributes that are 
respected during image generation: if the Z Depth attribute is enabled 
then a depth file are rendered additionally to the usual color image. It gets 
the same name as the image file with "Depth" appended. This is saved in 
the mentalDepth proprietary file format, which can be viewed and 
converted with the imf_disp and imf_copy tools provided with mental 
ray. There is a way to change the default depth image format. 

The mentalrayText node is used to hold custom mi text. It's the basis for 
the current implementation of custom shader support. 

In general, those attributes that are guaranteed to be supported and 
recognized in the plug-in are exposed in the user interface with a 
descriptive name. Most of the attributes of the Render Globals node 
mentalrayGlobals are working similar to the matching ones in the Maya 
Render Globals. For details about the mental ray Render Globals, see 
”Render Global Settings window” on page 165 in the Rendering guide. 

The mentalrayCurveApprox, mentalrayDisplaceApprox, 
mentalraySurfaceApprox, and mentalraySubdivApprox nodes hold 
information regarding mental ray approximation of geometric entities. 
They should be handled and applied with the help of the Approximation 
Editor. For more information, see ”Obtain quads for subdivision surfaces” on 
page 62 in the Rendering guide. 

Custom Commands

The following additional commands are available in Maya after loading 
the plug-in: 

• Mayatomr 

• MayatomrJob 

• convertLightmap 

• miProgress 

The Mayatomr command executes the main functions of the plug-in. It 
controls the actual translation of the scene animation, takes care of the 
rendering and preview inside Maya. The MayatomrJob command is used 
to call MEL procedures on certain plug-in events. The miProgress 
command is used to display export progress in Maya, and can be used to 
interrupt the translation by pressing the Escape key. Both commands are 
executed and controlled via the custom user interface. 
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How do I? Build shading networks
Building a shading network typically consists of the following:

• ”Open and customize Hypershade” on page 58.

• ”Create nodes” on page 67.

• ”Connect nodes” on page 70.

• ”Adjust node attributes” on page 75.

• ”Work with shader libraries” on page 78.

Open and customize Hypershade

Open and navigate Hypershade

For more information on the Hypershade, see ”Hypershade” on page 122.

To open Hypershade

Select Window > Rendering Editors > Hypershade from Maya’s main 
menu bar.

To navigate Hypershade

To zoom or track in the Hypershade view, use the same view navigation 
methods you use in the scene view. See ”Camera aim” on page 30 in the 
Rendering guide for more details. In addition, do any of the following in 
the Hypershade:

• If you can’t see the swatch names in the panel, either zoom in, or drag 
the cursor over the swatches to display the swatch names. 

• Shift-click to select more than one swatch.

• Double-click a node to show its attributes in the Attribute Editor.

Show top and bottom level tabs

For more information on the Hypershade, see ”Hypershade” on page 122.

You can view shading networks within tabs in a split panel display (the 
default) or in separate panels by selecting the buttons at the top-right of 
Hypershade. These items are also accessible in the Tabs menu. 

Tip See also ”Show node connections” on page 70 to see content 
of the tabs in different ways.
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Filter nodes in Hypershade tabs

Every scene tab (also called an Asset tab) in Hypershade has  controls for 
filtering the nodes displayed in the tab (similar to the ones in 
HyperGraph). 

By default, each scene tab has an implicit filter that is determined by the 
tab type specified when the tab was created (or by the default tabs when 
the scene was first created). The tab only displays nodes that pass this 
filter, and you cannot disable this filter. For example, a Materials tab 
shows only material nodes. 

However, you can filter the nodes in a tab by name (in the text box) or by 
type (with the Show button). 

At any given time, one or more of these filters can apply to each scene tab. 
Only nodes that pass all of the applied filters are displayed. You can clear 
filters at any time.

Show Top and Bottom tabs

Show Bottom tab only

Show Top tab only
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Clear button 

Click to clear any applied filters (beyond the implicit one) and return 
the tab to its default contents. 

The text box

Lets you type in a character string, which can be a regular expression, 
to specify by name the nodes to be shown. Only nodes whose name 
matches the character string are displayed in the tab. 

Show button 

Shows a menu from which you can select the types of nodes to be 
shown. 

Objects Choose which object types to show. Select Clear 
Below to turn off all filters.

Invert Shown Reverse the filters so visible objects are invisible and 
invisible objects are visible.

Show All Turns off all filters in the Show menu.

Show selected types Shows only object types of the same type as the 
current selection.

Create Entry Lets you save the current filter with a name.

Delete Entry  Lets you delete a saved filter.

Show Auxiliary nodes Shows node types that are normally not shown 
because they are rarely needed (such as underworld 
nodes).

Auxiliary nodes Lets you set what nodes are considered "auxiliary". 
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Hide shape and transform nodes in 
Hypershade

Hypershade automatically displays all shape and transform nodes that are 
connected to various types of shading nodes (Shading Engine, Switch 
nodes, for example). 

Often, you want to view only those shapes and transforms that influence a 
shading network and not those that happen to be in the Shading Group to 
express set membership. You can suppress the display of shapes and 
transforms in Hypershade to simplify a cluttered Work Area or to reduce 
the amount of time it takes for Hypershade to refresh.

To control the display of shapes and transforms

1 In Hypershade, select Options > Display (Work Area Only), then 
specify the options.

2 Regraph to see the change.

No Shapes

No shapes are displayed in Hypershade. 

All Shapes except Shading Group members 

Only shapes that are directly connected to shading nodes are shown. 
Shapes that are only connected to the Shading Group are not shown. 

All Shapes

All shapes are displayed, including ones that are connected to the 
Shading Group only for the purpose of expressing set membership. 

Transforms

Transforms are shown.

The display of transform nodes in Hypershade is controlled by the 
"Transforms" flag in the object’s Attribute editor. 

Create Hypershade tabs

For more information on the Hypershade, see ”Hypershade” on page 122.

Hypershade’s tabs contain the nodes that make up the current scene. Click 
a tab to view specific nodes. 

To create a new tab in Hypershade

1 Select Tabs > Create New Tab.

2 Enter the name of the new tab. This name appears on the new tab in 
Hypershade. 
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3 For the Initial Placement, select either the Top or Bottom option to 
view the new tabs at either the top or bottom panels of Hypershade.

4 Select a Tab Type and specify the corresponding options:

Scene Displays a collection of nodes in the current scene. 
When you select this tab, you must specify an 
option from the Show Nodes Which Are drop-down 
list.

Work Area Displays shading networks that are in the scene 
depending on the mode you choose: Input, Output, 
or Input and Output Connections.

Disk Displays files and, or directories on disk. When you 
select this tab type, the Create New Tab window 
expands to display the “Root Directory” option.

Show Nodes Which 

Are For Scene tabs, select to display only certain node 
types within a specified tab.

Root Directory For Disk tabs, either type the path name if you 
know it, or click the folder icon to browse through 
directories to select the directory where the items 
are stored.

Only Show Files (Hide 

Directory Tree) For Disk tabs, turn this on or off to hide or show the 
directory tree. This is especially helpful if you find 
you routinely work with files located in one specific 
directory. You can switch between viewing 
directory folders or just the files within that 
directory.

5 Click Create.

For example, if you want to create a tab that displays only the special 
effects nodes of the scene, name it appropriately, select Post Process 
from the list, then click Create. Hypershade displays the Post Process 
nodes in the scene.

Tip Use names that indicate the content of the tab.
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Hide, resize or customize the Create bar

For more information on the Hypershade, see ”Hypershade” on page 122.

Do any of the following:

Enter a name that 
reflects the tab’s 
content.

In Hypershade 
click the new 
tab to display 
the selected 
type of nodes in 
the current 
scene.

Select the type of nodes 
you want displayed in 
the tab, then click 
Create.

Both the nodes 
and directory tree 
display in 
Hypershade.

When on, only 
files within the 
specified 
directory appear.
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• Hide or show the Create bar by clicking the  button in the 
Hypershade toolbar, or select Create Bar > Show Create Bar from the 
Options menu. 

• Resize the Create Bar by clicking the  and  
buttons at the bottom of the Create Bar panel.

• The Options menu also provides items to customize the icon display. 
Select either Options > Create Bar > Display Icons and Text (the 
default) or Display Icons Only.

Display icons and text

Display icons 
only
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Organize render nodes with Hypershade 
sorting bins

Sorting bins, which are containers for shading nodes (materials, textures, 
and so on), have been added to Hypershade to help you organize and 
track shading nodes in your scenes. 

A default Master bin contains all shading nodes in your scene. You can 
add any number of additional bins to a scene and assign nodes to one or 
more of those bins. By strategically naming the bins, (for example, wood, 
metal, doors, foliage), you can quickly and more easily locate shading 
assets to work with them.

To select (see the contents of) bins

When you select one or more bins, you can see the contents of the bins.

Notes • When a node is assigned to a bin, all the 
shading nodes upstream to this node are also 
assigned to this bin. 

• The Hypershade asset tabs (Materials, Textures, 
and so on) exist for all sorting bins, allowing for 
further organization and filtering. 

• While shading nodes can be assigned to more 
than one bin, they are not duplicated in the 
scene. 

The Master Bin 
(default) contains all 
shader nodes
in a scene.

Add and name any 
number of bins, and 
assign assets to bins.
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• To select and see the contents of one bin, click the bin.

• To select multiple bins, do one of the following:

• Shift+click a range of bins.

• Ctrl+click each bin you want to select.

• Ctrl+click a bin to toggle between selecting and deselecting it. 

To create a new empty bin

1 In the Hypershade Bins tab, click the Create Empty bin button. The 
New Bin Name window appears. 

2 Type the new name, then click OK. A new empty bin appears.

To create a new bin with selected content

1 Select the assets you want to add to a bin.

2 In the Hypershade Bins tab, click the Create bin from selected button. 

To rename a bin

1 In Hypershade, double-click the bin you want to rename.

2 Type the new bin name and press Enter.

To duplicate a bin

1 In Hypershade, right-click the bin.

2 Select Duplicate. The bin is duplicated and all the same assets are 
assigned to it.

To select assets

• To select one asset, click the asset. 

• To select multiple assets, do one of the following:

• Marquee drag across the assets.

• Shift+click to switch between selecting and deselecting an asset.

• To select assets that are not assigned to a bin, in the Hypershade Bins 
tab, click the Select unsorted content button. 

To add assets to a bin

In Hypershade, do one of the following:

• Select the assets you want to add to a bin, then right-click bin and 
select Add Selected. 

• Select the assets you want to add a bin, then middle-drag them to 
the bin. 
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• To add a single asset to a bin, drag it to the bin. 

To make assets exclusive to one bin 

This procedure removes selected assets from all other bins.

1 In the Work Area, select the assets you want to make exclusive to one 
bin.

2 Right-click any existing bin.

3 Select Make Selected Exclusive. 

To remove some assets from a bin

1 Select the assets you want to remove from a bin.

2 Right-click the bin.

3 Select Remove Selected. 

To remove all assets from a bin

Right-click the bin, then select Empty.

Change default connection line colors

For more information on the Hypershade, see ”Hypershade” on page 122.

For more information on node connections, see ”Render node 
connections” on page 24.

To change the default color of connection lines

1 Select Window > Settings/Preferences > Colors to open the Colors 
window. 

2 Open the Hypergraph/Hypershade section to view a list of the default 
connection colors. 

3 To change the colors, drag the sliders or click the color swatch to open 
the Color Chooser and select a color.

Create nodes

Create a node

For more information render nodes, see ”Render nodes” on page 22.
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For more information on the Hypershade, see ”Hypershade” on page 122.

To create a node

1 Do any of the following:

• Middle-drag a node from the Create Bar into the Hypershade 
panel or onto another node in the Work Area. 

If you drop the new node onto another node, a connection pop-up 
menu may appear. Select an attribute on which you want to connect a 
node, and release the mouse button. Hypershade displays the new 
node swatch and the material swatch updates. For more information 
about render node connections, see ”Render node connections” on 
page 24. 

• Select Create > from Hypershade’s menu bar to access the “Create 
> Create Render Node” items.

• Middle-drag a node from the Create Render Node window, or a 
directory (such as the Shader Library).

• Right-click in a panel and select a node from the pop-up menu.

In Hypershade, you 
can click to choose 
the type of node 
you want to create.
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Duplicate a node

For more information about render nodes, see ”Render nodes” on page 22.

To duplicate a node and its network

1 Select the node you want to duplicate.

2 In Hypershade, select Edit > Duplicate > Shading Network. Maya 
creates the duplicated shading network in Hypershade with the 
original node. Each node you duplicate is placed in the appropriate 
directory.

Delete a node and its network

For more information on render nodes, see ”Render nodes” on page 22.

For more information about shading networks, see ”Shading networks” 
on page 21.

To delete a node and its network

1 Click the node you want to delete (marquee-select or Shift-click to 
select more than one node). 

The associated node swatches are highlighted.

Tips If you want a clear the Hypershade Work Area every time 
you drag a new node into Hypershade, turn on Options > 
Clear Before Graphing. This is helpful especially if you 
have large networks with many nodes and you want to 
work on just one node or a smaller section of the network. 
You can select the node you want to work on and graph 
upstream or downstream connections to show you just that 
section without having to look at the rest of the network.

For more information on the work area, see ”Work Area 
tab” on page 125.

Tips • If you want to duplicate a node without its network, 
select the node and select Edit > Duplicate > Without 
Network.

• If you want to duplicate a node and connect it to the 
same network (in effect sharing the network), select 
Edit > Duplicate > With Connections to Network.
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2 Press Backspace (Windows, IRIX and Linux) or Delete (Mac OS X) to 
delete the node(s). 

The swatches in Hypershade are deleted.

Import and export shading networks

Use the import or export options in Hypershade’s File menu to import 
and export rendering networks among scenes (see ”Hypershade” on 
page 122). You can also import rendering networks into the current scene 
by dragging them from the project directory. 

For more information about shading networks, see ”Shading networks” 
on page 21.

To import a rendering network

Drag the network you want from the Project tab directory into the Work 
Area. The network swatch appears in Hypershade’s Work Area.

To import all networks from another scene

Open the scenes directory in the Project tab and middle-drag a Maya 
scene file into the Work Area. 

Maya imports all the nodes from that scene into the current scene.

To export a rendering network

1 In Hypershade, select the node(s) you want to export.

2 Select File > Export Selection.

3 Select the folder you want to export to, and choose Export Selection. 
(You can also export all the nodes in the scene by selecting File > 
Export All in the main Maya window.)

Connect nodes

Show node connections

For more information about render nodes and connections, see ”Shading 
networks” on page 21.

To show connections

Select the node for which you want to see the connections, then click one 
of the following icons at the top-right of Hypershade. (Point to an icon to 
display its name.)
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Input Connections

 Displays the input connections of the selected node. Input 
connections are those Maya automatically creates depending on the 
node type.

Output Connections

 Displays the output connections of the selected node. Output 
connections show the Shading Group Node. Double-click the Shading 
Group swatch to open its Attribute Editor. 

Input and Output Connections

 Displays both the input and output connections of the selected 
node.

Connect render nodes using their default 
connections

For more information about render nodes and connections, see ”Shading 
networks” on page 21.

Note Input and output connections are sometimes called 
upstream/downstream connections. 
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To automatically connect nodes

If you drag and drop rendering nodes on top of each other, Maya 
automatically connects them in a default way. The default depends on the 
type of node. For example:

• Middle-mouse button drag a 2D or 3D texture swatch over a material 
to automatically connect the texture’s output color to the material’s 
output color. 

• Middle-mouse button drag a Bump2d General utility node over a 
material node to automatically connect the bump map to the 
material’s Bump Mapping attribute.

Connect default output to a specific input 
attribute

For more information about render nodes and connections, see ”Shading 
networks” on page 21.

To connect two rendering nodes using a default output and 
explicit input connection

1 Middle-drag a node from within Hypershade, the Create Render 
Node window, the Create Bar, or from the Shader Library, onto a 
node in Hypershade. The Connect Input menu of the receiving node 
appears.

2 Select the input attribute from the pop-up menu to make the desired 
connection.

Connect render nodes by dragging existing 
connection lines

For more information about render nodes and connections, see ”Shading 
networks” on page 21.
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To connect attributes using connection lines

1 Click the connection line.

2 Drag one end of the connection line (it turns white when you point to 
it) to the material to which you want to connect the node, then select 
an attribute from the Connect Input menu.

Maya makes a new connection, a new line and new node displays, 
and the material updates with the new connections.

Connect render nodes using the Connection 
Editor

For more information about render nodes and connections, see ”Shading 
networks” on page 21.

To open the Connection Editor

Do one of the following: 

• Click Window > General Editors > Connection Editor.

• Double-click a connection line.

• Shift+middle-mouse button drag a node onto another node in 
Hypershade.

Click connection line...

Point to the yellow line (it turns white),

Select an 
attribute from 
the pop-up 
menu.

then drag it to another node. 

Before 
connection

After 
connection
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To connect rendering nodes in the Connection Editor

In the Connection Editor, select the output attribute on the left, and the 
input attribute on the right to connect the nodes. 

When you select an output attribute, some of the input attributes on the 
right are dimmed, indicating either that they cannot be connected to this 
type of output node or you must double-click the dimmed attributes to 
see the nested, connectable nodes.

For more information on the Connection Editor, see ”Connection Editor” 
on page 120.

Change existing render node attribute 
connections

For more information about render nodes and connections, see ”Shading 
networks” on page 21.

1 Do one of the following to show the Connection Editor:

• Drag a node over a material swatch

• Double-click the connection line between nodes.

2 Select an item from the Outputs column (for example, a utility node 
you selected), then select an item from the Inputs column (the material 
attributes) to connect them. 
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Delete a render node connection

For more information about render nodes and connections, see ”Shading 
networks” on page 21.

To delete a node connection

1 Click the connection line(s) you want to delete (marquee-select or 
Shift-click to select more than one). 

The lines are selected.

2 Press Backspace (Windows, IRIX and Linux) or Delete (Mac OS X) to 
delete the connections. 

The lines are deleted and the swatches in Hypershade update to show 
the changes.

Adjust node attributes

Adjust node attributes

For more information about render nodes and their attributes, see 
”Shading networks” on page 21.

For a detailed description of the material node attributes, see ”Material 
nodes - Maya software” on page 143.

You can adjust one node at a time (for example if you want to adjust an 
individual attribute while using IPR), or you can adjust several nodes at 
the same time using the Attribute Editor, Attribute Spread Sheet, the 
Rendering Flags window, or the Channel Box.

To set an attribute for one node

1 Select the node whose attribute you want to adjust and open its 
Attribute Editor (double-click the swatch in Hypershade to open its 
Attribute Editor, or select Window > Attribute Editor).

2 Adjust the attribute by moving the slider or typing a value in the field 
next to the attribute name. If you want to map a texture, utility, or 
optical effect, click the map button at the end of an attribute’s name.

To set attributes for multiple rendering nodes in the 
Attribute Spreadsheet

1 Select the surfaces or rendering nodes whose attributes you want to 
adjust.

2 Select Window > General Editors > Attribute Spread Sheet.

3 Click a tab heading to see the attributes. 
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• The Keyable tab contains the render node attributes. 

• The Render tab contains the attributes that determine how a 
surface renders.

4 Use the scroll bar to view the attributes horizontally.

5 Drag down an attribute column to select its contents and select the top 
field to select all the entries in the column.

6 Type the value you want in the top field of the selected attribute 
column and press Enter (Windows, IRIX and Linux) or Return (Mac 
OS X). 

All the attributes in the column update with the new value.

To set attributes for nodes in the Rendering Flags window

1 Click Window > Rendering Editors > Rendering Flags. 

2 In the Rendering Flags window, from the Show drop-down list, select 
the item(s) for which you want a list of attributes. 

The attributes for these items are listed in the right panel where you 
can change and set them, much like in the Channel Box.

3 Do one of the following:

• To change the attributes of one node, click the listed node in the 
left panel to display the attributes in the right panel, then change 
the attributes. 
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• To change attributes for several related objects by selecting them 
in the left panel of the Rendering Flags window, and setting the 
attribute value in the right panel. For example, if you want to turn 
the visibility off for two NURBS spheres in the scene, select both 
spheres from the left panel and type off beside Visibility in the 
right panel.

Once you change an attribute for a selected item, the heading changes 
color in the list, reminding you of the change.

Animate a node attribute

For more information about render nodes and their attributes, see 
”Shading networks” on page 21.

For a detailed description of the material node attributes, see ”Material 
nodes - Maya software” on page 143.

To animate an attribute

1 In Maya’s main window, set the Time Slider to a frame.

2 In the node’s Attribute Editor, right-click the label of the attribute you 
want to key, such as the Color attribute, and select Set Key from the 
pop-up menu to create a key.

Tip You can also set an attribute for multiple nodes using the 
Render Flags window or the Channel Box.
Shading

77



1 | About shading and texturing surfaces
How do I? > View the Shader Library Gallery
3 Set the Time Slider to another frame.

4 Adjust the attribute and set another key. For example, click the Blinn 
material’s color attribute and select a different color from the Color 
chooser each time you set a new key.

5 Playback the animation. The surface to which the rendering attributes 
are assigned animate in the view (for instance, the Blinn color changes 
at each key you set). 

Work with shader libraries

View the Shader Library Gallery

For more information about shading network libraries, see ”Shader 
network libraries” on page 22.

To view the Shader Library gallery

In the directory where you store the Shader Library, click the 
readme.html file or the gallery.html file to view these shading 
networks on your browser. Click an image to get a closer look and use the 
arrows to navigate.

Assign a shading group from the Shader 
Library 

For more information about shading network libraries, see ”Shader 
network libraries” on page 22.

To assign a shading group from the Shader Library

1 Click to open a folder, then middle-drag the swatch representing a 
shading network into Hypershade.

2 To view how the shading network is connected, select the swatch, 
then click the Input and Output Connections button to graph the 
shading network into the Work Area tab.

3 To assign the shading network to an object, middle-drag the material 
swatch over the object in the view.

Note By default, the material type for the shading networks is 
PhongE. To achieve different results, you may want to 
change the Material type (by selecting a new Type in the 
material's Attribute Editor). When you do this, however, 
some of the material attributes change which requires you 
to manually reconnect some parts of the network.
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Create a material

For more information about Maya materials, see ”Maya materials” on 
page 25.

For more information about mental ray for Maya shaders, see ”mental ray 
for Maya Shaders” on page 39 and ”mental ray for Maya nodes” on 
page 253.

Use one of the following methods to create a material in Hypershade:

• Right-mouse button click in Hypershade, then select a material from 
the pop-up menu (Create > Materials).

• Select a material from the Create menu in the menu bar.

• From the Create Bar, middle-drag a material swatch into Hypershade. 

• Select a material from the “Create Render Node window” window.

To open the Create Render Node window

Do one of the following:

• Click the map button  next to an attribute in an Attribute Editor. 

• In Hypershade, select Create > Create New Render Node.

Assign existing materials to surfaces

For more information about Maya materials, see ”Maya materials” on 
page 25.

The following lists a few quick ways to assign (connect) a material to a 
surface. 

In the scene view, you can be in either wireframe or shaded mode to make 
the connection. If you are in wireframe mode, make sure the cursor 
touches the surface when you release the mouse button, otherwise the 
connection may not be made.

Assign a material to surfaces

You have several options to assign a material to a surface or surfaces.

To assign a material to a surface or surfaces (option 1)

Right-mouse button click the object(s), then click Assign new material. 
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To assign a material to a surface or surfaces (option 2)

1 In the view, select the surface(s) to which you want to assign the 
material. 

2 From the Hypershade, middle-drag the material swatch over the 
selected surface(s).

To assign a material to a surface or surfaces (option 3)

1 In the view, Shift-select the object to which you want to assign the 
material, and in the Hypershade, click the material swatch.

2 While the cursor is over the material swatch in the Hypershade, right-
click-drag to select Assign Material to Selection from the pop-up 
menu.

To assign a material to a surface or surfaces (option 4)

Middle-drag and drop a Hypershade swatch onto an object in the IPR 
Render View.

To assign a material to several surfaces

1 Select the surfaces in a view.

2 In the Hypershade, right-click over the material swatch and select 
Assign Material To Selection from the pop-up menu. Maya applies the 
material to the surfaces. 

Assign a material to a group of faces on a polygonal 
surface

You have several options to assign a material to a group of faces. 

To assign a material to a group of faces on a polygonal 
surface (option 1)

1 Right-mouse button click the surface.

2 Select Face from the marking menu.

3 Choose Select by component type icon (or press the hotkey F11).

To assign a material to a group of faces on a polygonal 
surface

1 Select (either drag or Shift-click) the faces you want to map.

2 In Hypershade, right-mouse button click the material you want to 
assign, then select Assign Material To Selection from the pop-up 
menu. 

Maya applies the material to the faces.
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Layer shaders

For more information on layered shaders, see ”Layered shaders” on 
page 26.

To create a layered shader (example)

1 Open the Layered Shader’s Attribute editor. 

2 Create a Lambert shader and drag to the area with the green swatch in 
the Attribute Editor.

3 Create a Phong and do the same.

The leftmost shader is the topmost material. You’ll have to have some 
level of transparency to see the shader underneath. So, for this 
example, you’ll need to map the Lambert’s transparency channel with 
something to see the shiny Phong underneath. Then assign the shader 
to an object.

Create double-sided shaded surfaces

For more information about double-sided surfaces, see ”Double-sided 
shaded surfaces” on page 27.

To create a double-sided shaded surface

1 In the Hypershade, create one of each of the following:

• Material (this procedure uses a Phong material).

• A Sampler Info utility. The Sampler Info utility provides access to 
camera and surface information that you can pipe into your 
shading networks during rendering. 

• A Condition utility. The Condition utility lets you specify which 
texture is mapped to each side of the surface.

• Checker texture.

• Crater texture.

2 Assign the Phong material to the surface. 

3 In the Hypershade, middle-drag the Checker texture onto the 
Condition utility to open the Connection Editor.

4 In the Connection Editor, connect the Checker’s Out Color attribute to 
the condition utility’s Color If True attribute (click the Out Color 
attribute in the Checker column, then click Color If True in the 
Condition column).
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5 In the Hypershade, middle-drag the Crater texture onto the Condition 
swatch, and in the Connection Editor, connect the Crater’s Out Color 
to the Condition’s Color if False attribute.

6 Middle-drag the SamplerInfo swatch over the Condition swatch to 
open the Connection Editor.

7 In the Connection Editor, click the Flipped Normal attribute then click 
the Condition’s First Term or Second Term attribute.
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8 In the Hypershade, middle-drag the Condition swatch onto the Phong 
material swatch and select color to connect it to the Phong’s Color 
attribute.

9 Perform a test render. 

Maya shades each side of the surface with a different texture.

Swapping the textures on the surfaces

For more information about double-sided surfaces, see ”Double-sided 
shaded surfaces” on page 27.

You can use the Condition utility to specify which texture is applied to the 
front and back sides of the surface. For more information about the 
condition utility, see ”Condition” on page 372.

To swap texture mapping for double-sided shading

1 Double-click the Condition swatch in Hypershade to open its 
Attribute Editor. 

2 In the Condition Attributes section, change the Operation attribute to 
Not Equal (or if it is set to Not Equal, change it to Equal). 

3 Perform a test render. The following shows the result.
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Map and position textures

Map a 2D or 3D texture

When you map a 2D or 3D texture to an object, you connect it to an 
attribute of the object’s material. Textures map to geometry based on the 
object’s UV texture coordinates. For more information about texture 
mapping, see ”Texture mapping” on page 33.

Unless you use a method that explicitly connects a texture to a specific 
attribute of the object’s material, it connects to the material’s default 
attribute (usually color or transparency). For more information on node 
connections, see ”Render node connections” on page 24. 

To map a texture using Hypershade

1 In the Create bar, make sure the Create Texture tab is shown. 

2 Select a mapping method.

For information about mapping methods, see ”Mapping methods” on 
page 35.

3 Do one of the following:

• From the Create textures bar, middle-mouse drag a 2D or 3D 
texture onto the desired object’s material. You can drag either 
directly to the material in Hypershade, or to the object in the scene 
view. 

The texture is placed on the object in a default position, and a 
placement node appears in the Hypershade. For more information on 
placement nodes, see ”Placement nodes” on page 249.

Note You can apply more than one material to polygonal models 
at the face level.

Before After
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• In the Attribute Editor, click the map button next to the attribute to 
which you want to connect the texture. The Create Render Node 
window appears. See ”Create > Create Render Node” on page 133. 

Position 2D textures and labels

You can reposition 2D textures with numerical precision in the 
place2dtexture node’s Attribute Editor, or you can use Maya’s 
Texture Placement Tool to reposition textures or labels interactively. 

For more information about texture positioning the place2dtexture node 
”2D texture positioning” on page 36.

To position a 2D texture interactively

1 In the Hypershade, click the place2dtexture swatch that is connected 
to the texture you want to reposition.

The place2Dtexture’s Attribute Editor appears

Note When you middle-drag-drop a file texture on to a material 
and select Default in the pop-up menu, this automatically 
connects the file.outColor to the material.color and, if 
the image file has an alpha channel, connects the 
file.outTransparency to the material.transparency. 

In versions previous to Maya 4.5, this connected the 
file.outColor to material.transparency. If you prefer the old 
behavior, you can disable the automatic connection of 
file.outTransparency to material.transparency in the 
situations described above. To do so, set the environment 
variable:

MAYA_DISABLE_OUTTRANSPARENCY_CONNECT

Tip If you cannot see the place2dtexture swatch, do the 
following:

• Select the texture swatch, then click the Input 
Connections button on the Hypershade toolbar.

• If no place2Dtexture swatch exists, it has been deleted or 
not created (because it’s automatic creation has been 
turned off by default). You must add one (see ”Create a 
node” on page 67), then connect it to the texture (see 
”Connect nodes” on page 70) before you can reposition 
it.
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2 Do one of the following:

• Change the values of the attributes in the Attribute Editor. For 
detailed descriptions of the attributes, see ”Place 2d Texture” on 
page 249.

• For NURBS, click the Interactive Placement button in the 
Attribute Editor to use the Texture Placement tool. To set the 
Texture placement tool, see ”Texture placement vs. label 
mapping” on page 38. 

Position 3D textures

For more information about texture positioning the place3dtexture node 
”3D texture positioning” on page 37.

To use the 3D placement manipulator

1 Assign a 3D texture to a surface.

The texture’s place3Dtexture node (swatch) appears in Hypershade 
and a manipulator appears in the view panel. 

2 Double-click the node to open the Attribute Editor. 

3 Select the Interactive placement (see ”Interactive Placement” on 
page 249) to reposition the 3d texture to show the placement 
manipulator. (This tool similar to a combined version of the move, 
scale, and rotate tool.) 

To use the Fit to group bbox option

1 Assign a 3D texture to a surface.

The texture’s place3Dtexture node (swatch) appears in Hypershade 
and a manipulator appears in the view panel. 

2 Double-click the node to open the Attribute Editor. 

3 Select the Fit to group bbox to reposition the 3d texture. This causes 
the 3D texture to be scaled, moved, rotated as necessary to the 
assigned object’s bounding box. 

Tip It may be difficult to place a texture using only the 
manipulator. Use both the manipulator and the Attribute 
Editor to get the desired result.
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Tip You can also use Maya’s transform tools to position the Fit 
to group bbox manipulator.

Interactive Placement

The result after 
adjustment.

Wood texture 
applied to a 
sphere

Fit to Bbox
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Use a layered texture

For more information on layered textures, see ”Layered textures” on 
page 28.

To use a layered texture

1 In the Layered Texture’s Attribute Editor, select the layer you want to 
edit.

Tip: To re-order the layers in the Layered Texture’s Attribute 
Editor, middle-mouse button drag the texture swatch.

Selected layer.

When you select a layer, 
Maya updates the Color, 
Alpha, Blend Mode, and 
Layer visibility attributes 
to reflect the properties of 
the selected layer.

Hypershade view

Rendered result
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2 Edit any of the attributes. For a detailed description of the attributes, 
see ”Layered texture” on page 247.

Tip: To change a layer’s texture attributes, click the tab at the top 
of the Attribute Editor to access that texture’s attributes.

Middle-drag these swatches to re-arrange layers

Click to show the 
layer’s texture 
attributes

Hypershade view 
and rendered result 
of adjusted layer’s 
texture attributes
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Create Texture Reference Object 

You can create a texture reference object for the selected surface to lock a 
3D texture or projected 2D texture to the surface. As the surface animates 
or deforms, the texture stays with the surface, producing a very natural 
looking result. 

To create a Texture Reference Object

1 Select a surface and assign a 3D texture to it.

If the 3D texture node is grouped within an object’s hierarchy, see 
”Troubleshoot:When I move a referenced object, the texture swims” 
on page 109.

2 Select Texturing > Create Texture Reference Object. 

Maya creates a templated copy of the surface called the reference 
object. You can move a reference object anywhere in the scene.

3 Use the texture placement manipulators to position the texture relative 
to the reference object.

4 Animate the original surface (not the reference object).

As the original surface moves or deforms, Maya uses the reference 
object to move or deform the texture so that it matches the motion or 
deformation of the original surface.

Select and delete a texture reference object

To select a reference object

Do one of the following: 

• Click Texturing > Select Texture Reference Object.

Note • You must create a reference object before you animate or 
deform the original surface.

• A reference object for a polygonal surface must have the 
same topology (number of faces) as the original surface. 
When you create a reference object, the topology of the 
reference object is identical to the original surface. 
However, if you make subsequent changes to the 
topology of the original surface, you must create another 
reference object.

• A scene can contain any number of reference objects, but 
each surface in the scene can only have one reference 
object.
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• Click the reference object’s heading in the Channel Box.

To delete a reference object

Click Texture > Delete Texture Reference Object.

Convert a texture or shading network to a File 
Texture

When you convert illumination, shadow, shading, and textures to a file 
texture, you are performing a render; the process draws on the settings in 
Maya Software Render Global Settings (see ”Render Global Settings 
window” on page 165 in the Rendering guide for more information). Be sure 
you set these settings to achieve the result you want.

Use this procedure when you map a procedural texture or shading 
network to a surface and want to change it to a file texture.

To find out more about file textures in general, see ”Procedural textures” 
on page 29. 

For more information on the difference between converting and baking, 
see ”Baking illumination and color” on page 327.

To convert a procedural texture or shading network into a 
File texture

1 Shift-click the object in the view and the material swatch in 
Hypershade.

2 Do one of the following:

• Select Edit > Convert to File Texture in Hypershade. 

• Click Edit > Convert to File Texture >  , adjust the options, then 
click Convert Texture.

Transfer surface information

You can transfer surface characteristics from one surface to a texture map 
on another. The most common application of this tool is in the creation of 
high-performance, real-time models where some surface detail cannot be 
adequately represented within the polygon limit required. 

You can create a higher-detail (non-real-time) model that defines the 
desired details, then transfer the details across onto the real-time model in 
the form of a map (for example, a normal map). 

To load the Transfer Surface Information plug-in

1 Select Window > Settings/Preferences > Plug-in Manager.
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The Plug-in Manager window appears.

2 Locate one of the following and turn on loaded.

• TransferSurfaceInfo.mll (Windows)

• TransferSurfaceInfo.so (IRIX and Linux)

• TransferSurfaceInfo.lib (Mac OS X)

Maya loads the TransferSurfaceInfo plug-in and the Transfer Surface 
Information menu item appears in the Lighting/Shading menu of the 
Rendering menu set. 

To load this plug-in automatically every time you start Maya, turn on 
auto load.

3 Click Close.

To bake a normal map

1 Select the source surface, then the target surface. 

2 Select Lighting/Shading > Transfer Surface Information > .

3 Set any options, then click Bake and Close, Bake, or Close.

For a description of the Transfer Surface Information options, see 
”Lighting/shading > Transfer Surface Information” on page 114.

Use Photoshop files as textures in Maya

Use PSD files as textures in Maya

The PSD File node lets you use a PSD file as a texture in Maya. It is similar 
to Maya’s File texture node, but it’s for PSD files only.

By default, Maya links a PSD file to the composite image, which is 
included in the PSD file. Maya can only read image and vector layers, so 
when the PSD node is linked to Photoshop’s composite image (it is by 
default), Maya supports anything that Photoshop supports, including (for 
example) layer styles, adjustment layers, text, and so on.

However, you can choose to link the PSD node to a layer set instead, in 
which case layer styles and adjustment layers are not supported and 
should be rasterized before the PSD file is read in Maya.
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The advantage of PSD files with layer sets 

PSD files with layer sets facilitate iterative painting:

• Photoshop artists can add, modify, or delete any number of layers 
within a layer set while maintaining the connections in Maya (see also 
”Create a PSD file with layer sets from within Maya” on page 93). 

• Maya artists can convert a PSD node to a Layered Texture, and see the 
layer sets as multiple PSD File Textures connected to a layered texture 
in Hypershade.

To use an existing PSD file in Maya

1 In Hypershade, load your PSD image file with the new PSD File 
Texture node (Create Maya Nodes > 2D textures > PSD File Texture).

The PSD file is linked to Photoshop’s composite image. 

2 If the file has multiple mask channels, you can choose which one to 
see. Select the mask from the Alpha to Use attribute in the Attribute 
Editor.

3 If the PSD file has layer sets, you can choose  a layer set to link to. 
Select the layer from the Link to LayerSet attribute in the Attribute 
Editor.

4 As with any File Texture in Maya, you can set any PSD File Texture 
attributes. 

See ”PSD File Texture attributes” on page 96.

To convert an existing Photoshop File Texture with layer sets 
to a Layered Texture

1 In Hypershade, do one of the following: 

• Right-click a PSD File Texture, then select Convert to Layered 
Texture.

• Select Edit > Convert PSD to Layered Network.

2 To see the multiple layer sets connected to the layered texture, regraph 
the layered texture.

Create a PSD file with layer sets from within 
Maya

When you create a PSD file from within Maya, you select the channels to 
be painted in Photoshop. 

Note Maya treats all layers within a layer set as a single 
flattened image.
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These channels are then represented in Photoshop as layer sets, and you 
can add, edit, or delete any layer within a layer set (see also ”Use PSD files 
as textures in Maya” on page 92). Any changes you make in Photoshop 
are piped back into the appropriate channels in Maya when you update 
the PSD node (see ”Update PSD textures” on page 96).

To create and use a layered PSD file in Maya

Make sure UVs fit within the 0 to 1 texture space (see the online 
documentation for details) and select the required material (like Phong, 
for example).

1 Select the object you want to paint. 

2 Select Texturing > Create PSD Texture.

The Create PSD Texture window opens. 

3 Type the name of the Photoshop file to be created, and set any of the 
options (or use the default). 

For information on the options, see ”Texturing > Create PSD Texture” 
on page 118.

Note An optional UV snapshot works as a guideline to 
help you paint the texture with greater accuracy. 
You can create a UV snapshot when you create a 
layered PSD file in Maya (see ”To create and use a 
layered PSD file in Maya” on page 94).

Channels you select from the first column and add to the 
second column become layer sets in Photoshop.

For a detailed (advanced) list of attributes, turn on Detailed Attribute List. 
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4 In the list of Attributes, double-click an attribute you want to paint to 
add it to the list of Attributes. Repeat for additional attributes you 
want to include. If you want to paint an attribute not shown in the list, 
turn on the Detailed Attribute List.

5 Select Create. 

An empty PSD file is created by Maya with layer sets for the selected 
attributes you want to paint. The background colors are taken from 
the material.

6 Locate the PSD file in the sourceimages directory of your project.

7 Open the file in Photoshop. 

• Each attribute to be painted is represented by a layer set, and you 
can add or delete as many layers as you want within a given layer 
set. Maya treats each layer set as a separate flattened image, and 
the material’s base color is used.

• If you opted to include a UV snapshot, it is inserted on the 
topmost layer as reference for painting. (This layer does not 
contribute to the render.) 

8 Paint the layers in Photoshop, then save the file. 

9 In Maya, select Texturing > Update PSD Textures.

Each of the PSD image file’s layer sets are represented by a separate 
node attached to the PSD file node. 

Sketch out guidelines (“lipstick”) for paint 
application

You can use Maya’s 3D Paint Tool to initially sketch out (“lipstick”) where 
paint should be applied to an object. Painters can then paint more 
strategically in Photoshop because they can easily see where to apply the 
paint. This works especially well for models with UVs that don’t give you 
enough information to paint effectively.

To lipstick a model

1 Roughly paint what you want to see (for example, eyes, mouth, beard) 
on the model with Maya’s 3D paint Tool (see “The paint tools” in the 
Maya Help for details).

2 Save the scene. 

Note You can also start by mapping file textures (rather 
than using the 3D Paint Tool.
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3 Follow the steps to create and use a PSD File texture. See ”Create a 
PSD file with layer sets from within Maya” on page 93.

The painted textures are inserted as the base layer in each layer set.

Update PSD textures

When you modify a PSD file (in Photoshop) that is connected to a Maya 
PSD node (in Maya), you can update (refresh) the image in Maya to show 
the modifications immediately. 

To update a PSD texture in Maya

• Select Texturing > Update PSD textures. All PSD textures in the scene 
are updated.

PSD File Texture attributes

Most of the PSD File Texture attributes are the same as Maya’s File 
Texture Node; see ”File” on page 196 in Shading guide for details.

Disable File Load

For more information, see ”Disable the initial load of a file texture 
image” on page 98.

Use Image Sequence

See ”Use Image Sequence” on page 302.

Note Once you have created the PSD, you cannot go back 
to 3D Paint for those attributes.
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Test textures

Test textures (and texture ranges)

Available on Windows and Mac OS X.

Though most swatches in Hypershade and the Attribute Editor update 
automatically to show your changes as you build shading networks, you 
can now create a full image (or range of images), at various resolutions, on 
any node in a shading network. 

You can use this sample image to see the results of portions of a  shading 
network texture or to verify the look of a texture that doesn’t have a visual 
interactive representation (such as Multiply Divide or Gamma Correct 
utilities). 

You can also perform simple compositing within Maya by connecting 
several File node outputs to a layered texture and setting the desired 
attributes. For example, you can composite hardware rendered particles 
over software rendered scenes.

Limitations and conditions

• Utility node’s output must be connected to something downstream to 
see a sample from it.

• Texture testing supports the native Maya rendering nodes.

• The tested texture always overwrites the same image using the same 
file name (but you can save it to a different name) from Render View.

To test a texture on any native Maya rendering node

1 In Hypershade, do one of the following:

• Right-click a render node, then select Test Texture.

Tweak textures in scene views 
as usual

...and see your changes in 
Render View

Right-click the swatch, 
then select Test Texture
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• Select the texture, then select Edit > Test Texture.

• If you want to change the resolution first, select the texture, then 
select Edit > Test Texture >  to display the options. For 
descriptions of the options, see ”Edit > Test Texture” on page 132.

A sample image is rendered in Render View.

2 To save the tested image, in Render View, select File > Save As. 

To test a range of images on any native Maya render node

• Do one of the following: 

• Select the texture, then select Edit > Render Texture Range.

• If you want to change the resolution, file format, frame range or 
padding, select the texture, then select Edit > Render Texture 
Range >  to display the options. For descriptions of the options, 
see ”Edit > Render Texture Range” on page 132.

The rendered range of images is automatically loaded and played 
back in FCheck. 

Disable the initial load of a file texture image

To load scenes faster, you can disable the initial loading of file texture 
images on a per-node basis from disk. 

To disable the initial loading of a file texture image

1 Select the file texture. 

2 In the File Attributes section of the Attribute Editor, turn on Disable 
File Load. 

Disable File Load

Turn this attribute on to prevent the file associated with the File 
Texture node from loading.

Note Turning on disableFileTexture off after the file has 
been read does not "unload" the texture.
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Work with mental ray shaders

Use a custom-made mental ray for Maya 
shader in Maya

To use custom-made mental ray for Maya shaders in Maya

1 Write or obtain a shader declaration file (that is, an .mi file that 
contains the description of the shader(s)). 

See ”Write a shader declaration file” on page 99.

2 Insert the shader into a shader library (.dll on Windows, and .so on 
IRIX, Linux, MAC). 

• Maya6.5/mentalray/lib contains shader libraries compiled and 
loaded into Maya by default. 

• Compiling and linking a shader on NT requires to include 
shader.h and link to shader.lib. These two files are shipped 
with maya, and can be found at Maya6.5/devkit/mentalray. 

For more information on shader libraries, see ”mental ray for Maya 
Shaders” on page 39. 

3 Edit the maya.rayc file to link the shader declaration file to it, so that 
Maya can use mental ray for Maya to render the shader. 

See ”Edit the maya.rayrc file” on page 100.

4 Load the shader by doing one of the following

See ”Load shaders” on page 101.

Write a shader declaration file

For an example of how to write shader header and source code, see 
Maya6.5/devkit/mentalray. Maya6.5/mentalray/include contains base.mi, 
contour.mi and physics.mi that declares basic shaders. 

As a part of devkit, Microsoft Visual Studio project files are shipped. You 
can open base.dsw, contour.dsw, physics.dsw and compile them yourself. 

If apply is not provided in the shader declaration, you will find the shader 
node in Miscellaneous section of the Create Render Node window (or bar 
in the Hypershade). 

Note Compiling and linking a shader on NT requies to include 
"shader.h" and link to "shader.lib". These two files are 
shipped with maya, and can be found at Maya6.5/mentalray/
devkit. 
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To place the node into a different category, use the apply keyword in the 
shader declaration. For example, for mib_texture_vector (base.mi). 
mib_texture_vector node is under Textures section: 

      declare shader
         vector "mib_texture_vector" (
            integer      "select",
                  integer      "selspace",
            integer      "vertex",
            integer      "project"
         )
         version 2
         *apply texture*
      end declare

Click your shader node. The shader has blank icon and the Script Editor 
will have a warning message, unless you provided render_myshader.xpm. 

Check out the Attribute Editor of the shader. If the shader had any 
parameters, you should be able to see corresponding fields in the Attribute 
Editor. 

You can create your own Attribute Editor Template file to provide better 
look of the attribute editor. 

If the shader is called myShader, create a file called 
AEmyShaderTemplate.mel, and place it in Maya6.5/scripts/AETemplates. 

Edit the maya.rayrc file 

You need to edit this file for every shader that is to be rendered by mental 
ray for Maya; it allows Maya to see the shader. Find this file Maya6.5/
mentalray. 

Editing the maya.rayrc requires you to restart Maya. Alternatively, you 
can type the following in the script editor (see  Mayatomr MEL 
documentaiton for more details): 

Mayatomr -updateRayrc

To edit the maya.rayrc file

The following is an example of how to edit the maya.rayrc file. 

Note For some categories not supported by the apply flag 
(contour, for example), we provide a mel script: 
mentalrayCustomNodeClass.mel

Please refer to the comment in the file for further detail. 
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Assuming the declaration file is myshader.mi and the shader file is 
myshader.dll/so, do the following:

      mi "MI_FILE_DIRECTORY/myshader.mi"
      link "SHADER_FILE_DIRECTORY/myshader.{DSO}"

An example of maya.rayrc : 

      registry "{MAYABASE}"   value   "C:/Program Files/
Alias/Maya6.5/mentalray" end registry

      registry "{SYSTEM}"   value   "windows"      end 
registry
      registry "{DSO}"   value   "dll"      end registry

      $lookup "{MAYABASE}"
      $lookup "{SYSTEM}"
      $lookup "{DSO}"

      registry "{MRMAYA_START}"
         <B>link “C:/myshader/Release/myshader.{DSO}”<b>
         link    "{MAYABASE}/lib/base.{DSO}"
         link   "{MAYABASE}/lib/physics.{DSO}"
         link   "{MAYABASE}/lib/mayabase.{DSO}"
         link   "{MAYABASE}/lib/contour.{DSO}"
         <b>mi   "C:/myshader/include/myshader.mi"</b>
         mi    "{MAYABASE}/include/mayabase.mi"
         mi    "{MAYABASE}/include/base.mi"
         mi    "{MAYABASE}/include/physics.mi"
         mi    "{MAYABASE}/include/contour.mi"
         echo   "mental ray for Maya - startup done"
      end registry

      $lookup   "{MRMAYA_START}"

Load shaders

To import a custom shader library

1 Copy the declaration file to the include directory of your mental ray 
for Maya installation.

2 Copy the library file into the lib directory of your mental ray for 
Maya installation.

3 Modify the configuration file “maya.rayrc” in the plug-ins directory of 
your Maya installation. Add statements to include the declaration file 
and to link with the library file. 
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mental ray for Maya is able to load and render with your custom 
shader library. Placing the declaration file in the include directory also 
uses mental ray for Maya to parse the file and create new Maya node 
types that correspond to the shaders declared in the library.

With the mental ray Shader Manager

The Shader Manager lets you interactively load and unload mental ray 
shader libraries and work with them during a Maya session. (You do not 
need to shut down first, and you do not need to set the environment 
variable MI_CUSTOM_SHADER_PATH.)

You can select from a list of.mi library files that contain the mental ray 
shader declarations. The shaders contained in the selected.mi library files 
automatically appear in Hypershade, just like the Maya and mental ray 
for Maya base shader nodes. mental ray for Maya base shaders are now 
fully integrated into Hypershade and Create Render Node panel.

(You do not need to set the environment variable 
MAYA_MRFM_SHOW_CUSTOM_SHADERS to show custom shaders in 
Hypershade.)

To load or unload custom mental ray shaders

1 Select Window > Rendering Editors > mental ray > Shader Manager. 

The Shader Manager opens and shows which declaration files are 
loaded. 

2 Click to load or unload a declaration file, auto load the file, or get 
information on the file. For descriptions of the buttons and options in 
the mental ray Shader Manager window, see ”Window > Rendering 
Editors > mental ray > Shader Manager” on page 113.

With the MI_CUSTOM_SHADER_PATH environment 
variable

You need to add your .mi file to this environment variable path (unless 
you use the Shader manager) to load any shader that is to be rendered 
mental ray for Maya. 

Note Though you can dynamically load/unload shaders 
in render time, those shaders that are used should 
be specified in the maya.rayrc file.

The maya.rayrc file requires both .mi and, or .so 
of the desired libraries to be included. 
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This variable tells mental ray for maya a directory where .mi files are 
located. Every .mi file located in MI_CUSTOM_SHADER_PATH will be 
parsed on plug-in load.  

This environment variable should be set prior to loading the plug-in. 
mental ray for Maya interprets this variable in different ways. If it is not 
empty but does not point to an existing file or directory,  a file dialog 
opens up as the mental ray for Maya plug-in is (auto-)loaded. A .mi file 
should be selected that contains mental ray shader/phenomenon 
declarations which the Factory should create Maya node types for. The file 
dialog comes up again in a loop to allow more than one .mi file to be 
loaded. It stops when the Cancel button has been pressed. 

If the Factory should load all required files automatically, then a file or a 
directory containing .mi files should be given in the environment variable. 
For loading a single file, set MI_CUSTOM_SHADER_PATH as follows:

• Unix

setenv MI_CUSTOM_SHADER_PATH /usr/local//aw/maya6.5/
include/base.mi   

• Windows

set MI_CUSTOM_SHADER_PATH=C:/Program Files/Alias/Maya6.5/
mentalray/include/base.mi  

For parsing all files in a directory, you could use (in which no file dialog 
will appear) the following:

• Unix

setenv MI_CUSTOM_SHADER_PATH /usr/local/mi/rayinc31  

• Windows

set MI_CUSTOM_SHADER_PATH=c:/usr/local/mi/rayinc31  

The default value of MI_CUSTOM_SHADER_PATH is Maya6.5/mentalray/
include. 

You can modify Maya.env to add your own directory to the path. For 
example, the following line in Maya.env will append C:\myshader\include 
to the path : 

MI_CUSTOM_SHADER_PATH = C:\myshader\include 

To make your shader be loaded by default, you can either add the 
directory to the path, or put the file in the path. 

While mental ray plug-in is loaded, base.mi, contour.mi and physics.mi are 
parsed, nodes for each shader declared in the .mi files will be created. See 
the Script Editor for nodes being created. 
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Same for your shader. If the .mi file is in MI_CUSTOM_SHADER_PATH , 
you should be able to find your shader name in the Script Editor. For 
example, my Script Editor has following lines (if optionVar 
miFactoryVerbosity is set to 4 or higher. ( myshader1 and myshader2 are 
declared in myshader.mi ) 

      // generating nodes ...
      // parsing C:/myshader/include/myshader.mi
      // myshader1
      // myshader2

Use a mental ray for Maya shader 

You can use mental ray for Maya shaders the same way you use Maya 
materials, textures, and other render nodes; you build shading networks 
out of them in Hypershade.  See ”Connect nodes” on page 70.

The following shows where in a scene specific mental ray for Maya nodes 
are typically connected:

1 Lens shader. Attaches to camera.

2 Surface shader. For surface effects (Blinn, Phong, and so on). Attaches 
to Shading Group.

3 Light shader. For lighting style (point, spot, and so on), and 
shadowing controls. Attaches to light.

4 Shadow shader. Called when a shadow ray hits an object. Overrides 
the appearance of the object to shadow rays (color, transparency). 
Attaches to Shading group. 

1

2

3

4

6

5

7

9

8

10
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5 Volume Shader. Handles rays passing through objects. Attaches to 
Shading Group (or to Camera for Environment Fog).

6 Geometry shaders. Calle d prior to rendering for rendering. Attaches 
to transform node.

7  Displacement shader. Same as Maya, displaces surface geometry. 
Attaches to Shading Group.

8 Output shader. For post effects (glow, 2D blur, DOF, and so on). 
Attaches to camera, attaches to multiple shaders, control order of 
execution. 

9 Contour shading. 2 Global shaders, 1 shader on object, attaches to 
Shading group. 

10 Photon / photon volume shaders. Describe how photons are 
scattered/absorbed. Not commonly overridden. Attaches to Shading 
Group.

Specify light parameters

Light parameters are message attributes. Connect any output attribute of a 
light node (not the shape node) to, for example, the desired element of a 
light array of your custom material shader. 

These extensions should enable you to create pretty much any shading 
network supported by mental ray. It can be either exported to a file or 
rendered from within Maya. Some restrictions apply: 

• Cooperation between proprietary mental ray shaders and the Maya 
base shader library is not always seamlessly possible. Although much 
work has been put into making the Maya base shaders compatible 
with standard mental ray shaders, some restrictions still apply. 
Custom shaders might thus have to be designed in a special way, if 
cooperation between the Maya base shader library and custom 
shaders is desired. 

• The mental ray Phenomenizer represents a shader declaration, not a 
definition. Therefore, it cannot be directly linked into a shading 
network. 

Work with phenomenon

Build Phenomena

To build a phenomenon

1 In Hypershade, build a shading network normally with mental ray for 
Maya base shaders or any custom shaders. 

2 Add a phenomenon node to the Work Space.
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This is the root node for the phenomenon. 

3 Middle mouse drag from the node that has the look you want to 
capture in the phenomenon (for example, the final node that plugs 
into the Shading Network’s Shading Group) to the Phenomenon root, 
then select Other.

4 The Connection Editor appears. 

5 Connect one of the following to the root:

• For materials, connect the outcolor.

• For geometry, connect the meshout .

• For volume, connect the outvalue.

6 Add an attribute for the Phenomenon node by middle mouse 
dragging from the root to a node in the Shading Network, then 
selecting Other. 

The Connection Editor appears. 

Connect Interface to whatever attributes you want to make available 
on the Phenomenon for adjustments. 

7 Repeat for any other nodes whose attributes you want to make 
available for adjustments. 

8 Do the following:

• Specify version (optional).

• Apply flags for the type (optional).

• Apply global flags (optional).

9 Select the entire Shading Network, including the Phenomenon root. 

10 Select File > Export Selection > 

The Export Selection Options window appears. 

11 Select mental ray from the File Type drop-down list. 

12 Turn on Export Selected Items only.

13 Select Shaders, Phenomena, Materials from the Predefined Export Filters.

14 Save to your project’s mental ray directory.

Use a Phenomenon in a scene

To use a phenomenon in a scene, you must load the phenomenon with the 
Shader Manager. 

After the Phenomenon is loaded, you can find it in the Miscellaneous 
section of the Create Render Node window, unless you set the Apply flag, 
in which case, you’d find it in the appropriate section. (See ”Write a 
shader declaration file” on page 99 for more information on the Apply 
flag.)
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Work with Custom mental ray text

Assign custom text to an object or shader 

For more information about the Custom mental ray text, see ”Custom 
mental ray text” on page 48.

To assign a material shader (example)

1 Create a new scene. 

2 Create a NURBS object.

3 Assign a new Blinn node to the NURBS object. 

4 Select the Blinn node (either in the Attribute Editor, the Hypergraph, 
or the Hypershade).

5 Select Window > Rendering Editors > mental ray > Custom Text 
Editor. 

The Custom Text Editor opens.  For a description, see ”mental ray 
Custom text editor” on page 142.

When selecting objects or shaders in Maya the editor is updated 
according to the selected entity and enable the appropriate control if 
the current selection allows creation and assignment of custom mi 
text. 

6 Click the new button in the Custom Text Editor. 

The Attribute Editor displays the custom text user interface. 

7 Enter some text and click Apply. 

Any valid mi text can be entered and is stored once Apply is selected. 
Selecting Clear deletes the current text from the node and clears the 
text field. 

The custom text can make use of special placeholder characters or 
strings that are recognized during translation. They are replaced by 
actual values on export. Right now, there is just one such variable 
supported: the at sign (@) is a placeholder for the current frame 
number. 

8 Select a Custom Text Mode to specify if this text should be appended, 
prefixed to or completely replace the corresponding entity in the mi.

9 Select the name in the Attribute Editor, for example mentalrayText1, 
and type myMaterial.

After applying the text you should rename the node to some 
descriptive identifier, perhaps including a hint about the mode of 
application. Especially the shader text nodes should get a name that 
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mentions their intended use because the Custom Shader Text section 
gathers all light, camera, material, and shader text nodes into one 
menu. 

10 Select the Blinn node again. 

The text editor shows the new entry myMaterial. 

11 Select File > Export All and export the scene to a mental ray (mi) file. 

Assign text to entities

For more information about the Custom mental ray text, see ”Custom 
mental ray text” on page 48.

Click the button in the Custom Text Editor to create a custom text node 
and assign it to the selected node in the scene. The Attribute Editor is 
updated. 

The option menu lists all the available text nodes that were previously 
created. By selecting a new entry in this option menu the text assignment 
of the current scene entity is replaced with this newly chosen text node. 
Saving the scene to a Maya file also stores all the existing text nodes, both 
connected and unconnected. Custom text nodes have to be deleted by 
standard Maya methods, as the Custom Text Editor doesn't provide a way 
to do it. 

For more information on the different types of text assignments refer to 
”Types of text assignments” on page 50. 

What 
went 
wrong?

Maya materials and textures

Troubleshoot:Movies don’t play on Image 
Plane

Not all movie file formats are readable in Maya’s image planes. 

On Windows: Only .avi files are accepted. On IRIX: Only .mov (quicktime) 
and sgi movie files (uncompressed or using RLE, RLE24, JPEG, MVC1, or 
MVC2 compression) are accepted. 

Troubleshoot:NURBS surface blend renders 
incorrectly

At times, the result of NURBS surface blend will appear not to render 
smoothly with the original surfaces. 
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Running stitchAndExplodeShell on the prompt line, with the surfaces in 
question selected, may correct this situation. 

Troubleshoot:Warped textures

A 2D texture is positioned directly onto a NURBS surface's UV space. If it 
the texture appears warped the first time you apply the texture, you may 
need to edit the surface direction, fix uneven UV values (fix texture warp), 
or even rebuild the surface. See ”Texture Map” on page 252.

Troubleshoot:Can’t see the place2Dtexture 
swatch

If you cannot see the place2dtexture swatch, do one of the following:

• Select the texture swatch, then click the Input Connections button on 
the Hypershade toolbar.

• If no place2Dtexture swatch exists, it has been deleted or not created 
(because it’s automatic creation has been turned off by default). You 
must add one (see ”Create a node” on page 67), then connect it to the 
texture (see ”Connect nodes” on page 70) before you can reposition it.

Troubleshoot:Animated objects swim through 
3D texture

Converting a solid texture to a file texture can prevent an animated object 
from swimming through a 3D texture. For more information, see ”Baking 
illumination and color” on page 327. See also ”Troubleshoot:Textures on 
deforming surfaces” on page 110.

Troubleshoot:When I move a referenced 
object, the texture swims

This workflow allows you to move the referenced object anywhere in the 
scene without having the texture swim on the original object. 

If the 3D texture node is grouped within an object's hierarchy

1 Select the top node of your object's hierarchy. 

Note Convert to File Texture does not support Fix Texture Warp 
If the surface uses Fix Texture Warp, it is ignored when 
converting the material.
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2 Create the referenced object. See ”Create Texture Reference Object” on 
page 90.

3 Run the Optimize Scene Size tool. 

4 Move the original 3D texture node from the original object's hierarchy 
into the referenced object's hierarchy. 

Troubleshoot:Movies files are slow to load

The first time you access a frame from an MPEG file, it may be slow to 
load. The movie library has to scan to the end of an MPEG file to see how 
many frames are in it since this information is not available in the movie 
header.

Troubleshoot:Textures on deforming surfaces

If a procedural texture is very noisy and appears to shift and swim during 
an animation, try increasing the Filter and, or Filter Offset values to try to 
achieve a slightly blurred effect and to reduce the sharpness that causes 
the swimming. You can also try increasing the Shading Samples as a last 
resort.

If a texture does not stick to a deforming surface, you have a few options, 
each of which have advantages and disadvantages. Check the following 
table to find out which option is best for your particular circumstance.

Option Advantage Disadvantage

Parent the 3D 
placement node 
or projection to 
the object being 
animated.

Simple, fast and uses minimal 
memory. It works for complex object 
with many sub objects as long as 
none of the children objects are 
animated. For example attaching to a 
robot would not work because the 
arms are animated relative to the 
body. However an animated chair 
would work well. The texture may 
also be animated.

Handles only a single animated 
transform. For example, for a space 
scene containing many asteroids, 
each asteroid would need a 
separate shader (or texture if 
switch nodes are used). This 
method does not work at all for 
objects with morphing CVs.
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What went wrong? > Troubleshoot:Textures on deforming surfaces
Turn on "local" 
on the 3d texture 
or projection.

Simple, fast, uses minimal memory, 
and works for multiple objects.

For example, the texture would move 
correctly with each of many asteroids 
even if the asteroids are moving in 
different directions. You don’t need 
to group with objects. The texture can 
also be animated. 

You cannot customize the 
placement for different objects. 

Complex object hierarchies appear 
seamless only if you do a zero 
transform on the object first. It 
does, however, move with 
transforms on sub objects, such as 
the arms of a robot.

The placement node does not 
reflect the actual position of the 
texture, which additionally is 
transformed to the position of each 
object (at render time). 

This method does not handle 
morphing surfaces.

Convert to file 
texture

Handles morphing surfaces (CV 
animation) well. Renders as file 
textures, which can be faster and 
supports blurring. 

Can be exported to game engines, 
and complex texture networks can be 
collapsed to a single more optimal 
file texture. 

Handles multiple objects with 
different transforms and instances.

Can be too blurry unless the 
generated resolution is high. 

For complex objects, this method 
can generate many textures that 
use switch nodes. This is a more 
complicated workflow and can 
consume a lot of memory; it takes 
time to do the convert operation. 

Any animation on the 3D textures 
is ignored.

Create a 
reference object

Handles morphing surfaces (CV 
animation) well. Shows animation on 
texture and does not blur (unlike 
converting to file texture).

For simple objects memory usage 
may be substantially less than 
converting to file texture. 

Can be complex to setup and 
manage, and it may affect render 
times and memory, particularly for 
large complex objects. 

Option Advantage Disadvantage
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What went wrong? > Troubleshoot:Crash or render abort
mental ray for Maya shaders

Troubleshoot:Crash or render abort

mental ray for Maya expects only certain connections to be made the the 
message attribute in the Attribute Editor. See ”mental ray shader 
connections” on page 41 for more details.

Troubleshoot:Node factory errors in Script 
Editor

The Node Factory prints progress and error messages to the Script Editor. 
If Maya was unable to create a node (that is, a node seems to be missing) 
or an attribute on a node, a parsing error may have occurred and an error 
message is printed. 

The reason for such errors are usually name clashes.

Troubleshoot:Error messages

PHEN 0.2 error 051011: shader "myShader" not found 
: missing link statement 

Make sure the maya.rayrc has a proper link statement for myShader.

API 0.0 error 301031:Call to undeclared function 
"myShader" 

Ensure the following:

• The maya.rayrc has a proper mi statement for myShader.

• Shader files don’t have a .cpp extension. A shader written in C++ is 
not recognized correctly.

API 0.0 error 301032: while defining "": undefined 
shader "myShader" 

Ensure the following:

• The maya.rayrc has a proper mi statement for myShader.

• Shader files don’t have a .cpp extension. A shader written in C++ is 
not recognized correctly.

Troubleshoot:Cannot find main function

Did you choose Win32 Dynamic-Link Library when starting a new project? 
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Reference > Troubleshoot:Cannot open input file "shader.lib"
Troubleshoot:Cannot open input file 
"shader.lib" 

Make sure the library path is valid. There is be no space between /libpath: 
and the path name. 

Reference Menus

Window

Window > Rendering Editors > mental ray > 
Shader Manager

Opens the mental ray Shader Manager window. For more information, see 
how to use custom mental ray shaders in Maya ”With the mental ray 
Shader Manager” on page 102.

The following are descriptions of the buttons and options in the mental 
ray Shader Manager window.

Auto-load

These buttons show which files have been loaded by means of the 
MI_CUSTOM_SHADER_PATH mechanism.

Information button

This button displays a window that shows you which node types 
have been created from a loaded declaration file. 

Browse button

Opens a File Browser window that allows you to locate and load .mi 
declaration files not yet listed in the Shader Manager. 

Rendering menu set

Lighting/shading

Lighting/shading > Material Attributes

Opens the Attribute Editor for the shading group and material assigned to 
the selected surface. 

• For more information on the Attribute Editor, see ”Attribute Editor” on 
page 193 in the Basics guide.
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Reference > Lighting/shading > Assign New Material
• For more information on the shading group, see ”Shading group 
node” on page 21.

• For more information on materials, see ”Surface, displacement, 
volumetric materials” on page 25.

Lighting/shading > Assign New Material 

Select an item from the menu to create a new material and assign it to 
selected object(s).

For more information on materials, see ”Surface, displacement, volumetric 
materials” on page 25.

Automatic Attribute Editor

If on (on by default), the Attribute Editor opens and displays the new 
material’s attributes.

Lighting/shading > Assign Existing Material

Assigns one of the shading groups in the Assign Existing Material sub-
menu to all selected surfaces. This menu updates depending on the 
materials you create. 

• For more information on the shading group, see ”Shading group 
node” on page 21.

• For more information on materials, see ”Surface, displacement, 
volumetric materials” on page 25.

Lighting/shading > Transfer Surface 
Information

Transfers surface characteristics from one surface to a texture map on 
another by means of baking. For more information, see ”Transferring 
surface information” on page 39 and ”Transfer surface information” on 
page 91.

Lighting/shading > Transfer Surface Information > 

The following are descriptions of the Transfer Surface Information 
options.

Target Options

Transfer

Selects the information you want to transfer. 
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Reference > Lighting/shading > Transfer Surface Information
Object space Object space normals always point in the same 
direction, even if the triangle is rotated, so use them 
for textures on non-animated objects. 

Tangent space 

normals Tangent space normals are defined locally, per 
vertex, and can be rotated by deformation. They are 
good for textures on animated objects.

Map width

The width of the texture to be created, in pixels.

Map height

The height of the texture to be created, in pixels.

File name

The filename and location of the texture to be created.

File format

The format of the texture to create (for example, .dds, .bmp, .jpg).

Target UV Set

The UV set on the target surface for which this texture should be 
created. 

The UV set defines how the target surface is mapped into texture 
space. For accurate results, the UV mapping must be non-overlapping 
(that is, you cannot map two different faces on the target surface to 
the same UV region). 

Shading Network

Controls how the newly created texture is displayed on the object. 

Preserve current 

shading network Leaves the current network intact, and creates the 
texture file on the disk; no visible change exists in 
the scene view. 

Attach a color channel 

preview network Replaces the current network with a simple shading 
network that provides a color-only preview of the 
result on the object itself. 

Attach a Cg preview 

network Replaces the current network with a simple 
hardware shader that displays the actual result of 
the mapping on the object; this requires the 
cgfxPlugin to be loaded, otherwise this option is 
grayed out.
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Reference > Lighting/shading > Transfer Surface Information
Algorithm Options

Search method

Controls how intersections between the source and target surfaces are 
selected. 

Use outermost 

intersection Instructs the algorithm to find the furthest 
intersection from the target surface that is within the 
search depth. 

This option should be selected to capture modeled 
surface detail such as shoelaces, armor, pockets, and 
so on.

Use nearest 

Intersection Instructs the algorithm to use the closest point on 
the source surface, which prevents map artifacts that 
are caused when neighboring parts of the source 
surface are projected across gaps in concave 
surfaces. 

Common examples are under arms or between 
fingers, where the skin on one "side" of a gap is 
mapped across onto the wrong side. When using the 
first option (say, to map the effect of shoelaces), 
these same artifacts can often be removed by 
selecting appropriate Search Depth values.

Search depth 

Controls how far away from the target surface to look for intersections 
on the source surface. For concave models, this value should be set to 
around half of the minimum distance between parts of this surface 
which should remain separate (for example, fingers). If you are seeing 
large areas of the result which do not contain the correct surface 
information, try increasing this value. 

Overscan Pixel Passes

Controls how many pixels to overscan in order to fill UV mapping 
seams and prevent blending discontinuities. Each pixel requires an 
additional pass and will increase the time taken to create the result. 

Note Overscan pixel passes can be slow on scenes with large 
areas of non-intersecting objects.
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Reference > Texturing > Create Texture Reference Object
Texture Fill Pass

When turned on, all “empty” pixels in the final map are smoothly 
blended from the surrounding pixels to remove UV seam blending 
artifacts. This occurs after any pixel overscanning.

Texturing

Texturing > Create Texture Reference Object 

Creates a texture reference object for the selected surface to lock a 3D 
texture or projected 2D texture to the surface. As the surface animates or 
deforms, the texture stays with the surface, producing a very natural 
looking result. 

See also, ”Create Texture Reference Object” on page 90.

Texturing > Delete Texture Reference Object

Deletes the texture reference object for the selected surface if one exists. To 
select a reference object for a selected surface to delete it, either use 
“Texturing > Select Texture Reference Object” (see next), or click the 
reference object’s heading in the Channel Box.

See also, ”Create Texture Reference Object” on page 90.

Texturing > Select Texture Reference Object

Selects the texture reference object for the selected surface if one exists. 
You can also click its heading in the Channel Box.

See also, ”Create Texture Reference Object” on page 90.

Texturing > NURBS Texture Placement Tool 

Provides you with a 2D texture placement manipulator for the selected 
surface. When you create a 2D texture, an icon for the Texture Placement 
Tool appears in Maya’s tool bar. 

For more information, see ”Texture placement vs. label mapping” on 
page 38.

Texturing > NURBS Texture Placement Tool > Texture 
Placement Options > 

Modify texture

Controls which of the texture’s 2D Texture Placement attributes you 
can interactively adjust—Surface mapping or Label Mapping.
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Reference > Texturing > Create PSD Texture
Texturing > Create PSD Texture

Creates a PSD texture you can use as a texture map. 

See ”Use PSD files as textures in Maya” on page 92 for more 
information.

Image Name

Type the name of the Photoshop file you will be painting. By default, 
Maya uses the scene name and model name.

Size X

Sets the horizontal resolution in pixels.

Size Y

Sets the vertical resolution in pixels.

Keep Aspect Ratio

Constrains the proportions of the X and Y resolution. That is, if you 
move the X slider, the Y slider moves an equal distance.

Include UV Snapshot

Creates a UV snapshot as a guideline to help you paint with a greater 
degree of accuracy in Photoshop. 

UV Set

Specifies which UV Set to use for the UV Snapshot.

Color Value

Specifies the color to be used for the UV mesh in the snapshot image.

Anti-alias Lines

Specifies whether or not the lines forming the UV mesh in the 
snapshot image are anti-aliased. Anti-aliased lines appear smoother, 
but extend over more than one pixel with varying opacity.

Attributes, Selected Attributes

Choose from this list of default Attributes for the material. (If you 
want more advanced options, turn on Detailed Attribute List.)

Note: See ”3D texture positioning” on page 37 to find out how to 
place 3D textures on surfaces. 
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Reference > Texturing > Create PSD Texture
Selected attributes in the Selected Attributes list represent the 
channels to be painted. When you open the PSD file in Photoshop, 
each attributes listed here appears as a layer set. 

The following table shows the default available channels that 
correspond to the layer sets that are created when you create the PSD 
file. 

Detailed Attribute List

Shows a more detailed list of advanced options you can paint.

Lambert Blinn Phong Phong E

Color x x x x

Transparency x x x x

Ambient Color x x x x

Incandescence x x x x

Bump Map (Normal 
Camera)

x x x x

Displacement x x x x

Diffuse x x x x

Translucence x x x x

Specular Color x x x

Reflectivity x x x

Reflected Color x x x

Eccentricity x

Specular Rolloff x

Roughness x

Highlight size x

Whiteness x

Cosine Power x
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Reference > Texturing > Update PSD Texture
Texturing > Update PSD Texture

When you modify a PSD file (in Photoshop) that is connected to a 
Maya PSD node (in Maya), you can update (refresh) the image in 
Maya to show the modifications immediately. 

See ”Update PSD textures” on page 96.

Windows and Editors

Connection Editor

Connection Editor

The Connection Editor provides node network information in a side-by-
side layout where you can view two connected nodes in a node network. 
This editor is useful for fine-tuning a shading network. 

You can quickly and easily traverse from node to node and show a node’s 
outputs or inputs to facilitate connections, meaning you can make 
connections in either direction in a node network.
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Reference > Connection Editor
Connected attributes in the Connection Editor appear in italics, while non-
keyable attributes appear dimmed. Some dimmed attributes indicate a 
nested list of attributes. Double-click the attribute, or expand the attribute 
to view the connectable nodes.

To connect nodes with the Connection Editor, see ”Connect render nodes 
using the Connection Editor” on page 73.

Connection Editor buttons

The Connection Editor’s buttons control how connections are made.

Reload Left and Reload Right

Loads a node into the output or input panes of the Connection Editor. 
Select a node, object, or shader and click Reload Left or Reload Right.

from -> to

Switches the output attributes to input attributes, and the input 
attributes to output attributes.

Arrow buttons (   )

Moves the output node into the input pane ( ), or moves the input 
node into the output pane ( ).

Clear All

Removes the nodes from the output and input panes.

Remove

Removes the node in the output pane.

Break

Breaks the selected connection. Select the connection you want to 
break from the output pane, then click Break. This button is only 
available when the Auto-connect option is off.

Make

Makes a connection between the selected attributes. Select an output 
attribute, and select an input attribute, then click Make. This button is 
only available when the Auto-connect option is off.

Close

Closes the Connection Editor.

Note Some utility nodes can only be connected to a material’s 
attributes through the Connection Editor.
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Reference > Hypershade
Connection Editor menu bar

Options > Auto-connect

Causes a connection to be created automatically, when you select an 
output attribute and an input attribute. This option is on by default.

Left Display > Show Readable and Right Display > Show Readable

Displays all the attributes for the node, regardless of whether the 
attribute is keyable or not. This option is on by default.

Left Display > Show Outputs Only and Right Display > Show Outputs 

Only

Displays only the output connections for the selected node.

Left Display > Show Inputs Only and Right Display > Show Inputs 

Only

Displays only the input connections for the selected node.

Left Display > Show Non-Keyable and Right Display > Show Non-

Keyable

Displays the non-keyable (attributes you cannot create connections 
for) attributes of the node. This option is on when the the Show 
Readable option is on.

Left Display > Show Connected Only and Right Display > Show 

Connected Only

Displays only the attributes that have connections.

Left Display > Show Hidden and Right Display > Show Hidden

Displays hidden attributes for the node.

Hypershade

Hypershade

The Hypershade is the central working area of Maya rendering, where 
you can build shading networks by creating, editing, and connecting 
rendering nodes, such as textures, materials, lights, rendering utilities, and 
special effects.

To open and customize Hypershade, see ”Open and customize 
Hypershade” on page 58. 
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Reference > Hypershade
Create bar

When you first open Hypershade, the Create Bar panel appears at the left. 
From this panel, you can choose among node types that let you create 
different types of rendering effects. 

Different types of nodes are nested in sections within the bar. Click the bar 
to see the categories of nodes, then click a section to see the nested nodes.

The Create bar is very similar to the Create Render Node window. For a 
description of what is in the Create bar, see ”Create Render Node 
window” on page 133.

Click here to 
reveal hidden 
tabs of node 
categories 
from which 
you can 
select nodes 
to add to 
your scene.
Shading

123



1 | About shading and texturing surfaces
Reference > Hypershade
Sorting Bins

Use Sorting bins, which are containers for shading nodes (materials, 
textures, and so on),  to help you organize and track shading nodes in 
your scenes. 

A default Master bin contains all shading nodes in your scene. You can 
add any number of additional bins to a scene and assign nodes to one or 
more of those bins. By strategically naming the bins, (for example, wood, 
metal, doors, foliage), you can quickly and more easily locate shading 
assets to work with them.

Notes • When a node is assigned to a bin, all the 
shading nodes upstream to this node are also 
assigned to this bin. 

• The Hypershade asset tabs (Materials, Textures, 
and so on) exist for all sorting bins, allowing for 
further organization and filtering. 

• While shading nodes can be assigned to more 
than one bin, they are not duplicated in the 
scene. 

• You can rename an existing bin by 
double-clicking it.

The Master Bin 
(default) contains all 
shader nodes
in a scene.

Add and name any 
number of bins, and 
assign assets to bins.
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Reference > Hypershade
Hypershade tabs

Hypershade’s tabs contain the rendering components that contribute to 
the current scene. 

Each Hypershade tab displays specific rendering node as a node icon (a 
swatch), that visually represents the characteristics of the node. When you 
edit a node’s attributes or assign textures or special effects, the swatch 
updates in Hypershade.

For a detailed description of Hypershade tabs, see ”Hypershade” on 
page 122. 

Work Area tab

Displays the shading network for a selected node.

Select a node, then select one of the graphing icons on the tool bar, such as 
Input Connections. The selected nodes appear in the Work Area tab. If 
another Work Area tab is selected, the graph operation graphs the selected 
nodes into that tab. (The Work Area tab cannot be deleted.) 

For more information about Shading networks, see ”Shading networks” 
on page 21.
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Reference > Hypershade
Shader Library tab

The Shader Library tab in the bottom panel of Hypershade provides 
access to several shading networks comprised of different node types such 
as materials, textures, and utilities. You can use these shading networks 
can be used to create interesting natural and artificial substances (see 
Shading networks, see ”Shading networks” on page 21).

Projects tab

The Projects tab displays the contents of the default projects directory. 

If you keep projects elsewhere, create a new disk tab pointing to the 
directory in which you keep your projects. See ”To create a new tab in 
Hypershade” on page 61.

For example:

• Windows

drive:\Documents and Settings\username\My 
Documents\maya\projects 

• Mac OS X

/Users/username/Documents/maya/projects. 

• IRIX and Linux

~username/maya/projects 

1. Select 
a node 2. Select a 

graphing 
icon.

3. The node’s 
shading network 
appears in the 
Work Area.
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Reference > File > Import (Hypershade)
Hypershade menu bar

File > Import (Hypershade)

Opens the Import dialog so you can choose a Maya scene file, such as a 
file containing a shader, to import into Maya.

File > Import Selected Scene Files

Reads elements from another file and loads them into the current file.

File > Import Selected Image Files

Select an item from the drop-down list to choose how to import image 
files. 

For a description of the mapping options, see ”Mapping methods” on 
page 35.

Include Placement

When on, Maya automatically creates a texture placement node when 
you create a texture render node. The default setting is on.

File > Export Selected Network

Exports the selected item into a new file. The file browser opens to its best 
guess directory, but you can browse to any directory, or cancel, before 
exporting.

Edit > Delete (Hypershade)

Deletes the selected node(s). When you delete a node from Hypershade, 
Maya deletes it from the session.

Edit > Delete Unused Nodes

Deletes nodes not assigned to geometry or particles.

Edit > Delete Duplicate Shading Networks

Deletes redundant shading networks. 

Edit > Delete All by Type

Deletes all nodes of the type you select, whether they are assigned or not.
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Reference > Edit > Revert Selected Swatches
Edit > Revert Selected Swatches

Reverts the selected swatches to their default shapes.

Edit > Select All by Type

Highlights all the node swatches you select from this menu.

Edit > Select Objects with Materials

Edit > Select Materials from Objects

Highlights all the node swatches from selected objects. For example,  if 
you want to know which materials are used by objects A,B,C, you can first 
select objects A,B,C, then select this menu item to select materials related 
to A,B,C.  Objects A,B,C will no longer be selected. The initial objects you 
selected can be a normal object or a group or faces of a polygon geometry.

Edit > Duplicate (Hypershade)

Duplicates the selected node or shading network. To duplicate a node 
without its network, select the node and select Edit > Duplicate > Without 
Network. To duplicate a node and connect it to the same network (in 
effect, sharing the network), select Edit > Duplicate > With Connections to 
Network.

For more information on shading networks, see ”Shading networks” on 
page 21.

Edit > Convert to File Texture

Converts (renders) illumination, shadow, shading, and textures to a file 
texture you can use as a texture map. 

See ”Baking illumination and color” on page 327 for more information.

Convert to File Texture (Maya Software) > 

Note: For Convert to File Texture to work properly for polygonal 
objects, the polygons must have (UV) values, and unique 
(UV) values across the surface. Otherwise, the result may 
not be what you expect.
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Reference > Edit > Convert to File Texture
Anti-alias

If on, sharp, jagged edges within the solid texture are blurred or anti-
aliased.

Background Mode

When converting a file to a texture, occasionally some of the pixels 
along texture edges are missed. As a result parts of the geometry are 
not properly covered and the background color shows through. In the 
Background Mode drop-down list, there are three options for 
managing this situation.

Shader Default A default color is applied to the background. The 
color may be a blend of the shader colors. This 
option is intended for compatibility with previous 
versions of Maya. This is the default. 

Custom Color Specify a color to apply to the background. For 
example, this can be useful if you want to import the 
file texture into image editing software and want a 
special key (color) to select the background for 
processing.

Extend Edge Color Looks at the neighboring pixels’ colors to determine 
the appropriate background color to extend the 
texture pattern at the edges. This option provides 
the best quality in some situations.

Fill Texture Seams

If the selected UV space contains boundaries, these boundaries may 
appear as black stripes in renderings that use the baked textures. This 
occurs when the texture is sampled so close to a boundary that the 
filter picks up values (generally black) from outside the desired space. 

This setting artificially extends the boundaries by a small amount to 
alleviate this problem. It is measured in texels (pixels of texture). 
Typically, the filter is only a few texels in diameter and can only reach 
as far as its radius into these boundary spaces, so a value of 1 or 2 is 
usually enough.

Tip: In the Hardware Texturing Options window, set the 
Texture Filter option to Filtered for best quality. Set the 
Texture Filter option to Unfiltered to see the potential 
artifacts.
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Reference > Edit > Convert to File Texture
Bake Shading Group Lighting

Bakes the lights that illuminate the selected surface into a new image 
file when you convert a texture or material into an image file. The new 
image file is lit by the same lights linked to the surface in the scene. 
(This option is ideal for color matching.)

Bake Using Virtual Plane

This option lets you create an image map for layered shaders or other 
non directly supported shading networks properly without having the 
image cropped based on an object’s UVs. This bakes out a sample 
image using a virtual plane with UVs from 0,0 to 1,1 square.

Bake Shadows

Specifies whether to compute shadows when baking lighting. Disk-
based shadow maps are used. Only lights with depth map shadows 
turned on (Use Depth Map Shadows in a light’s Attribute Editor) are 
used. 

Bake Transparency

Specifies whether to compute transparency when baking lighting. 
Bake transparency samples both the color and transparency of the 
shading network—Maya sets the alpha channel of the file texture to 
correspond to the sampled transparency’s result. Transparency is not 
computed by default.

Double Sided

Turn this option off when baking lighting or shadows. If on, normals 
that are needed when sampling the shading network are flipped to 
face the camera. (You can use this option when baking a shading 
network’s lighting to light both sides of the surface). 

Note: The Convert to File Texture algorithm consists of two 
passes by default. The first pass samples the color of the 
inside of triangles; the second pass extends the sampled 
color slightly in each direction along the polygon border to 
fill texture seams. Game developers, or other users who 
have no room for overscanning, can disable the second pass 
by turning the Fill Texture Seams attribute off.

Note: Turning Double Sided on makes the conversion dependent 
on the camera which may be undesirable in some cases, 
particularly with baked lighting and shadows.
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Reference > Edit > Create PSD Texture
UV Range

Specifies the amount of the surface to sample in UV space. For example, if 
you select one or more faces on a polygonal object, instead of sampling the 
whole surface, only the selected faces are sampled. 

Default For NURBS surfaces, Maya samples the entire 
surface. For polygonal and SubDivision surfaces, 
Maya samples an area from [0,0] to [1,1].

Entire Range Samples the entire surface (for example, a polygonal 
cube is sampled from [-1,0] to [2,4]). A 
place2dTexture node is created and connected to the 
file texture. 

User Specified Turn on to enable the U and V Min/Max options 
(see next). A place2dTexture node is created and 
connected to the file texture. 

U Min/Max, V Min/Max

Slider values specify how much to stretch the sampling range of U or 
V components. Maya stretches the sample region to fit the output 
image size within the [0,0] to [1,1] sampling range.

X Resolution, Y Resolution

The horizontal and vertical resolution of the image file, measured in 
pixels. The slider range is 1 to 512. The default value is 256.

File Format

Lets you choose a format in which to save the file texture. The default 
is IFF.

Edit > Create PSD Texture

Creates a PSD texture you can use as a texture map. See Texturing > 
Create PSD Texture.

Edit > Update PSD Texture

When you modify a PSD file (in Photoshop) that is connected to a Maya 
PSD node (in Maya), you can update (refresh) the image in Maya to show 
the modifications immediately.  See Texturing > Update PSD Texture.

Note: UV Range can be used in conjunction with selected 
polygonal faces. 
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Reference > Edit > Test Texture
Edit > Test Texture

See ”Test textures (and texture ranges)” on page 97.

Edit (Hypershade) > Test Texture > 

These are descriptions of the options in the  Test Texture Options dialog 
box.

x/y resolution

The x and y resolutions in the tested texture.

Edit > Render Texture Range

See ”Test textures (and texture ranges)” on page 97.

Edit (Hypershade) > Render Texture Range > 

These are descriptions of the options in the  Render Texture Range 
Options dialog box.

Image name

The name of the resulting rendered images. Images are written to the 
images directory of the active project. The file name will be padded 
(for example, checker.0001.iff).

File Format

The file format of the rendered texture images. 

x/y Resolution

The x and y resolutions for the rendered texture images.

Start Frame

The first frame number used for the sequence.

End Frame

The last frame number used for the sequence.

By Frame

The number of frames to advance between the Start and End frames 
(see ”Render Global Settings window” on page 165 in the Rendering guide 
for details).

Padding

The number of padding digits in the number (for example, 001 is 3, 
0001 is 4, and so on).
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Reference > View > Frame All
Fcheck

Launches and loads the newly created sequence into fCheck.

View > Frame All

Frames all the nodes displayed in the current Hypershade layout.

View > Frame Selected

Frames only the selected nodes in the current Hypershade layout.

Create > Create Render Node

Opens the Create Render Node window from which you can select 
rendering nodes. Icons representing the nodes are displayed under each 
tab. 

Create Render Node window

The Create Render Node window provides access to materials, textures, 
lights, and utility nodes you can create and customize in Hypershade. 
Icons representing the nodes are displayed under each tab.

To open the Create Render Node window, from the Hypershade, select 
Create > Create Render Node.

Materials

With Shading Group

When on, Maya automatically creates a shading group when you 
create a material node. See ”Shading networks” on page 21 for more 
information about the Shading Group.

If you create a material with a shading group, Maya automatically 
selects all surfaces assigned to that shading group, or when you select 
a surface, Maya automatically selects the shading group to which it is 
assigned.

To display the shading group icon in Hypershade, click the Graph > 
Input and Output Connections button.

Note The Create Render Node window has the same 
functionalities as the Create Bar in the Hypershade. 
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Reference > Create > Create Render Node
Surface Materials

Describe the physical appearance of surfaces. See ”Surface materials” 
on page 143 for more information.

Volumetric Materials

Describe the physical appearance of phenomena which occupy a 
volume of space (for example, fog or particles). See ”Volumetric 
materials” on page 175 for more information.

Displacement Material

Change the surface of geometry. When viewed in silhouette, you can 
see the displacement of the surface. See ”Displacement material” on 
page 174 for more information. 

Textures

With New Texture Placement

Click the Textures tab to display this option. When on, Maya 
automatically creates a texture placement node when you create a 
texture render node. The default setting is on.

Normal

See ”Mapping methods” on page 35.

As projection

See ”Mapping methods” on page 35.

As stencil

See ”Mapping methods” on page 35.

2D Textures

2D patterns that simulate various types of surface materials by using 
either an image file (File texture) or a computer graphic procedure. 
See ”2D and 3D textures” on page 27. 

3D Textures

3D patterns that simulate solid materials (for example, wood or 
marble) using a computer graphic procedure. When you map a 3D 
texture to a surface, the surface appears to be carved out of the 
material. See ”2D and 3D textures” on page 27.

Environment Textures

Simulate 3D spaces using a series of image files (Env Ball, Env Cube, 
and Env Sphere textures) or using a computer graphic procedure (Env 
Chrome and Env Sky textures). See ”Environment textures” on 
page 236. 
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Reference > Create > Create Render Node
Other Textures (Layered Texture)

Provides a quick way to layer attributes. You can create a texture 
consisting of two or more of the textures already existing in the scene 
and control how they are composited. See ”Layered textures” on 
page 28.

Lights

Surfaces are illuminated by light rays directly emitted from these light 
sources. Using the attributes and properties associated with lights, you 
can simulate many different types of real-world light sources and special 
effects. 

For more information about light sources and their attributes, see ”Sources 
of direct light” on page 14 in the Lighting guide.

Utilities

General Utilities

Utilities provided to enhance and blend various attributes and 
textures. See ”General utilities” on page 368.

Color Utilities

Utilities provided to color correct and enhance texture colors. See 
”Color utilities” on page 342.

Switch Utilities

Several objects can share shading characteristics, and you can define 
unique characteristics for each object on an object-by-object basis. See 
”Switch utilities” on page 342.

Particle Utilities

For more information about particles, see ”Particles” on page 19 in the 
Dynamics guide. 

Image Planes

Control the appearance and placement of an image plane. You can 
assign a texture or image file to an image plane to create a background 
for the scene.

For more information, see ”Create, edit, or position an image plane” 
on page 293. 

Glow Utilities

Glows, halos, or lens flares optical effects are produced when a light 
shines directly into the camera. You can add an optical FX to any 
light.
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Reference > Tabs > Create New Tab
For more information, see ”Glows, halos, and lens flares” on page 20 in 
the Lighting guide. 

Tabs > Create New Tab

Opens a window in which you can set options for the new tab you want 
to create. 

For more information on Hypershade tabs, see ”Hypershade tabs” on 
page 125.

Tabs > Move Tab Up, Down, Left, Right

Select a tab then select one of these options to move the tab up, down, left, 
or right.

For more information on Hypershade tabs, see ”Hypershade tabs” on 
page 125.

Tabs > Rename Tab

Opens a window in which you can assign a new name for a selected tab.

For more information on Hypershade tabs, see ”Hypershade tabs” on 
page 125.

Tabs > Remove Tab

Select a tab then select this option to remove it.

For more information on Hypershade tabs, see ”Hypershade tabs” on 
page 125.

Tabs > Revert to Default Tabs

Removes new tabs and reverts to the default organization.

For more information on Hypershade tabs, see ”Hypershade tabs” on 
page 125.
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Reference > Tabs > Current Tab
Tabs > Current Tab 

For more information on Hypershade tabs, see ”Hypershade tabs” on 
page 125.

When the current tab is a disk tab or the default Projects tab, the following 
options become available:

Show Directories Only

The tab displays only the directory lists.

Show Files Only

The tab displays only the file icons.

Show Both

The tab displays both the directory lists and the file icons in a split 
panel.

Refresh File Listing

The tab refreshes the list display.

Refresh Selected Swatches

The tab refreshes the selected swatches. This applies to disk tabs in 
Hypershade.

Refresh All Swatches

The tab refreshes all the swatches. This applies to disk tabs in 
Hypershade.

Generate Swatch Files for Current Images

When you navigate to a directory containing images in a disk tab 
(such as the default Projects tab), Hypershade reads each image file 
from disk and displays a swatch that represents it. Reading every 
image file and creating a swatch takes time, particularly for directories 
containing large image files and, or many image files, or over a 
network.

Once the swatches for the image files are created and displayed, you 
can use the Generate Swatch Files for Current Images menu item to save 
them. Now, every time you navigate to the same directory in 

Tip: In the Project and custom disk tabs of Hypershade you can 
right-click a file and select Refresh Swatch to refresh that 
file swatch.
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Reference > Graph > Graph Materials on Selected Objects
Hypershade, the display updates much faster since Hypershade no 
longer has to read each image file—it can read the saved swatches 
instead.

The swatch files are saved in a .mayaSwatches subdirectory of the 
directory containing the images, and the names of the swatch files 
correspond to the names of the image files. For example, for an image 
file called earth.tif, the .mayaSwatches subdirectory contains a file 
called earth.tif.swatch. 

Graph > Graph Materials on Selected Objects

Displays the shading group networks of selected objects.

For more information on shading networks, see ”Shading networks” on 
page 21.

Graph > Clear Graph

Clears the Hypershade Work Area tab of all nodes and shading networks.

For more information on the Work Area tab, see ”Work Area tab” on 
page 125.

Graph > Input Connections

Displays only the input connections of selected nodes. See also ”Input 
Connections” on page 71.

For more information on render node connections, see ”Render node 
connections” on page 24.

Graph > Output Connections

Displays only the output connections of selected nodes. See also “Output 
Connections”.

For more information on render node connections, see ”Render node 
connections” on page 24.

Notes: • Because the swatch files are saved in a subdirectory, you 
need write permissions to the directory to successfully 
generate swatch files for current images.

• Refreshing a swatch may require some processing time 
due to the disk/network access times.
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Reference > Graph > Input and Output Connections
Graph > Input and Output Connections

Displays the input and output connections of the selected nodes. See also 
”Input and Output Connections” on page 71.

For more information on render node connections, see ”Render node 
connections” on page 24.

Graph > Show Previous Graph

Displays the graph you were previously working on, in the Work Area. 
This is similar to a web browser’s Back button.

For more information on the Work Area tab, see ”Work Area tab” on 
page 125.

Graph > Show Next Graph

Displays the graph you were working on next (if you showed one or more 
previous graphs) in the Work Area. This is similar to a web browser’s 
Forward button.

For more information on the Work Area tab, see ”Work Area tab” on 
page 125.

Graph > Add Selected to Graph

Adds the selected nodes to the Work Area. This is helpful for adding non-
rendering nodes, such as shape and transform nodes, to the Hypershade 
for use in shading networks.

For more information on the Work Area tab, see ”Work Area tab” on 
page 125.

Graph > Remove Selected from Graph

Removes the selected nodes from the Work Area. This helps to reduce 
clutter.

For more information on the Work Area tab, see ”Work Area tab” on 
page 125.

Graph > Rearrange Graph

Rearranges the nodes in the current layout to view all nodes and shading 
networks without overlaps. 

For more information on the Work Area tab, see ”Work Area tab” on 
page 125.
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Reference > Window > Attribute Editor
Window > Attribute Editor

Displays the Attribute Editor for the selected node.

Window > Attribute Spread Sheet

Displays the Attribute Spread Sheet and loads it with the selected nodes 
so you can edit attributes for all nodes at one time.

For more information on the Attribute Spread Sheet, see ”Attribute Spread 
Sheet” on page 199 in the Basics guide.

Window > Connection Editor

Displays the Connection Editor (without pre-loading nodes in either 
column).

For more information on the Connection Editor, see ”Render node 
connections” on page 24.

Window > Connect Selected

Displays the Connection Editor with the selected node loaded in the 
Outputs column.

For more information on the Connection Editor, see ”Render node 
connections” on page 24. 

Options > Create Bar

Contains options for managing the Create Bar display: Show Create Bar, 
Display Icons and Text, Display Icons Only. See ”Hide, resize or 
customize the Create bar” on page 63.

For more information on the Create Bar, see ”Hypershade” on page 122.

Options > Bins Sort Shading Node Only

Options > Display (Work Area Only)

Use these to control the display of shapes and transforms. See ”Hide 
shape and transform nodes in Hypershade” on page 61.

No Shapes

No shapes are displayed in Hypershade. 
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Reference > Options > Keep Swatches at Current Resolution
All Shapes except Shading Group members 

Only shapes that are directly connected to shading nodes are shown. 
Shapes that are only connected to the Shading Group are not shown. 

All Shapes

All shapes are displayed, including ones that are connected to the 
Shading Group only for the purpose of expressing set membership. 

Transforms

Transforms are shown.

The display of transform nodes in Hypershade is controled by the 
"Transforms" flag in the object’s Attribute editor. 

Options > Keep Swatches at Current 
Resolution

Does not rerender swatches in the Hypershade when you zoom. This is 
helpful if a scene is complex and there are many swatches in a 
Hypershade layout.

Options > Clear Before Graphing

If Clear Before Graphing is on, selecting a node already in the Work Area 
and performing a Graph Input and, or Output Connections operation 
clears the Work Area before the new graph is drawn. If Clear Before 
Graphing is off, the same workflow adds the nodes in the new graph to 
the Work Area without removing previous nodes.

Hypershade toolbar

Hypershade toolbar

These are the buttons on the Hypershade toolbar. For more information 
about Hypershade, see ”Hypershade” on page 122.

Create Bar On/Off

 Displays or hides the Create Bar. See ”Create bar” on page 123.

Show Previous Graph, Show Next Graph

 Show Previous Graph

 Show Next Graph
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Reference > mental ray Custom text editor
These work just like Back and Forward page commands in a web 
browser. As you graph and work with networks in the Work Area, 
Hypershade remembers the networks that have been shown. Use 
Show Previous Graph to step back through the networks. Use Show 
Next Graph to move forward through the networks. 

Clear Graph

 Clears the current Hypershade layout.

Rearrange Graph

 Rearranges the nodes in the current layout to display all nodes 
and networks.

Graph Materials on Selected Objects

 Displays the Hypershade layout of nodes and, or shading 
networks for the selected objects.

Windows and editors

mental ray Custom text editor 

For more information on the mental ray Custom Text Editor, see ”Custom 
mental ray text” on page 48.

custom shader text

Enabled when selecting any light, any camera, any shading group, 
except the initial variants, any shader, except Maya’s default lambert1 
and particleCloud1. 

custom object text

Enabled when a mesh or NURBS shape is selected. If a direct 
transform of a shape is selected, the underlying shape is automatically 
determined and used.
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Reference > Overview of surface materials
Nodes

Material nodes - Maya software

Surface materials

Overview of surface materials

The Material tab in the Create bar and the Create Render Node window 
includes Surface Materials, Volumetric Materials, and Displacement 
Materials. For more information on surface materials, see ”Surface 
material” on page 26.

Some attributes (such as color and transparency) are common to most 
surface materials and are described in ”Common surface material 
attributes” on page 143. 

Some attributes are shared among many surface materials, are therefore 
grouped separately from the Common surface attributes and are 
described in ”Shared surface material attributes” on page 165. 

Surface material-specific descriptions are provided in this section under 
the material name.

Common surface material attributes

The following attributes are common to most surface materials.
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Reference > Common surface material attributes
For material-specific specular shading attributes, see the particular 
material. For example, for information on the specular shading attributes 
of the Anisotropic material, see ”Anisotropic” on page 149.

Type

The material’s basic type (such as Blinn or Phong).

When you change a material’s type, only those attributes common to 
both types retain their previous values or settings. For example, if you 
change the material type from Blinn (which has a Color attribute and 
a Specular Color attribute) to Lambert (which has a Color attribute but 
no Specular Color attribute), the Color setting is preserved, but the 
Specular Color setting is lost.

Color

The default material color. 

Transparency

A material’s color and level of transparency. For example, if the 
Transparency Value is 0 (black), the surface is totally opaque; if the 
Transparency value is 1 (white), the surface is totally transparent.

To make an object semi-transparent, set the Transparency color to a 
shade of grey or to the same color as the material Color. The default 
value is 0 (black).

If you change Transparency from the default black (0), the 
background of the material’s Hypershade swatch becomes a 
checkered pattern. This is a visual aid and is not rendered.

For more information, see ”Transparency” on page 18.

Ambient Color

Set to black by default, which means it does not affect the material’s 
Color. As the Ambient Color becomes lighter, it affects the material’s 
Color by lightening it and blending the two colors. If there are 
ambient lights in the scene, the color and brightness of those lights is 
used to control how much the ambient color contributes to the final 
color of the material. 

Note: If the material has specular highlights the transparency 
setting do not affect the highlights. So if you are trying to 
make an object disappear by animating the transparency 
attribute, you may also have to animate the specular 
highlight attributes. 
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Reference > Common surface material attributes
Incandescence

The color and brightness of light that a material appears to be 
emitting. (Incandescent objects do not illuminate other objects.) For 
example, to simulate lava, use a bright red Incandescence. The default 
color value is 0 (black). 

Bump Mapping

Makes the surface appear rough or bumpy by altering surface normals 
(during rendering) according to the intensity of the pixels in the bump 
map texture. A bump map does not actually alter the surface. A 
silhouette of the surface appears smooth. 

For more information about bump mapping, see ”Surface relief” on 
page 275.

Diffuse

Gives the material the ability to reflect light in all directions. The 
Diffuse value acts like a scaling factor applied to the Color setting—
the higher the Diffuse value, the closer the actual surface color is to 
the Color setting. The valid range is 0 to infinity. The slider range is 0 
(no light is reflected in all directions) to 1, but you can type in a higher 
value. The default color value is 0.8.

Translucence

Gives the material the ability to transmit and diffuse light. Light 
falling on a translucent surface is first absorbed beneath the surface, 
and then diffused in all directions. If set to 0, the default, no light 
shows through the object. If set to 1, all the light shows through. The 
default value is 0.

Note: Although incandescence makes a surface appear to glow, it 
does not actually act as a source of light in the scene. 

Tip: Use a little Incandescence for vegetation to make it look 
organic.

Tip: Use Translucence to simulate clouds, fur, hair, marble, jade, 
wax, paper, leaves, flower petals, or frosted light bulbs.
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Reference > Common surface material attributes
Translucence Focus

The Translucence Focus value controls how much translucent light is 
scattered depending on the direction of the light. 

For example, use a high value for very thin materials, such as wax 
paper or steam, where most of the light is scattered over a small angle 
relative to the light’s direction. The object looks brightest with the 
light source directly behind it.

Notes: • The Translucence value of a surface lit by a non-shadow-
casting light is zero or infinite (all non-zero values). 

• If the scene combines a translucent surface with a 
shadow casting spotlight, faint grid-like artifacts may 
become visible. If this happens, increase the spotlight 
Dmap Filter Size or lower the Dmap Resolution.

• For high values of Translucence, lower Diffuse 
accordingly to avoid washout.

• A surface’s actual translucence is based on the 
illumination it receives from lights, and is not related to 
its transparency. However, as an object becomes more 
transparent, its translucent (and diffuse) illumination 
gets dimmer.

• Ambient lights have no effect on translucent (or diffuse) 
illumination.

Note: When a spotlight is used to light an object with a 
translucent material, the light does not scatter past the 
light's cone of influence, even if Translucence Focus is 
lowered. 

Low Focus (~0.1) High Focus (~0.9)
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Reference > Common surface material attributes
Use a mid-range focus value for items such as leaves. The leaves glow 
when backlit, but do not wash out when lit from the front.

Use a low focus value for thicker objects, such as wax. To compensate 
for the added light and avoid a washed out result, lower the diffuse 
value, or lower the overall color (which also affects ambient lighting). 
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Reference > Common surface material Specular Shading attributes
Common surface material Specular Shading 
attributes

For more information about specular highlights, see ”Specular highlight 
(shine)” on page 19.

For material-specific specular shading attributes, see the particular 
material. For example, for information on the specular shading attributes 
of the Anisotropic material, see ”Anisotropic” on page 149.

Specular Color

The color of shiny highlights on the surface. A black Specular Color 
produces no surface highlights. The default color value is 0.5. 

Reflectivity

Gives the surface the ability to reflect its surroundings or the Reflected 
Color (similar to Specular Roll Off). The valid range is 0 to infinity. 
The slider range is 0 (no reflections) to 1 (clear reflections). The default 
value is 0.5.

Reflectivity values for common surface materials are car paint (0.4), 
glass (0.7), mirror (1), chrome (1).

Tip: Lower the color value for very shiny objects that have a 
bright specular component.

Tip: For glossy plastic surfaces, use a whitish Specular Color. 
For metallic surfaces, use a Specular Color similar to the 
surface color.

Notes: • For the Anisotropic material, you must turn off 
Anisotropic Reflectivity to change this value.

• Real reflections are only calculated during raytracing.

• If you are doing raytracing and you want other objects 
in the scene to be seen in reflections, then for those 
objects you must ensure the Visible In Reflections 
attribute is turned on in the Render Stats section of the 
Attribute Editor. (It is on by default.)
Shading

148



1 | About shading and texturing surfaces

Reference > Anisotropic
Reflected Color

Represents the color of light reflected from the material. When 
raytracing, Maya multiplies the color with the light color reflected 
mirror-like from the surface. This can be used to tint a reflection.

If you are not raytracing, you can map an image, texture, or 
environment map to the Reflected Color attribute to create fake 
reflections, which is faster and uses less memory than raytracing. This 
is called reflection mapping. For more information on reflections, see 
”Reflection” on page 311.

Anisotropic

Is a material (shader) that represents surfaces with grooves, such as a CD, 
feathers, or fabrics like velvet or satin. The appearance of specular 
highlights on an Anisotropic material depends on the properties of these 
grooves and their orientation. The Specular shading attributes (shiny 
highlights) determine the direction of the grooves as well as their 
properties.

An isotropic material (such as Phong or Blinn) reflects specular light 
identically in all directions. If you spin an isotropic sphere, its specular 
highlight remains still. 

An anisotropic material reflects specular light differently in different 
directions. If you spin an anisotropic sphere, its specular highlight 
changes, depending on the direction of the grooves.

You can set attributes of Anistropic materials to control the appearance of 
highlights, determine the orientation and spread of grooves, set the 
roughness and reflectivity, and reduce spherical abnormalities (fresnel 
index). 

You can find this material in the Create bar.

Specular Shading attributes (Anisotropic)

Control the appearance of specular highlights on a surface. 

Angle

Determines the orientation of the grooves. The range is 0.0 (default) to 
360.0. Use to determine the X and Y direction for non-uniform 
specular highlight.
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Reference > Anisotropic
Spread X/Spread Y

Determines how much the grooves spread out in the X and Y 
directions. The X direction is the U direction rotated counter-clock-
wise by the specified Angle degrees. The Y direction is perpendicular 
to the X direction in UV space.

For Spread X, the range is 0.1 to 100.0 and the default is 13. For Spread 
Y, the range is 0.1 to 100.0 and the default is 3.0

Large values correspond to surfaces which vary smoothly in the X or 
Y direction. Small values correspond to surfaces with fine structure. 
When increased, the specular highlight in the X or Y direction shrinks 
in size—when decreased, the specular highlight spreads out.

When the Spread X value is equal to the Spread Y value, the surface 
becomes isotropic—equally smooth in all directions. When the Spread 
X value is more than the Spread Y value, the surface is smooth in the 
X direction and rough in the Y direction.

For example, when a surface such as a piece of cloth whose fibers run 
along the X direction is rendered, the highlights non-uniformly spread 
out with more highlights along the Y direction. 

Roughness

Determines the overall roughness of the surface. The range is 0.01 to 
1.0. The default is 0.7. Smaller values correspond to smoother surfaces 
and the specular highlights are more concentrated. Larger values 
correspond to rougher surfaces and the specular highlights are more 
spread out—similar to being diffused. 

Fresnel Index

A fresnel is a flat lens consisting of a number of concentric rings that 
reduces spherical abnormalities. The Fresnel Index value computes 
the fresnel factor that connects the reflected light wave to the 
incoming light wave. For instance, the Fresnel Index for water is 1.33. 
Values range from 1.0 to 20.0.

V

U

Angle

y
x
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Reference > Blinn
Specular Color

See ”Common surface material Specular Shading attributes” on 
page 148.

Reflectivity

See ”Common surface material Specular Shading attributes” on 
page 148.

Reflected Color

See ”Common surface material Specular Shading attributes” on 
page 148.

Anisotropic Reflectivity

If on, Maya automatically calculates Reflectivity as a fraction of 
Roughness. Reflectivity is on by default.

If off, Maya uses the specified Reflectivity value for the environment 
map (mapped on the Reflected Color attribute), similar to how the 
Phong and Blinn materials work.

In the following, Anisotropic Reflectivity is on, an environment is 
mapped on the Reflected Color, and the Roughness is set to 0.01, 0.05, 
0.1, and 1.0 (from very smooth to very rough).

Blinn

Is a material (shader) that is particularly effective at simulating metallic 
surfaces (for example, brass or aluminum) which typically have soft 
specular highlights.

0.01 0.05

0.1 1.0
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Reference > Blinn
You can set attributes of Blinn materials to control the size of shiny 
highlights and the ability of the surface to reflect its surroundings. 

You can find this material in the Create bar.
 

Specular Shading attributes (Blinn)

Eccentricity

Controls the size of shiny highlights on the surface. The valid range is 
0 (no highlight) to 0.999 (broad highlight, not very shiny surface). A 
value of 0.1 produces a small highlight (very shiny surface). The 
default value is 0.3.

Specular Roll Off

Gives the surface the ability to reflect its surroundings (the 
environment, other surfaces) or the Reflected Color, when viewed at 
oblique angles. The slider range is 0 to 1. The default value is 0.7.

To help visualize the effect of Specular Roll Off in a Blinn material 
swatch, assign a texture to the Reflected Color.

Note: Blinn is the most computationally expensive of the three 
common materials: Lambert, Phong, and Blinn.

Tip: The soft highlights on Blinn surfaces are less likely to 
exhibit artifacts or flickering for thin highlights than the 
harder highlights on Phong surfaces. Use the Blinn surface 
material for surfaces with bump or displacement maps to 
reduce highlight artifacts or flickering.

Tip: Use a Specular Roll Off value of 0.3 to simulate a wet 
surface (for example, wet paint).
Shading

152



1 | About shading and texturing surfaces

Reference > Lambert
Specular Color

See ”Common surface material Specular Shading attributes” on 
page 148.

Reflectivity

See ”Common surface material Specular Shading attributes” on 
page 148.

Reflected Color

See ”Common surface material Specular Shading attributes” on 
page 148.

Lambert

Is a material (shader) that represents matte surfaces (such as chalk, matte 
paint, unpolished surfaces) with no specular highlights. 

The initial (default) shading group uses a special Lambert surface 
material. Do not modify it; instead, create and apply a new Lambert 
material.

Find this material in the Create bar.

You can set attributes of Lambert materials to control its appearance. See 
”Common surface material attributes” on page 143.

Layered Shader

For more information on layered shaders, see ”Layered shaders” on 
page 26.

Find this material in the Create bar.

Layered Shader Attributes

Transparency

Sets the material’s transparency. By default the material is semi-
transparent.

Compositing Flag

Composites the layers in either Layered Shader node or Layered 
Texture node. Each mode calculates the transparency flag differently. 

For more information, see ”Layered textures with the Layered Shader 
node” on page 27.
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Reference > Ocean Shader
Layered Shader The color and transparency are processed and 
passed together to the Layered Shader. In other 
words, transparency is taken into consideration to 
modify the color before the color is reported to the 
Layered Shader. 

Layered Texture Color and transparency are passed separately to the 
layered shader. In other words, color is reported to 
the Layered Shader with no consideration of the 
transparency setting; transparency is passed as a 
separate channel. The color and transparency are 
then composited. However, this can lead to dark 
halos where the negative space of the alpha channel 
is represented.

Hardware Shading Attributes

Hardware Color

Helps you distinguish the objects assigned to a layered shader in the 
views.

Ocean Shader

You can find this material in the Create bar.

For information on Ocean Shader, see ”Ocean shader and texture” on 
page 165 in the Fluid Effects guide.

Phong

Is a material (shader) that represents glassy or glossy surfaces (such as car 
moldings, telephones, bathroom fittings) with a hard specular highlight. 

You can find this material in the Create bar.

Tip: The soft highlights on Blinn surfaces are less likely to 
exhibit roping or flickering for thin highlights than the 
harder highlights on Phong surfaces. Use the Blinn surface 
material for surfaces with bump or displacement maps to 
reduce highlight roping or flickering.
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Reference > Phong E
Specular Shading attributes (Phong)

Cosine Power

Controls the size of shiny highlights on the surface. The valid range is 
2 to infinity. The slider range is 2 (broad highlight, not very shiny 
surface) to 100 (small highlight, very shiny surface), though you can 
type in a higher value. The default value is 20.

Specular Color

See ”Common surface material Specular Shading attributes” on 
page 148.

Reflectivity

See ”Common surface material Specular Shading attributes” on 
page 148.

Reflected Color

See ”Common surface material Specular Shading attributes” on 
page 148.

Phong E

Is a material (shader) that is a simpler version of the Phong material. The 
specular highlights on Phong E surfaces are softer than those on Phong 
surfaces, and Phong E surfaces render faster.

You can find this material in the Create bar.

Specular Shading attributes (Phong E)

Roughness

Controls the specularity focus.

Highlight Size

Controls the amount of specular highlight.

Whiteness

Controls the specular highlight color. The default is white, but you 
can choose any color. You can also map a texture to this value.

Ramp Shader

You can find this material in the Create bar.
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Reference > Ramp Shader
The Ramp Shader is a material (shader) that you can use for extra control 
over the way color changes with light and the view angle. You can 
simulate a variety of exotic materials and tweak traditional shading in 
subtle ways. 

All the color-related attributes in the Ramp Shader are controlled by 
ramps (gradients). Graphs let you avoid complex shading networks by 
making certain looks, like toon shading, easier to achieve. 

You can set the many attributes of the Ramp Shader to control the 
appearance of objects. 

Each color entry in a ramp has a circular color handle above the ramp, and 
a square color icon below the ramp. The active color has a white border 
around its color handle and icon.

Color 

The basic color of the surface.

Selected Position

Position of the active color entry in the ramp. 

Selected Color

The color of the active color entry. 

Tip: To make a shader that avoids linear artifacts on the edge 
where a surface turns away from the light try the following:

Diffuse = 0

Translucence = 1

Color: two entries, black at 0.5 and surface color at 1.0

With Linear Interpolation, this should be the same as a 
normal lambertian falloff. Using Smooth Interpolation 
makes the linear shading artifacts disappear.

Click to delete the 
color entry.

Click the handle to edit 
the color entry.

Click-drag the handle to 
move the color entry’s 
position.

Click in the ramp to add a 
new color entry or click-
drag to add and 
interactively position a new 
color entry.
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Reference > Ramp Shader
Interpolation

Controls the way colors blend in the ramp. Select an option from the 
drop-down list: None, Linear, Smooth, Spline. The default is Linear. 

None There is no interpolation; the different colors show 
up as distinct bands in the final texture. 

Linear The values are interpolated linearly in RGB color 
space. 

Smooth The values are interpolated along a bell curve, so 
that each color on the ramp dominates the region 
around it, then blends quickly to the next color. 

Spline This takes into account neighboring indices for a 
smoother effect.

Color Input

Determines how the color is spread over the surface. Select an option 
from the drop-down list: Light Angle, Facing Angle, Brightness. The 
default is Light Angle. 

Light Angle The position along the ramp is determined by the 
angle of the light with the surface normal. The right 
side of the ramp is the color where the normal 
points directly towards the light. The center of the 
ramp represents the point at which the surface 
normal is perpendicular to the light. The left side is 
the color where the normal faces directly away from 
the light. The color values to the left of the ramp 
center is not be visible unless the shader has some 
translucency. This takes into account all lights in the 
scene.

Facing Angle The position along the ramp is determined by the 
angle of the surface with the view direction. The 
right side of the ramp is the color where the surface 
normal faces the camera. The left side is the color 
where the surface normal is perpendicular to the 
camera. 
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Brightness The total light brightness is used to index the ramp. 
This can be used to create cartoon style shading by 
using a ramp with stepped values. The right side of 
the ramp is the output color where the brightness of 
the diffuse and translucent lighting is 1.0 or greater. 
The left side is the output color where the brightness 
is zero.

Transparency attributes

Controls how transparent or opaque the material is, as well as the 
transparency color. Black, the default, is completely opaque and white is 
completely transparent. You can set it to any level in between. If there is 
more than one index in the ramp then the transparency value varies with 
the facing angle.

For descriptions of the attributes, which are the same as the Color 
attributes, see ”Color” on page 156.

Incandescence attributes

Makes a material appear as if it were emitting light, such as lava or a 
phosphorescent moss. The default color is black, which has no effect on 
the surface. If there is more than one index in the ramp the incandescence 
value varies with the facing angle. 

For descriptions of the first few attributes, which are the same as the Color 
attributes, see ”Color” on page 156.

Ambient color 

See ”Ambient Color” on page 144.
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Reference > Ramp Shader
Bump Mapping 

See ”Bump Mapping” on page 145.

Diffuse

See ”Diffuse” on page 145.

Forward Scatter

Controls how much of the light is diffusely scattered along the light 
direction. At a value of 0 the light is scattered uniformly in a 
lambertian fashion, which is good for most surfaces. Some materials, 
such as skin, scatter the light more along the forward direction so 
values larger than zero may help in simulating these materials. 

Translucence 

See ”Translucence” on page 145.

Translucence Focus 

See ”Translucence Focus” on page 146.

Translucence Depth

See ”Translucence Depth” on page 159.

Specular Shading attributes

Specularity

Controls how bright the specular highlights are. It is a simple 
multiplier of the specular color.

Eccentricity

Controls how big the specular highlights, or hot spots, are. For more 
information, see ”Specular Shading attributes (Blinn)” on page 152.

Specular Color

Is the color of the specular reflections, also called hot spots, on the 
material. The final color of a specular reflection is a combination of the 
Specular Color and the color of the light. By making the Specular 
Color brighter or dimmer, you can control the brightness of the 
specular reflections on an object. If there is more than one ramp index, 
the specular color varies based on the brightness of the highlight.

For descriptions of the attributes, which are the same as the Color 
attributes, see ”Color” on page 156.
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Specular Roll Off attributes

This modulates or scales the intensity of the specular highlight. The 
facing ratio is the input to the graph. Making the graph slope down to 
the right simulates the fresnel effect, where objects with a low 
refractive index are more reflective towards the edge (where the 
normal is perpendicular to the view). Water and wax both have a 
relatively low refractive index, thus this can help simulate the look of 
a waxed car finish, an ocean surface or a wet object. The horizontal 
dimension of the graph represents the brightness of specular 
reflections and the vertical represents the facing angle with the view. 

Specular Rolloff does not affect the reflections produced when you 
render using raytracing. 

Selected Position

The active value on the x-axis of the ramp graph. 

Selected Value

The active value on the y-axis of the ramp graph.

Interpolation

Controls the way values are calculated in the ramp. Select an option 
from the drop-down list: None, Linear, Smooth, Spline. The default is 
Smooth. 

None

There is no interpolation; the different colors show up as different 
bands in the final texture. 

Linear

The values interpolated linearly in RGB color space. 

Tip: To get a wet look, such as wet paint, make the edges more 
reflective.

Click to delete the 
entry.

Click the handle to edit 
the entry.

Click-drag the handle to 
move the entry.

Click in the ramp to add a 
new entry or click-drag to 
add and interactively 
position a new entry.
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Reference > Ramp Shader
Smooth

The values interpolated along a bell curve, so that each value on the 
ramp dominates the region around it, then blends quickly to the next 
value. 

Spline

This takes into account neighboring indices for a smoother effect.

Reflectivity attributes

This functions in the same manner as specular rolloff, but modulates the 
environment and reflected color instead of specularity. It also affects 
raytrace reflections. Reflectivity is used to make an object reflect light and 
its environment like a mirror. Set to 0 for no reflection. Increase the value 
to make brighter reflections. Note that brighter reflections hide more of 
the base surface color. This attribute is only meaningful if there is a 
reflection map, or if you are raytracing the render. 

For descriptions of the Selected Position, Selected Value, and Interpolation 
attributes, see ”Specular Roll Off attributes” on page 160.

Environment attributes

Defines a simple sky to ground environmental reflection using a ramp. 
The left of the ramp is the top of the sky and the right is the bottom.

For descriptions of the Selected Position, Selected Color, and Interpolation 
attributes, see ”Color” on page 156.

Reflected Color

Affects the color of light reflected from the material. You can map an 
image, texture, or environment map to this attribute in order to make 
fake reflections, which are less expensive than raytracing. This is 
called reflection mapping. Reflection mapping and raytracing may be 
used together, in which the reflection map is used as background,and 
raytraced reflections appear in the foreground.

Note: If you are doing raytracing and you want other objects in 
the scene to be seen in reflections, then for those objects you 
must ensure the Visible In Reflections attribute is turned on 
in the Render Stats section of the Attribute Editor. (It is on 
by default.)
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Reference > Shading Map
Shading Map

Is a material (shader) that lets you create various non-photorealistic 
shading effects, such as cartoon-style materials, or highlight threshold 
values in a rendered image. 

Use a Shading map shader with a basic shader (such as a Phong or Blinn 
shader) and a texture (such as a Ramp or File texture). 

For example, you can create a material that renders the bright areas of an 
object (the areas facing light) as red, and the dark areas of an object (facing 
away from light) as blue. For this example, you would use a Shading Map 
shader, a Lambert shader, and a Ramp texture. The Ramp texture is red 
on the top, and blue on the bottom. Connect the Lambert shader's Out 
Color attribute to the Shading Map shader's Color attribute. Connect the 
Ramp texture's Out Color attribute to the Shading Map shader's Shading 
Map Color attribute. 

Shading maps work like a post process: the regular shader computes a 
color for each point on the surface, then the shading maps shader replaces 
this color with another color. This mapping is based on two things; the 
brightness of the original color, and the hue of the original color. 

You can find this material in the Create bar.

Shading Map Attributes

Color

Select a color, or map with a shader to this attribute. This provides the 
base color to which the shading map is applied.

Shading Map Color

Defines the color of the material. The default is gray.
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Reference > Surface Shader
Map Options

Map Function U, Map Function V

Their defaults are Hue and Value, respectively, but other options 
include Saturation, Red, Green, Blue, and RGB Average. Map 
Function U specifies how the input color is used when looking up in 
the U direction of the shadingMapColor. Map Function V specifies the 
input color is used when looking up in the V direction of the 
shadingMapColor.

Surface Shader

Is a material (shader) that is a wrapper node, which means that you can 
connect any keyable attribute to this shading group, and then connect the 
shading group to an object. For example, you can connect an object’s 
Translate Position to a Surface Shader’s Out Color attribute to determine 
the object’s color by the object’s position.

Find this material in the Create bar.

Surface Shader Attributes

Out Color

The color of the material. The default is black.

Out Transparency

The transparency of the material. The default is black (opaque).

Out Glow Color

The glow color of the material. The default is black, without glow.

Out Matte Opacity

Connect another attribute to this to control the opacity of the material’s 
matte (alpha) channel.

Use Background

You can create custom shadow and reflection passes with the 
useBackground material which catches shadow and, or reflections. 

When the shadow pass is rendered, a black image is created with mask 
channel that contains the shadow information. A compositor can work 
with this channel to blur, lighten, darken, and so on, the look of the 
shadows. When the reflection pass is rendered, an RGB image is created 
with a white mask in the mask channel. 

Find this material in the Create bar.
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Reference > Use Background
For more information about the Use Background material as a catcher, see 
”Shadow catching” on page 38 in the Lighting guide.

Use Background Attributes

Specular Color

Defines the material’s specular color. If you change this color or assign 
a texture to it, the reflections in the scene display your changes. For 
instance, if you map a checker texture to the Specular Color, the 
reflection appears in a checkered pattern. Drag the slider to set the 
Specular Color to white if you want to see very clear reflections in the 
rendered result. The default is gray. 

Reflectivity

Determines how much of the object’s texture reflects on the Use 
Background material. For instance, if the object is very shiny, increase 
this value. The default is 0.5.

Reflection Limit

Determines the reflection’s distance. The default is 2.

Shadow Mask

Determines the density of the material’s shadow mask. If you change 
this value, the shadow masks becomes darker or lighter, allowing you 
to better verify the shadows and reflections in the scene when viewing 
the mask channels in Render View. 

The default value is 1.0. If set to 0.0, the shadow does not display. 

Matte Opacity

For best results when adjusting these attributes, select the Display Alpha 
Channel icon in the Render View to view the mask channels when re-
rendering the scene.

Matte Opacity Mode

Opacity Gain Displays both reflections and shadows.

Solid Matte Adjusts the density of the Use Background material.

Matte Opacity

Use the slider or enter a value to adjust the density of the mask 
channels.

Click to display RGB channels Click to display mask channels
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Reference > Shared surface material attributes
Shared surface material attributes

The following sections of the Attribute Editor provide attributes that are 
shared between most materials.

Special Effects

These attributes control the appearance of glows produced from light 
reflecting off surfaces, or from surface incandescence. Special Effects 
attributes are available for Anisotropic, Blinn, Lambert, Phong, and 
PhongE material types. See also ”Glow” on page 343 for more 
information.

Hide Source

Makes the surface invisible when rendered (if the Glow Intensity 
value is non-zero) showing only the glow effect. Hide Source is off by 
default. 

Glow Intensity

The brightness of the surface glow effect. The slider range is 0 to 1, but 
you can type in higher values to create a ‘blown out’ or ‘burn in’ 
effect. The default value is 0. Mapping a texture to the Glow Intensity 
can create very interesting effects. Turn on Hide Source to view the 
results.

Matte Opacity

You can control the mask value for individual objects. Matt Opacity 
attributes are available for Anisotropic, Blinn, Lambert, Layered Shader, 
Phong, PhongE, Shading Map and Use Background material types.

Matte Opacity Mode

Select from the list of modes in the drop-down list. 

Blinn material, color 
applied.

Glow Intensity 
mapped to Bulge 
texture, Hide Source 
off.

Result when Hide 
Source is on.
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For best results when adjusting these attributes, select the Display 
Alpha Channel icon in the Render View to view the mask channels 
when re-rendering the scene.

Opacity Gain 

This is the default Matte Opacity Mode. This mode produces both 
reflections and shadows. 

The matte channel is first calculated, and then multiplied by the 
specified Matte Opacity value. The Opacity Gain value is used as a 
multiplier on the matte value produced by this material.

The Matte Opacity Mode value is also keyable. The Opacity Gain 
range is from completely invisible to no effect (rendered as usual). 

Solid Matte 

Solid Matte makes the value of the matte channel constant for the 
material. The value you specify in the Matte Opacity slider is used, 
instead of the default value.

Use Solid Matte to adjust the overall density or visibility of the Use 
Background material.

Black Hole 

When you select the Black Hole mode, the matte channel for the 
material is set to 0 (fully transparent). This creates a black hole in the 
alpha output where the object assigned shader renders the matte 
‘knocked out’. 

In this mode, the Matte Opacity slider is disabled and its value 
ignored. 

Opacity Gain with a Matte 
Opacity value of 0.5.

Solid Matte set to 0.0. Solid Matte set to 0.5.
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Reference > Shared surface material attributes
Matte Opacity

This value depends on which Matte Opacity Mode is selected 
(Opacity Gain or Solid Matte). For example, for Opacity Gain, the 
Matte Opacity value indicates the multiplier amount for the alpha 
channel. The default is 1, which means that any opaque material 
registers an unaffected alpha value. 

Any values between 0 and 1 act as a multiplier to the alpha channel 
value to arrive at modified value. Use the slider or enter a value to 
adjust the density or visibility of the mask channels. 

Raytrace Options

The Raytrace Options attributes control the appearance of a surface 
during raytracing only.

Raytrace Options attributes are available for Anisotropic, Blinn, Lambert, 
Phong, and PhongE material types.

Note: For the Opacity Gain and Solid Matte modes, if an object 
has non-zero Transparency, objects behind it make their 
usual contribution to the matte channel’s values. This is the 
difference between setting Matte Opacity to 0.0 in these 
modes, and choosing the Black Hole mode. 

Rendered result with Matte 
Opacity Mode set to Black Hole.

Opacity Gain with a Matte 
Opacity value of 1.0.

Opacity Gain with a Matte 
Opacity value of 0.5.
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Refractions

When enabled, rays that are traced through transparent or semi-
transparent objects are refracted, or bent according to the material’s 
refraction index. 

Refractive Index

The amount that light rays bend when passing through a transparent 
object. A Refractive Index value of 1 does not bend light rays at all, so 
you need to set the index value higher than 1. Refractive Index values 
for common materials are: glass (1.6), air (1), water (1.333), crystal (2), 
diamond (2.417). The valid range is 0.01 to infinity. The slider range is 
0.01 to 3, but you can type in a higher value. The default setting is 1.6. 

Refraction Limit

The maximum number of times the surface allows a light ray to be 
refracted. For example, if the Refraction Limit value is 10, the surface 
refracts light rays that have previously been refracted and, or reflected 
(off itself or off other surfaces) 9 times or less; the surface does not 
refract light rays that have previously been refracted and, or reflected 
10 or more times. The valid range is 0 to infinity. The slider range is 0 
to 10. The default value is 6. Increasing this value may significantly 
increase render times.

You must also consider the Render Global Settings window 
Raytracing Refraction attribute too. Maya uses the lower value of the 
2. For instance, if your limit is set to 9 on the material and 6 in the 
Render Global Settings window, a value of 6 is be used. See also, 
Reflection Limit

In the following example, a glass sits in front of a mirror.

Tips: • The material’s Hypershade swatch only approximates 
the effect of the Refractive Index attribute. 

• Surfaces must have thickness for Refractive Index to 
have any effect. If a surface does not have thickness (for 
example, a plane or face element), set the Refractive 
Index value to 1.

• For best results, make sure there are suitable objects in 
the background to be refracted.
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Reference > Shared surface material attributes
The number of refractions includes both the entry and exit of a light 
ray from a surface having thickness.

The physical property Total Internal Reflection (TIR) can make some 
transparent objects appear not to refract light. This is caused by light 
rays reflecting inside the thickness of the object. If this occurs, 
increasing Refraction Limit has no effect because the Reflection Limit 
is stopping light rays before they can exit the surface. However, 
because TIR is a real-world property, you may want to keep this 
effect.

Reflection Limit

The maximum number of times the surface allows a light ray to be 
reflected. For example, if the Reflection Limit value is 4, the surface 
reflects light rays previously reflected (off itself or off other surfaces) 3 
times or less; the surface does not reflect light rays previously 
reflected 4 or more times. The valid range is 0 to infinity. The slider 
range is 0 to 10. The default value is 1. 

Set the Reflection Limit value according to the material’s Reflectivity 
value. For example, if the Reflectivity value is between 0 and 0.5, set 
the Reflection Limit value between 1 and 2. If the Reflectivity value is 
between 0.5 and 1, set the Reflection Limit value between 2 and 5.

Tip: To simulate realistic looking glass, set the Refraction Limit 
value to 9 or 10.

mirror: material must have a Reflection Limit of at least 5

eye point

glass: material must have a Refraction 
Limit of at least 9

5
4 3

2 1

6

7
8 9
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High values for Reflection Limit greatly increase rendering time. Test 
render the scene using various settings, and use the lowest values that 
give you acceptable results. Even highly reflective surfaces rarely need 
a Reflection Limit value as high as 10 or more. 

You must also consider the Render Global Settings window 
Raytracing Reflection attribute too. Maya uses the lower value of the 
2. For instance, if your limit is set to 5 on the material and 1 in the 
Render Global Settings window, a value of 1 is used. See also 
Reflection Limit.

Reflection Specularity

This attribute is available for Blinn, Anisotropic, Phong, and PhongE 
materials.

Reduce this value to avoid highlight aliasing artifacts produced in 
reflections during raytracing because of very thin or small highlights. 
Maya adds Reflection Specularity to each material to control the 
contribution of the specular highlights in reflections. The valid range 
is 0 to 1. The default is 1 (full contribution).

Translucence Depth

Simulates the way light diffusely penetrates through translucent 
objects. For example, when light shines on one side of the object, the 
other side is partially illuminated. This can be used for effects such as 
clouds, fur, hair, marble, jade, wax, paper, leaves, and so on. (To see 
this effect, turn on raytraced shadows for the light shining on the 
object.) 

Translucence depth is based on worldspace. If it is set to 0 (the 
default), no light shows through the object. If set to 10, light penetrates 
through the surface, 10 units past the point where the object is in 
shadow.

Light Absorbance

Describes how light-absorbing a material is. A material with an 
Absorbance of 0.0 transmits completely. The higher the value, the less 
light passes through.

Tip: To see the effects of translucence depth, set the 
transparency to a non-zero value. If the surface is supposed 
to be opaque, set the transparency to a very small value, 
such as 0.0001.
Shading

170



1 | About shading and texturing surfaces

Reference > Shared surface material attributes
Transparent materials generally absorb an amount of the light which 
passes through them. The thicker the material, less light gets 
through—the thinner the material, more light gets through. 

Surface Thickness

The simulated thickness (in world space) of transparent objects 
created from single surfaces (for example, a NURBS plane, or polygon 
face). 

Using Surface Thickness does not produce the same results as 
building a surface with actual thickness—the effect works well when 
the edges of the surface are not visible (for example, closed surfaces, 
or bounded shapes, like a car windshield).

Shadow Attenuation

Shadows of transparent objects are brighter in the center, simulating a 
light’s focus. A setting of 0 results in constant intensity shadows. The 
focusing increases as the parameter increases from 0 to 1. The default 
value is 0.5. The amount of attenuation for a given light ray depends 
on the angle between the light ray and the surface normal of the 
transparent object: the greater the angle, the greater the attenuation. 
To turn off the shadow attenuation completely, set shadow 
attenuation to 0. 

Chromatic Aberration 

Different wavelengths of light refract at different angles when passing 
through a transparent surface during raytracing. Chromatic 
Aberration only affects light rays as they pass through the second 
surface of a transparent object (the first exit ray).

mental ray

Reflection/Refraction Blur

Determines the blurriness of the reflection or refraction by calculating 
the angle (in degrees) between the perfect reflection or refraction 
direction and the jittered ray direction. A value of 0 creates a perfectly 
specular interaction; a value of 90 a perfectly diffuse reflection or 
refraction. Values of 10 to 30 are good starting points. 

Reflection/Refraction Rays

Specifies how many rays to use to sample the random deviation from 
the perfect specular direction. (Blurry reflections and refractions 
require supersampling because a ray's direction is not precisely 
determined with this feature. It may deviate (randomly) from the 
perfect specular direction, within the bounds specified by Reflection/
Refraction Blur.) 
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In general, more rays are required for more blurry reflections or 
refractions. Other sampling parameters also affect this setting: per-
object samples and the Render Globals sample setting supersample in 
image space. If you increase any of these two settings, you may be 
able to reduce the number of rays without loss of quality, while 
significantly improving performance. 

Irradiance

This is the ability to bounce indirect photons. Use this to map an 
incoming illumination map, such as one generated using ”Lighting/
shading > Batch Bake (mental ray)” on page 334. For information 
about baking in general, see ”Baking illumination and color” on 
page 327.

Irradiance color

This is the color of bounced photons.

Occlusion Mask

Lets you see the soft shadow, produced by final gathering, of an object 
on a surface that uses the Use Background shader. These soft shadows 
are also captured in the alpha channel of the image for compositing 
purposes.

You can set values for Occlusion Mask between 0 (no shadows) to 1 
(full shadows), or map the attribute.

Photon Attributes

Set attributes to Derive From Maya, or turn the option off and set 
remaining attributes, such as Specular Color and Diffuse, so that they are 
calculated using mental ray. Alternatively, you can change the settings in 
the Maya sections of the Attribute Editor (Common Material Attributes, 
and so on) and click Take Settings From Maya to compute the equivalent 
mental ray values for these attributes.

Hardware Shading

This is not rendered.

Override hardware shading for Lambert, Blinn, Phong, PhongE, and 
Anisotropic shaders. 

Hardware Shader

Plug-in writers can use this to override the hardware display while 
preserving software rendering. 

Hardware Texturing

This is not rendered.
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Preview rendered materials and textures in the scene views. You can 
select specific channels to view and determine the hardware render 
quality. Hardware Texturing attributes are available for Anisotropic, 
Blinn, Lambert, Phong, and PhongE material types. 

Textured channel

This drop-down list displays the mapped attributes for a texture-
mapped material. This can be useful if you map several textures to a 
material and want to view them one by one. If, for example, you map 
a Checker texture to a Blinn material’s Color attribute, and a File 
texture to its Specularity attribute, you can select Color from the drop-
down list to display only the Checker texture in the view. The top of a 
material’s Attribute Editor also provides tabs for each texture so you 
can select and edit the texture and watch the results in the view.

The Combined Textures option can be used to process the entire 
shader into one texture for hardware display purposes. It allows the 
entire shader to be previewed on the applied object and not just single 
channels, for example, color and incandescence.

Texture resolution

Lets you choose to view the textured object with varying degrees of 
accuracy and clarity.

Default Highest (256 x 256
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Displacement material

Displacement

For more information on the displacement material, see ”Displacement 
material” on page 26.

Find this material in the Create bar.

The Displacement Shader only has one attribute.

Displacement

The amount by which the surface is displaced. The default 
displacement value is 0. 

Notes: • Some effects, such as bump mapping or glows, cannot 
be seen in hardware texture mode (in the scene views). 
Use the Render View or IPR render to view the results.

• The Texture Resolution options only improve the quality 
of the hardware textured image in the scene views. You 
cannot use these options to improve the test render 
quality in Render View. Instead, change the Resolution 
and Anti-aliasing Quality settings in the Render Globals 
Settings window. Remember: the higher the quality the 
slower the render time. 
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Volumetric materials

Overview of volumetric materials

The Material tab in the Create Bar (in the Hypershade) and the Create 
Render Node window includes Surface Materials, Volumetric Materials, 
and Displacement Materials. For more information on volumetric 
materials, see ”Volumetric material (atmosphere)” on page 26.

• Some attributes (such as Matte Opacity) are common to all volumetric 
materials and are described in ”Common Volumetric material 
attributes” on page 190. 

• Volumetric material-specific descriptions are provided under the 
material name. 

Environment Fog

Simulates the effect of fine particles (fog, smoke, or dust) in the air. These 
particles affect the appearance of the atmosphere and the appearance of 
objects in the atmosphere. To simulate particles in the air illuminated by a 
particular light, use Light Fog (see ”Light Fog” on page 184).
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There are two types of Environment Fog: Simple Fog (default) and 
Physical Fog, each of which have specific attributes. 

Find this material in the Create bar.

Simple Fog

Color

Change to simulate different effects, such as smog (brown fog), or to 
create the illusion of great distance (blue fog). The default setting is 
white.

Color Based Transparency

If off, objects obscured by environment fog appear as flat-shaded 
silhouettes. If on, objects obscured by environment fog are fully 
shaded, not just flat-shaded silhouettes. 

If the fog Color is dark (black), turn off Color Based Transparency or 
the fog is not visible. Color Based Transparency is on by default.

Saturation Distance

The distance (measured in the scene’s linear working unit) from the 
camera at which environment fog becomes fully saturated (its color 
value reaches the Color setting). The Saturation Distance affects how 
much objects within or behind the fog are obscured. The slider range 
is 0.001 to 200. The default value is 100.

To change the amount that objects within or behind environment fog 
are obscured, adjust the Saturation Distance attribute and the value of 
the Color attribute.

Use Layer

If on, you can assign a texture to the Layer attribute to create 
variations in the density and color of environment fog across the 
camera’s view (that is, in two dimensions). If off, constant density 
environment fog fills the camera’s view. Use Layer is off by default.

Important! 

Environment fog cannot cast shadows. If you want to cast 
shadows, use Light Fog (see ”Light Fog” on page 184). See 
also Matte Opacity.
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Layer

Lets you map a texture to the fog, which gives the effect of patchiness 
in the fog’s density. The most common application is mapping the 
Density to a 3D texture, like a Solid Fractal, and mapping a Ramp 
texture to the Layer attribute. Make the Ramp black and white to get a 
contrast of transparency and opacity. Use Layer is off by default.

Use Height

If on, environment fog exists between the Min Height and Max 
Height. If off, environment fog fills the camera’s view. Use Height is 
off by default.

Min Height, Max Height

The minimum and maximum height (measured in the scene’s linear 
working unit) from the origin within which environment fog exists 
(when Use Height is on). If Max Height is less than Min Height, 
environment fog extends from Min Height to infinity. The slider range 
is -10 to 10. The default value is -1 for Min Height and 1 for Max 
Height.

Blend Range

The vertical distance (measured in the scene’s linear working unit) 
over which environment fog gradually fades from full density to zero 
density. (The edges of the fog are defined by the Min Height and Max 
Height values.) The slider range is 0 (fog suddenly ends at Min Height 
and Max Height) to 1 (fog gradually fades at Min Height and Max 
Height). The default value is 0.

Physical Fog

To access the attributes of Physical Fog, you must turn it on (click the 
check box under the swatch in the Attribute Editor).

Fog Type

Controls how Maya simulates the fog in the scene. It has a number of 
different settings, depending on what kind of fog effect you want. 
This attribute is only available when Physical Fog is turned on.

Uniform Fog Fog has uniform density in all directions.

Atmospheric Fog is thickest near the ground, and thins out 
(decays) as you move upwards. 

Sky Simulates the effect of a whole sky, with fog 
blending properly at the horizon, and so on. Use 
this to provide a complete background to a foggy 
scene. Especially useful for scenes where you can 
see a long distance. 
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Water Simulates the effect of water, scattering light shining 
in from above. Useful for underwater shots, or for 
shots where objects are visible in a pool of water 
from above. 

Water/Fog Uniform Fog appears above the water in the scene. 

Water/Atmos Atmospheric Fog appears above the water in the 
scene.

Water/Sky The full Sky Fog simulation appears above the water 
in the scene.

Fog Axis

Controls the direction the fog simulation uses for the up direction. 
You can choose any of the X, Y, or Z axes in the positive or negative 
direction. 

This attribute is only available when Physical Fog is turned on, and 
the Fog Type is not Uniform. 

Planet Radius 

Available for the Atmospheric, Sky, Water/Atmos, Water/Sky Fog 
Types.

Fog

Depending on the Fog Type you select, Fog attributes are either available 
or disabled. 

Fog Color

Controls the color of light scattered by the fog. When light passes 
through air or fog, some frequencies (colors) pass directly through, 
while other frequencies are scattered. The scattered frequencies give 
the fog its distinctive color. 

Fog Opacity

Controls which light frequencies (colors) are absorbed as they pass 
through the fog. This affects the way objects in the background seem 
to be tinted by the fog. 

Fog Density

Controls the optical density of vapor in the fog layer. Increase this 
value to thicken the fog. 

Fog Min Height

Controls the height of the bottom of the fog layer. This attribute is only 
available when Physical Fog is turned on, and Fog Type is not Uniform. 
Shading

178



1 | About shading and texturing surfaces

Reference > Environment Fog
Fog Max Height

Controls the height of the fog layer. If the Fog Type is Atmospheric (or 
Water/Atmos), the density of the fog decreases exponentially from 
Fog Min Height upwards. If the Fog Type is Sky (or Water/Sky), Fog 
Max Height is the height of the top of the fog layer. This attribute is 
only available when Physical Fog is turned on and Fog Type is not Uniform. 

Fog Decay

Fog Decay controls the rate that the fog thins out at higher altitudes. A 
value of 0.5 makes the fog decay linearly. Values between 0.5 and 1 
makes the fog fairly even near the ground, then drop off suddenly at 
the top. Values between 0 and 0.5 causes the fog to thin out very 
rapidly near its base. This attribute is only available when Physical Fog is 
turned on and Fog Type is not Uniform.

Fog Light Scatter

Controls how evenly light is scattered in the fog. A value of 1 
uniformly scatters the light spread throughout the fog. Lower values 
make the fog brighter near the position of the sun. 

Air

Depending on the Fog Type you select, Air attributes are either available 
or disabled. The following table lists the Air attributes available for the 
Fog Type.

Air Color

Controls the color of light scattered by the air. When light passes 
through air or fog, some frequencies (colors) pass directly through, 
while other frequencies are scattered. The scattered frequencies give 
the sky, for example, its distinctive color. 

Air Opacity

Controls the light frequencies (colors) absorbed as they pass through 
the air. This affects the way objects in the background appear to be 
tinted by the air. For example, objects on the horizon often appear 
bluish to the naked eye. 

Air Density

Controls the optical density of air in the fog simulation. Increase this 
value to make the air seem denser. 

Air Min Height

Controls the height of the bottom of the air layer. This attribute is only 
available when Physical Fog is turned on and Fog Type is not Uniform.
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Air Max Height

Controls the height of the air layer. If the Fog Type is Atmospheric (or 
Water/Atmos), the air density decreases exponentially from Air Min 
Height upwards. If the Fog Type is Sky (or Water/Sky), Air Max 
Height is the height of the top of the air layer. This attribute is only 
available when Physical Fog is turned on, and Fog Type is not Uniform. 

Air Decay

Controls the rate at which the air thins out at higher altitudes. A value 
of 0.5 makes the air decay linearly. Values between 0.5 and 1 makes 
the air fairly even near the ground, then drop off suddenly at the top. 
Values between 0 and 0.5 cause the air to thin out rapidly near the 
ground. This attribute is only available when Physical Fog is turned on and 
Fog Type is not Uniform.

Air Light Scatter

Controls how evenly the light is scattered in the air. A value of 1 
means that the light is uniformly scattered, and appear s to spread 
throughout the air. Lower values cause the atmosphere to appear 
brighter around the sun position. This attribute is only available when 
Physical Fog is turned on. 

Water

These attributes become available if the Fog Type is either Water, Water/
Fog, Water/Atmos, or Water/Sky.

Water Color

Controls the color of light scattered by the water. When light passes 
through air or water, frequencies (colors) pass directly through, while 
other frequencies are scattered. The scattered frequencies give the 
water its distinctive color. This attribute is only available when Physical 
Fog is turned on and Fog Type is set to one of the Water types. 

Water Opacity

Controls the light frequencies (colors) absorbed as they pass through 
the water. This affects the way objects in the background appear to be 
tinted by the water. This attribute is only available when Physical Fog is 
turned on and Fog Type is set to one of the Water types. 

Water Density

Controls the optical density of water in the fog simulation. Increase 
this value to make the underwater fog seem more dense. This attribute 
is only available when Physical Fog is turned on and Fog Type is set to one of 
the Water types. 
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Water Level

Value represents the water level. This attribute is only available when 
Physical Fog is turned on and Fog Type is set to one of the Water types. 

Water Depth

Value represents the water depth. This attribute is only available when 
Physical Fog is turned on and Fog Type is set to one of the Water types. 

Water Light Decay

Controls the rate illumination drops off with depth. Set this to 0 if you 
don’t want the light to decay (that is, you don’t want it to get darker 
as it gets deeper). A value of 1.0 results in a linear decay, and higher 
values darken faster. This attribute is only available when Physical Fog is 
turned on and Fog Type is set to one of the Water types. 

Water Light Scatter

Controls how evenly the light is scattered in the water. A value of 1 
uniformly scatters the light and it appears to spread throughout the 
water. Lower values cause the water to appear brighter near the 
surface from where the light is coming. This attribute is only available 
when Physical Fog is turned on and Fog Type is set to one of the Water 
types. 

Sun

Sun Intensity controls the overall brightness of the sunlight illuminating 
fog. Only available when Physical Fog is turned on, and the Fog Type is not 
Uniform. 

Sun Color

Controls the color of the sunlight illuminating the fog.

Sun Azimuth

Controls the position (angle) of the sun along an imaginary circle that 
goes around the Fog Axis.

Sun Elevation

Controls the position (angle) of the sun along a line from the horizon 
to directly overhead. A value of 90 puts the sun directly above 
(actually, directly in the position pointed to by the Fog Axis) and a 
value of 0 puts the sun at the horizon.
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Clipping Planes

Distance Clip Planes

If set to Fog Near/Far, environment fog exists between the Fog Near 
Distance and the Fog Far Distance. If set to Camera Near/Far, 
environment fog exists between the camera’s near and far clipping 
planes. The default setting is Fog Near/Far.

Fog Near Distance, Fog Far Distance

The minimum and maximum distance (measured in the scene’s linear 
working unit) from the camera where environment fog exists when 
Distance Clip Planes is set to Fog Near/Far.

If Fog Far Distance is less than Fog Near Distance, environment fog 
extends from the Fog Near Distance to infinity. The slider range is 0 to 
200. The default value is 0 for Fog Near Distance and 200 for Fog Far 
Distance.

Volume Fog

Find this material in the Create bar.

Apply this material to volumetric primitives to create effects such as 
spherical, conical, or cubicle smoke, fog, or dust. For more information on 
strategies, see ”Create > Volume primitives” on page 324.

Color 

Assign a color or map a texture to the volume. To use the color ramp, 
see ”Ramp” on page 207. 

Transparency

Represents the amount of the volume’s Transparency.

Incandescence 

To make a material appear as if it were emitting light, such as lava or 
a phosphorescent moss. A slight touch of incandescence on vegetable 
matter, for example, can make the vegetation look alive. The color is 
black by default, which has no effect on the surface.

Note: Although a surface appears to glow when you apply 
Incandescence, it does not act as a source of light in the 
scene. See also Glow Intensity.
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Glow Intensity 

As you increase this value, the material seems to glow and is 
surrounded by a faint halo of light. Glow Intensity is different from 
Incandescence in two ways: 

• Glow adds a halo to the surface.

• Maya adds the glow effect at the end of rendering as a post-
process; Incandescence just makes the surface appear brighter.

Density 

Represents the density or transparency of the fog.

Density Mode 

Determines if the density is defined in world space or object space. 
Object space density preserves the look when an object is scaled.

Illuminated 

If on, lights are computed for the fog. The lighting for each volume 
span is determined by the volume sample’s attribute on the geometry.

Light Scatter

The amount the fog scatters light in all directions. As it approaches 
zero, the fog tends to scatter light directionally, which results in halos 
around light sources.

Dropoff

Dropoff Shape

Select either the Cone, Sphere, Cube, or Light Cone as a shape used to 
define an outer boundary to create a soft-edged volume. For example, 
if rendering a box volume, Cube should match the edges of the 
volume.

Edge Dropoff

Defines how suddenly the density falls off near the edges defined by 
the Dropoff Shape. A value of 0.0 results in a hard edge with no 
dropoff. A value of 1.0 results in smooth density fade from the edge to 
the center of the volume.

Note: Light Cone is different from Cone—the dropoff (or fade) 
occurs near the point of the cone.
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Axial Dropoff

Defines the density dropoff down the center axis of a cone. Higher 
values make the fog less dense further from the peak of the cone. 
(Only works with Cone shapes). 

Dropoff Method 

Scale Opacity Multiplies the overall density by the fade value, 
causing a uniform change in transparency.

Subtract Density Subtracts the fade value multiplied by the Dropoff 
Subtract value from the density. Useful when 
density or transparency is textured. Low density 
regions become completely transparent, while high 
density regions are not very affected. This can help 
preserve the character of a fluffy cloud, for example.

Dropoff Subtract

The maximum amount of density subtracted from the volume when 
Dropoff Method is Subtract Density. If the volume density is 1.0 and 
Dropoff Subtract is 1.0, the edge of the volume is completely 
transparent.

Light Fog

Simulates particles in the air (for example, fog, smoke, dust) illuminated 
by a particular light. You can add light fog to spot lights or point lights. 
Light Fog can cast depth map shadows. Environment Fog cannot.

Find this material in the Create bar.

Color

The color of illuminated fog. (The light’s Color also influences the 
color of illuminated fog.) The default color is white.

Density

The density of illuminated fog. The higher the density, the more 
obscured the objects within or behind the fog. (The density also 
influences the brightness of illuminated fog.) Color Based 
Transparency and Fast Drop Off also influence how objects are 
obscured by illuminated fog. The slider range is 0 to 1. The default 
value is 1.

Color Based Transparency

If on, the amount that objects within or behind the fog are obscured is 
based on the Density value and the Color value. Objects obscured by 
the fog are fully shaded, not just flat-shaded silhouettes. If the fog 
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Color is dark (for example, black), turn off Color Based Transparency 
(otherwise the fog is not visible). Color Based Transparency is on by 
default.

Fast Drop Off

If off, all objects within or behind the fog are obscured by the same 
amount, based on the Density value. If on, each object within or 
behind the fog is obscured by a different amount, based on the 
Density value and the object’s distance from the camera (that is, the 
amount of fog between the camera and the object). Fast Drop Off is off 
by default.

An object (or part of an object) which has more fog between it and the 
camera appears more obscured than an object (or part of an object) 
which has less fog between it and the camera. This is the way real-
world fog behaves. 

Particle Cloud

Used to achieve effects such as gas or clouds. You can software render 
particles as thin gas, cloud, thick cloud, blobby surface or tube. 

Volume material which can be connected to the volume port of a shading 
group. The initialParticleSE is a shading group that has a lambert material 
connected to its Surface port, and a particle cloud material connected to its 
Volume port. You can connect the particle cloud shading group to a 
particle emitter to achieve effects such as gas or clouds. You can software 
render particles as thin gas, cloud, thick cloud, blobby surface or tube. 

Color, Transparency, and Incandescence can be set to a fixed value, or 
texture mapped over the particles’ lifetime. If mapped, the V values of the 
map are mapped onto the particles’ lifetime.

Find this material in the Create bar.

Color

The basic color of the particle cloud. The default color is a green-blue. 

Tip: If Fast Drop Off is on, objects within the fog that are further 
from the camera may be obscured too much, so you may 
want to reduce the Density value.
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Transparency

Controls how much you can see through the particle cloud. It is a 
color, so that you can control the transparency of the red, green, and 
blue channels separately. To make the cloud more opaque, set 
transparency to be darker. To make the cloud more transparent, set 
transparency to be brighter.

Incandescence

Use Incandescence to make the particle cloud brighter, as though it 
were a light source. By default, Incandescence is black, meaning no 
glow is added. 

Life Color

Determines the color at a particular time in the life of the particle. You 
can use the Particle Sampler Info node to animate this attribute over a 
particle’s lifetime.

Life Transparency

Determines the transparency at a particular time in the life of the 
particle.You can use the Particle Sampler Info node to animate this 
attribute over a particle’s lifetime.

Life Incandescence

Determines the incandescence at a particular time in the life of the 
particle.You can use the Particle Sampler Info node to animate this 
attribute over a particle’s lifetime.

Note: When Incandescence is turned on, although the particle 
cloud glows, it does not cast light on other objects in the 
scene. 

Note: Life Color, Life Transparency, and Life Incandescence are 
driven by the particle age (the texture defines color, 
transparency, and incandescence, all of which get their UV 
information from the Particle Age Mapper utility node). The 
Particle Age Mapper utility node is created automatically at 
the time the texture is created.
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Glow Intensity

Controls how much of a halo-like glow effect is added to the particle 
cloud. This glow effect is added as a post-process, after the rendering 
is completed. Glow Intensity is zero by default, meaning that no glow 
is added. 

Transparency

Density

Similar to transparency; it controls how dense the cloud of particles 
appears to be, and therefore how much of the background can be seen 
through it. Increase this value to make the cloud more dense.

Blob Map

Specifies a scaling factor applied to the transparency of the particle 
cloud. You can connect a 3d texture to it in order to give some internal 
texture or shape to the cloud beyond what it gets from the particles. 

Roundness

Controls the noise’s irregularity. The smaller the value, the less 
rounded the shape. 

Translucence

Specifies a scaling factor for density that is used only to compute 
shadows. The larger the translucence value, the more light penetrates. 
The formula is:

density * (1 - translucence)

Built-in Noise

Noise

Controls the jitteriness within the particle cloud. If it is set to zero, the 
cloud looks very smooth and uniform throughout. As the amount of 
noise increases, the cloud appears noisier, like static on a television 
screen. Noise is set to 0.75, by default.

Noise Freq

Determines the size of the noise artifacts when Noise is turned on. 
Higher values of Noise Frequency produce smaller, finer artifacts, and 
lower values produce larger, coarser artifacts. If Noise Frequency is 
set to zero, that is the same as turning Noise off. 
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Noise Aspect

Controls the distribution of the noise (when Noise is turned on). It is 
zero by default, meaning the noise is equally distributed in X and Y. 
Positive values make the noise run perpendicular to the particle’s 
path. Negative values make the noise run more parallel to the path. 

Noise Anim Rate

Specifies a scaling factor that controls the rate of built-in noise changes 
during an animation. 

Solid Core Size

Determines the size of the core, which is the area where the particle is 
opaque. 

Surface Shading Properties

Diffuse Coeff

Controls how much of the light in the scene is reflected from the 
particles. Most materials absorb some of the light falling on them, and 
scatter the rest.

The default value is 0.0. If you set this to 1.0, all the light falling on the 
material is reflected. Use a high value when creating dense clouds. If 
you set this to 0.0 (the minimum), no light is reflected and no surface 
shading occurs. 

The surface color is modulated by the transparency. This value can be 
greater than 1.0, so the surface property can still appear even when 
the material is transparent. 

Surface Color

Specifies the basic color of the particle cloud surface (as opposed to 
the inside of the cloud). Diffuse Coeff must be set to a value greater 
than 0 to enable this option.

Bump Mapping

Makes the surface appear rough or bumpy by altering surface normals 
(during rendering) according to the intensity of the pixels in the bump 
map texture. Diffuse Coeff must be set to a value greater than 0 to 
enable this option. (A bump map does not actually alter the surface. A 
silhouette of the surface appears smooth).

Translucence Coeff

Simulates the way light diffusely penetrates through translucent 
objects. This means that when light shines on one side of the object, 
the other side is partially illuminated. You can use this to create effects 
such as clouds, fur, hair, marble, jade, wax, paper, leaves, and so on. If 
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you set Translucence Coeff to 0 (the default), no light shows through 
the object. If you set Translucence Coeff to 1, all the light shows 
through. Diffuse Coeff must be set to a value greater than 0 to enable 
this option.

Surface Shading Shadow

Determines if the surface shading is combined with the pre-
illumination, which contains shadows, if enabled (see the Filter 
Radius attribute description next). Diffuse Coeff must be set to a value 
greater than 0 to enable this option.

Pre-illumination Controls

Filter Radius

Volumetric particles use pre-illumination, which evaluates the 
lighting at each particle’s center by default. This can sometimes cause 
popping if the illumination changes too fast in an animation, and is 
especially noticeable if Surface Shading Shadow is on.

Filter radius lets you filter the pre-illumination results so the value at 
each particle’s center is the average of all the pre-illumination results 
within the filter radius. Higher values increase render time but 
produce smoother images.

Volume Shader

Controls the color, transparency, and matte opacity of a volumetric 
material, such as light fog. This shader lets you connect other attributes 
and effects directly to its color, transparency, and matte opacity. The 
Volume Shader can be used with a Spot Light, Point Light, Environment 
Fog, and particles. 

Find this material in the Create bar.

Out Color

Defines the out color of the material. The default is black.

Out Transparency

Sets the out Transparency of the material. The default is black, which 
is opaque.

Fluid Shape

Find this material in the Create bar.

For information on Fluid Shape, see ”Fluid Shape shader as a particle shader” 
on page 165 in the Fluid Effects guide. 
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Common Volumetric material attributes

The following attributes are common to the Environment Fog and Light 
fog Volumetric materials:

Matte Opacity

You can control the mask value for individual objects. See Matte Opacity.

Matt Opacity attributes are available for Anisotropic, Blinn, Lambert, 
Layered Shader, Phong, PhongE, Shading Map and Use Background 
material types.

Matte Opacity Mode

Click to display the three Matte Opacity Modes from the drop-down list.

Opacity Gain 

Default Matte Opacity Mode. The Opacity Gain value is used as a gain 
control on the usual matte value contribution of a material.

A matte channel is first calculated this way— a value of 1.0 for an 
opaque surface completely covers a pixel, less if it covers part of a 
pixel. The value is reduced appropriately for transparent objects, and 
then multiplied by the specified Matte Opacity value. 

The Matte Opacity Mode value is also keyable. The Opacity Gain 
range is from completely transparent to no effect (rendered as usual). 

Solid Matte 

Makes the value of the matte channel constant for all pixels covered 
by these surfaces. The value you specify in the Matte Opacity slider is 
used.

Black Hole

The matte channel for all pixels covered by the object is set to 0 (fully 
transparent), even if the object is transparent, and regardless of what 
is behind the object if it is transparent. This creates a black hole where 
the object is in the image, to knock out the matte. In this mode, the 
Matte Opacity slider is disabled and its value ignored. 

Note: For the Opacity Gain and Solid Matte modes, if an object 
has non-zero Transparency, objects behind it makes their 
usual contribution to the matte channel’s values. This is the 
difference between setting Matte Opacity to 0.0 in these 
modes, and choosing the Black Hole mode. 
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Matte Opacity

This value behaves in different ways based on which Matte Opacity Mode 
is selected (Opacity Gain or Solid Matte).

For example, for the Opacity Gain mode, the Matte Opacity slider value 
indicates the transparent multiplier amount for the alpha channel. The 
default is 1, which means that any opaque object registers a full alpha 
value. 

If the Matte Opacity value is 1, a 0 alpha value is registered. Any values 
between 0 and 1 act as a multiplier to the alpha channel value to arrive at 
a new alpha value.

Shading group node

Shading group node

For more information on Maya’s shading group node, see ”Shading group 
node” on page 21.

Shading Group attributes

In the Shading Group’s Attribute Editor, the mental ray section contains 
the following options:

Flags

These are the the options in the Flags section.

Opaque

Turn this on if the material is fully opaque. It should assist in 
speeding up mental ray rendering.

Contours

These are the the options in the Contours section. Each shading group can 
have individual contour rendering attributes defined. Set the following 
options to achieve the desired look. See also ”Contours” on page 207 in the 
Rendering guide.

Enable Contour Shading

Enables contour shading for all objects associated with the shading 
group. 

Color

The color of the contour lines. This attribute can only be a color and 
cannot have a procedural or texture map connected to it.
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Alpha

The alpha of the contour lines. 

Width

The width of the contour lines. 

Relative Width

If off, Width is specified as (fractional) number of pixels. If on, Width is 
specified in percents of the horizontal image resolution thus 
maintaining the relative contour size if the resolution changes. 

Custom Shaders

These are the the options in the Custom Shaders section.

Suppress all Maya Shaders

Use this for backwards compatibility as it disables automatic 
translation of Maya shaders. Only the mental ray ports are evaluated 
and exported.

Export with Shading Engine/Export with Volume Sampler

When turned on, these both insert additional helper shaders into the 
export stream. These shaders are required if you want to write custom 
shaders that cooperate with the Maya base shader package delivered 
with mental ray for Maya. These options are for advanced mental ray 
for Maya users only.
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Texture nodes

Overview of texture nodes

The Texture tab in the Create Bar and the Create Render Node window 
includes 2D textures, 3D textures, Env(ironment) textures, and Other 
textures (Layered Texture). For information about 2D textures, see ”2D 
textures” on page 28. For information about 3D textures, see ”3D textures” 
on page 28.

Some attributes are shared among many surface materials, are therefore 
grouped separately, and are described in:

• ”Shared 2D texture attributes” on page 214. 

• ”Shared 3D texture attributes” on page 233. 

For texture-specific attributes, see the 2D or 3D texture name.

2D textures

2D Textures 3D Textures

Environment 
Textures

and 

Other 
Textures
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Bulge

Procedurally creates a grid of white squares that fade to gray toward the 
edges. Use as a bump or displacement map to create surface bulges, as a 
transparency map or specular map to simulate real-world objects, such as 
windows that are dirty around the edges, or as a color map to simulate 
tiles.

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Uwidth, Vwidth

The width of the texture squares in U and V directions. The range is 0 
to 1. The default value is 0.1.

Checker

Represents a checkerboard pattern. 

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Color1, Color2

The two colors of the checkerboard squares.

Contrast

Contrast between the two texture colors. The range is 0 (the two colors 
are averaged over the entire texture) to 1. The default value is 1.

Cloth

Simulates fabric or other woven materials.

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.
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Gap Color

The color of the area between the warp (U direction) and weft (V 
direction) threads. The colors blend into the Gap Color at their edges. 
A lighter Gap Color simulates a cloth with softer, more translucent 
threads.

U Color, V Color

U and V thread colors. Double-click the color bar to open the Color 
Chooser and select colors.

U Width, V Width

U and V thread widths. If the thread width is 1, the threads touch 
with no gap between them. If the thread width is 0, the thread 
disappears. The range is 0 to 1. The default value is 0.75.

U Wave, V Wave

The waviness of U and V threads. Use to create special weave effects. 
The range is 0 to 0.5. The default value is 0.

Randomness

Smears the texture randomly in U and V directions. Adjust the 
Randomness value to create natural-looking cloth with irregular 
threads, or to prevent aliasing and moiré patterns on very fine cloth 
textures. The valid range is 0 to infinity. The range is 0 to 1. The 
default value is 0.

Tips: • Rendering is faster if the randomizing attributes 
(Randomness, Width Spread, and Bright Spread) are set 
to 0.

• Very fine cloth textures may produce aliasing or moiré 
patterns, especially when viewed from a distance. If this 
occurs, set the Randomness value to a small non-zero 
value.

• If you apply the cloth texture as a bump or 
displacement, set the U Color and V Color to white, the 
Gap Color to black, and use the Color Balance attributes 
(Alpha Gain and Alpha Offset) to control the intensity of 
the bump/displacement effect. 

• Decrease the bump node’s Bump Filter value to provide 
greater definition in the bump/displacement effect. 
Generally, the Alpha Gain and Bump Filter values 
should be very low (less than 0.1).
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Width Spread

Randomizes the width of each thread along its length by subtracting a 
random amount (between 0 and the Width Spread value) from the U 
Width and V Width values. For example, if Width Spread is greater 
than or equal to the Width value, some threads disappear at certain 
points along their length. The range is 0 to 1. The default value is 0.

Bright Spread

Randomizes the brightness of each thread along its length by 
subtracting a random amount (between 0 and the Bright Spread 
value) from U Color and V Color (similar to Width Spread). The range 
is 0 to 1. The default value is 0.

File

Lets you use an image file as a 2D texture. 

To learn more about File textures and how to create them, see ”File 
textures” on page 29.

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Filter Type

The sampling technique applied to the image file during rendering. 
The Quadratic, Quartic, and Gaussian filters only work when the File 
texture is mapped directly to a shading group. The default setting is 
Quadratic.

If off, there is no filtering. For games design, this can be useful to view 
a texture’s pixels without interpolation by the renderer.

Quadratic, 

Quartic, 

Gaussian Types of bell curves, in which the extreme values 
get less weight than values toward the center of the 
curve. 

Tips: • The quadratic filter type provides the best quality to cost 
ratio. With the default settings, this filtering scheme 
provides crisper details than mipmap, at a reasonable 
cost.

• IFF image file format is optimal for performance.
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Extreme means points in the texture near the far 
edge of the filter’s sample region.

Center of the curve means the center of the region 
being filtered. 

Quadratic and Quartic approximate the Gaussian 
filter type, but are optimized for speed. Since this 
method can decrease rendering speed, use mostly 
for high-quality rendering. Quadratic is the most 
efficient filter type. 

Mipmap filter

Mipmap stores values starting with values averaged 
at a large texture map size, and linearly decreasing 
map sizes down to a single pixel value. 

Use this filter for previewing—it’s fast and provides 
moderately good results. Do not use for high quality 
renders, however. Textures may swim or appear 
blurry. 

Mipmap is inexpensive to use. Maya uses it as a 
technique to store color values by default. The 
performance cost associated with using the Mipmap 
filter type is negligible compared to using other 
filter types.

Box filter

Uses a simple box sampling method for the texture 
map. Each sample of the map is given the same 
shading sample weight. The Box filter uses the sum 
of the values sampled divided by the number of 
samples taken.

Pre-Filter

The Pre-Filter and Pre-Filter Radius attributes are used to correct file 
textures that are aliased or contain noise in unwanted areas. This can 
be very useful when displacement mapping.

When on, the image file is pre-filtered to cancel out noise and aliasing 
which helps provide better quality results, particularly for bump 
maps. Pre-Filter is off by default. Turn it on to enable the Pre-Filter 
Radius attribute. 

Pre-Filter Radius

Determines the size of the filtering radius. The default value of 2.0 
works for most images, but you can increase the radius to provide 
even smoother results.
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Image Name

The name of the image file or movie file used by the File texture. 

For tips on creating images for File textures, see ”Considerations for 
creating file textures” on page 29.

To use a sequence of image files to create an animation, the file name 
must be expressed in one of the following three formats:

name.#.ext

name.ext.#

name.#

where name is the base name of the file; # is the frame number (with or 
without leading 0s), ext is the file extension of the file. 

To use a sequence of image files to create an animated file texture, the 
file extensions must be separated from the basename and, or the 
extension by periods.

For example, the following works:

test.1.iff

test.0001.iff

test.1

test.0001

test.iff.1

test.iff.0001

But the following would not work:

test1

test0001

test1.iff

After Pre-filterBefore Pre-filter
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test0001.iff

Reload File Texture

Use this to force a refresh (read from disk to temporary memory) of 
the texture. This is recommended in situations where textures being 
used are updated by other artists.

Use Cache

When off, Maya loads the entire image file into memory during 
rendering. When on, Maya only loads 8x8 tiles of the image file into 
memory when needed, and unloads them from memory when they 
are no longer needed (provided that the image is block ordered 
textured [BOT]. This reduces the amount of memory for image file 
textures, and can reduce render times.

If Use Cache is on and the image file is not a BOT file, Maya creates a 
temporary BOT file for the image file during rendering. This can make 
rendering slower and can increase the amount of disk space used 
during rendering. However, it uses less memory during the rendering 
process. Because of this, converting all image file textures to BOT files 
before rendering using the Optimize Scene command can be helpful. 

Use Frame Extension

Appends the frame extension number (Frame Extension) to the Image 
file name. To use a sequence of image files as an animated texture 
when rendering, turn on Use Frame Extension, then keyframe the 
Frame Extension value. Use Frame Extension is off by default.

Frame Extension

The frame extension number appended to the Image file name. To use 
a sequence of image files to create an animation, turn on Use Frame 
Extension, then keyframe the Frame Extension value. If Use Frame 
Extension is off, Frame Extension is not available.

Interactive Sequence Caching Options 

Use Interactive Sequence Caching

Interactive Sequence Caching is used for caching file textures when 
animating textures to play the animation at regular speed.

When Use Interactive Sequence Caching is on, the file textures you 
specify within the range of the Sequence Start, Sequence End, and 
Sequence Increment are loaded into memory only once. This provides 
faster interactive animation of the file textures.

Turn Use Interactive Sequence Caching on to get better performance 
when: 
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• using a sequence of frames for the file textures (see also “Use 
Frame Extension” above.)

• using Hardware texturing in the 3d view 

• you need to scrub along the time line (move the time slider back 
and forth) and see the animated texture update. 

Use the following attributes to indicate which frames you want to 
load. If you don’t load them all, Maya uses the closest available frame 
at playback.

Sequence Start 

The number of the first frame Maya loads into memory when Use 
Interactive Sequence Caching is on. 

Sequence End

The number of the last frame Maya loads into memory when Use 
Interactive Sequence Caching is on.

Sequence Increment

Controls how many frames are skipped (if any) Maya loads into 
memory when Use Interactive Sequence Caching is on. If 1, Maya 
loads every frame between Sequence Start and Sequence End. If 2, 
Maya loads every second frame, and so on.

Fluid Texture 2D

Find this texture in the Create bar. To use this texture, see ”Apply a fluid 
texture to an object” on page 166 in the Fluid Effects guide.

Fractal

Represents a random function with a particular frequency distribution (a 
fractal). You can use the Fractal texture as a bump or displacement map to 
simulate rock or mountains, or as a transparency map to simulate clouds 
or flames. The Fractal texture has the same level of detail at any level of 
magnification (that is, at different distances from the camera).

Note: These attributes do not alter the final rendered image.
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Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Amplitude

A scaling factor applied to all values in the texture. The valid range is 
0 to infinity. The range is 0 to 1. The default value is 1.

Threshold

An offset factor applied to all values in the texture. The valid range is 
0 to infinity. The range is 0 to 1. The default value is 0.

Ratio

Controls the frequency of the fractal pattern. The range is 0 (low 
frequency) to 1 (high frequency). The default value is 0.707.

Frequency Ratio

Determines the relative spacial scale of the noise frequencies. If this 
ratio is not a whole integer then the fractal does not repeat at the 
integer uv boundaries. A cylinder with default placement would then 
display a seam.

Level Min, Level Max

The minimum and maximum number of iterations used to calculate 
the fractal pattern. These values control the granularity of the fractal 
pattern. The valid range is 0 to 100. The range is 0 to 25. The default 
value is 0 for Level Min and 9 for Level Max. 

Inflection

This applies a kink in the noise function. This is useful for creating 
puffy or bumpy effects. 

Animated

Animate the fractal pattern by setting Animated on and keyframing 
the Time value. The Fractal texture takes longer to calculate when 
Animated is on. Animated is off by default.

Time

Change the Time value to adjust an animated fractal pattern. If 
Animated is off, the Time attribute is unavailable. The range is 0 to 
100. The default is 0.

Time Ratio

Determines the relative time scale of the noise frequencies. If this ratio 
is not a whole integer then the animation does not repeat when time = 
1. The default is equal to the frequency ratio, which means that higher 
frequency noises move faster in direct proportion to the frequency. 
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Many natural effects, such as water waves, move instead relative to 
the square root of the frequency, therefore it may create better motion 
to make the timeRatio = sqrt(frequencyRatio). For example, if the 
frequencyRatio is 2, make the timeRatio = 1.4.

Grid

Represents a scalar grid pattern.

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Line Color

Color of the grid lines. The default color is white.

Filler Color

Color of the spaces between the grid lines. The default color is black.

U Width, V Width

Width of the grid lines in U and V directions. The valid range is 0 to 1. 
The range is 0 to 0.5. The default value is 0.1.

Contrast

Contrast between the Line Color and the Filler Color. The range is 0 
(the two colors are averaged over the entire texture) to 1. The default 
value is 1.

Mountain

Find this texture in the Create bar.

Simulates rocky terrain using a 2D fractal pattern. To apply this texture as 
a texture map, see ”Map and position textures” on page 84.

Use the Mountain texture as both a color map and a bump or 
displacement map (on a flat surface) to simulate snow-capped mountains. 
To do so, apply the Mountain texture this way:

• The texture calculates the color map based on the bump/displacement 
map, so, for example, the location of snow is based on the surface’s 
displacement.
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• The color attributes (Snow Color and Rock Color) relate only to the 
color map and have no effect on the bump/displacement map—and 
all non-color attributes relate only to the bump/displacement map 
and have no effect on the color map.

• The Boundary, Snow Altitude, Snow Dropoff, Snow Slope, and Depth 
Max attribute values of the bump/displacement map override those 
of the color map. For example, the Boundary value of the bump/
displacement map controls the raggedness of the snow/rock 
boundary of the color map.

Snow Color, Rock Color

Color of the snow and rock. Click the color file to choose a different 
color from the Color Chooser.

Amplitude

Scaling factor applied to all values in the texture. The valid range is 0 
to infinity. The range is 0 to 1. The default is 1.

Snow Roughness

Roughness of the snow. The range is 0 (very smooth snow) to 1 (very 
rough snow). The default is 0.4.

Rock Roughness

Roughness of the rock. The range is 0 (very smooth rock) to 1 (very 
rough rock). The default is 0.707.

Boundary

Raggedness of the rock/snow boundary. The range is 0 (very smooth 
rock/snow boundary) to 1 (very rough rock/snow boundary). The 
default is 1.

Snow Altitude

The level (altitude) of the transition between rock and snow. The valid 
range is 0 to infinity. The range is 0 to 1. The default is 0.5.

Snow Dropoff

The suddenness with which snow no longer sticks to the mountain. 
The valid range is 0 to infinity. The default is 2.

Snow Slope

The maximum angle (expressed as a decimal value) over which snow 
does not stick to the mountain. For example, where the slope exceeds 
the Snow Slope value, it would be bare rock. The valid range is 0 to 
infinity. The range is 0 to 3. The default is 0.8.
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Depth Max

The maximum number of iterations used to calculate the fractal 
pattern, which controls the granularity of the fractal pattern. The 
range is 0 to 40. The default is 20.

Movie

The movie texture assumes the following:

• an entire multiple frame sequence is stored in a single multiple frame 
file (a movie file) instead of a sequence of individual image files. 

• is optimized for reading and displaying those frames interactively as 
quickly as possible.

The Movie texture shares the same attributes as the File texture. The 
difference is that the Movie texture assumes all frames are stored in a 
single concatenated file using the assigned Image Name instead of 
separate files. 

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Noise

Can be used to create many different types of effects. 

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Threshold

The number added to the whole fractal effect, making it uniformly 
brighter. If some parts of the fractal are pushed up out of range 
(greater than 1.0), they are clipped to 1.0. If the Volume Noise is used 
as a bump map, it appears as plateau regions.

Note: The first time you access a frame from an MPEG file, it may 
be slow to load. The movie library has to scan to the end of 
an MPEG file to see how many frames are in it since this 
information is not available in the movie header.
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Amplitude

Scaling factor applied to all the values in the texture, centered around 
the texture's average value. 

• When you increase Amplitude, the light areas get lighter and the 
dark areas get darker. 

• If Noise is used as a bump map, increasing Amplitude results in 
higher bumps and deeper valleys.

• If set to a value greater than 1.0, the parts of the texture that scale 
out of range are clipped. On a bump map, they display as plateau 
regions.

Ratio

Controls the fractal noise frequency. Increase this value to increase the 
fineness of the fractal detail.

Frequency Ratio 

Determines the relative spacial scale of the noise frequencies. If not a 
whole number, the fractal does not repeat at the UV boundaries. For 
instance, a cylinder with default placement displays a seam.

Depth Max 

Controls how much calculation is done by the Noise texture. Since the 
Fractal texture process produces a more detailed fractal, it takes 
longer to perform. By default, the texture chooses an appropriate level 
for the volume being rendered. Use Depth Max to control the 
maximum amount of calculation for the texture.

Inflection 

Applies a kink in the noise function. Useful for creating puffy or 
bumpy effects.

Time 

Used to animate the Noise texture. You can keyframe the Time 
attribute to control the rate and amount of change of the texture.

Frequency

Determines the fundamental frequency for the noise. As this value 
increases the noise becomes more detailed. It has the inverse effect of 
the scale parameter.
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Implode 

This warps the noise function in a concentric fashion about a point 
defined by the Implode Center. At a value of zero there is no effect, 
while at a value of 1.0 it is a spherical projection of the noise function, 
creating a starburst effect. Negative values can be used to skew the 
noise outward instead of inward.

Implode Center

This defines the center UV point about which the implode effect is 
defined.

Noise Type

Determines which noise to use during the fractal iteration. 

Perlin Noise The standard 3D noise used in the solidFractal 
texture. Billow has a puffy, cloud-like effect. 

Wave A sum of 3D waves in space. 

Wispy A Perlin noise that is uses a second noise as a smear 
map; this makes the noise stretch out in places, 
looking wispy. When the time value is animated the 
smear texture is moved causing an undulating 
effect. It creates an effect similar to thin clouds being 
blown by wind. 

SpaceTime A 4-dimensional version of the Perlin noise, where 
time is the 4th dimension.

Density

Controls how many cells are imbedded in the medium used by the 
Billow noise type.

At 1.0, the medium is completely packed with cells. Reduce this value 
to make the cells sparser. If the texture is used as a bump map, low 
values for Density results in smooth looking surfaces with occasional 
bumps.

Spottyness

Controls the density randomization of individual cells used by the 
Billow noise type.

When set close to 0, all the cells are the same density. As you increase 
Spottyness, some cells are randomly denser or thinner than others.
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Size Rand

Controls the randomization of the size of the individual blobs used by 
the Billow noise type. When it is close to 0, all the cells are the same 
size. As you increase Size Rand, some cells are smaller than others, in 
a random fashion.

Randomness

Controls how the cells for the Billow noise type are arranged relative 
to one another. Set to 1.0 for a more natural random distribution of 
cells.

If set to 0, all the spots are laid out in a regular pattern. This can 
provide interesting effects when used as a bump map—for instance, 
you can make things like insect eyes, or machine-tooled raspy 
surfaces.

Falloff

Controls the way intensity falls off for individual blobs for the Billow 
noise type. 

Linear A uniform falloff from the center to a value of zero 
at the edges of the blobs. 

Smooth More natural looking, using a gaussian falloff. Fast 
focuses the intensity more towards the center of the 
blobs. 

Bubble Uses a reverse falloff, fading to zero at the blob 
center.

Num Waves

Determines how many waves to generate for the Wave noise type. 
The larger the number, the more random-looking and slower the 
texture.

Ocean

Find this texture in the Create bar. For information about Ocean, see 
”Ocean shader and texture” on page 165 in the Fluid Effects guide.

Ramp

Creates a gradation through a series of colors. The default Ramp texture is 
blue/green/red. Use this texture: 
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• to create different types of effects, such as stripes, geometric patterns, 
or mottled surfaces 

• as a 2D background

• as the source file for an environmental sphere texture to simulate a 
sky and horizon

• as the source file for a projection texture to simulate wood grain, 
marble, or rock

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Type

The direction of the color ramp. The default is V Ramp. The following 
shows what happens when you select the Circular Type and adjust 
the colors of the Ramp swatch in the Attribute Editor (see also 
“Ramp” next).

Interpolation

Controls the way colors blend in the ramp. The default setting is 
Linear. In the above example, because the surface is spherical, a 
Smooth Interpolation type works well.

Ramp

Each color component in the ramp has a circular color handle on the 
left side, and a square color icon on the right side. The active color has 
a white border around its color handle and icon.

Note: Very complex ramp textures may experience aliasing 
during an animation. If this occurs, convert the ramp 
texture into an image file (see ”Convert a texture or shading 
network to a File Texture” on page 91 for details).

Ramp in 
Attribute Editor

Swatch in Hypershade

Object in view
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Selected Color

The active color component. This attribute applies to the active color 
only.

Selected Position

Position of the active color component in the ramp. This attribute 
applies to the active color only. The range is 0 (bottom of ramp) to 1 
(top of ramp).

U Wave, V Wave

Controls the amplitude of a sine wave offset of the texture in the U 
and V directions. Increasing the U Wave or V Wave increases the 
display of the texture’s waviness. The range is 0 (no wave) to 1. The 
default is 0.

Noise

Offset amount in the U and V directions by 2D noise. If the texture 
repeats (Repeat UV values are greater than 1), the noise does not 
repeat (each instance of the texture is unique). The range is 0 (no 
noise) to 1. The default is 0.

Note: Only changes in Type, Interpolation, Selected Position, and 
Selected Color are displayed in the ramp. Changes in all 
attributes are displayed in the Hypershade swatch.

Tip: To increase the number of waves in the texture, increase the 
Repeat UV values in the 2D texture placement node.

Click the handle 
to edit the color 
component.

Drag the handle 
to move the 
color 
component.

Click in the ramp to add the 
new color component or 
drag to add and interactively 
position a new color 
component.

Click to delete 
the color 
component
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Reference > Water
Noise Freq

Controls the noise granularity (if the Noise value, above, is non-zero). 
The range is 0 to 1. The default is 0.5.

HSV Color Noise

Randomize a Ramp texture’s color using three separate 2D noises which 
affect the color’s Hue, Saturation, and Value.

Hue Noise

Offsets the color hue. Use to mark the color with specks of different 
colors. The range is 0 to 1. The default is 0.

Sat Noise

Offsets the color saturation (or whiteness). Use to create a weathered 
look. The range is 0 to 1. The default is 0.

Val Noise

Offsets the color value (or blackness). The range is 0 to 1. The default 
is 0.

Hue Noise Freq, Sat Noise Freq, Val Noise Freq

Controls the granularity for hue, saturation, and value noise. The 
range is 0 to 1. The default is 0.5. (For each non-zero Freq value, 
additional calculations may slow down rendering.)

Water

Simulates linear water waves, concentric water ripples (like an object 
falling into water), or a combination of waves and ripples. Use as a bump 
or displacement map to simulate water, or as a color map to simulate light 
reflections or refractions from a water surface. 

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Number Of Waves

The number of linear waves in the texture. The valid range is 0 to 100. 
The slider range is 0 to 32. The default is 8. 
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Reference > Water
Wave Time

Controls the appearance of the waves over time. The range is 0 to 1. 
The default is 0.

The wave effect is similar to the waves produced from a boat—the 
waves start at a point with a certain velocity and amplitude. This is 
time zero. As time increases, the waves travel to shore and the 
appearance changes (velocity and amplitude decrease). To simulate 
moving waves, animate the Wave Time value. The waves move as this 
value increases. Maya determines the wave speed by the Wave 
Velocity value and the rate at which you animate the Wave Time 
value.

Wave Velocity

The wave speed. The valid range is 0 to infinity. The range is 0 to 1. 
The default is 1.

Wave Amplitude

Scales the wave height. The valid range is 0 to infinity. The range is 0 
to 1. The default is 0.05.

Fast

An optimization for the Water texture. When on, Maya computes the 
color tables once per frame. When off, Maya computes the color tables 
for every sample.

Wave Frequency

Controls the distance between primary waves. The higher the value, 
the shorter the distance. The valid range is 0 to infinity. The slider 
range is 0 to 20. The default is 4.

Tips: • For water ripples with no linear waves, set Number Of 
Waves to 0. 

• To combine linear waves with concentric ripples, set 
Number Of Waves to a low number (1 to 3). 

Tip: The only time you might turn this off is when water is 
viewed close-up in the final scene. 
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Reference > Water
Sub Wave Frequency

Controls the distance between secondary waves that ride on top of 
primary waves (for example, white caps). The valid range is 0 to 
infinity. The slider range is 0 to 1. The default is 0.125.

Smoothness

Controls the intensity of secondary waves. The valid range is 0 to 
infinity. The slider range is 0 to 5. The default is 2.

Wind UV

The strength of wind in the U and V directions (which determines the 
overall direction of the linear wave pattern). The range is from -1 to 1. 
The default for U is 1. The default for V is 0.

Concentric Ripple Attributes

Control the appearance of concentric water ripples. The Concentric Ripple 
attributes do not affect the linear wave component of the texture.

Ripple Time

Controls the appearance of ripples over time. The range is 0 to 1. The 
default is 0. 

For example, imagine a water droplet falling into a glass of still 
water—at time 0 there is no ripple since the droplet has not touched 
the surface of the water. As the time attribute increases to a value 
greater than 0, the droplet has fallen onto the water surface and the 
ripple wave effect simulates the effect on the water in the glass at that 
point in time. When time has reached a value of 1, the effect of the 
droplet on the water surface is nearly complete and the water in the 
glass becomes still again.

To simulate moving water ripples, animate the Ripple Time value. 
The ripples move as this value increases. The actual speed of the 
ripples is determined by the Group Velocity value and the rate at 
which you animate the Ripple Time value.

Ripple Frequency

Controls the distance between individual ripples. The higher the 
value, the shorter the distance. The valid range is 0 to infinity. The 
slider range is 0 to 20. The default is 25.

Ripple Amplitude

Scales the height of the ripples. The valid range is 0 to infinity. The 
slider range is 0 to 1. The default is 0.05.
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Reference > Water
Drop Size

The mass of the droplet that starts the water ripples. A Drop Size 
value of 0 produces no ripple effect because the droplet has no mass. 
As the Drop Size value increases, the mass of the drop increases, 
causing a greater ripple effect. The valid range is 0 to infinity. The 
slider range is 0 to 1. The default is 0.3.

Ripple Origin

The location of the center of the ripples along U and V directions. The 
range is from 0 to 1. The default is 0.5.

Group Velocity

The speed of the primary ripple. The valid range is 0 to infinity. The 
slider range is 0 to 10. The default is 1.

Phase Velocity

The speed of sub-ripples. The valid range is 0 to infinity. The slider 
range is 0 to 10. The default is 2.5.

Spread Start

Degree of effect a droplet has on a still water surface at time 0. A 
concentric ripple starts as a point of disturbance in space (defined by 
the Ripple Origin values) when the Ripple Time value is 0. The size of 
the disturbance at time 0 is determined by the Spread Start value. The 
greater the value, the greater the effect of the disturbance at time 0. 
The valid range is 0 to infinity. The slider range is 0 to 1. The default is 
0.005.

Spread Rate

Rate at which the primary ripple breaks into sub-ripples. (As a ripple 
expands outward, it breaks up into sub-ripples.) The valid range is 0 
to infinity. The slider range is 0 to 1. The default is 0.3.

Reflection Box

Activates an imaginary reflective bounding box ripples can reflect off. 
Reflection Box is off by default. (This effect can slow down the render 
speed.)

Box Min, Box Max

Defines the bounding box in the U and V directions. If Reflection Box. 
is off, these attributes have no effect. The range is 0 to 1. The default 
for Box Min is 0; the default for Box Max is 1.
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Reference > Shared 2D texture attributes
Shared 2D texture attributes

For texture-specific attributes, see the 2D texture name: Bulge, Checker, 
Cloth, File, Fluid Texture 2D, Fractal, Grid, Mountain, Movie, Noise, 
Ocean, Ramp, Water. 

Color Balance

Corrects the color or intensity of a texture.

Default Color

If you map a texture to a material in such a way that it that does not 
cover the entire surface, the file node’s Default Color shows through. 
To select a different color, click the color bar to open the Color 
Chooser. To change the texture’s coverage, use the placement options.

Color Gain

Scaling factor applied to the texture’s outColor channel. For example, 
you can color-correct a texture that appears too green by setting the 
Color Gain to a shade of blue. The default color is white (no effect).

Color Offset

Offset factor applied to the texture’s outColor channel. For example, 
you can brighten a texture that appears too dark by setting the Color 
Offset to a shade of gray. The default color is black (no effect).

Alpha Gain

Only has an effect if the texture is used as a bump or displacement. Scaling 
factor applied to the texture’s outAlpha channel. The default value is 1 
(no effect).

Alpha Offset

Only has an effect if the texture is used as a bump or displacement. Offset 
factor applied to the texture’s outAlpha channel. For example, if the 
Alpha Gain value is -1 and the Alpha Offset value is 1, the outAlpha 
channel is inverted. The default value is 0 (no effect).

Alpha is Luminance

Off by default. The alpha (mask) output depends on the luminance of 
the color channels. Bright areas of the texture are more opaque when 
compositing, and dark areas are more transparent. 

Note: You cannot use Alpha as Luminance for Cloth, Ramp, or 
Stencil textures. 
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Reference > Shared 2D texture attributes
Effects

Filter

Filter attributes scale the size of the filter and let you specify the 
amount of blur in the texture map. Use it as an anti-aliasing technique 
used to refine file textures, reduce flickering, or to achieve special 
effects.

By default, Filter is set to a value of 1.0 to help prevent such aliasing 
effects. The effect of Filter is related directly to eye space. As the object 
moves further away from the eye, the more the texture blurs.

For more information, see ”Texture filtering” on page 32.

Filter Offset

Controls the texture blur in texture space (not eye space). Use Filter 
Offset for a blurred effect instead of anti-aliasing. Maya adds a 
constant value to the Filter setting. The default value is 0. Increasing 
the value increases the texture blur. For example, 1.00 completely 
blurs the texture.

Invert

Reverses all texture colors (black becomes white, white becomes black, 
and so on). Invert is off by default. For example, you can change a 
bump or displacement map’s raised regions to depressions and vice 
versa by setting Invert on or off. 

Color Remap

Applies a color map to the texture and lets you add or subtract colors 
from a texture’s default settings. Maya maps the U value to the 
original texture’s hue, and the V value to the original texture’s 
intensity. (Color Remap is similar to the ”Shading Map” on page 162 
material and uses the RGB to HSV Color Utility.)

Tip: A Filter and Filter Offset of 0.00 results in no blur effect, 
however a small amount of blur can help reduce moiré and 
aliasing effects in texture maps. 

Invert off

Stucco texture bump mapped

Invert on
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Reference > Brownian
To remap a texture

Click the Color Remap button. The texture colors change and a Remap 
Ramp Attribute Editor appears. Adjust the Ramp texture colors and 
attributes if necessary.

UV Coord

The current UV coordinate values of the current sample point. 

3D textures

Brownian

Resembles thickly painted metal.

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Lacunarity

Defines the gap between the frequencies (Octaves) you add to form 
the texture. By default, Lacunarity for noise-based textures is set to 
2.0, but you can adjust the value to create interesting effects. 

Increment

Determines the ratio for the fractal noise. Results in a crisper texture 
when close to zero, and a smoother texture when close to 1.

Octaves

Sets the upper limit for noise frequencies (the repeat value of the 
fractal). See also “Depth”.

Weight3d

Determines how wavy the image appears when projected by 
controlling the scale of the frequency of any fractal used in the 
procedure.

Cloud

Simulates clouds.

You should only map the Cloud texture to a sphere. You can combine 
several spheres to create complex cloud arrangements. If you map the 
Cloud texture to any other type of surface, the results may be 
unpredictable.

The area surrounding the cloud is always transparent, regardless of the 
map type.
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Reference > Cloud
Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Color1, Color2

The two colors blended together to form the cloud. To select different 
colors, click the color bars to open the Color Chooser.

Contrast

The contrast between Color1 and Color2. For example, if the Contrast 
value is -1, Color1 and Color2 are reversed. The range is from - 
infinity (the two colors are averaged over the entire texture) to + 
infinity. The default is 0.5.

Amplitude

Controls the strength of the fractal noise used to generate the Cloud 
texture. The valid range is 0 (no noise) to + infinity (strong noise). The 
default is 1.

Depth

Controls the granularity of the texture. Values represent the minimum 
and maximum number of iterations used to calculate the texture 
pattern. The range is 0 to + infinity. The defaults are 0 and 8.

Ripples

Determines the texture’s waviness in the X, Y, and Z directions. The 
values represent the frequency scale of the fractal used to generate the 
texture. The range is from 0 to + infinity on X, Y and Z. The default is 
1.

Soft Edges

Simulates natural looking clouds. Gradually increases the 
transparency of the texture as the surface it is mapped to turns away 
from the camera. If Soft Edges is off, the texture is entirely opaque, 
and looks similar to the Fractal texture. Soft Edges is on by default.

Edge Thresh, Center Thresh

If Center Thresh is low and Edge Thresh is high, the texture resembles 
a dense cotton-ball. If Center Thresh is high and Edge Thresh is low, 
the texture resembles a wispy cloud. The range is from - infinity to + 
infinity. The default is 0 for Center Thresh and 1 for Edge Thresh.

Transp Range

The range over which the texture becomes transparent. The value 
controls the sharpness/softness of the cloud’s edges. The valid range 
is 0 to infinity. The slider range is 0 (sharp edges) to 1 (very soft 
edges). The default is 0.5.
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Reference > Crater
Ratio

Controls the frequency of the fractal noise used to generate the Cloud 
texture. The range is 0 (low frequency) to + infinity (high frequency). 
The default is 0.707.

Crater

Creates the appearance of both plateaus and craters by mixing normal 
disturbance and 3D disturbance, such as color or transparency. The Crater 
texture provides a three component attribute (Out Color RGB) and a 
Normal output (Out Normal X, Y, and Z).

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Shaker

Increase this value to add more detail to the default Shaker texture (as 
though it has been shaken up). If used as a bump map, increase the 
value to increase the number of craters and valleys. 

Channel1, Channel2, Channel3

The three channels through which information such as color values 
passes. You can also supply information to the channels using a three-
channel (RGB) mapping.

Melt

Controls the edge softness between the colors in the texture. Increase 
this value to display the borders between the colors smoother and 
wider. 

Balance

Controls the ratio of the three shaken (or disturbed) colors.

Frequency

Controls the frequency of how many times the texture colors are 
shaken.

Normal Options (Crater)

Note: Norm Depth, Norm Melt, Norm Balance, and Norm 
Frequency only has an effect if the Out Normal attribute is 
connected to the Normal Camera attribute of a shader.
Shading

218



1 | About shading and texturing surfaces

Reference > Fluid Texture 3D
Norm Depth

Controls the depth of the craters when the texture is used as a bump 
map. Increasing Norm Depth deepens the craters. 

Norm Melt

Controls the softness of the crater edges when this texture is used as a 
bump map. Increase Norm Melt to make the edges softer. Animate 
this texture to make the cratered surface look like it is melting. 

Norm Balance

Controls the ratio between the low and high normal’s disturbance 
when this texture is used as a bump map. 

Norm Frequency

Norm Frequency controls the amount of rough detail when this 
texture is used as a bump map. Increase Norm Frequency to make the 
texture rougher, with finer detail. Decrease it to make the roughness 
larger-grained. 

Fluid Texture 3D

Find this texture in the Create bar. For information on Fluid Texture 3D, 
see ”Apply a fluid texture to an object” on page 166 in the Fluid Effects guide.

Granite

Simulates granite. 

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Color1, Color2, Color3, Filler Color

The color of the three different types of cells (Color1, Color2, Color3) 
and the color surrounding the cells (Filler Color). Click any of these 
color bars to select a different color from the Color Chooser.

Tips: • The Granite texture is the same as the Leather texture 
except that there are three cell colors instead of one.

• The Granite texture can take a long time to render. To 
save time when rendering, convert the granite texture 
into an image file (see ”Baking illumination and color” 
on page 327).
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Reference > Leather
Cell Size

Represents the individual cell size. This value scales the entire texture. 
The valid range is 0 to infinity. The slider range is 0 to 1. The default is 
0.15.

Density

Controls the cell spacing. The valid range is 0 to infinity. The slider 
range is 0 to 1 (fully packed). The default is 1.

Mix Ratio

Determines which color is dominant. The range is 0 (Color1 is 
dominant) to 1 (Color3 is dominant). The default is 0.5 (Color2 is 
dominant).

Spottyness

Randomizes the cell color intensity. The range is 0 to infinity. The 
slider range is 0 to 1. At 0 all cells have the same intensity. At 1 the cell 
intensity is entirely random. The default is 0.3. The Threshold value 
also influences the cell color intensity.

Randomness

Randomizes the cell position. The valid range is 0 to infinity. The 
slider range is 0 to 1. At 0 cells are arranged in a regular 3D lattice. At 
1, cell location is entirely random. The default value is 1.

Threshold

Controls how cell colors and filler color mix into each other. The valid 
range is 0 to infinity. The slider range is 0 to 1 (if no mixing occurs, 
cells display as solid color dots). The default value is 0.5.

Creases

Creates boundaries between cells. If off, the cells diffuse uniformly 
into each other. Creases is on by default.

Leather

Simulates leather. Can also be used to simulate materials such as snake or 
alligator skin, styrofoam, or concrete. 

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.
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Reference > Leather
Cell Color, Crease Color

The color of individual cells (Cell Color) and the color surrounding 
the cells (Crease Color).

Cell Size

The size of individual cells. The Cell Size value scales the entire 
texture. The valid range is 0 to infinity. The slider range is 0 to 1. The 
default is 0.5.

Tips: • For many situations, a real leather image file (File 
texture) produces a good leather simulation; however, it 
is often difficult to map a file texture to a surface without 
distortions and discontinuity. Chord Length or 
Worldspace texture mapping may eliminate distortions, 
but require some effort and do not always work. In these 
cases, use the Leather texture. 

• The Leather texture uses a 3D array of spheres to 
simulate 2D leather. This is unlike real leather because 
real leather is a surface, not a solid. However, the 
Leather texture usually produces very realistic results. 
The exception is if the surface is deformed during an 
animation because the surface may seem to move 
through the solid texture. In this case, convert the texture 
into an image file (see ”Baking illumination and color” 
on page 327).

To create concrete, apply a bump map to the 
material and adjust the color and cell size as 
well as the bump map’s Bump Depth attribute.

To create an alligator skin-type texture, turn 
Creases off and adjust the cell size and color.
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Reference > Marble
Density

Controls the spacing of cells in the texture. The valid range is 0 to 
infinity. The slider range is 0 to 1 (fully packed). The default is 1.

Spottyness

Randomizes the cell color intensity. The range is 0 to infinity. The 
slider range is 0 to 1. At 0 all cells have the same intensity. At 1 the cell 
intensity is entirely random. The default is 0.1. The Threshold value 
also influences the cell color intensity.

Randomness

Randomizes the cell position. The valid range is 0 to infinity. The 
slider range is 0 to 1. At 0 cells are arranged in a regular 3D lattice. At 
1, cell location is entirely random. The default value is 0.5.

Threshold

Controls how the cell color and crease color mix into each other. The 
valid range is 0 to infinity. The slider range is 0 to 1 (if no mixing 
occurs, cells display as solid color dots). The default value is 0.83.

Creases

Creates boundaries between cells resembling creases in leather. If off, 
the cells diffuse uniformly into each other. Creases is on by default.

Marble

Simulates marble. Maya uses a vein material sandwiched between layers 
of filler material. 

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Filler Color, Vein Color

The color of the filler material and the vein material. Click a color bar 
to select a different color from the Color Chooser.

Vein Width

The thickness or width of the veins. The range is 0 to 1. The default is 
0.1.

Diffusion

Controls the amount of Vein Color that blends into the Filler Color. 
The range is 0 (no blending) to 1 (smooth blending). The default is 0.5. 
(The Contrast value also affects how the two colors blend.)
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Reference > Rock
Contrast

The contrast between the Vein Color and Filler Color. The range is 0 to 
1. The default is 0.5.

Noise Attributes (Marble)

The Marble texture creates a 3D texture by projecting a 2D texture. The 
Noise Attributes control the randomization (using fractal noise) of the 
texture in the direction the texture is projected.

Amplitude

A scaling factor applied to all values in the fractal noise about the 
average value. The valid range is 0 to infinity. The slider range is 0 (no 
noise) to 1 (strong noise). The default is 1.5.

Ratio

Controls the fractal noise frequency. The valid range is 0 (low 
frequency) to 1 (high frequency). The default is 0.707.

Ripples

Determines the texture’s waviness in the X, Y, and Z directions. The 
values represent the frequency scale of the fractal used to generate the 
texture. The range is from 0 to + infinity for X, Y, and Z. The default is 
1.

Depth

The minimum and maximum number of iterations used to calculate 
the texture pattern. Controls the texture’s granularity. The range is 
from 0 to 20. The default values are 0 and 20.

Rock

Simulates rock using a random 3D distribution of two different grain 
material types. 

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Color1, Color2

The color of the two grains in the texture. To select different colors, 
click the color bars to open the Color Chooser.

Tip: Assign this texture to the material’s bump map to achieve a 
coarser simulated texture.
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Reference > Snow
Grain Size

Specifies the grain size and scales the entire texture. The valid range is 
0 to infinity. The slider range is 0 (no grains) to 0.1 (large grains). The 
default value is 0.01.

Diffusion

Controls the amount Color1 blends into Color2. The range is 0 to 
infinity. The slider range is 0 (no blending) to 1 (smooth blending). 
The default is 1.

Mix Ratio

Determines the dominant color. The valid range is 0 to infinity. The 
slider range is 0 (Color1 is totally dominant) to 1 (Color2 is totally 
dominant). The default is 0.5.

Snow

Simulates snow on a surface. 

You can find this texture in the Create bar. To apply this texture as a 
texture map, see ”Map and position textures” on page 84.

Note If you assign Snow to geometry whose surface normals and 
tangents are constant (for example, those of a primitive 
cone), the Snow texture appears as a uniform color, and the 
difference between the Snow Color and Surface Color is 
non-existent.

Tips: • To display snow on all objects in the scene, apply the 
Snow texture as a transparency map on a white material 
and then layer this material onto other shaders.

• Try combining a Fractal bump map with a Snow color 
map. The snow only appears on the peaks and valleys of 
the bump mapped surface. For best results, set the 
Fractal bump map’s Alpha Gain and Filter values to a 
low number. 

• To simulate windswept snow, rotate the Snow texture 
by rotating the 3D Placement Object about a horizontal 
line.
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Reference > Solid Fractal
Snow Color

The color of the snow on the top of the surface.

Surface Color

The color of the surface on which the snow lies.

Threshold

Determines the maximum slope that holds snow. The range is 0 (90 
degrees from horizontal) to 1 (0 degrees from horizontal). The default 
is 0.5 (45 degrees from horizontal).

Depth Decay

The rate at which the snow color blends into the surface color. The 
range is 0 to 10. The default is 5.

Thickness

The apparent depth of the snow. Thickness controls the opacity of the 
snow (deeper snow is more opaque). The range is 0 (transparent) to 1 
(opaque). The default is 1.

Solid Fractal

Represents a 3D random function with a particular frequency distribution 
(fractal).

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Threshold

Offset factor applied to all values in the texture. The valid range is 0 to 
infinity. The slider range is 0 to 1. The default is 0.

Amplitude

Scaling factor applied to all values in the texture. The valid range is 0 
to infinity. The slider range is 0 (no noise) to 1 (strong noise). The 
default is 1.

Ratio

Controls the frequency of the fractal noise. The range is 0 (low 
frequency) to 1 (high frequency). The default is 0.707.

Tip: Assign this texture to the material’s bump map to achieve a 
coarser simulated texture.
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Reference > Solid Fractal
Frequency Ratio

Determines the relative spacial scale of noise frequencies. If not a 
whole number, the fractal does not repeat at the UV boundaries. For 
instance, a cylinder with default placement would display a seam.

Ripples

Determines the texture’s waviness in the X, Y, and Z directions. The 
values represent the frequency scale of the fractal used to generate the 
texture. The range is 0 to infinity. The default is 1.

Depth

The minimum and maximum number of iterations used to calculate 
the texture pattern. This parameter controls how fine grained the 
texture is. The range is 0 to 20. 

Bias

Attracts the -1 to 1 noise towards either 1 or 0. Values greater than 
zero result in a more contrasting fractal while values less than zero 
make it more flat and spiky.

Inflection Applies a kink in the noise function. This can be 
useful when creating puffy or bumpy effects. 
Inflection is off by default.

Animated Turn on to access the Time and Time Ratio 
attributes (see next).

Time

Determines the relative time scale of noise frequencies. If not a whole 
number, the animation does not repeat when Time = 1.

Time Ratio

Default is equal to the Frequency Ratio setting, which means higher 
frequency noises move faster in direct proportion to the frequency. 
For example, to create more natural-looking effects, such as water 
waves, if the Frequency Ratio is 2, set the Time Ratio to 1.4.

Note: The following attributes let you swirl the noise pattern in a 
Solid Fractal texture to create interesting effects.
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Reference > Stucco
Stucco

Randomly disturbs the material by mixing two input attributes, Channel1 
and Channel2, to create an effect resembling stains or clouds. Stucco 
includes Normal Options attributes you can use to control the effect. See 
also ”Crater” on page 218.

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.

Shaker

Increase this value to add more detail to the default Shaker attribute 
setting (as though it has been shaken up). If used as a bump map, 
increase the value to increase the number of craters and valleys. 

Channel1, Channel2

The two channels through which information such as color values 
passes. You can also supply information to the channels using a three-
channel (RGB) mapping.

Normal Options (Stucco)

Normal Depth

Controls the depth of the craters when the texture is used as a bump 
map. Increasing Normal Depth deepens the craters. 

Normal Melt

Controls the softness of the crater edges when this texture is used as a 
bump map. Increasing Normal Melt softens the edges. Animate this 
texture to simulate a melting cratered surface.

Volume Noise

Can be used to create many different types of effects. 

You can find this texture in the Create bar. To apply this texture as a 
texture map, see ”Map and position textures” on page 84.

Note: Normal Depth and Normal Melt only have an effect if the 
Out Normal attribute is connected to the Normal Camera 
attribute of a shader.
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Threshold

The number added to the whole fractal, making it uniformly brighter. 
If some parts of the fractal are pushed up out of range (greater than 
1.0), they are clipped to 1.0. If the Volume Noise is used as a bump 
map, it appears as plateau regions.

Amplitude

Scaling factor applied to all the values in the texture, centered around 
the texture's average value. 

When you increase Amplitude, the light areas get lighter and the dark 
areas get darker. 

If Volume Noise is used as a bump map, increasing Amplitude results 
in higher bumps and deeper valleys.

If set to a value greater than 1.0, the parts of the texture that scale out 
of range are clipped. On a bump map, they display as plateau regions.

Ratio

Controls the fractal noise frequency. Increase this value to increase 
fractal detail and make it finer.

Frequency Ratio 

Determines the relative spacial scale of the noise frequencies. If not a 
whole number, the fractal does not repeat at the UV boundaries. For 
instance, a cylinder with default placement appears a seam.

Depth Max 

Controls how much calculation is done by the Volume Noise texture. 
Since the Fractal texture process produces a more detailed fractal, it 
takes longer to perform. By default, the texture chooses an 
appropriate level for the volume being rendered. Use Depth Max to 
control the maximum amount of calculation for the texture.

Inflection 

Applies a kink in the noise function. Useful for creating puffy or 
bumpy effects.

Time 

Used to animate the Volume Noise texture. You can keyframe the 
Time attribute to control the rate and amount of change of the texture.

Frequency

Determines the fundamental frequency for the noise. As this value 
increases the noise becomes more detailed. It has the inverse effect of 
the scale parameter.
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Scale 

Determines the scale of the noise in the local X, Y, and Z directions. 
This is similar to scaling the transform node for the texture. When you 
increase Scale, the fractal detail seems to smear out in the direction 
you choose.

Origin

The zero point for the noise. Changing this value moves the noise 
through space.

Noise Type

Determines which noise to use during the fractal iteration. Select from 
the following:

Perlin Noise The standard 3D noise used in the solidFractal 
texture. 

Billow A puffy, cloud-like effect. 

VolumeWave A sum of 3D waves in space. 

SpaceTime A 4-dimensional version of the Perlin noise, where 
time is the 4th dimension.

Density

Controls how many cells are embedded in the medium used by the 
Billow noise type.

At 1.0, the medium is completely packed with cells. Reduce this value 
to make the cells sparser. If the texture is used as a bump map, low 
values for Density results in smooth looking surfaces with occasional 
bumps.

Spottyness

Controls the density randomization of individual cells used by the 
Billow noise type.

When set close to 0, all the cells are the same density. As you increase 
Spottyness, some cells are randomly denser or thinner than others.

Size Rand

Controls the randomization of the size of the individual blobs used by 
the Billow noise type. When it is close to 0, all the cells are the same 
size. As you increase Size Rand, some cells are smaller than others, in 
a random fashion.
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Randomness

Controls how the cells for the Billow noise type are arranged relative 
to one another. Set to 1.0 for a more natural random distribution of 
cells.

If set to 0, all the spots are laid out in a regular pattern. This can 
provide interesting effects when used as a bump map—for instance, 
you can make things like insect eyes, or machine-tooled raspy 
surfaces.

Falloff

Controls the way intensity falls off for individual blobs for the Billow 
noise type. Select from the following:

Linear A uniform falloff from the center to a value of zero 
at the edges of the blobs. 

Smooth More natural looking, using a gaussian falloff. 

Fast Focuses the intensity more towards the center of the 
blobs. 

Bubble Uses a reverse falloff, fading to zero at the blob 
center.

Num Waves

Determines how many waves to generate for the Volume Wave noise 
type. The larger the number, the more random-looking and slower the 
texture.

Wood

Simulates wood by projecting a 2D pattern. This pattern consists of 
concentric ring layers defined by veins and filler. When you map the Wood 
texture to a surface, the surface seems to be carved out of wood. When 
you map it to several surfaces, they seem to be carved from a single block 
of wood.

Find this texture in the Create bar. To apply this texture as a texture map, 
see ”Map and position textures” on page 84.
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Filler Color

The color of the space between veins. The vein color diffuses into the 
filler color. Double-click the color bar to choose a different color from 
the Color Chooser.

Vein Color

The vein color of the wood. The vein color diffuses into the filler color. 
Double-click the color bar to choose a different color from the Color 
Chooser.

Vein Spread

The amount of vein color that diffuses into the filler color. The valid 
range is 0 to infinity. The slider range is 0 to 3. The default is 0.25.

Layer Size

The average thickness of each layer or ring. The valid range is 0 to 
infinity. The slider range is 0 to 0.5. The default is 0.02. (The thickness 
of individual layers or rings is also influenced by the Randomness and 
Age values.)

Randomness

Randomizes the thickness of individual layers or rings. The range is 0 
to 1. The default is 0.5.

Age

The age of the wood (in years). This value determines the total 
number of layers or rings in the texture, and influences the relative 
thickness of central and outer layers. The valid range is 0 to infinity. 
The slider range is 0 to 100. The default is 20.

Grain Color

The color of the random grain in the wood.

Tips: • There are four Wood attributes that are frame constant, 
meaning that mapping them with textures or other 
nodes that produce different values from point to point 
may lead to unpredictable results. These attributes are: 
Grain Spacing, Layer Size, Randomness, and Age. You can 
key all of these attributes to make their appearance 
change over time in an animation sequence.

• If you use the Wood texture as a bump map, lower the 
Grain Contrast setting to reduce the potential for texture 
artifacts during animation.
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Grain Contrast

Controls the amount of Grain Color that diffuses into the surrounding 
wood color. The range is 0 to 1. The default value is 1.

Grain Spacing

The average distance between grain spots. The range is 0.002 to 0.1. 
The default value is 0.01.

Center

The location of the center of the texture’s concentric rings in the U and 
V directions. The range is -1 to 2. The default values are 0.5 and -0.5.

Noise Attributes (Wood)

The Wood texture creates a 3D texture by projecting a 2D pattern. The 
Noise Attributes control the randomization (using fractal noise) of the 
texture in the direction the pattern is projected. Select from the following:

Amplitude X, Amplitude Y

An average scaling factor applied to all values in the fractal noise in 
the texture’s X and Y directions. The valid range is 0 to infinity. The 
range is 0 (no noise) to 1 (strong noise). The default value is 0.1.

Ratio

Controls the fractal noise frequency. The range is 0 (low frequency) to 
1 (high frequency). The default is 0.35.

Ripples

Determines the texture’s waviness in the X, Y, and Z directions. The 
values represent the frequency scale of the fractal used to generate the 
texture. The range is 0 to 20. The default is 1.

Depth

The minimum and maximum number of iterations used to calculate 
the texture pattern. This parameter controls how fine grained the 
texture is. The range is 0 to 25. The default values are 0 and 20.

Tip: Do not set the Center values less than -3 or greater than 3.

Tip: The Wood texture renders faster if the Amplitude X and 
Amplitude Y values are both 0. 
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Shared 3D texture attributes

For texture-specific attributes, see the 3D texture name: Brownian, Cloud, 
Crater, Fluid Texture 3D, Granite, Leather, Marble, Rock, Snow, Solid 
Fractal, Stucco, Volume Noise, Wood. 

Color Balance

Corrects the color or intensity of a texture.

Default Color

If you map a texture to a material in such a way that it that does not 
cover the entire surface, the file node’s Default Color shows through. 
To select a different color, click the color bar to open the Color 
Chooser. To change the texture’s coverage, use the placement options.

Color Gain

Scaling factor applied to the texture’s outColor channel. For example, 
you can color-correct a texture that appears too green by setting the 
Color Gain to a shade of blue.The default color is white (no effect).

Color Offset

Offset factor applied to the texture’s outColor channel. For example, 
you can brighten a texture that appears too dark by setting the Color 
Offset to a shade of grey. The default color is black (no effect).

Alpha Gain

Only has an effect if the texture is used as a bump or displacement. Scaling 
factor applied to the texture’s outAlpha channel. The default value is 1 
(no effect).

Alpha Offset

Only has an effect if the texture is used as a bump or displacement. Offset 
factor applied to the texture’s outAlpha channel. For example, if the 
Alpha Gain value is -1 and the Alpha Offset value is 1, the outAlpha 
channel is inverted. The default value is 0 (no effect).

Alpha is Luminance

Off by default. The alpha (mask) output depends on the luminance of 
the color channels. Bright areas of the texture are more opaque when 
compositing, and dark areas are more transparent. 

Note: You cannot use Alpha as Luminance for Cloth, Ramp, or 
Stencil textures. 
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Effects

Filter

Filter attributes scale the size of the filter and let you specify the 
amount of blur in the texture map. Use it as an anti-aliasing technique 
used to refine file textures, reduce flickering, or to achieve special 
effects.

By default, Filter is set to a value of 1.0 to help prevent such aliasing 
effects. The effect of Filter is related directly to eye space. As the object 
moves further away from the eye, the more the texture blurs.

For more information, see ”Texture filtering” on page 32.

Filter Offset

Controls the texture blur in texture space (not eye space). Use Filter 
Offset for a blurred effect instead of anti-aliasing. Maya adds a 
constant value to the Filter setting. The default value is 0. Increasing 
the value increases the texture blur. For example, 1.00 completely 
blurs the texture.

Invert

Reverses all texture colors (black becomes white, white becomes black, 
and so on). Invert is off by default. For example, you can change a 
bump or displacement map’s raised regions to depressions and vice 
versa by setting Invert on or off. 

Local, Wrap

Wrap repeats or tiles the texture completely over the object. If off, 
everything outside the 3D placement cube displays the texture’s 
default color. Wrap is on by default. 

Tip: A Filter and Filter Offset of 0.00 results in no blur effect, but 
a small amount of blur can help reduce moiré and aliasing 
effects in texture maps. 

Invert off. Invert on.

Stucco texture 
bump mapped.
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To adjust texture placement on all objects at once, turn Local on, 
transform the texture placement icon, then turn Local off to see the 
results. Turning on Local also means that if you transform any of the 
objects during an animation, the 3D texture transforms accordingly. 

Blend

Controls how much of the texture’s Default Color is mixed into the 
texture Color. A value of 0 means the Default Color does not affect the 
texture Color. As you increase the Blend value, more and more of the 
Default Color mixes in. This attribute does not work unless Wrap is turned 
off and Local is turned on.

To blend colors and textures using the Blend slider

1 Change the Default Color (in the Color Balance section of the texture’s 
Attribute Editor), or map another texture to the Default Color.

2 Make sure Invert and Wrap are off and turn Local on.

3 Drag the slider to change the Blend value.

Color Remap

Applies a color map to the texture and lets you add or subtract colors 
from a texture’s default settings. Maya maps the U value to the 
original texture’s hue, and the V value to the original texture’s 
intensity. (Color Remap is similar to the ”Shading Map” on page 162 
material and uses the RGB to HSV Color Utility.)

To remap a texture

Click the Color Remap button. The texture colors change and a Remap 
Ramp Attribute Editor appears. Adjust the Ramp texture colors and 
attributes if necessary.

UV Coord

The current UV coordinate values of the current sample point. 

Tip: Some nodes, such as the Reverse utility, repeat themselves 
to achieve the effect of Wrap, so that it extends infinitely. 
Others, such as a “Marble” texture, extend outwards 
without repeating. 
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Environment textures

Common Environment texture attributes

Color Remap

Color Remap applies a color map to the texture. It is the only common 
Effects Environment texture attribute. The U value of the Color Remap 
texture is mapped to the original texture’s hue, and the V value is mapped 
to the original texture’s intensity (the value defined by [R+G+B]/3). The 
Color Remap attribute acts similar to the Shading Map material (see 
Shading Map).

Env Ball

Uses an image of a highly reflective chrome ball in an environment (real 
world or computer generated) to re-create that environment. This is 
possible because the reflections in the chrome ball provide a (nearly) 360 
degree view of the environment. 

An Env Ball texture background renders faster than a procedural texture 
background or a background modeled with surfaces. You can therefore 
replace a complex background with an Env Ball texture (by rendering an 
image of a chrome ball in that environment) to reduce rendering times.

Find this texture in the Create bar. To use this texture, see ”Simulate 
reflections with Env Ball” on page 314.

Image

The texture used by the Env Ball texture. To use a single image of a 
highly reflective chrome ball in an environment, map a File texture to 
the Env Ball texture’s Image attribute, and then specify an image file 
for the File texture’s Image Name attribute.

Inclination

The rotation (in radians) of the ball image about the vertical axis. The 
valid range is 0 to 3.142. The slider range is 0 to 3.142. The default 
setting is 0.

Set the Inclination value to the inclination of the camera (the angle 
between the camera’s view and the environment’s YZ plane) used to 
generate the image file (by photographing or rendering a reflective 
ball in an environment). For example, if the camera is parallel to the 
YZ plane, set the Inclination value to 0. When creating the ball image, 
a camera inclination and elevation of zero provides the best resolution 
for the view you intend to use.
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Elevation

The rotation of the ball image about the horizontal axis. The valid 
range and the slider range are both -1.571 to 1.571. The default setting 
is 0.

Set the Elevation value to the elevation of the camera (that is, the 
angle between the camera’s view and the environment’s grid plane: 
XZ plane for a Y-up scene) used to generate the image file (by 
photographing or rendering a reflective ball in an environment). For 
example, if the elevation of the camera is 90 degrees (that is, it is 
directly above the ball), set the Elevation value to 1.571. If the camera 
is parallel to the grid plane, set the Elevation value to 0. When 
creating the ball image, a camera inclination and elevation of zero 
provides the best resolution for the view you intend to use.

Eyespace

Causes the position of the Env Ball texture’s Image file to be defined 
relative to the window, not the camera view.

If Eyespace is on, the Env Ball texture’s Image file automatically 
matches the environment’s Backdrop image file (provided they were 
both originally photographed/rendered from the same point of view), 
even if the camera view changes. Reflections, however, are based on 
the background being infinitely far away; that is, the reflection planes 
are ignored (see “Projection Geometry”). Rendering is faster when 
Eyespace is on. The default setting is off.

Reflect

Causes the Image file to be reflection mapped onto the background.

If Reflect is off, the Image file is mapped using a solid texture 
spherical projection. This allows you to model the geometry of the 
background image and then map the background image to this 
geometry, for example, to add shadows, lighting effects, or fog to the 
scene. The default setting is on.

Projection Geometry

The Projection Geometry attributes controls the appearance of reflections 
from an Env Ball texture. They define the location of the sky and, or room 
walls of the original environment so that Maya can calculate reflections on 
surfaces in the re-created environment.

For example, if the original environment consisted of a grid plane and a 
sky, then you would set the Sky Radius value to the radius of the sky, and 
the Bottom value to the distance between the grid plane and the reflective 
ball. If the original environment consisted of a room, then you would set 
the Bottom, Top, Left, Right, Front, and Back values to the distance 
between each wall and the reflective ball.
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In some cases you may want to use values different than the original 
environment. For example, instead of using the Bottom, Top, Left, Right, 
Front, and Back values to define the walls of a room, you may simply use 
the Sky Radius attribute. Because Sky Radius defines a sphere, reflections 
on surfaces in the simulated environment are smoother and less likely to 
become blurred. You can also combine Sky Radius with Bottom, Top, Left, 
Right, Front, and, or Back.

Sky Radius

The radius of the sky of the original environment. The valid range is 0 
to infinity. The slider range is 0 to 20. The default value is 0.

Bottom, Top, Left, Right, Front, Back

The distance between the reflective ball and each wall of the original 
environment. The valid range is 0 to infinity. The slider range is 0 to 
20. The default value is 0.

Env Chrome

Simulates a showroom environment. The texture consists of a plane and a 
sky plane (with fluorescent style light rectangles), and provides a simple 
but effective environment to simulate reflections off chrome surfaces.

The Environment Chrome Attributes control the size and placement of the 
simulated fluorescent lights in an Env Chrome texture. (These “lights” 
produce reflections in surfaces, but they do not actually illuminate 
surfaces.)

Find this texture in the Create bar.

Light Width, Light Depth

The width and depth of each light. These parameters also determine 
spacing between lights. The valid/slider range is 0 to 1. The default 
Light Width value is 0.5 and the default Light Depth value is 0.1.

Light Width Gain, Light Width Offset

The number of lights per unit length. The valid/slider range is 0 to 1. 
The default Light Width Gain value is 1 and the default Light Width 
Offset value is 0.

Light Depth Gain, Light Depth Offset

The light displacement. The slider range is 0 to 1. The default Light 
Depth Gain value is 1 and the default Light Depth Offset is 0.
Shading

238



1 | About shading and texturing surfaces

Reference > Env Chrome
Sky Attributes

Sky Color

The color of the sky at the horizon. Overall sky color is linearly 
interpolated between Sky Color and Zenith Color.

Zenith Color

The color of the sky at the zenith (straight up). Overall sky color is 
linearly interpolated between Sky Color and Zenith Color.

Light Color

The color of the simulated fluorescent lights. These “lights” produce 
reflections in surfaces, but they do not actually illuminate surfaces.

Floor Attributes

Floor Color, Horizon Color, Grid Color

The color of the floor, the floor’s horizon and the floor’s grid.

Real Floor

If Real Floor is off, the environment’s floor is located at infinity, so 
reflections on moving objects and, or reflections viewed from a 
moving camera are incorrect.

If Real Floor is on, the floor is located relative to the grid plane (based 
on the Floor Altitude value), so reflections on moving objects and, or 
reflections viewed from a moving camera are correct. If Real Floor is 
on, make sure surfaces and, or the camera do not go below the grid 
plane. Real Floor is on by default.

Floor Altitude

The height of the floor relative to the grid plane. Floor Altitude has no 
effect if Real Floor is off. The slider range is -1 to 1. The default value 
is -1.

Grid Placement

Grid Width, Grid Depth

The width and depth of the grid lines. These attributes also determine 
the spacing between grid lines. The valid/slider range is 0 to 1. The 
default value is 0.1.

Note: If you set the Floor Altitude too high, the texture swatch 
becomes red, indicating that the camera is looking under 
the floor, which you probably do not want. Lower the Floor 
Altitude until the red color disappears.
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Grid Width Gain, Grid Depth Gain

The number of grid cells per unit length. The valid/slider range is 0 to 
1. The default value is 1.

Grid Width Offset, Grid Depth Offset

The grid displacement. The slider range is 0 to 1. The default value is 
0.

Env Cube

Simulates an environment by mapping six image files onto the inner 
surfaces of a large (or infinitely large) cube. 

Use Env Cube to make reflections on a moving surface during an 
animation if you do not have time to raytrace because it treats the texture 
placement box as the geometry of the environment. This means changes in 
the relative size and position of camera, surface, and environment are 
respected.

For example, you can fake a nice reflection on the surface of an animated 
shiny car as it drives down a road. This process is known as reflection 
mapping. 

Find this texture in the Create bar. To use this texture, see ”Simulate 
reflections with Env Cube” on page 315.

Infinite Size

When on, the images in the cube are reflected as though the sides of 
the cube were infinitely far away. If you are using images with 
distance, such as the horizon or a starfield, turn on Infinite Size. If the 
images are of the interior of a room, or nearby objects, leave Infinite 
Size off. 

Right, Left, Top, Bottom, Front, Back

The image files mapped to the right, left, top, bottom, front, and back 
inner surfaces of an infinite cube. (The front of the cube faces the front 
orthographic view.)

Env Sky

Simulates a planetary environment viewed from the surface of a planet. 

Find this texture in the Create bar.
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Environment Sky Attributes

Total Brightness

The overall brightness of the environment. The valid range is 0 to 
infinity. The slider range is 0 to 5. The default is 1.

Sun Attributes

Sun Brightness

The color and brightness of the sun. The default color Value is 0.5.

Halo Brightness

The color and brightness of the halo around the sun. The default color 
value is 0.1.

Interactively adjusting Sun attributes

The following attributes relate directly to the Sky’s texture placement 
object. You can use the Maya transform tools, such as Scale and Rotate to 
place the manipulator, or use the Show Manipulator tool.

As you change the settings for Elevation, Azimuth, and Size attributes, 
notice how the various manipulators adjust in the View. IPR render to 
watch the texture change on the object. 

The following indicates which manipulators correspond to which 
attribute.

Note: If the eye point or view drops below the floor, the Env Sky 
texture swatch turns red as a warning. If you render the 
scene, the floor appears red. To avoid this, make sure the 
eye point is always above the floor (the grid plane).
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Elevation

The angle (in degrees) of elevation of the sun relative to the floor. The 
valid range is -90 to 90. The slider range is 0 (sunrise/sunset) to 90 
(midday). The default value is 45.

Azimuth

The angle (in degrees) of the sun in the sky about a vertical vector. 
The valid range is 0 to 360. The slider range is 0 to 360. The default 
value is 145.

Size

The size (radius) of the sun. The valid range is 0 to 10000. The slider 
range is 0 to 20. The default value is 0.531

Blur

The size (radius) of the halo around the sun. The valid range is 0 to 
1000. The slider range is 0 to 20. The default value is 1.

Floor

“Elevation”

“Azimuth”

Sun “size”
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Atmospheric Settings

Sky Brightness

A scaling factor applied to the sky color. The default color Value is 0.5.

Air Density

The density of the air in the atmosphere. The denser the air, the more 
light is scattered. 

Air density represents low and high altitudes. High altitude skies are 
almost black straight up and blue near the horizon (the Air Density 
value less than 1). Low altitude skies are blue straight up and white 
near the horizon (the Air Density value greater than 1). The slider 
range is 0 to 3. The default value is 1.

Dust Density

The density of dust in the atmosphere. The slider range is 0 to 3. The 
default value is 0.

Sky Thickness

The thickness of the atmosphere. The valid range is 0 to infinity. The 
slider range is 0 to 10000. The default value is 1000.

Sky Radius

The outer radius of the sky as a multiple of Sky Thickness. 

Sky Thickness and Sky Radius values determine the planet radius, 
and planet radius influences the appearance of sunsets. A planet with 
a large radius results in very red (and very dark) sunsets (you can 

sun

sun vector
Sky Thickness

scene

planet center

Sky Radius * 

Sky Thickness

outer limit of atmosphere

cloud layer

planet surface
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adjust Sky Bright to compensate for sunsets that are too dark). The 
valid range is 0 to infinity. The slider range is 0.01 to 300. The default 
value is 50.

For example, if Sky Thickness is 1000 and Sky Radius is 50, the outer 
radius of the sky is 1000 x 50 = 50 000 units, and the radius of the 
planet is (1000 x 50) - (1000 x 1) = 49 000 units.

Floor Attributes

Has Floor

Turns the floor on or off. If Has Floor is off, the environment below 
the horizon is a mirror image of the environment above the horizon.

Floor Color

The color of the floor. The default color value is 0.392.

Floor Altitude

The height of the floor relative to the grid plane. Floor Altitude has no 
effect if Has Floor is off. The slider range is -100 to 100. The default 
value is -10.

Cloud Attributes

Use Texture

Controls whether or not Env Sky pays attention to the Cloud Texture 
attribute. If you attach a Cloud or other fractal texture node to the 
Cloud Texture attribute, then you must turn on Use Texture to see the 
results. 

Cloud Texture

The texture that determines cloud distribution in the sky. For 
example, the Fractal texture creates very realistic clouds. By default, 
there is no cloud texture map (and no clouds).

Cloud Brightness

The brightness and color of cloud illumination from ambient scattered 
light in the atmosphere. (The amount of ambient light depends on the 
Elevation value.) The default color Value is 0.5.

Sunset Brightness

The brightness and color of cloud illumination when the sun is below 
the horizon and the clouds are front lit (for example, when the sun’s 
Elevation value is 0 and its Azimuth value is 180).

This is a very subtle effect and occurs only briefly in nature during a 
sunrise or sunset. The effect is more noticeable with high altitude 
clouds. The default color Value is 1.
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Density

The density of individual clouds. The valid range is 0 to infinity. The 
slider range is 0 (no clouds) to 5 (heavy clouds). The default value is 1.

Threshold

A threshold value for the Cloud texture that controls how much of the 
sky is covered with cloud. 

As the Threshold value increases, darker areas of the texture do not 
produce clouds. The valid range is 0 to infinity. The slider range is 0 
(entire sky is cloudy) to 1 (no clouds). The default value is 0.5.

Power

The clouds are scaled and positioned by adjusting the Power value. 

The cloud density is achieved by subtracting the Threshold from the 
pixel value clipping to 0, then multiplying the result with Density. To 
control the amount of de-focusing of the Cloud Texture, adjust the 
Blur value (under Sun Parameters). The valid range is 0 to infinity. 
The slider range is 0 to 1. The default value is 1.

Altitude

The height of the clouds. 

The Altitude value does not greatly affect the position of the clouds. 
Instead, it determines how much the atmosphere obscures the clouds 
near the horizon. Low altitude clouds disappear into haze much more 
slowly than high altitude clouds. The valid/slider range is 0 to 1. The 
default value is 0.2.

Halo Size

The size (radius) of cloud illumination from direct back lighting by the 
sun (for example, when the sun’s Azimuth value is 0). 

Direct back lighting is most noticeable near the edges of thick clouds 
or through thin clouds. The valid range is 0 to infinity. The slider 
range is 0 to 50. The default value is 20.

Calculation Quality

The Calculation Quality attributes control the rendering speed of an Env 
Sky texture.

The calculations required for curved atmospheres reduce speed. The 
Calculation Quality attributes do not greatly affect the appearance of the 
sky, but do affect the speed at which the calculations are computed.
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Sky Samples

The number of samples used above the cloud layer. Set the Sky 
Samples value to 1 for maximum speed. The valid range is 0 to 20. The 
slider range is 0 to 3. The default value is 5.

Floor Samples

The number of samples used by the atmosphere between the eye and 
the horizon. 

Increasing the Floor Samples value increases the effect of the 
atmosphere along the floor. The valid range is 0 to 20. The slider range 
is 0 (no atmosphere between the eye and horizon) to 3. The default 
value is 1.

Cloud Samples

The number of samples used below the cloud layer. The valid range is 
0 to 20. The slider range is 0 (clouds do not fade to mist at the horizon) 
to 3. The default value is 5.

Env Sphere

Simulates an environment by mapping a texture or image file directly 
onto the inner surface of an infinite sphere.

Find this texture in the Create bar. To use this texture, see ”Simulate 
reflections with Env Sphere” on page 316.

Image

The texture mapped to the inner surface of an infinite sphere.

Shear U

Shears the Image texture in the U direction. For example, horizontal 
stripes resemble a barber pole when sheared. The slider range is -10 to 
10. The default value is 0.

Shear V

Shears the Image texture in the V direction. For example, concentric 
lines at the poles spiral inward when sheared. The slider range is -10 
to 10. The default value is 0.

Flip

Reverses the U and V orientation of the Image texture.
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Other textures

Layered texture

For more information on layered textures, see ”Layered textures” on 
page 28.

Find this texture in the Create bar.

Layer is Visible

Specifies whether the layer should be taken into consideration during 
computation of the result color and alpha of the layered texture. If off, 
it is as if the layer does not exist. Use this when you want to isolate a 
particular layer to see how it looks by itself.

Alpha is Luminance

Lets you determine whether the Alpha should be the luminance of the 
Out Color, as with other 2D textures, such as a File texture. 

Automatic Alpha for File and Layered Texture nodes

Hardware Color

Specifies which color objects using this texture display in the view 
while in hardware shading mode (not hardware texturing mode).

Blend modes

Layers can be blended with those below them using the Texture Blend 
attribute in the Layered Texture’s Attribute Editor.The Blend Mode 
specifies how the selected layer blends with the below it. The 
following lists the blend modes: 

None Edits or paints each pixel to make it the result color. 
This is the default. (Normal mode is called 
Threshold when you’re working with a bit mapped 
or indexed-colored images). 

 

Layer is Visible on
 

Layer is Visible off
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Over The top layer is applied like a decal to the following 
layer. The shape of the decal is determined by the 
top alpha. 

In  The background texture is cut in the shape of the 
foreground alpha. 

Out The result is the opposite of In. It is as if the shape of 
the foreground layer has been cut out of the 
background alpha. 

Add The result color is the foreground color added to the 
background color as if being projected on the 
background through a slide projector. The result 
color is then applied over the background color 
using the foreground alpha to define the opacity of 
the result.

Subtract The result color is the foreground color subtracted 
from the background color. The result color is then 
applied over the background color using the 
foreground alpha to define the opacity of the result. 

Multiply Looks at the color information in each layer and 
multiplies the bottom color by the blend color. The 
result color is always a darker color. Multiplying 
any color with black produces black. Multiplying 
any color with white leaves the color unchanged. 

Difference Looks at the color information in each layer and 
subtracts either the blend color from the bottom 
color or the bottom color from the blend color, 
depending on which has the greatest brightness 
value. Blending with white inverts the bottom color 
values; blending with black produces no change.

Lighten Looks at the color information in each layer and 
selects the bottom or blend color, whichever is 
lighter, as the result color. Pixels darker than the 
blend color are replaced, and pixels lighter than the 
blend color do not change.

Darken Looks at the color information in each layer and 
selects the bottom or blend color, whichever is 
darker, as the result color. Pixels lighter than the 
blend color are replaced, and pixels darker that the 
blend color do not change. 

Saturate Creates a result color with the luminance and hue of 
the bottom color and the saturation of the blend 
color. 
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De-saturate The result color is the background color with 
saturation decreased in proportion to the 
foreground color scaled by foreground alpha. If the 
foreground color is red, for example, the resulting 
color is the background color with desaturated reds. 

Illuminate Creates a result color with the hue and saturation of 
the bottom color and the luminance of the blend 
color. This mode creates an inverse effect from that 
of the Color mode. 

Placement nodes 

Place 2d Texture

Defines a texture frame—a rectangular area on a surface (in the UV 
coordinate space) in which the texture appears. You can control the 
position, size, and rotation of this frame on the surface using the 
“Coverage”, “Translate Frame”, and “Rotate Frame” attributes. You can 
also control how the texture is tiled within the frame using the “Repeat 
UV”, “Rotate UV”, “Offset”, “Mirror U, V”, “Stagger”, and “Wrap U, 
Wrap V” attributes.

The two columns of boxes in the Attribute Editor represent U and V 
values.

Interactive Placement

Displays the texture placement manipulator. Either click this button 
from the Attribute Editor, or click the Texture Placement Tool icon in 
the main window and select the surface. Middle-drag the manipulator 
handles to place the texture.

Coverage

Specifies what ratio of the surface the texture map covers. The valid 
range is 0 to + infinity for NURBS surfaces. A value of 1 (the default) 
covers the entire surface in either the U or V direction. 

For example, to cover half the surface, set the value at 0.5 in both the 
U and V directions. 

U = 1.0, V = 0.5
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Translate Frame

The Translate attributes position the texture map on the surface and 
move the coverage area across the surface. The range is from - infinity 
to + infinity.

Rotate Frame

Rotates the texture map on the surface. This attribute is represented in 
degrees.

Mirror U, V

Only works when U Repeat or V Repeat attributes are greater than 1. 
Mirror in the U and V direction separately. When on, the repeat areas 
are mirrored—rows of images display as mirrored images of 
themselves. This helps to disguise the effect of seams between repeat 
areas.

Stagger

Maya offsets repeats of maps making alternate rows of repeats offset 
exactly by half (like brick walls). When off, the repeats line up 
horizontally and vertically.

These values 
produce these 
results.

 After you select Mirror 
and place the texture.

Default File 2D texture 
placement.
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Wrap U, Wrap V

Wrap U and Wrap V attributes control whether a map is repeated in 
U or V directions, or both U and V. Both the Wrap attributes are on by 
default. Turn these off to prevent seams from showing on a closed 
surface, such as a cylinder or sphere, or to prevent the texture from 
duplicating itself when you use Translation and Coverage attributes 
to limit the mapping to a very specific surface area. 

Repeat UV

Specifies how many copies of the texture map are mapped within the 
coverage area along either the U or V directions (depending on the 
texture). By default, Maya maps one copy of the texture. Values 
greater than 1 result in more copies of the map displayed in the same 
coverage area. Values less than 1 result in only a portion of the map 
displayed.

Offset

Offsets the pattern of the texture map. This can be particularly useful 
when fine-tuning the placement of a pattern on a surface. U Offset 
offsets the texture pattern along the U direction and V Offset along the 
V direction. Each value ranges from - infinity to + infinity. 

Rotate UV

Since you cannot use the interactive tool to rotate surface placement, 
use this attribute. Rotate UV is calculated in degrees. The valid range 
is 0 to 360 degrees.

Noise UV

2D noise for U and V. Displaces the colors of the texture map.

Fast

When on, Fast checks if the placement is the default and all shading-
time evaluations perform less computations. Turn Fast on to slightly 
improve rendering speed. Fast is off by default.

Repeat: 
U = 4  
V = 4

Repeat: 
U = 10 
V = 4
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Texture Map

Texture Map

Provides you with various adjustable attributes as well as a way to fix 
texture warp on objects with 2D textures. This is especially useful, for 
example, waving fabric, like a flag.

Fix Texture Warp

The Texture Map attributes only apply to NURBS surfaces. 

Fix Texture Warp adjusts a texture’s UV parameters so the texture 
does not rely on a NURBS object’s UV parameterization, which 
alleviates texture warp on objects with 2D textures. For example, if 
you want to create and animate a flag with a Checker texture, you can 
create a NURBS plane on which to map the Checker texture, 
transform the CVs, and turn Fix Texture Warp on in the object’s 
Attribute Editor. 

When you animate the flag by moving some of the CVs to simulate 
the wind blowing the flag, the checker pattern on the flag expands 
and shrinks appropriately.

Note: Convert to File Texture does not support Fix Texture Warp 
If the surface uses Fix Texture Warp, it is ignored when 
converting the material.

Fix Texture Warp off. Fix Texture Warp on.

Surface parameterization
after adjusting CVs.
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Setting the grid size

When Fix Texture Warp is on, Maya texture maps a 2D NURBS 
surface based on the chord length of a grid placed on the surface. You 
can determine the size of the grid by the value you specify in the 
Grid Division Per Span U and Grid Division Per Span V, and the 
corresponding number of spans on the surface. The default grid size is 
4, and the result is a multiple of 4.

Grid Div Per Span U Specifies the number of divisions per span of the 
Chord Length grid along the U parameter.

Grid Div Per Span V Specifies the number of divisions per span of the 
Chord Length grid along the V parameter.

mental ray for Maya shaders

mental ray for Maya nodes 

For more information about mental ray for Maya nodes (shaders), see 
”mental ray for Maya Shaders” on page 39.

Materials

dgs_material

This shader can simulate mirrors, glossy paint or plastic, anisotropic 
glossy materials such as brushed metal, diffuse materials such as paper, 
translucent materials such as frosted glass, and any combination of these. 

Tips: • To see the textured surfaces update, you must view 
them in Render View (Render > Render Current Frame). 
Re-render the scene to see the fixed texture.

• Because computing exact arc-lengths is very expensive, 
Fix Texture Warp is a compromise used to achieve well 
spaced UV texture values with chord length (which 
measures the length of a line drawn between two points 
on the surface). Use this feature to apply textures more 
evenly on surfaces with uneven parameterization.

• Fix Texture Warp is applied on a per-NURBS surface 
basis.

Note: This shader cannot be used as a shadow shader. 
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For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

dielectric_material

This shader is a physically based material shader that can be used to 
simulate dielectric media such as glass, water, and other liquids. 

The shader uses Fresnel's formulas for dielectric interfaces. This means 
that most light is transmitted through the surface for perpendicular 
incident directions while most light is reflected by the surface for grazing 
incident angles, simulating the behavior of real dielectric materials. 

The shader also uses Beer's law for absorption of light that passes through 
a medium. This means that the light is subject to an exponential falloff as 
it is transmitted between two surfaces with dielectric material. 

Two types of dielectric interfaces are supported: dielectric-air simulates 
the interface between a dielectric material and air (such as glass-air), and 
dielectric-dielectric simulates the interface between two dielectric 
materials (such as glass-water). To achieve physically correct simulations 
it is important to use the correct surface interfaces. 

This shader cannot be used as a shadow shader. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_illum_blinn

Perform Blinn illumination, which is a like Cook-Torrance illumination 
(see ”mib_illum_cooktorr” on page 254) but without the color shift with 
angles. It only requires one index of refraction. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_illum_cooktorr

Perform Cook-Torrance illumination, given ambient, diffuse, and specular 
RGB colors, a roughness, index of refraction for three wavelengths, and a 
light list.  With this, you can produce silk-type highlights.

Cook-Torrance illumination has an off-specular peak and a color shift 
with angles. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_illum_hair

This has a fine-tuned sheen-like specular highlight that produces sub-pixel 
anti-aliasing, which helps to render high-quality thin strips, such as hair.
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For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_illum_lambert

Perform Lambertian illumination, given ambient and diffuse RGB colors 
(alpha is ignored). 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_illum_phong

Perform Phong illumination, given ambient, diffuse, and specular RGB 
colors, a specular exponent. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_illum_ward

Perform Ward illumination, given ambient, diffuse, and glossy RGB 
colors, two shinyness parameters, two direction vectors (from a texture). 
Useful to produce anisotropic effects. See also ”mib_illum_ward_deriv” 
on page 255.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_illum_ward_deriv

Perform Ward illumination, given ambient, diffuse, and glossy RGB 
colors, two shinyness parameters. Differs from  mib_illum_ward in that 
the brushing directions are taken from the surface derivatives. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Path_material

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Transmat

This doesn’t alter the ray; instead the ray passes through the material (the 
material is invisible). Use it to create volumetric or participating media 
effects.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.
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Shadow shaders

Shadow shaders determine the appearance of shadows cast from an 
object. This is similar to the Shadow Color attribute on Maya light sources.

Shadow shaders can only be attached to the appropriate input in the 
Shading Group. Shadow shaders are special in that their result color is 
also an input color, which means that the output cannot be attached to 
another shader parameters because such attachments are one-way, 
output-to-parameter only. 

They are referenced when a shadow ray hits an occluding object; the 
shadow shader of the occluding object controls how much light is 
transmitted. 

In a Phenomenon, shadow shaders can only be attached to a material 
inside the Phenomenon, or to the Phenomenon root if the Phenomenon is 
attached to a material's shadow shader. 

mib_shadow_transparency

The transparency shadow shader can be used to assign a (possibly 
transparent) color to an object, and to make it transparent for shadow 
rays. Either a color alpha < 1 or a nonzero transparency cause shadow 
rays to be transmitted through the object. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Volumetric materials

Volume shaders can be assigned to particular objects by connecting to the 
object’s Shading Group. 

This controls the appearance of fog or other volumetric effects inside those 
objects. In mental ray for Maya you can also specify a global volume 
shader to control the appearance of fog outside of the objects in the scene 
(corresponds to Maya’s Environment Fog). In mental ray for Maya, the 
global volume shader is assigned by connecting to the Volume Shader 
attribute in the mental ray section of the camera’s Attribute Editor.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_ray_marcher

The ray marcher casts light rays from points on a given ray, and 
approximates the volumetric contribution from light sources sending light 
through the volume.
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Instead of using shader interface functions like mi_sample_light, it calls a 
shader given as an input parameter of type shader. Ray marching consists 
of calling the shader for regular points between the start point and end 
point of the ray, and adaptively subdividing each of these intervals until a 
given subdivision limit is reached if the color returned by two adjacent 
samples is smaller than a given contrast threshold. The total weighted 
sum is returned. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_volume

A simple volume shader that simulates volume in a linear direction by 
receiving samples from the ray marcher. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

parti_volume

This is an advanced volume shader for simulating volume, such as fog, 
clouds, silty water, and similar media by scattering, absorbing, 
transmitting as the light travels through the volume. 

The volume shader parti_volume can simulate homogeneous (uniform 
density) and nonhomogeneous participating media with isotropic 
(diffuse) or anisotropic scattering. parti_volume and parti_volume_photon 
use a two-lobed scattering model, which means that light scatters both 
forward and back in the incoming light direction. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Displacement shaders

These shaders (not supplied with Maya) can be used to add new details to 
a surface prior to rendering.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Photonic materials

Photon shaders control the reflection, transmission (refraction), and 
absorption of light for caustics and global illumination. 

Advanced users can use these materials to simulate physically correct 
lighting situations. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.
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dgs_material_photon

dgs_material_photon is the photon shader that matches dgs_material. It 
has the same parameters; however, it respects photons and uses global 
illumination to illuminate objects. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

dielectric_material_photon

dielectric_material_photon is the photon shader that matches 
dielectric_material. It has the same parameters; however, it respects 
photons and uses global illumination to illuminate objects. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_photon_basic

This is the basic photon shader that supports diffuse reflection and 
specular reflection and transmission/refraction. Use it to reflect, transmit, 
and absorb photons for global illumination and caustic effects.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

parti_volume_photon

parti_volume_photon is the photon shader that matches parti_volume. It 
has the same parameters; however, it respects photons and uses global 
illumination to illuminate objects. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

transmat_photon

transmat_photon is the photon shader that matches transmat. It has the 
same parameters; however, it respects photons and uses global 
illumination to illuminate objects. It simply traces a photon further in the 
direction it came from. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Textures

Use texture shaders to apply image files on materials, generate procedural 
textures, or determine texture placement.  

All textures in this section are File Texture based. 
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mib_bump_basis

Defines the normals to be used by mib_bump_map or 
mib_passthough_bump_map.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_bump_map

Apply a File Texture with mib_bump_basis o the normal vector by 
evaluating the texture at multiple points to compute U and V gradients 
that are multiplied with the basis vectors, combined with the original 
normal, normalized, and written back. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_passthough_bump_map

This is the same as mib_bump_map, but the normals return to the original 
values after the bump mapping is complete.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_texture_checkerboard

Divide the unit cube into eight subcubes, each with a separate RGBA 
color. Use it to generate stripes and 2D or 3D checkerboards. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Defines the normals to be used by this node
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mib_texture_filter_lookup

Looks up of texture image using elliptical filtering. Use it to reduce 
flickering (moire patterns) or aliasing on a specific surface that has a 
texture.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_texture_lookup

Looks up a texture image. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_texture_polkadot

A procedural texture to generate polkadots.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_texture_polkasphere

A procedural texture to generate 3D polkadots.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_texture_remap

Accepts a texture vertex and scales, rotates, translates, crops, and joins 
textures. The order of operations is transform first, then repeat, alternate, 
torus (wrapping), and finally min/max crop. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_texture_rotate

An angle is used to rotate the surface orientation around the surface 
normal. An orthogonal vector pair is returned that, together with the 
normal which both are orthogonal to, define the rotated orientation. This 
is especially useful for anisotropic reflection. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_texture_turbulence

Create a turbulent scalar pattern in a unit cube. One, two, or all three 
texture vector components may be computed in polar coordinates, causing 
spherical mapping. 
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For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_texture_vector

Return a texture vector derived from orthographic projections of the 3D 
point in space (XY, XZ, YZ), non-orthographic projections (spherical or 
cylindrical); or return a numbered texture vector from the texture vector 
list. Optionally, this shader can base its calculations on object, camera, 
world, or screen space. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_texture_wave

Create cosine waves in U, V, and W directions, each with a programmable 
amplitude. (Frequency and offset can be controlled using a texture 
remapping base shader.) The result is a grayscale color, R=G=B=A, that 
can be remapped using a color map base shader. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Environments 

These are shaders that catch rays leaving the scene, similar to 
Environment textures.

These shaders return colors from color textures that have been mapped to 
finite or infinite distances. Use them  for background or foreground plates. 
Environments must be used for environment shaders; overlays must be 
used for lens shaders; and textures must be used for texture or material 
shaders on a plane or other objects in the scene. 

They can be used either globally or on an object-specific basis. 

mib_lookup_background

Use this to insert background plates, like image planes. 

Place the background plate in the background of the scene so that it 
matches the size of your image resolution. Depending on which shader 
you’re using, you can do the following:

• Environment shaders can place the background plate at infinity. 

• Lens shaders can place the plate in front of the entire scene by 
evaluating the background shader first then casting an eye ray only if 
the returned alpha is less than 1, and blending the results. 
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• Material shaders on an XY-axis-aligned-plane in the scene insert the 
plate at the Z coordinate of the plane if they first evaluate the 
background shader, then cast a transparency ray only if the returned 
alpha is less than 1, and blend the results. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_lookup_cube1

A cube mapping with one image on all six planes. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_lookup_cube6

A cube mapping with six images, one for each plane. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_lookup_cylindrical

A cylindrical mapping that uses one image. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_lookup_spherical

A spherical mapping that uses one image. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Lights 

Light shaders specify the amount of light that a light source contributes to 
a particular surface point, taking into account the intensity and directional 
properties of the light source.

When a light shader is connected to a native Maya light source, all the 
settings on the Maya light source (color, intensity, shadows, and so on) are 
ignored, with the exception of the position and orientation (the light 
shader takes settings from the native Maya light source). 

mib_light_infinite

Infinite (directional) lights cast parallel rays in the light direction. The 
origin is infinitely far away (and left unspecified), and there is no decay. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.
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mib_light_photometric

Uses a vendor-supplied light profiles (IES or Eulumdat) This supplies a 
full description of the physical behavior of the specific light. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_light_point

A point light shader emitting light uniformly in all directions.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_light_spot

The spot light is similar to the point light, except that it also supports 
angle attenuation based on the light direction. It takes the light direction 
and the spread from the light definition. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

physical_light

This models physically correct light sources. The light energy decreases 
quadratically. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_amb_occlusion

This Ambient Occlusion shader is used to calculate how ambient light 
affects the scene. Use it to add more realism in a more efficient way than 
traditional global illumination.

mib_blackbody

The blackbody light utility shader.

mib_cie_d

The CIE D Illuminant light utility shader.

Photon Emitter shaders

These shaders (not supplied with Maya) can be used to specify the 
intensity and directional distributions of the photons emitted by a light 
source
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Light Maps

Use these shaders to bake surface shading effects to image texture files on 
disk. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_lightmap_sample

The lightmap illumination sampling shader is a simple color shader that 
samples the surface light influx density. It gathers direct illumination and 
(optionally) indirect illumination. Assign it not to a material, but instead 
to the input parameter of the mib_lightmap_write node. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_lightmap_write

This is the main lightmap shader. It gathers geometric information and 
texture coordinates on the triangle vertices and then writes a triangular 
region of texture for each triangle. For each pixel of the texture that the 
triangle covers, a sampling function is called and the results are written to 
the shader. The lightmap shader is attached to the appropriate input in the 
Shading Group. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Lenses

These shaders determine how rays of light bend as they leave the camera, 
and can be used to simulate various lens effects such as depth of field. 

Currently the UI only supports connection of a single lens shader to the 
camera. In general, the mental ray render core supports a series of lens 
shaders that are executed in succession.

Mib_lens_clamp

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.Mib_lens_stencil

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Oversampling_lens

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.
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physical_lens_dof

Simulates depth of field by casting multiple eye rays into the scene so that 
an object at the focal distance is sharp and in focus, while objects at other 
distances are blurred. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Output shaders

Output shaders, which are used to postprocess rendered images, are 
connected to the camera using the Output Shader attribute in the mental 
ray section of the camera’s Attribute Editor.

The Framebuffers attributes in that section (color, alpha, depth, and so on) 
control which image channels are passed to the shader and in what 
format. For example, a 2D blur output shader might require 8-bit color, 
floating-point alpha, and motion vectors. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Geometry shaders

These shaders can be used to introduce new pieces of geometry into the 
scene at render time. 

Geometry shaders are connected to transform nodes, which are used to 
determine the position and orientation of the geometry. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_geo_add_uv_texsurf

This shader returns a copy of the input object, which must be of freeform-
surface type. It loops over all faces and adds a Bézier texture surface of 
degree 1 to each face as the last texture surface. The parameters and 
control points of the texture surfaces so that the texture coordinates of the 
triangle vertices are the uv coordinates of the triangle vertex positions. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Note: Even if this option is enabled (in the transform node’s 
Attribute Editor, ... Enable Geometry Shader checkbox), you 
don’t see anything in the Scene Views; you see the geometry 
only when you render. 
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mib_geo_cone

This is a sample geometry shader to be used with 
mib_geo_add_uv_texsurf.

It generates a polygonal cone centered on the Z axis with the apex at Z=0 
and the base at Z= -1. The cone has a radius of 1 at the bottom and a 
height of 1. The cone bottom disc is subdivided into u_subdiv 
subdivisions, the cone side in v_subdiv subdivisions in the Z axis 
direction. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_geo_cube

This is a sample geometry shader to be used with 
mib_geo_add_uv_texsurf. 

It generates an axis-aligned unit cube with volume 1 centered on the 
origin. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_geo_cylinder

This is a sample geometry shader to be used with 
mib_geo_add_uv_texsurf.

It generates a polygonal cylinder centered on the Z axis with the bottom at 
Z=-1 and the top at Z=0. The cylinder has a radius of 1 and a height of 1. 
The two cylinder discs are subdivided in u_subdiv subdivisions, the sides 
in v_subdiv subdivisions in the Z axis direction. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_geo_instance

This constructs an instance of one of a geometry shader that translates, 
scales, and rotates the geometry, and returns a group with the instance of 
the source geometry as its only member. If the result was nonzero because 
the base shader is part of a list, a new group is not created; instead the 
instance is added to the result group.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.
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mib_geo_instance_mlist

Same as mib_geo_instance, but accepts a material array, which is 
converted into a material list in the new instance if the array has more 
than one member. Material lists are useful if the instanced object is tagged, 
meaning its polygons or surfaces carry integers that index into the 
material array. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_geo_sphere

Generates a polygonal sphere with a given number of U and V 
subdivisions, centered on the origin. The sphere is subdivided with 
v_subdiv subdivisions in the Z axis (longitude) and u_subdiv subdivisions 
in the XY plane (latitude). 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_geo_square

Generates a square with area 1 centered on the origin, with the normal 
pointing up the positive Z axis. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_geo_torus

Generates a polygonal torus lying in the XY plane, centered at the origin. 
The torus is defined by two circles: the smaller one revolves around the 
center of the larger circle. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Contour store

Contour store shaders decide what kind of information to store at an 
image sample location. This information allows the contour contrast 
shader to decide whether two samples are different enough to place a 
contour line between them. 

contour_store_function

This shader returns the intersection point, normal, material tag, object 
label (tag), triangle index, color, and the refraction and reflection level. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.
Shading

267



1 | About shading and texturing surfaces
Reference > mental ray for Maya nodes
contour_store_function_simple

This contour store function only stores the material tag. It can be used for 
very fast contour computations if only the outlines of objects need to have 
simple contours.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Contour contrast

contour_contrast_function_levels

This lets you to modulate a threshold within a sample range. It draws a 
contour between two samples, if their sample values differ more than the 
specified threshold.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_contrast_function_simple

This uses a default contrast definition. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Contour shader

These shaders can be used to generate cartoon-like renderings. After the 
contour contrast shaders decide where contours should be drawn, contour 
shaders decide on the contour color and width (and optionally motion, 
normal, material tag, and label). 

contour_shader_combi

This is a combination of the depthfade, layerthinner, and widthfromlight 
contour shaders. 

The width of the contour fades into the background (from near_width to 
far_width), and the color fades from near_color to far_color. The contour 
width and color changes with a ramp function between distances near_z 
and far_z. For each layer the ray has passed through, a factor is multiplied 
onto the width. If no factor is specified, the width will not depend on the 
layer. If a light source is specified, the width also depends on the surface 
normal relative to the light source direction. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.
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contour_shader_curvature

This shader draws contours whose width depends on the curvature (the 
difference in surface orientation). 

If two normals are in nearly opposite directions, there is a contour of 
width close to max_width between them. When the angle between them 
decreases, the width of the contour decreases down to nearly min_width. 
(The width will never reach min_width completely, since the contour 
contrast function will not create any contours where the surface curvature 
is less than ndelta degrees, and ndelta cannot be set to zero without 
getting contours in the interior of all objects.)

At the edge of an object, where the depth difference is large, the maximum 
contour width is used. The minimum width would theoretically occur at 0 
degrees and the maximum width at 180 degrees. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_shader_depthfade

Contours are drawn whose color and width are linearly interpolated 
between two values as specified with the near and far parameter sets. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_shader_factorcolor

This shader draws a contour whose color matches the color of the object 
being contoured, only with a different brightness (usually much darker). 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_shader_framefade

This shader draws contours with a color and width that depends linearly 
on the frame number. Two frame numbers, colors, and widths are 
specified. If the frame number is less than the first frame number, the first 
color and width is used. If the frame number is higher than the last frame 
number, the last color and width are used. If the frame number is in 
between, a linear interpolation of the two colors and widths are used. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.
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contour_shader_layerthinner

With this contour shader, the width of a contour will change depending 
on how many levels of materials are on top of it. If the material is on top, 
its contour will be of a width specified by a parameter. For each material 
on top of it, its width will decrease by a factor that is also controllable with 
a parameter. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_shader_randomtransparency

Contours are drawn with a random transparency, based on the specified 
value. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_shader_randomwidth

Contours are drawn with a random width, based on the specified value. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_shader_simple

A simple contour of constant color and width is applied when  
contour_shader_simple is used. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_shader_widthfromcolor

With the contour_shader_widthfromcolor contour shader, a material gets 
contours whose thickness depends on material color. The thickness 
depends on the maximum of the red, green, and blue color bands (the 
maximum is clamped to 1 if it is larger than 1). When the color is bright no 
contour is visible, and when the color gets darker the contour gets wide. 
The minimum width is used at bright colors and the maximum width is 
used at black. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.
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contour_shader__widthfromlight

Contours are drawn whose width depends on the angle between the 
surface normal and the direction to a light source. The thickness increases 
gradually from min_width when the surface is directly facing the light 
direction to max_width when the surface is facing exactly opposite the 
light direction. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_shader_widthfromlightdir

This shader is a variation of the contour_shader__widthfromlight. It 
accepts a direction explicitly, instead of a light that implicitly provides the 
direction. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Contour output

Contour output shaders are called after the regular image has been 
computed. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_only

This generates a contour image with a given background color in the color 
frame buffer, discarding the rendered color image. See also Hide Source in 
the mental ray tab in the Render Globals Settings window.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_ps

The contour output shader contour_ps creates PostScript code with black 
contours. The PostScript code can be written to a file with a separate 
output statement that specifies the file type ps. This shader does not touch 
the rendered color frame buffer. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

contour_composite

This layers contours on top of a given source.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.
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Sample Compositing

mib_dielectric

Another variation of refraction, with the addition of specularity (Snell's 
law). This shader does only the refraction part of a dielectric material; 
highlights are left to other illumination nodes. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_opacity

Casts a transparency ray of a given intensity and merges the result with 
an input color. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib-reflect

Casts a reflection ray of a given color and merges the result with an input 
color. Use it to add a reflection effect to a base shader that provides 
illumination, possibly in conjunction with refractions or transparency 
added by other base shaders. If no reflection ray can be cast (because the 
trace depth has been exceeded, or the reflection ray caused a shader to be 
called that failed, or the notrace parameter is set), sample the environment 
if there is one. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_refract

Casts a refraction ray of a given color with an index of refraction and 
merges the result with an input color. The indices of refraction can be 
computed with another base shader, such as mib_refraction_index, which 
is also stored back into the appropriate state variables. Use this to add a 
refraction effect to a base shader that provides illumination. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_refraction_index

Decide whether the ray is entering or leaving the object it has hit, based on 
a scan of parent rays (not based on the normal vector). The index of 
refraction ratio (outgoing divided by incoming) is returned. As a side 
effect, both incoming and outgoing indices of refraction are stored in the 
state (ior_in and ior, respectively), and the current volume shader 
becomes the refraction volume if the ray is entering. 
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For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_transparency

Casts a transparency ray of a given color and merges the result with an 
input color. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_twosided

Choose one or the other input color, depending on which side of the 
geometry was hit. This is commonly used as a multiplexing material 
shader, with two other material shaders assigned to the front and back 
parameters. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Data conversion

mib_color_alpha

Convert a color to RGBA grayscale, either by extracting the alpha 
component, by averaging RGB, or by weighting RGB according to a 
physiological color model that emphasizes green and deemphasizes red. 
The resulting grayscale value can also be used as a scalar. The returned R, 
G, B, and A components all have the same value. 

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_color_average

See ”mib_color_alpha” on page 273.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_color_intensity

See ”mib_color_alpha” on page 273.

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_color_interpolate

Given a scalar or a color, perform a lookup and interpolation of a 
multicolor map. The map is a set (not array) of up to 8 colors. The actual 
number of colors is specified by a parameter. 
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For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_color_mix

Accepts a base color and up to 8 inputs (the exact number is determined 
by a parameter), each of which consists of an input color, a weight scalar, 
and a mode. The inputs are evaluated in sequence, each operating on the 
result of the previous one (the first begins with the base color, which 
defaults to transparent black).

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

mib_color_spread

For a full description of this node’s attributes, see the mental ray Shaders 
Guide in the Maya Help.

Miscellaneous

mentalrayPhenomenon

When you create and load Phenomenon, the nodes appear here. See 
”Phenomena” on page 41. 
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About Surface relief

Surface relief is the depressions (low relief) and elevations (high relief) in 
the surface of an object. Examples include the peaks, valleys, and plateaus 
of a planet, or a dimples of a golf ball. 

Although you could model surface relief into an object’s geometry, 
usually it is faster and easier to achieve the same look with textures used 
as bump maps (which create the illusion of relief) or displacement maps 
(which create true surface relief by changing the topology of the object). 

Related topics

”Bump maps” on page 275.

”Displacement maps” on page 276.

Bump maps

Bump maps are grayscale textures you map to objects to create the illusion 
of surface relief (elevations and depressions) on an otherwise flat object. 

Image by 
Christine Beaumont

Image by Matt Dougan
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With bumps maps depressions and elevations look real, but are not, 
because they don’t alter the geometry of the surface the way Displacement 
maps do. Bump maps just change the direction of the surface’s normals 
based on the bump map’s Alpha Gain value. 

Use bump maps to create very shallow reliefs. For example, you can make 
objects look like they are embossed, have shallow rolling hills, and so on.

Because bump maps are not true surface relief, they: 

• cannot cast or receive shadows

• cannot be seen if you silhoutte the mapped object

• take less time to render than displacement maps

Related topics

”Surface relief” on page 275.

”Texture mapping” on page 33.

”Map a 2D or 3D texture” on page 84.

Displacement maps

Note: Although scratches are like little depressions, you can more 
easily achieve them with 2D texture. 

Tip: Map surface relief (bumps or displacements) to the Blinn 
surface material to reduce highlight roping or flickering.

The soft highlights on Blinn surfaces are less likely to cause 
roping or flickering than the harder highlights on Phong 
surfaces. 

Image by 
Christine Beaumont
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Displacement maps are grayscale textures you map to objects to create 
true surface relief (elevations and depressions) on an otherwise flat object. 

With Displacement maps, depressions and elevations become part of the 
geometry of the object, changing the topology, unlike Bump maps that 
only create the illusion of surface relief. 

Displacement maps move an object’s vertices. By default, the height of the 
displacement is determined by the Alpha Gain value in the displacement 
map’s Attribute Editor. If you turn on Alpha is Luminance, the height 
result is based on the intensity of the pixels instead.

Use displacement maps to create shallow or deep surface relief. For 
example, you can create embossing, mountain peaks and valleys, spikes, 
and so on. 

Because Displacement maps create true surface relief, they: 

• can cast or receive shadows

• can be seen if you silhoutte the object

• take more time to render than bump maps, which create the illusion of 
surface relief

Displacement Bounding Box

Because displacement mapping changes the volume of an object, it’s 
bounding box may become too small or too large. 

Bounding boxes, which represent the bounding volume of an object, can 
be used to speed up Maya operations and can make a significant 
difference for complex models. See ”Change bounding box scale” on 
page 283.

Related topics

”Surface relief” on page 275.

”Texture mapping” on page 33.

Note Because displacement changes the geometry of an object, 
displacement mapped objects usually require further 
tessellation (more triangles, which the renderer uses to 
approximate the smoothness of the surface). 

By default, Maya uses Feature-based displacement mapping 
to automatically add more triangles where required. 

Tip
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”Map a 2D or 3D texture” on page 84.

mental ray for Maya displacement

You can displacement map all mental ray for Maya geometry types 
(polygon meshes, free-form objects (NURBS curves/surfaces), and 
subdivision surfaces. 

mental ray uses an adaptive tesselation approach to better fit the details of 
the displacement map. The initial tesselation (for NURBS: after surface 
approximation) is further subdivided to fit secondary criteria, controlled 
by the displace approximation settings. By default, mental ray for Maya 
creates appropriate settings that lead to curvature dependent subdivision 
of the triangles, one form of feature-based displacement mapping. You 
can change these settings by creating or selecting a custom displace 
approximation node in the Approximation Editor (mental ray > 
Approximation Editor). 

Feature-based displacement

By default, Maya uses feature-based displacement mapping to attain high 
quality displacement mapping with the lowest impact on rendering 
resources. Displacement features are parts of the texture used as the 
displacement map that provide the information for the height variations 
(depressions or elevations). 

This technique detects the density of the features in the displacement 
texture (that is, the more detailed areas) and adds triangles to the 
tessellation only where needed, keeping the triangle count to a minimum. 

When using this technique, the tessellation attributes do not have to be set 
high, just high enough to capture the surface shape. 

Tip It’s important to specify an accurate Max Displace value for 
the objects being displaced. The typical approach is to 
derive this value from Maya’s Bounding Box Scale, but this 
is not suitable in all cases.

As an alternative, you can use the Max Displace setting 
(Render Global Settings window, mental ray tab, 
Overrides > Displacement section) to control shape nodes. 

To determine the right value, set the Max Displace to 0, and 
adjust it according to the messages in the Output window.
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Non-feature based displacement 

With non-feature-based displacement the software renderer does not add 
vertices to the geometry being displaced. As a result, many of the features 
in the displacement map may be lost if there are not enough vertices in the 
model. 

Maya tries to alleviate the potential loss by bump mapping (in addition to 
displacement mapping) the displacement map to perturb the normals to 
create the features where there are not enough vertices. In this case, the 
bump map’s Filter Size and Filter Offset attributes (if they have them) are 
automatically adjusted for optimal results.

If the material cannot be bump mapped (for example, Layered Shaders 
cannot be bump mapped), the texture is instead connected as a 
displacement texture and no bump mapping occurs. You should connect 
this texture as a bump map where it makes sense. For example, use the 
displacement texture as a bump map on the various materials connected 
to the Layered Shader. Attach the bump node to all Normal Camera 
attributes in the shading network you have just displacement mapped. 
Also, if you drag a texture onto a displacement node manually within 
Hypershade instead of dragging from Hypershade onto the Displacement 
Material area in the Attribute Editor, no bump map is connected, and the 
displacement may not look right. 

How Do I? Apply colors, shading, and textures

Connect a texture as a displacement map

For more information about displacement, see ”Displacement maps” on 
page 276.

Note: We do not recommend that you turn off Feature-based 
displacement to use non-feature-based displacement.
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To create a displacement map

1 Create a material in the Hypershade and middle-drag the material 
swatch onto the object in the view.

2 Select the material swatch in the Hypershade and click the Input and 
Output Connections button to display its shading group swatch.

3 Double-click the shading group swatch to open the Attribute Editor.

4 Click the box beside Displacement Mat. to open the displacement 
shader’s Attribute Editor and click the box next to Displacement to 
map a texture.

Notes: • Avoid using Environment textures for displacement 
mapping. The basic characteristics of environment 
mapping preclude accurate calculations when used for 
displacement mapping.

• During bump or displacement mapping, if an image file 
contains a mask channel, the mask channel is used for 
displacement and bump mapping. If the mask channel is 
absent, the luminance of the RGB is used to displace 
and, or bump map.

If you prefer to use the luminance information as the alpha, 
turn on the Alpha Is Luminance attribute (in the Color 
Balance section of the file texture’s Attribute Editor).

Tip: Displacement mapped texture results do not display in 
hardware texturing mode (the view) unless temporarily 
mapped to a material’s channel.

You can also use Modify > Convert > Displacement to 
Polygons.
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Set displacement map tessellation 

Connect a displacement map

Because displacement maps alter the geometry of the surface, the textures 
you use as the map should not contain jagged edges (aliasing) or noise. 

To, filter out aliasing and noise before you displacement map a surface, 
see ”Texture filtering” on page 32. 

If you must use a texture with a small amount of noise for displacement 
mapping, use Feature-based Displacement mapping, and adjust the 
Texture Threshold attribute.

Tip Occasionally when you map a texture with distinct features 
to an object, the volume, or size, of the object could change.

Preserve the object’s volume (size) 

To adjust this problem, use a negative Alpha Offset value 
for the texture to bring the size of the geometry back down 
(such as -2). You may also have to adjust the file texture to 
get the desired result.

Hypershade View

Result in Render View 
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Preview the displacement results

To preview the displacement map

Map the displacement texture temporarily to a material’s channel, such as 
Color, which displays the results in the view (with Hardware Texturing 
turned on).

Adjust displacement sampling rates

To determine how to set the Initial and Extra sample rates

1 Make sure the displacement mapped object is selected and its 
Attribute Editor appears. 

2 Display the tessellation triangles of the object. 

3 ”Preview the displacement results” on page 282. 

4 For each tessellation triangle, look at how much texture height 
variation is in the triangle, then (in the Displacement section of the 
object’s Attribute Editor), adjust the Initial Sample Rate.

5 For each tessellation triangle, notice how sharp the features are and 
how many curvy features there are. The sharper the features, the 
higher the Extra Sample Rate needs to be; adjust accordingly.

Convert a displacement to polygons

To convert a displacement to polygons

If the displacement isn’t changing over the course of an animation, 
convert the displacement to a polygon mesh to speed up rendering time.

For any surface, after estimating the sampling rates, use the Create 
Texture Reference Object tool to create a mesh (see ”Create Texture 
Reference Object” on page 90 in the Shading guide for more details). This 
mesh is made from the displaced tessellation.

If not enough texture details are included, try increasing the Initial Sample 
Rate.

If the mesh is too jagged, try increasing both the Initial Sample Rate and 
Extra Sample Rate. You should always set the Extra Sample Rate lower 
than the Initial Sample rate.
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Change bounding box scale

To change the bounding box scale

1 In the Memory and Performance Options section of the Render Global 
Settings window, turn on Use Displacement Bounding Box (it is on by 
default).

2 Estimate how much the surface will grow when it is displacement-
mapped. Consider the following: 

• If the bounding box of the displaced surface will be more than 50 
percent larger than the bounding box for the original surface in 
World Space, open the surface’s Attribute Editor and enlarge the 
bounding box scale. 

• If the bounding box of the displaced surface will be less than 50 
percent larger than the bounding box for the original surface in 
World Space, open the surface’s Attribute Editor and reduce the 
bounding box scale to optimize the rendering speed and memory. 

• If you choose to let Maya automatically compute the proper 
bounding box scale for the displaced object, click Calculate 
Bounding Box Scale in the Attribute Editor and Maya 
automatically sets the bounding box scale for the surface. 

3 Render.

If the estimated bounding box scale is too small, a warning message 
appears in the render log with instructions on how to set the 
bounding box scale correctly. An example message:

Warning: The bounding box is too small for shape 
“surbsSphereShape1”. Reset the bounding box scale to: 
1.56778 1.56778 1.56778. You can use the following mel 
commands: setAttr nurbsSphereShape1.boundingBoxScale -
type double3 1.56778 1.56778 1.56778;

4 Adjust the bounding box scale as recommended in the render log 
message.

5 Render again. 

Warning

Be careful if you have an animation that changes the 
relationship between the displacement and the size of the 
surface being displaced. Choose the most extremely-
displaced frame to perform the Calculate Bounding Box 
Scale operation. Alternatively, animate the value manually.
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What 
went 
wrong?

Bumps and displacements

Troubleshoot:Displacement textures ‘pop’

To prevent a displacement texture “popping,” make sure the surface’s Use 
Min Screen attribute is turned off in the Secondary Tessellation Attributes 
section of its Attribute Editor. 

Use Min Screen tessellates a surface based on its distance from the camera 
and uses the screen space to determine how much tessellation is required 
(as opposed to object or world space). If the surface is moving toward or 
away from the camera and Use Min Screen is on, the tessellation changes 
over time, and the displaced texture pops.

Troubleshoot:My blurred file texture looks 
crisp, not blurred

Maya's file texture node provides controls for blurring the texture (filter 
size and filter offset), but these controls behave differently when the 
texture is applied to a color channel versus a displacement map, so that 
extremely fine details can be captured.

So, though you can bring (for example) a photograph into Maya, use the 
filter size/offset controls to blur it out, and map it to the color of an object 
to see blurry texture on your object when you render, you won’t get the 
same result if you apply that blurred texture as a displacement map. 
Instead, the embossed image looks very crisp.

You have two options to blur the image suitably for displacement 
mapping:

• Increase the filter values, possibly into the hundreds before you begin 
to see blurring of the displacement map 

• Make use of the Pre Filter control to blur the image file before it is 
used for rendering. This applies an image-space filter of a specified 
radius (in pixels) to the image before any operations are done on it. 

Reference Nodes

Feature-based displacement map attributes

”Connect a displacement map” on page 281.

”Adjust displacement sampling rates” on page 282.
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Feature Displacement

Turn on (default) Feature-based Displacement. 

Initial Sample Rate

This rate is used to check the texture values to determine the 
difference between displacement heights and where to introduce new 
vertices. It defines a regular sampling grid in each original tessellation 
triangle. For example, with the default value of 6, the sample grid is 
6x6. 

Try to keep this sample rate to a reasonable value since it does take 
longer to render the higher the value. 

For each tessellation triangle, notice how much texture height 
variation is in the triangle and estimate how many initial samples are 
required to include these features when displacement mapping. 
Consider the following:

• If the original triangle is large and the feature in the triangle is 
fine, then the Initial Sample Rate has to be large to include the fine 
features.

• If the original triangle is small and the features are sparse, the 
Initial Sample Rate does not have to be very large. The default of 6 
may be enough.

Extra Sample Rate

This rate is used to take extra samples to refine the new vertices 
introduced during displacement mapping. Maya adjusts the vertices 
to align with the displacement. 

For each tessellation triangle, notice how sharp the features are and 
how many curvy features there are. The sharper the features, the 
higher the Extra Sample Rate needs to be; adjust accordingly

Always try to set this value at 0 first if the result looks too jagged, then 
increase the value to get the results you need. The default value is 5. A 
value of 20 is usually enough.

In the following examples, the displaced surface on the left only needs 
an Extra Sample Rate value of 0, but the surface on the right needs an 
Extra Sample Rate of 5.

Note: We do not recommend that you turn off Feature-based 
displacement to use non-feature-based displacement.
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Texture Threshold

This value is used to eliminate vertices that do not significantly 
contribute to the displacement. This is a threshold of the percentage of 
the maximum height variation. Any vertex where the variation is 
smaller than this value is not considered. The default value is 0.

Normal Threshold

Determine the angle threshold of the normal difference between two 
adjacent triangles (the angular value is in degrees). If the normal 
difference is higher than the threshold, the edge between these two 
triangles is recognized as a sharp edge. If lower, the normals are 
averaged which produces smooth edges. The default value is 30 
degrees.

Note: It is recommended that you pre-process the texture so that 
it contains as little noise as possible and leave this value at 
the default of 0. Consider the following:

• If render times are high, you can increase default value 
slightly.

• If you have black and white (embossing), the default 
setting of 0 is optimal. 

• If you have smooth displacement, like a bulge, specify 
small values (as close to 0 as possible).

Note: It is recommended that you leave this value at the default 
of 30.

Image by 
Christine Beaumont

Image by 
Matt Dougan
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Bounding Box Scale

Determines the bounding box scale for a displacement map and helps 
to compute the bounding box scale automatically by tessellating the 
object.

Bounding Box Scale lets you estimate the size of a displaced object’s 
bounding box. It is in world space because the displacement is applied 
to vertices in world space. Based on the bounding box scale, Maya 
calculates the new bounding box for the displacement-mapped object.

When you scale the bounding box, make sure it is not too small or the 
displacement may look cut-off or look as though it has holes. The 
default bounding box scale (1.5 in world space) should be adequate in 
most situations; however, if you want large-scale displacement, 
increase the bounding box scale significantly. If you do not increase 
the size enough, artifacts result in the rendered image, but if the 
estimate is too large, Maya may use more memory to render the 
object.

Warning

Be careful if you have an animation that changes the 
relationship between the displacement and the size of the 
surface being displaced. Choose the most extremely-
displaced frame to perform the Calculate Bounding Box 
Scale operation. Alternatively, animate the value manually.
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About Backgrounds

Backgrounds

Typically you render the objects in a scene against a black background 
and composite the rendered images later with an appropriate background 
using compositing software. However, you can insert a background: 

• to avoid having to model background objects or scenery, but want 
them represented, 2Dly, in your scene (especially if you don’t have 
access to compositing software).

• as a temporary reference (especially for rotoscoping or motion 
matching) for modeling or animating objects in the scene.

To create a background, see ”Create backgrounds” on page 293.

Basic color and texture backgrounds

Note: When you create a background in Maya, you create it for a 
specific camera. When you render a scene from that camera, 
the background is included in the rendered image. If you 
render the scene from a different camera, the background is 
not included. For more information on cameras, see ”Maya 
camera types” on page 27 the Lighting guide.

Color backgrounds flood the 
background with a solid color.

Texture backgrounds use a 2D, 3D or 
Environment texture to simulate a 3D 
environment.
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Color backgrounds

A color background floods the background of the scene with a solid color 
(for example, black, white, or red). To create a color background, see 
”Create a basic color background” on page 293.

Texture backgrounds

A texture background uses a 2D, 3D, or environment texture on an image 
plane to simulate a 3D background, or environment. 

To create a texture background, see ”Create a texture background” on 
page 293.

Image file backgrounds

You can import an image, a series of image files, or a movie file and map 
them to an image plane to act as a backdrop for your scene. You can use 
this backdrop in the following ways: 

• As a reference while you build your scene.  

• As the background for your scene instead of you having to build it all. 

• To catch shadows and reflections with the Use Background material 
(see ”Shadow catching” on page 38 in the Lighting guide.

• To produce environments with Environment textures. 

Image planes are automatically created at the camera's far clipping plane. 
They are perpendicular to the camera and parented to it so that even 
when a camera moves or changes the point of interest, the image plane is 
still covers the entire view behind your scene. 

You can create multiple image planes per camera for interesting 
backgrounds, ordered by depth. To create, edit, or position an image 
plane, see ”Create, edit, or position an image plane” on page 293. 

The Image Plane Attributes control the appearance and placement of an 
image plane. For a detailed description of image plane attributes and 
guidelines on how to change them, see ”Image plane” on page 299.

Image file background use an image file, a 
series of image files, or a movie file as a 
background.
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Image plane syntax

When you import an image as an image plane, the syntax must be as 
follows: 

• name.# (or name.#### for multiple frames)

• name.#.ext (or name.###.ext for multiple frames) 

Static image file backgrounds

A static image file background uses a single image file as a background. 
The background image does not change during an animation.

To create a static image file background, see ”Create a static image file 
background” on page 295.

Animated image file backgrounds

You can create an animated image file background using either a series of 
image files or a movie file. (A movie file updates in the views much faster 
than a series of image files.)

To create an animated image file background, see ”Create an animated 
image file background” on page 295.

3D background simulations

An image file background is a 2D image that exists behind the objects in 
the scene. You can, however, simulate a 3D background by creating 
“stand-in” surfaces that represent objects in the background image. An 
object in the scene can then:

• move behind an object in the background image.

• cast shadows onto objects in the background image.

• receive shadows from objects in the background image.

• be accurately reflected by the objects in the background image.

Note: If a moving camera was used to record the original image 
files or movie file that you want to use as a background, 
then you must match the camera’s motion using Maya Live. 
See the Maya Live Guide. 
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For more information, see:

• ”Create a 3D image file background” on page 296.

• ”Create a static image file background” on page 295. 

• ”Create an animated image file background” on page 295.

• ”Create a 3D image file background” on page 296.

Important

Before you create an image file background, you should set 
up the camera, and the camera’s view so that it matches the 
camera used to record the background image. For more 
information about setting up cameras, see ”Maya camera 
types” on page 27 in the Rendering guide.

Note: It is also possible to create a 3D image file background so 
that the objects in the scene accurately reflect the objects in 
the background image.

You would first 
create a stand-in 
surface for the fence, 
then position the CG 
character behind the 
stand-in surface

This background 
image contains a 
fence. You want a 
CG character to 
appear behind the 
fence.
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How Do I? Create backgrounds

Create a basic color background

For more information on basic color backgrounds, see ”Basic color and 
texture backgrounds” on page 289.

To create a color background

In the Environment section of the camera’s Attribute Editor (View > 
Camera Attribute Editor), set the Background Color attribute.

For more information on a camera’s Attribute Editor, see ”Attribute Editor” 
on page 193 in the Lighting guide.

Create a texture background

For more information on texture backgrounds, see ”Basic color and 
texture backgrounds” on page 289.

To create a texture background

1 In the Environment section of the camera’s Attribute Editor (View > 
Camera Attribute Editor), click the Create button to the right of the 
Image Plane attribute. 

Maya creates an image plane and connects it to the camera.

2 Set the Type attribute for the image plane to Texture.

3 Click the texture button for the Texture attribute. 

The Create Render Node window appears.

4 Select the texture you want to use as a background (for example, an 
Environment Texture). 

Maya creates the texture and connects it to the image plane.

Create, edit, or position an image plane

For more information about image planes, see ”Image plane” on page 299.

To create an image plane

1 Select View > Image Plane > Import Image from the current view.

2 Browse to the file you want and click Open. 

A placement icon appears in either the current view or all views, 
depending on the Display mode you set (in all views by default), and 
the Image Plane Attribute Editor opens.
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3 Select an Image File or Texture from the Type drop-down list, then 
click the folder icon next to Image Name to load an image plane into 
the view.

For a description of image plane attributes, see ”Image plane” on 
page 299

To edit an existing image plane

Select View > Image Plane > Image Plane Attributes from the current view 
and choose any of the camera’s image planes you want to edit. 

The selected image plane’s attributes display in the Attribute Editor 
(unless the Attribute Editor has been hidden) 

To position an image plane

Do one of the following:

• Use the Placement attributes to position an image plane relative to the 
camera. See ”Placement” on page 303.

• Use the Placement Extras attributes to control which portion of an 
image file is visible on the image plane. See ”Placement Extras” on 
page 308. 

Tip: Right-click the arrow key of the image plane attribute in the 
camera to display a list of the image planes per camera.
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Create a static image file background

For more information on image file backgrounds, see ”Image file 
backgrounds” on page 290.

To create a static image file background

Do one of the following: 

•  In the Scene View,  click View > Image Plane > Import Image. An 
image plane is automatically created and connected to the camera and 
you are promted to choose the image.

• In the Environment section of the camera’s Attribute Editor (View > 
Camera Attribute Editor), click the Create button to the right of the 
Image Plane attribute. 

Maya creates an image plane and connects it to the camera.
.

• Make sure that the Type attribute for the image plane is set to 
Image File (the default setting).

• Click the folder button for the Image Name attribute. The file 
browser appears.

• Select the image file you want to use as a background, and click 
Open. Maya connects the image file to the image plane.

Create an animated image file background

For more information on image file backgrounds, see ”Image file 
backgrounds” on page 290.

To create an animated image file background

1 Create a static image plane. ”Create a static image file background” on 
page 295.

2 In the image plane’s Attribute Editor,  turn on Use Image Sequence. 

This automatically enters an expression (=frame) into the Image 
Number attribute. The Image Number is equal to the Timeline’s 
current frame.

Tip: Multiple image planes can be created per camera for 
interesting backgrounds, ordered by depth. right on the 
arrow key of the image plane attribute in the camera to 
display a list of the image planes per camera.
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If a non-standard animated image sequence logic is desired, you can 
either edit the expression on the Image Number attribute (right-click 
Image Number and select Edit Expression) and enter the desired 
changes. For example, if you wanted to slow down the image 
sequence to "playback" at half speed you could add a divide by 2 to 
the expression. 

Alternately, you can remove the expression from the Image Number 
attribute and set key frames on the Image Number attribute just like 
animating any other attribute. This allows for complex image 
sequence logic, for example reversing the image sequence or holding 
the first frame, then "playing" then holding the last frame.

To add file formats

Find the getFileSequenceFormats.mel file in the 
Maya6.5\Scripts\Others folder.

Create a 3D image file background

For more information on image file backgrounds, see ”Image file 
backgrounds” on page 290.

To create a 3D image file background

1 Create an image file background for the perspective camera you plan 
to render from (see ”Create a static image file background” on 
page 295 or ”Create an animated image file background” on page 295).

2 Use the background as a reference to create a relatively simple surface 
or group of surfaces to act as stand-ins for the objects in the 
background image that you want to interact with the objects in the 
scene.

For example, if you want an object in the scene to cast a shadow onto 
the floor in the background image, create a plane as a stand-in for the 
floor.

3 Scale and, or position the stand-in surfaces so that they are directly 
over the correct areas of the background image.

4 In Hypershade, select Create > Materials > Use Background, and 
assign the new material to the stand-in surfaces. The stand-in surfaces 
have the same color as the objects in the background image that they 
represent.

5 You can now make objects in the scene appear to move behind objects 
in the background image by moving them behind the stand-in 
surfaces.
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The objects in the scene also appear to cast shadows onto the objects 
in the background image by casting shadows onto the stand-in 
surfaces. Consider the following:

• To make objects in the background image appear to cast shadows 
onto objects in the scene, in the Render Stats section of the stand-
in surfaces’ Attribute Editor, turn on Cast Shadows.

• To make the objects in the scene appear to accurately reflect 
objects in the background image, in the Render Stats section of the 
stand-in surface’s Attribute Editor, turn on Visible in Reflections. 
Visible in Reflections is on by default.

To make objects in the scene accurately reflect the objects in 
the background image

1 Assign a Blinn or Phong material (for example) to the stand-in 
surfaces. Do not use a Use Background material.

2 Map a File projection texture to Color—select As projection when 
applying the texture in the Create Render Node window, or if 
importing a file, select As Projection from ”File > Import Selected 
Image Files” on page 127.

3 Map the background image to the Image attribute, set Proj Type to 
Perspective, and set Link To Camera to the camera with the 
background image. 

The stand-in surfaces now have the same color as the objects in the 
background image they represent and the objects in the scene 
accurately reflect the objects in the background image. However, it 
also means you have to illuminate the stand-in surfaces properly to 
make them look identical to the objects in the background image that 
they represent.

Size and position an image file background

How you position a texture or image file background depends on whether 
the background’s Image Plane attribute is Attached to Camera or Fixed.

When you create a background for a perspective camera, Image Plane is 
Attached to Camera by default. When you move the camera, the image 
plane also moves. You use this setting when you are using the image 
plane as a reference for animating objects in the scene (that is, motion 
matching or rotoscoping), or if you plan to render the image plane as a 
background.

When you create a background for an orthographic camera, Image Plane 
is Fixed by default. When you move the camera, the image plane does not 
move. You use this setting when you are using the image plane as a 
reference for modeling objects in the scene.
Shading

297



3 | Backgrounds
What went wrong? > Remove or hide a background
For more information on image file backgrounds, see ”Image file 
backgrounds” on page 290.

Remove or hide a background

For more information on image file backgrounds, see ”Image file 
backgrounds” on page 290.

To remove a color background

In the Environment section of the camera’s Attribute Editor (View > 
Camera Attribute Editor), set the Background Color to black.

To temporarily turn off a texture or image file background

In the Image Plane Attributes section of the image plane’s Attribute Editor 
(View > Camera Attribute Editor), set Display Mode to None.

To permanently remove a texture or image file background

In Hypershade, select the image plane swatch and either press Delete or 
select Edit > Delete.

What 
went 
wrong?

Backgrounds

Troubleshoot:Grainy or jagged background 
image

Do either of the following:

• Render the scene without a background image then composite the 
rendered image with the background image using compositing 
software.

• Increase Shading Samples and Max Shading Samples (to the lowest 
values that produce acceptable results) for the image plane.
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Reference Nodes

Image Planes

Image plane

The Image Plane’s Attribute Editor automatically disables the attributes 
for procedural textures when image files are used, and disables the 
attributes for image planes when procedural textures are used.

Display

Looking through 

camera The image plane only appears in the camera view in 
which the image plane is connected. 

In all views The image plane appears in all views. Display is set 
to In all views by default.

Display Mode

Controls how the image plane appears in views and in the rendered 
image. The default setting is RGBA. 

None No display in views or rendered image.

Outline A rectangle with diagonal lines in views; full 24 bit 
color image and transparency (alpha) in rendered 
image.

RGB Full 24 bit color image in views; full 24 bit color 
image and transparency (alpha) in rendered image.

RGBA Full 24 bit color image and transparency (alpha) in 
views and rendered image. (If the image file does 
not contain an alpha channel, set Display Mode to 
RGB instead of RGBA.)
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Luminance Grayscale image in views; gray-scale image and 
transparency (alpha) in rendered image.

Alpha Transparency (alpha) in views and rendered image.

Color Gain

A scaling factor applied to all colors in the image plane. Maya 
multiplies all colors in the image plane by the Color Gain color. For 
example, you can color correct an image plane that appears too green 
by setting the Color Gain color to a shade of blue. The default color is 
white (no effect).
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Color Offset

An offset factor applied to all colors in the image plane. Maya adds 
the Color Offset color to all colors in the image plane. For example, 
you can brighten an image plane that appears too dark by dragging 
the slider to set the Color Offset color to a shade of grey. The default 
color is black (no effect).

Alpha Gain

A scaling factor applied to the alpha channel (transparency) of the 
image plane. Maya multiplies all alpha values in the image plane by 
the Alpha Gain value. The slider range is 0 to 1, but you can type in 
higher values. The default value is 1 (no effect).

Image Plane

Attached to Camera Maya attaches the image plane to the camera. 
When you move the camera, the image plane also 
moves. Use this setting when you want to use the 
image plane as a reference for animating objects in 
the scene (such as motion matching or rotoscoping), 
or if you plan to render the image plane as a 
background.

Fixed Maya fixes the image plane in space. When you 
move the camera, the image plane does not move. 
Use this setting when you want to use the image 
plane as a reference for modeling objects in the 
scene.

Click the color swatch
next to Color Gain to
open the Color Chooser
and select a color.

Result with new Color Gain color.
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The default setting is Attached to Camera for 
perspective cameras, and Fixed for orthographic 
cameras. 

If set to Fixed, you can adjust the image plane using 
the “Placement Extras” attributes.

Type

The default setting is Image File. Select from the following:

Image File If set to Image File, the image plane uses the image 
file assigned to Image Name.

Texture If set to Texture, the image plane uses the texture 
assigned to Texture. 

Image Name

The path and name of the image file or movie file 
that the image plane uses when Type is Image File. 
Image files can be in any Maya-supported image file 
format. 

Use Image Sequence

If off (default), the image plane used is the single image file indicated 
by Image Name (the file name and extension). 

If on, the image loaded corresponds to an image from the sequence 
selected, determined by the Image Number.

Image Number

If Use Image Sequence is on, the default expression of “=frame” is 
used to synchronize the image sequence with the Timeline. 

In other words, at frame 1 the image with a numeric value of 1 in it 
will be loaded. At frame 24, the image with a numeric value of 24 in it 
will be loaded. 

By modifying the default expression (or removing it and setting keys) 
for Image Number, you specify alternate timeline to image sequence 
number relations. For example, setting a key frame of the last image at 
the beginning of the timeline and the first image at the end of the 
timeline will result in reversing the sequence. 

Frame Offset 

If Use Image Sequence is on, the default Frame Offset is set to 0, 
which means that the image sequence numeric value corresponds 
exactly to the timeline frame number. If an offset between these values 
is needed, enter the desired offset in frames. For example, if the image 
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sequence numeric value starts at 100 but the animation starts at frame 
1, enter a value of 100 to compensate. Negative offset values are also 
supported.

Texture

The texture the image plane uses when Type is Texture. A texture 
assigned to an image plane does not display in the views.

Placement

Use the Placement attributes to position an image plane relative to the 
camera.

Fit

Controls the size of the image plane relative to the film gate and 
resolution gate. You can choose a Fit option from the drop-down list. 
Best is the default Fit. 

See also ”Turn scene view guidelines on or off” on page 36 in the Rendering 
guide.

Fit is not available if Image Plane is Fixed.

Fill By default, or if you select Fit to Film Gate, the 
image plane fills the film gate.

If you select Fit to Resolution Gate, the image plane 
fills the resolution gate. 
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Maya maintains the aspect ratio of the image on the 
image plane. If the aspect ratios of the image and the 
film gate (or resolution gate) are different, the image 
extends beyond the film gate (or resolution gate) 
and is cropped.

Best By default, or if you select Fit to Film Gate, the 
image plane fits horizontally or vertically within the 
film gate.

If you select Fit to Resolution Gate, the image plane 
fits horizontally or vertically within the resolution 
gate. 

The aspect ratio of the image on the image plane is 
maintained. If the aspect ratios of the image and the 
film gate (or resolution gate) are different, the film 
gate (or resolution gate) extends beyond the edge of 
the image.

Horizontal By default, or if you select Fit to Film Gate, the 
image plane fits horizontally within the film gate.
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If you select Fit to Resolution Gate, the image plane 
fits horizontally within the resolution gate. 

The aspect ratio of the image on the image plane is 
maintained. If the aspect ratios of the image and the 
film gate (or resolution gate) are different, the image 
extends vertically beyond the film gate (or 
resolution gate) and can be cropped.

Vertical By default, or if you select Fit to Film Gate, the 
image plane fits vertically within the film gate.

If you select Fit to Resolution Gate, the image plane 
fits vertically within the resolution gate. 
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The aspect ratio of the image on the image plane is 
maintained. If the aspect ratios of the image and the 
film gate (or resolution gate) are different, the image 
extends horizontally beyond the film gate (or 
resolution gate) and can be cropped.

To Size By default, or if you select Fit to Film Gate, the 
image plane fills the film gate.

If you select Fit to Resolution Gate, the image plane 
fills the resolution gate. 

The aspect ratio of the image on the image plane is 
not maintained. If the aspect ratios of the image and 
the film gate (or resolution gate) are different, the 
image stretches to fit within the film gate (or 
resolution gate).
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Reference > Image plane
Fit to Resolution Gate

Scales the image plane so that it is the same size as the resolution gate 
of the camera. Fit to Resolution Gate has no effect if Image Plane is 
Fixed.

See also ”Turn scene view guidelines on or off” on page 36 in the Rendering 
guide.

Fit to Film Gate

Scales the image plane so that it is the same size as the film gate of the 
camera. Fit to Film Gate has no effect if Image Plane is Fixed.

See also ”Turn scene view guidelines on or off” on page 36 in the Rendering 
guide.

Size

The height and width of the image plane, measured in inches. If the 
image plane is Fit to Film Gate, the Size of the image plane is the same 
as the Camera Aperture. Size is not available if Image Plane is Fixed.

Squeeze Correction

Scales the image plane horizontally when Fit is To Size. If the Pixel 
Aspect Ratio for the scene is different than the pixel aspect ratio of the 
image plane’s image file, adjust the Squeeze Correction attribute to 
compensate for any distortion. The default value is 0.
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Reference > Image plane
Offset

Offsets the image plane horizontally and vertically relative to the film 
gate. Offset is not available if Image Plane is Fixed. Offset is measured 
in millimeters. The default values are both 0.

Depth

The distance of the image plane from the camera, measured in the 
scene’s linear working unit. Depth is not available if Image Plane is 
Fixed.

Placement Extras

The Placement Extras attributes control which portion of an image file is 
visible on the image plane. If Image Plane is Fixed, the Placement Extras 
attributes also control the position and size of the image plane.

Coverage X, Coverage Y

The number of horizontal and vertical pixels of the image file 
displayed on the image plane. The default values for Coverage X and 
Coverage Y are the horizontal and vertical resolution of the image file. 
By decreasing these values, you can limit the portion of the image file 
that is displayed.

Coverage Origin X, Coverage Origin Y

The horizontal and vertical value of the pixel in the image file 
displayed in the bottom left corner of the image plane. By changing 
the Coverage Origin X and Coverage Origin Y values, you can scale 
and offset the image file on the image plane. The default values are 
both 0.

The following diagram shows what happens to the image plane 
placement when you adjust Coverage attributes:
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Reference > Image plane
Center

The position of the center of the image plane (measured in the scene’s 
linear working unit). Center is not available if Image Plane is Attached 
to Camera.

Width, Height

The width and height of the image plane (measured in the scene’s 
linear working unit). Width and Height are not available if Image 
Plane is Attached to Camera.

The following diagramS shows what happens to the image plane 
placement when you adjust center, width, and height attributes:

set to 150 and

Coverage Origin

X and Y set to 10.

Coverage X and Y

Default settings.

Default settings.

Leave all default settings,
but change Y and Z to 
5.0 and 8.0.
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4 Reflection and 
Environment
About Reflection

True reflections

To create true (photorealistic) reflections, you must raytrace the scene, a 
process which can take a significant amount of time, depending on the 
complexity of your scene. To optimize raytracing to reduce rendering 
times you can limit the number of reflections per surface and which 
surfaces reflect. 

Raytracing is a type of shadow rendering where the path of individual 
light rays are calculated from their source (the light) to their destination 
(the camera). For more information on raytracing, see ”Depth map and 
raytraced shadows” on page 35 in the Lighting guide. 

To create true reflections, see ”Create true reflections” on page 312. See 
also ”Create blurry reflections” on page 313.

Simulated reflections

To simulate reflections, which can significantly reduce rendering time, 
you must use a texture as a reflection map. You apply the map to the 
Reflected color attribute of the object’s material to specify how the 
reflected environment looks on the object. 

For more information on maps, see ”Texture mapping” on page 33. 

Environment textures 

Environment textures simulate 3D spaces using a series of image files 
(Env Ball, Env Cube, Env Sphere) or using a computer graphic procedure 
(Env Chrome and Env Sky).

You can use them to create reflections.

You can simulate reflections using the following environment textures: 
Env Ball, Env Cube, and Env Sphere. To simulate reflections: 

• see ”Simulate reflections with Env Ball” on page 314.

Note: Reflectivity vs. reflected color

Reflectivity determines the degree to which a surface 
reflects its surroundings; reflected color (if raytracing is not 
used) determines what is reflected.
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How Do I? > Create true reflections
• see ”Simulate reflections with Env Cube” on page 315.

• see ”Simulate reflections with Env Sphere” on page 316.

When used to map image planes, environment textures do not use the 
reflected direction; they use the camera view direction. This means, for 
example, that in an Env Sky texture, if you want to see the sun on the 
background, it must appear in the view in front of the camera. Use the 
Env Sky manipulator and rotate or scale it until the line representing the 
sun is pointing to the background (you can achieve the same result by 
changing the sun elevation and azimuth). (For more information on image 
planes, see ”Create, edit, or position an image plane” on page 293.)

How Do I? Create reflections

Create true reflections

For more information about true reflections, see ”True reflections” on 
page 311.

You must have at least two surfaces to create true reflections (or a surface 
that somehow curves around so one part of its surface can reflect onto 
another part of its surface). 

You can control which surfaces appear in reflections and which don’t by 
turning Visible in Reflections on or off in each surface’s Attribute Editor. 
(Visible in Reflections is on by default when you create new surfaces.)

Note: Do not map an environment texture to a material’s Bump or 
Displacement parameter. The basic characteristics of 
environment mapping preclude accurate calculations when 
used for displacement mapping. An environment texture 
mapped to Bump produces unpredictable results; Maya 
ignores an environment texture mapped to Displacement. 
For more information on displacement mapping, see 
”Surface relief” on page 275.

Note: To create true (photorealistic) reflections, you must raytrace 
the scene, a process which can take a significant amount of 
time. For more information about raytracing, see ”Depth 
map and raytraced shadows” on page 35 in the Lighting guide.
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How Do I? > Create true reflections
To create true reflections (example)

1 Create a sphere and a plane, and position the sphere over the plane. 
Create a light to illuminate both surfaces.

2 Create a specular material (a Phong or PhongE) and assign it to the 
sphere. The sphere is reflected in the plane.

3 Create a second material and assign it to the plane. The plane reflects 
the sphere.

4 Make each surface a different color so you can see the reflection of one 
in the other.

5 In the Raytracing Quality section of the Render Global Settings 
window, turn on Raytracing. 

This tells Maya to raytrace any surface whose Visible in Reflections/
Refractions is toggled on. These attributes are on by default for all 
surfaces, but raytracing only works when you turn on Raytracing in 
the Render Global Settings window.

To learn more about the Render Global Settings, see ”Render Global 
Settings window” on page 165 in the Rendering guide.

6 Perform a test render to visualize the results. If you want the sphere to 
reflect the plane, open the plane’s Attribute Editor and turn on 
Render Stats > Visible in Reflections.

To test iterations of a scene, see ”Visualize interactively with IPR” on 
page 109 in the Rendering guide.

Create blurry reflections

Blurry reflections Blurry refractions (magnifying glass)

(Uffizi Light Probe image courtesy of Paul Debevec 
(www.debevec.org/Probes)
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How Do I? > Simulate reflections with Env Ball
Raytraced reflections and refractions are typically rendered perfectly 
sharp, but in the real world, no perfect mirror or transparency exists. 
Instead, small-scale impurities reflect or refract light slightly, creating a 
blurry, glossy look. You can now easily render natural looking blurry 
reflections and refractions with mental ray for Maya.

To render blurry reflections and refractions

1 With mental ray selected as the renderer, turn Raytracing on in the 
Render Globals Settings window (see ”Render Global Settings window” 
on page 165 in the Rendering guide). 

2 In the mental ray tab of the desired material’s Attribute Editor, set the 
reflection and, or refraction blur attributes. 

For detailed descriptions of the  of the reflection and, or refraction blur 
attributes (in the mental ray section of the Shading Group node), see 
”mental ray” on page 171.

Simulate reflections with Env Ball

For more information about this texture, see ”Env Ball” on page 236.

To use the Env Ball environment texture, you must map the texture’s 
Image attribute with the image of a reflective chrome ball in the 
environment you want to re-create. You should also create an image plane 
for the camera and map the image plane’s Image Name attribute with the 
image of the environment without the chrome ball.

To create an image of a chrome ball

1 Place a highly reflective chrome ball (sphere) in the environment (real 
world or computer generated) that you want to re-create. 

2 Place the ball at the exact location (in the original environment) where 
you want the model to appear (in the re-created environment), and 
take note of the ball’s distance from any floor/walls/ceiling or large 
objects.

3 Photograph (or render) the ball using a telephoto lens, and take note 
of the camera’s elevation (the angle between the camera’s view and 
the environment’s grid plane), and the camera’s inclination (the angle 
between the camera’s view and the environment’s YZ plane).

The photo essentially contains a compressed sample of the entire 
environment, except for the area directly behind the ball. The highest 
resolution is in the direction of the camera, so the image provides the 
best data compression for that point of view.
Shading

314



4 | Reflection and Environment

How Do I? > Simulate reflections with Env Cube
To re-create environments using Environment Ball

The Env Ball texture can best re-create environments that have no objects 
in their center (that is, near the chrome ball). For example, rooms and 
interiors should not contain furniture, and outdoor scenes should not have 
trees or cars near the chrome ball. (In general, outdoor scenes can contain 
buildings.)

To use a single image of a chrome ball using Environment 
Ball

1 Map a File texture to the Env Ball texture’s Image attribute, and then 
map the image file of the ball in the environment to the File texture’s 
Image attribute.

2 Map the image of the environment without the chrome ball to the 
image plane’s Image attributes.

3 Set the Env Ball texture’s Inclination and Elevation attributes to the 
inclination and elevation of the camera used to photograph the ball.

To obtain accurate reflections for the Environment Ball 
texture

For accurate reflections of the re-created environment on the model, set 
the Environment Ball texture’s Projection Geometry attributes to values 
corresponding to the distance between any floor/walls/ceiling or large 
objects and the chrome sphere when it was photographed.

To position the image planes’s image for the Environment 
Ball texture

To simplify positioning the image plane’s Image, set the Env Ball texture’s 
Eye Space on. 

To model background geometry when using the Environment 
Ball texture

To model background geometry (for example, so you can add shadows, 
lighting effects, or fog to the scene), set the Env Ball texture’s Reflect 
attribute off.

Simulate reflections with Env Cube

For more information about this texture, see ”Env Cube” on page 240.

To make reflections using the Env Cube material

1 Create a material, and map an Env Cube to its Reflected Color 
attribute.
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How Do I? > Simulate reflections with Env Sphere
2 Make the Env Cube’s texture placement object visible in the scene 
views and scale, rotate, translate it, or even animate the 
transformations.

Reflections of the Env Cube are rendered as if the six images in the 
texture were mapped directly onto the six faces of the placement box. 

To use the Cube’s texture placement object

Use Maya’s transform tools with the Cube’s texture placement object to 
adjust the placement of the texture on the object. To see the results, IPR 
render the surface.

Simulate reflections with Env Sphere

For more information about this texture, see ”Env Sphere” on page 246.

Notes: • A hardware rendered environment cube map matches 
the textured 3D view, but compared the software 
rendered result, the front and back images will be 
swapped. 

If you want the hardware rendered result to match the 
software rendered result (which won’t match the hardware 
textured scene view, however), open the Attribute Editor 
for the cube map and swap the images for the front and 
back. 

• About backward compatibility:

To achieve an infinite cube effect for backwards 
compatibility, turn on Infinite Cube. 

Default placement

Rotate Tool 
used to 
adjust Cube 
texture 
placement
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What went wrong? > Troubleshoot:Cube maps swap front and back images
To use the Sphere’s texture placement object

The Sphere environment texture provides a texture placement object to 
adjust the texture on the surface. Use Maya’s transform tools to scale, 
move, or rotate the texture placement object. 

You can also interactively place the texture, or fit it to the object. Select 
either Interactive Placement, which provides you with a special 
manipulator, or Fit to group bbox from the Sphere’s place3dtexture 
attributes.

What 
went 
wrong?

Maya materials and textures

Troubleshoot:Cube maps swap front and back 
images

A hardware rendered environment cube map matches the textured 3D 
view, but compared the software rendered result, the front and back 
images will be swapped. 

If you want the hardware rendered result to match the software rendered 
result (which won’t match the hardware textured scene view, however), 
open the Attribute Editor for the cube map and swap the images for the 
front and back. 
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What went wrong? > Troubleshoot:Cube maps swap front and back images
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5 Atmosphere 
About Fog, smoke, dust, and silt
Maya’s volumetric materials and mental ray for Maya’s volumetric 
materials let you simulate fog, smoke, dust, or other atmospheric effects. 

You can create atmospheric effects such as fog, smoke, dust in the 
following ways: 

• For basic spherical, conical or cubicle effects, create the appropriate 
Maya volume primitive, then assign a Maya volumetric material to it, 
then render with Maya software.

• For more complex shapes, create any geometrical object, then assign a 
Maya volumetric material to it, then render with mental ray for Maya.

• Use mental ray for Maya’s participating media. The workflow 
involves assigning a transfer material to acheive physically accurate 
light participation, with the potential to generate shadows and 
caustics. 

(Alternatively, you can create the effect in post production (that is, outside 
Maya).) 

How Do I? Create fog, smoke or dust 

Simulate fog, smoke, or dust

To simulate fog, smoke, dust, or other atmospheric effects with Maya 
software rendering, you create a volumetric primitive (shape) and assign 
one of Maya’s volumetric materials to the shape. 

mental ray for Maya’s participating media.
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How Do I? > Change the visual effect of fog, smoke, or dust
To create environment fog

In the Render Options section of the Render Global Settings window, click 
the map button beside the Environment Fog attribute. Maya automatically 
creates an environment fog node and an environment fog light node (an 
ambient light).

To adjust the depth range for environment fog

To make environment fog fill a specific region (between two distances 
from the camera), set Distance Clip Planes to Fog Near/Far and adjust the 
Fog Near Distance and Fog Far Distance attributes.

To adjust the vertical range for environment fog

To make environment fog fill a specific vertical region, turn on Use Height 
and adjust the Min Height and Max Height attributes. To make the edges 
of the region gradually blend, adjust the Blend Range attribute.

To create variations in environment fog’s density and color

To create variations in the density and color of environment fog across the 
camera’s view, turn on Use Layer and assign a texture to the Layer 
attribute. (You may need to limit the Depth Range, and increase Volume 
Samples for the environment fog shape to see the effect.)

Change the visual effect of fog, smoke, or dust

For more information about volumetric materials that let you simulate 
fog, smoke, and dust, see ”Volumetric materials” on page 175. 

The Volume Shader lets you connect other attributes and effects directly to 
its color, transparency, and matte opacity. The Volume Shader can be used 
with a Spot Light, Point Light, Environment Fog, and particles.

Try this simple example. By mapping a Volume Shader to a Spot Light’s 
Light Fog, you can map textures to the Volume Shader’s attributes and 
change the fog’s visual effects.

To use the Volume Shader with Light Fog (example)

Use a spot or point light in the scene. This example uses a spot light. 

Important! 

Environment fog cannot cast shadows. If you want to cast 
shadows, use Light Fog. 
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How Do I? > Change the visual effect of fog, smoke, or dust
1 In the spot light’s Attribute Editor’s Light Effects section, click the 
Light Fog map button to map it to the light. 

The spot light’s icon increases in size. If necessary, bump up the Fog 
Spread and Fog Intensity values.

2 In the Hypershade, create a Volume Shader material. 

3 Middle-drag the Volume Shader material swatch over the Spot Light 
swatch and select an attribute, such as color, with which you want to 
map the Volume Shader.

4 Open the Volume Shader’s Attribute Editor and map a texture, such 
as cloud, to the Out Color attribute. The following shows the rendered 
result.

Change the Cloud texture’s attributes to change the fog effects if 
necessary.

Spot Light with Light Fog in view. Rendered result.
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What went wrong? > Troubleshoot:Environment Fog problems
In the next example, the sphere on the left appears flat (2D) because it 
is shaded by a Surface Shader. Notice the absence of shadow on this 
sphere compared to the one on the right. The light fog on the right 
appears flat because it is shaded by a Volume Shader. Notice the 
absence of volume shadows compared to the light fog on the left.

What 
went 
wrong?

Fog, smoke, and dust

Troubleshoot:Environment Fog problems

You may notice the following problems in environment fog in a rendered 
image.

Transparent surfaces look incorrect

Set Ambient Shade to 0 for the environment fog light.

Image by Kelvin Sung
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What went wrong? > Troubleshoot:Environment Fog problems
Jagged surface edges in environment fog

Do one of the following: 

• Turn on Shading Samples Override for the environment fog shape. 
Increase Shading Samples and Max Shading Samples (to the lowest 
value that produces acceptable results).

• Increase Edge Anti-aliasing in Render Global Settings window (to the 
lowest setting that produces acceptable results).

Outlines around 2D motion blurred surfaces

Do one of the following: 

• Remove any transparent objects, fog, and, or glow, and set the 
background color to black. Render the scene, then composite the 
elements you removed with the rendered image using compositing 
software.

• In the Render Global Settings window, set Smooth Value to 0 and turn 
on Smooth Color.

Grainy or flickering environment fog

Do one of the following: 

• Turn on Shading Samples Override for the environment fog shape, 
and increase Shading Samples and Max Shading Samples (to the 
lowest value that produces acceptable results).

• Turn on Volume Samples Override for the environment fog shape, 
and increase Volume Samples (to the lowest value that produces 
acceptable results).
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Reference > Create > Volume primitives
Reference Menus

Create

Create > Volume primitives 

You can use Volume Primitives in conjunction with lights and Volume 
Fog to produce foggy atmospheric volume effects. For information on 
Volume Fog, see ”Volume Fog” on page 182. 

Tip: When rendering  shadow maps with volumes (with mental 
ray), increase the volume samples settings on the volume 
shape. Also try turning on depth jittering and tuning up 
mental ray shadow map settings, such as Softness and 
Samples, on light sources.
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Reference > Create > Volume primitives
Volume Noise 
mapped to 
Cone’s 
Transparency

Sphere Shape Off Cone Shape OffDropoff Shape Off Sphere Shape Off

Cube Dropoff 
Shape

Cube

Sphere Dropoff 
Shape

Fractal mapped to 
Cube’s 
Incandescence

Scale Opacity 
decreased

Sphere, Color 
applied

Cone

Sphere
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Reference > Create > Volume primitives
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6 Baking textures and 
Prelighting 
About Baking illumination and color

In a typical scene, you shade, texture, and light objects to create the look 
you want, then you render. You can instead pre-render materials, textures 
and illumination in a process called baking (by render experts) or 
prelighting (by modeling experts). 

Baking effectively freezes the illumination (and shadow and surface color, 
if wanted) of baked objects into an image file (if you bake to textures) or 
data (if you bake to vertices) that you can later apply to objects.

After you bake objects and apply the prerendered illumination to objects, 
you can simplify the scene by removing lights, materials, and textures 
(shading networks). Instead of computing illumination at render time, the 
renderer instead obtains it quickly from the applied file image or data that 
is produced (depending on what you bake to -- textures or vertices).

When to bake objects

• To accelerate time- and processor-intensive renders, particularly for 
complex shading networks or if mental ray for Maya’s global 
illumination features are involved. 

• To optimize renders for use on simpler display devices (such as a 
console game rendering engine). 

• To achieve lighting effects that would otherwise be difficult to achieve 
in other ways.

• Export to a platform that does not support certain shading effects. For 
example, some graphic APIs only support a limited number of lights, 
and many platforms have a limited amount of texture memory 
available. If you bake the effects of the lights and textures onto the 
geometry, the lights and textures can then be removed from the scene.

Related topics

”Bake-sets” on page 329.

Note: In Maya, baking is called Convert to File texture. See 
”Convert a texture or shading network to a File Texture” on 
page 91.
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About > Baking to textures and vertices
Baking to textures and vertices

You can bake to textures and vertices in mental ray for Maya. 

Baking to textures

When you bake to textures (as opposed to vertices) an image file called a 
light map is created. You can use this light map, which contains the 
material(s), texture(s), and illumination of the baked objects, as a file 
texture to apply to the object. 

Find this light map image file (by default) in the following location: 
Maya\projects\mentalray\lightMap

Baking to vertices

When you bake to vertices (as opposed to a texture) data is created and 
automatically stored in the polygon mesh’s vertex colors. 

A sample can either be stored as color-per-vertex, or used to displace the 
position of a vertex.

• If stored as a color-per-vertex-per-face color, RGB color and alpha 
(transparency) is stored. 

• For displacement, the X,Y,Z coordinates of the vertex position 
changes. Since a sample contains four channels (RGBA), the 
displacement uses the luminance value of the color. 

You can export this data as a texture map.  

Baking with global illumination 

For limitations of baking with global illumination, see ”Troubleshoot 
Global illumination baking limitations” on page 333.

Note: Selecting a surface (A) and baking it, then selecting another 
surface (B) and baking it is not the same as selecting two 
surfaces (A and B) and baking them together. 

This is more noticeable with global illumination, where 
objects bounce and absorb the light of other objects in a 
scene. Once an object is baked it’s assigned a surface shader 
and it no longer reflects light within the scene.
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About > Bake-sets
Final Gather

To bake scenes with Final Gather turned on, decrease the Max Radius 
setting to at least 1/10th of the size of the object being baked. This ensures 
a smooth lightmap (although you may need to adjust to even smaller 
values). 

In regular rendering, Final Gather precomputes Final Gather points based 
on the current view of the camera to achieve good quality for the 
particular view you are rendering. 

This precomputation step does not happen during baking. Instead, the 
Final Gather points are determined by the Final Gather Accuracy settings 
and the Min Radius and Max Radius settings  in the Final Gather section 
of the mental ray Render Global Settings window. These accuracy settings 
are by default set to 0, which means mental ray for Maya automatically 
determines the correct values using the scene size. This is critical for 
scenes that contain a surrounding sphere to model an environment, 
typical for rendering with Final Gather. 

This forces much more Final Gather points to be calculated during 
rendering, therefore raising the quality, but results in longer baking and 
rendering times.

Bake-sets

Though you can perform a simple bake without bothering with them, 
bake-sets are convenient way for those who require more flexibility to 
perform complex baking options (such as game developers). 

A bake-set is a type of set in Maya. Bake-sets define parameters for a 
collection of polygon or NURBS objects. A Maya scene can use multiple 
bake-sets to vary the result of baking.  There are two types of bake-sets in 
Maya. Vertex bake-sets (see ”Vertex Bake Set” on page 334) contain 
polygon objects, and Texture bake-sets (see ”Texture Bake Set” on 
page 334) can contain NURBS or polygon objects.  The type of bake-set 
used determines the available parameters.

Bake-sets let you:

• Easily apply different settings to different objects and bake them all at 
once. 

For example, you can texture-bake objects with different UV ranges or 
output resolution, or vertex-bake objects with different color blending 
or clamping. 

• Group objects to be baked with the same settings, then bake the 
groups all at the same time. 
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How do I? > Create lightmaps by baking textures and vertices
• Override any number of bake settings and save the overrides as a 
preset with a meaningful name. This lets you compare and contrast 
settings, re-baking as needed, without having to manually change 
individual settings.

Assigning objects to bake-sets 

By default, any object in your scene is automatically assigned to the initial 
vertex bake-set or the initial texture bake-set (depending on what you 
choose to bake to) as soon as you bake the object. The initial bake-set lets 
you bake objects with the same settings easily without having to set up 
additional bake-sets. 

If you want to bake objects with different settings, create bake-sets and 
assign objects to them. An assigned object is baked according to the 
attributes of the bake-set to which it is assigned, whether it is the default 
initial bake-set, a texture bake-set, or a vertex bake-set. 

How do I? Bake textures and vertices with mental ray for 
Maya

Create lightmaps by baking textures and 
vertices

Note: Typically, you don’t change the attributes of the initial bake-
set, but if you need to modify one or two of the default 
settings, see ”Adjust bake-set attributes” on page 332.

Note: When baking light maps using mental ray some of the built-
in texture filtering features in Maya can be of great help. For 
example, when a texture bake operation has been 
performed, go to the File Texture node in the shader 
network (by default connected to the outColor channel of 
the assigned SurfaceShader) and under the Effects tab in the 
Attribute Editor adjust interactively using the Filter and 
Filter Offset controls (the Filter Offset control is very 
sensitive and is effective with values in the 0.05 range) to 
get the required smoothness. This may then be converted to 
an unfiltered texture by using the ConvertToFileTexture 
procedure. 
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How do I? > Create a bake-set
Bake vertices

To bake vertices with mental ray for Maya

1 Select the objects for which you want to bake vertices. 

2 Do either of the following: 

• In the Rendering menu set, click Lighting/Shading > Batch Bake  
> 

• In the Modeling menu set, click Edit Polygons > Color > Polygon 
Prelight (mental ray) >  

3 Adjust any attributes, then click Convert and Close or Convert.

For a description of the options, see ”Lighting/shading > Batch Bake 
(mental ray) > ” on page 334.

Bake textures

To bake a texture

1 Select one or more objects you want to bake.

2 Click Lighting/Shading > Batch Bake (mental ray) > 

3 Set any options, then click Convert or Convert and Close.

For a description of the options, see ”Lighting/shading > Batch Bake 
(mental ray) > ” on page 334.

Create a bake-set

You can create your own bake-sets to be able to bake objects in different 
ways. To create a bake-set, you must have an object in your scene that you 
want to assign to the bake-set. 

To create a bake-set

1 Selected one or more objects for which you want to create a bake-set. 

2 Use one of the following methods to assign the bake-set:

• Click Light/Shading > Assign New Bake-Set > Texture Bake-set 
(to create a Texture bake-set) or Vertex Bake-Set (to create a Vertex 
bake-set).

• Right click the object, then select Baking > Assign New Bake-Set > 
Texture Bake-set or Vertex Bake-Set.

• Use the MEL command:

createNode [textureBakeSet|vertexBakeSet]
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The new bake-set’s attributes appear in the Attribute Editor (unless 
the Attribute Editor has been hidden).

3 Adjust the bake-set’s attributes, see ”Adjust bake-set attributes” on 
page 332.

Adjust bake-set attributes

To adjust the attributes of a bake-set

1 Do one of the following: 

• If the bake-set’s attributes are shown in the Attribute Editor, 
proceed to the next step. (If you can’t see the Attribute Editor, 
make sure it is not hidden.)

• If the bake-set’s attributes are not shown in the Attribute Editor, 
right-click the object, the select Baking Attributes. 

• To select a bake-set without selecting an object, you can select it 
from the tab that contains bake-sets in the Hypershade. If you do 
not see a tab that contains bake-sets, you must create one. See 
”Create a Bake-set tab in Hypershade” on page 333. 

2 Adjust the attributes. 

For a description of the attributes, see ”Texture Bake set” on page 335 
or ”Vertex Bake-set” on page 338

Assign objects to existing bake-sets

After you create a bake-set, you can assign any additional objects you 
create to that bake-set. 

To assign objects to existing bake-sets

• Assign each object, instance, or group to be baked to a bake-set, using 
one of the following methods:

• The Maya Relationship Editor 

• Lighting/Shading menu > Assign Existing Bake-Set > then choose 
from the list of existing bake-sets.

• Right-click the bake-set node in the Hypershade, then click Assign 
Selection to Bake Set.

• Right-click the object, then select Baking > Assign Existing Bake-
Set > then select the Bake-Set.

• Use the MEL command. For example:

sets –add myBakeSet nurbsSphere2;
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What went wrong? > Create a Bake-set tab in Hypershade
To change the attributes of the initial bake-set

1 Select any object in your scene.

The object’s attributes appear in the Attribute Editor. 

2 Select the initial bake-set tab. 

3 Set any of the attributes.

To change the attributes of the initial texture bake-set, see ”Texture 
bake-set attributes” on page 336.

To change the attributes of the initial vertex bake-set, see ”Vertex 
bake-set attributes” on page 338.

Create a Bake-set tab in Hypershade

You can create bake-set tab in the Hypershade to be able to view and 
select bake-sets.

To create a Bake-set tab

1 In the Hypershade, click Tab > Create New Tab.

2 In the Create New Tab window, type in the New Tab Name field a 
name, such as Bake-sets.

3 In the Show Nodes Which Are field, select Bake Sets.

4 Click Create.

What 
went 
wrong?

Troubleshoot Global illumination baking 
limitations

The following limitations apply when baking global illumination:

• motion blur may not appear in light maps 

• volumes and fog are not recognized in light maps

• the alpha channel is always rendered into file textures

Troubleshoot 32 bit TIFF and IFF images are 
black and have no color information

If you view 32 bit TIFF or IFF images in FCheck and they are black and 
contain no color information, use the mental ray Image Display 
(imf_disp) utility to view them. The imf_disp utility is located in the 
maya6.5/bin/imf_disp directory. For more information on how to use the 
utility, see the mental ray User Manual available from the Maya Help.
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Reference Menus

Rendering menu set

Lighting/shading

Lighting/shading > Assign New Bake Set 

Creates a new bake-set and assigns selected objects to it. 

Items

Texture Bake Set

Creates a new texture bake-set and assigns selected objects to it so that 
you can creates light maps with mental ray for Maya. 

For more information, see ”Bake-sets” on page 329.

Vertex Bake Set

Creates a new vertex bake-set and assigns selected objects to it so that 
you can create light maps with mental ray for Maya. 

For more information, see ”Bake-sets” on page 329.

Lighting/shading > Assign Existing Bake Set 

Assigns selected objects to existing bake-sets. 

For more information on bake-sets, see ”Bake-sets” on page 329.

Lighting/shading > Batch Bake (mental ray)

Bakes selected objects with their respective bake-set settings. 

For more information on bake-sets, see ”Bake-sets” on page 329.

Lighting/shading > Batch Bake (mental ray) > 

Objects to Bake

Select from this list to bake all objects, or only selected objects.

Skip objects in initialBakeSets

If you select Select All from the Objects to Bake option, then all objects 
that are not assigned to the initial bake-sets are baked. 

For information about initial bake-sets, see ”Assigning objects to bake-
sets” on page 330.
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Reference > Texture Bake set
Bake To

Bake either textures or vertices. The default is Texture when you 
access this window through the Lighting/Shading menu. If you select 
vertices, vertices are baked in the same manner as ”Bake vertices” on 
page 331.

Color Mode

Lets you bake only light, only global illumination, or light and color 
(that is, with surface color) object(s). This is the converse of Maya’s 
Bake Shading Group Lighting option, which allows you to bake only 
surface color vs. surface color with illumination. 

Bake Shadows

Enable this option to bake shadows.

Orthogonal Reflection

This option is off by default, which is useful if you are baking in order 
to accelerate software rendering and the reflections are only viewed 
from the baked position. However, the textures or vertex colors it 
generates are not for use as textures in a game engine. When turned 
on, the Orthogonal Reflection option causes all reflection rays to be 
orthogonal to the surface being baked. They are no longer true 
reflection rays, pointing instead parallel to the surface normal vectors, 
but the resulting baked texture or vertex colors are meaningful when 
viewed later from any direction.

Use Face Normals

mental ray for Maya lets the user specify the use of face normals for 
baking instead of interpolated vertex normals, as usually used for 
rendering.

Normal Direction

Determines in which direction the normals of the object to be baked 
should be pointing. 

Nodes

Bake-set nodes

Texture Bake set

For more information on bake-sets, see ”Bake-sets” on page 329.
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Reference > Texture Bake set
Texture bake-set attributes

Filename Prefix

Any bitmaps generated by this bake-set are prefixed with what is 
typed in this box. When Bake to One Map is checked, what you type 
in this box becomes the filename. 

x resolution, y resolution 

The horizontal and vertical resolution of the image file, measured in 
pixels. The slider range is 1 to 512. The default value is 256.

File format

Lets you choose a format in which to save the file texture. The default 
is IFF.

Bits per channel 

Specifies the number of bits per channel to use in the output bitmap.

Bake to One Map

Any objects assigned to this bake set is baked to the map. (Make sure 
the object’s UVs are not overlapped.) 

Bake Alpha 

Turn this on to bake the alpha channel (equivalent to Maya’s Bake 
Transparency option) and then select an Alpha Mode.

Alpha mode

When Bake Alpha is turned on, the Alpha Mode specifies how it’s 
computed. Select one of the options, which include Pass Through 
(alpha as output from shading network) Surface Transparency, 
Luminance of Surface Color, and Coverage. 

Note When you turn Bake Alpha on, the transparency connection 
is automatically made for you when you add a surface 
shader.

Note The Pass Through option is mainly for custom shader usage 
within Maya. The returned baked color alpha component is 
retained and is not further affected by Maya's matte 
channel. Custom shaders usually set the fourth component 
of a mental ray color to provide the alpha channel.
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Reference > Texture Bake set
Final Gather Reflect 

Determines the reflectivity of an object when precomputing final 
gather points for light mapping. This simplifies the simulation of 
reflective objects whose texture maps include contributions from 
objects that surround them. For example, if the Final Gather Reflect 
value is set to 0.25, every fourth final gather point is precomputed on 
the object hit by the reflection ray.

UV range 

Specifies whether to bake the area in UV space from [0,0] to [1,1], bake 
the entire UV space, or bake a manually specified space range.

U min, U max 

Slider values specify how much to stretch the sampling range of U or 
V components. Maya stretches the sample region to fit the output 
image size within the [0,0] to [1,1] sampling range.

V min, V max 

Minimum V and maximum V for baking.

Fill texture seams

If the selected UV space contains boundaries, these boundaries may 
appear as black stripes in renderings that use the baked textures. This 
occurs when the texture is sampled so close to a boundary that the 
filter picks up values (generally black) from outside the desired space. 

This setting artificially extends the boundaries by a small amount to 
alleviate this problem. It is measured in texels (pixels of texture). 
Typically, the filter is only a few texels in diameter and can only reach 
as far as its radius into these boundary spaces, so a value of 1 or 2 is 
usually enough.

Fill scale

This option carries out a boundary detection in the UV space to be 
baked. If UVs are normalized to the unit square and the mesh is finely 
tessellated, accuracy problems (such as zero-size triangles) can occur. 
Temporary up-scaling the UVs helps in this case.

Override mesh UV set assignments

Activate this option to bake meshes as if they were in the specified UV 
set instead of the UV sets to which they are currently associated.

UV set name

The UV set to use for the meshes in this textureBakeSet.
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Reference > Vertex Bake-set
Occlusion Rays 

This attribute determines the number of occlusion rays to trace per 
sample point. Increasing the number of occlusion rays improves 
quality, but reduces performance speed. The default is 64.

Occlusion Falloff

This attribute determines the maximum length of an occlusion ray. 
Rays longer than this value are not considered for occlusion.

For texture bake-sets, if Final Gather is not used, occlusion is 
computed for all sample points. Although this takes time, the result is 
very sharp light maps. If Final Gather is used, and the final gather 
quality is greater than 0, the occlusion is pre-baked into a final gather 
map. This final gather map can then be interpolated during rendering 
providing quick results at a reasonable quality.

Vertex Bake-set

For more information on bake-sets, see ”Bake-sets” on page 329.

Vertex bake-set attributes

Bake Alpha

Turn this option on to bake the alpha channel (equivalent to Maya’s 
Bake Transparency option). When this option is turned on, you can set 
Min Alpha and Max Alpha values, and the Alpha Blending method. 
This attribute is off by default.

Bake Color

Turn this attribute off when you do not want to bake the color 
channel. When this option is on, you can set Min Color and Max Color 
values, and the Color Blending method. This attribute is on by default.

Scale Rgba

Scale vertex colors by the specified value.

Clamp Min, Clamp Max

Turn on these attributes to clamp the minimum and maximum color 
and alpha values so that the values are forced to be within the set 
range.

Min Alpha

The lower clamp limit for the alpha channel.

Max Alpha

The upper clamp limit for the alpha channel.
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Reference > Vertex Bake-set
Min Color

The lower limit to which to clamp vertex color.

Max Color   

The upper limit to which to clamp vertex colors.

Occlusion Rays 

This attribute determines the number of occlusion rays to trace per 
sample point. Increasing the number of occlusion rays improves 
quality, but reduces performance speed. The default is 64.

Occlusion Falloff

This attribute determines the maximum length of an occlusion ray. 
Rays longer than this value are not considered for occlusion.

Vertex Color Filtering

Filter Size

If final gathering is baked to vertices and the scene contains high 
frequency information, discontinuities in the color channel may 
become visible. This artifact becomes especially apparent if low final 
gather quality settings are used. Filtering baked vertex colors yields 
the desired smooth look. 

Provide a small positive filter size as argument to this parameter (it is 
multiplied by the object's bounding box size to obtain the absolute 
size). Set the Filter Size value to -1  to turn filtering off. Set the value to 
0 or larger to turn it on. 

Start with values in the 0.1 range as this value is multiplied by the 
object’s bounding box size to obtain the absolute size. This process 
also allows smaller values to be used for the FinalGatherRays attribute 
in the Render Globals Settings Window for faster performance 
although accuracy of results may need to be taken into account.

Lower final gather quality settings require larger filter sizes to get a 
smooth look and renders are less accurate. In general, the final gather 
quality should be raised as long as rendering times are acceptable; 
then the filter size should be increased until the desired smooth look 
is obtained. A tiny filter size may suffice; it enforces that baked colors 
are shared at vertices which have identical positions and normals. 

Filter Normal Tolerance

The filter normal tolerance in degrees (0 to 180). 

This lets you adjust the angular tolerance for smoothing value across 
faces. 
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Reference > Vertex Bake-set
Vertices whose angular separation is greater than the entered value 
are not taken into consideration for filtering so that crisp transitions 
are maintained across hard edges, and undesired color bleed doesn’t 
occur.

After adjusting this option, repeat the prelight operation to test. When 
a fairly smooth result is obtained, use the Filter Size to adjust further. 

Color Blending

Merges existing vertex colors with the ones just baked, if any. Select a 
merge method from the Color Blending drop-down list.

Alpha Blending

Merges existing vertex alphas with the ones just baked, if any. Select a 
merge method from the Alpha Blending drop-down list.
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7 Render node utilities
About Render node utilities
Maya provides various render node utilities that let you expand the 
functionality of or obtain information about the way in which some 
rendering nodes are used. 

General utilities

Maya’s General utilities are used to add detail and create interesting 
effects for textures.

For a description of each of the general utilities and what you can use 
them for, see ”General utilities” on page 368.
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About > 
Color utilities

You can expand, enhance, or manipulate colors in applied textures using 
the Color utilities. For example, you can blend colors, adjust contrast, and 
convert HSV to RGB. 

For information on color utilities, see ”Color utilities” on page 392.

Switch utilities

Switch utilities let you apply textures, or parts of textures to different 
patches that make up one object. 

Several objects can share shading characteristics and you can define 
unique characteristics on an object-by-object basis using Maya’s Switch 
utilities.

For a description of each of the switch utilities and what you can use them 
for, see ”Switch Utilities” on page 397.

Particle utilities

For information, see ”Particles” on page 19 in the Dynamics guide. 

Image planes

Image planes are attached to cameras. For information on image planes, 
see ”Create, edit, or position an image plane” on page 293. 

Note: For StudioPaint users:

It is common to use Switch utilities when textures have 
been imported from StudioPaint since each surface has an 
individual texture assigned to it, but surfaces are in the 
same shading group.
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How do I? > Use the Bump 2d utility
Glow

For information on the Optical FX Glow utility, see ”Optical FX Attributes” 
on page 131 in the Lighting guide. 

How do I? Use General utilities

Use the Bump 2d utility

For a description of the Bump 2D utility, see ”Bump 2d” on page 369

To bump map layered textures using Provide3d Info

1 Map a 2D texture to a material’s Bump Mapping attribute.

2 Map a 3D texture to one of the 2D texture’s Color attributes (such as V 
Color).

3 Double-click the bump2d swatch in the Hypershade to open the 
bump2d’s Attribute Editor and turn Provide3d Info on. Maya bump 
maps both textures.

To cascade, or stack, bump maps

1 In the Hypershade, create two 2D textures and a material.

2 Create a Bump2d utility node.

3 Middle-drag the first 2D texture swatch over the Bump2d utility 
swatch.

4 Create another Bump2d node and middle-drag the second 2D texture 
swatch over the new Bump2d utility swatch. 
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How do I? > Use the Bump 2d utility
5 Middle-drag this Bump2d swatch over the first Bump2d swatch. 

The Connection Editor appears. 

6 From the Right Display menu, select Show Hidden.

7 From the Left Display menu, select Show Hidden.

8 Select Out Normal from the Outputs column and the Normal Camera 
from the Inputs column.

9 In Hypershade, middle-drag the first Bump2d utility swatch over the 
material swatch to assign both bump maps to a material’s attribute.

Bulge 
bump map.

Fractal bump 
map.

Bulge + Fractal 
bump maps.
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How do I? > Use the Bump 3d utility
To delete a bump2d map

1 Open the material’s Attribute Editor.

2 Right-click the word Bump Mapping.

3 Select Break Connection from the pop-up menu.

Use the Bump 3d utility

For a description of the Bump 3D utility, see ”Bump 3d” on page 370.

To delete a bump3d map

1 Open the material’s Attribute Editor.

2 Right-click the word Bump Mapping.

3 Select Break Connection from the pop-up menu.

Use the Clear Coat utility

For a description of the Clear Coat utility, see ”Clear Coat” on page 371

To create a clearcoat node

1 First load Clearcoat using the Plug-in Manager (Window > Settings/
Preferences > Plug-in Manager).

2 Open the Hypershade (Window > Rendering Editors > Hypershade). 

3 In Hypershade Create Bar, select Create Utilities from the pop-up 
menu, then select the Clearcoat plug-in from the General Utilities tab. 
(Close then re-open the Hypershade or the Create Render Node 
window, if open, to see the plug-in.

4 Middle-drag the Clearcoat swatch to create new clearcoat nodes.

Tip: If you bump-map a material that uses environment maps, 
connect the Out Normal attribute of the bump node to the 
Normal Camera attribute of the Environment texture, as 
well as to the Normal Camera attribute of the material. 
Otherwise, the environment does not reflect correctly in 
bumpy areas. 

Maya provides a MEL script that does this for you. After 
you connect the Out Color of the environment map to the 
Reflected Color of the material, type cnctBumpProjNormal 
shader-name in the command line (where shader-name is the 
name of the material).
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How do I? > Use the Condition utility
Use the Condition utility

For more information about the Condition utility, see ”Condition” on 
page 372.

To map the Condition utility to four textures (example)

Create a material, assign it to an object, then map the Condition utility to 
the material’s Color attribute. Adjust the material’s attributes if necessary.

In the Condition’s Attribute Editor, set the following:

• Map a texture to First Term. This texture represents the Second Term’s 
texture coverage.

• Map a texture to Second Term. This texture represents the pattern of 
the coverage.

• Map a texture to Color If True. This texture represents the surface 
color.

• Map a texture to Color If False. This texture represents the color of the 
overlying texture.

• Change the attributes for each texture and use the texture placement 
object to adjust the texture on the object if necessary.

• Use the Operation drop-down list items to see the transition between 
textures.

Use the Height Field utility

For a description of the Height Field utility, see ”Height Field” on 
page 374

To use the Height Field utility

1 Create the Height Field utility node (from the Hypershade select 
Create > General Utilities > Height Field).

A plane is created. Scale it if desired.

2 Create a texture and map it to the Height Field utility node’s 
displacement. 

3 Adjust the displacement of the plane by adjusting the texture’s Alpha 
Gain value. 

Tip: Set the Operation option to Greater Than or Less Than to 
see the combined results.
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How do I? > Use the Light Info utility
To improve the appearance of the shading press 6. You can also set 
the resolution that the Height Field utility uses. It can only display 
Surface textures or the Ocean Shader. 

Use the Light Info utility

For a description of the Light Info utility, see ”Light Info” on page 375.

To view and connect Light Data attributes to Light Info 
attributes

1 Once you have created lights in the scene, select Lights from the 
Hypershade menu bar to view the LightShape swatches in 
Hypershade.

2 Select Light Info from the Create > General Utilities menu. 

3 Ctrl+middle+drag the LightShape swatch over the Light Info swatch. 
The Connection Editor appears. 

4 In the light’s column, make sure Show Readable is on in the Filter 
menu. In the Light Info column, make sure Show Inputs only is on.

5 Click to connect the LightShape’s World Matrix [0] attribute to the 
World Matrix attribute of the Light Info node.

Notice the light tab added to the top of the Light Info’s Attribute 
Editor. Click this tab to access the light’s information and adjust these 
values to translate and change the light in X, Y, and Z.

You can also select any one of the Light Data attributes from the 
Connection Editor. Light Data attributes include the light direction, 
light intensity, light ambient, light diffuse, light specular, and light 
shadow fraction.

6 Select the attribute you want to connect from the list. 

Use this information as the input to other shading nodes to produce 
interesting effects. For example, if you connect the Sample Distance 
attribute to one of the color attributes of a material, the color changes 
depending on how far it is from the light. 

Use the Multiply Divide utility

For a description of the Multiply Divide utility, see ”Multiply Divide” on 
page 377.

Note: You can attach the World Matrix of any object (not just a 
light) to this node, to get information about the object’s 
position relative to the point being shaded. 
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To multiply and divide input attributes

1 In a material’s Attribute Editor, map the Multiply Divide utility to the 
Color attribute.

2 In the Multiply Divide Attribute Editor, map textures to the input 
attributes. Click the boxes next to Input 1 and Input 2 to and select 
textures from the Create Render Node window. 

3 Click the Input 1 and 2 boxes to access the Attribute Editors for the 
mapped textures and change the attribute settings if necessary.

Use the Plus Minus Average utility

For a description of the Plus Minus Average utility, see ”Plus Minus 
Average” on page 379.

You can make several connections to the same attribute using Plus Minus 
Average based on a number. The last part of the attribute name has a 
number within square brackets.

Input3D[0] designates the first connection to the Input3D attribute, 
Input3D[1] designates the second connection to this attribute, Input3D[2] 
designates the third connection to this attribute, and so on. The first 
connection is always assigned a 0. Each connection gets its own ID 
number. For example, the OutColor of Stucco consists of one group of 
three values that you can connect to the Input3D values, not the Input 2D 
values or Input1D values.

Use the Projection utility

For a description of the Projection utility, see ”Projection” on page 381.

To map a Projection utility node to a texture

1 Create a Projection utility node.

Tip: To return the focus to the Multiply Divide Attribute Editor, 
either click the Focus button in the texture’s Attribute Editor 
until you access it, or click the Multiply Divide swatch in 
the Hypershade panel.

Tip: You can rearrange connections to a higher or a lower 
number without interfering with the other connections in 
the list, and you can break connections as you would any 
connection.
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How do I? > Use the Stencil utility
2 In the Projection node’s Attribute Editor, map a texture to the Image 
attribute.

3 Adjust the texture attributes if necessary, then create a material.

4 Middle-drag the Projection swatch over the material swatch and select 
an attribute from the pop-up menu, such as Color. 

You can now use the Projection Attributes (next) to adjust the texture 
placement on the surface.

Use the Stencil utility

For a description of the Stencil utility, see ”Stencil” on page 386.

To map a Stencil to an object

1 In a material’s Attribute Editor, map the Stencil utility to the Color 
attribute.

2 In the Stencil’s Attribute Editor, map a 2D texture to the Image 
attribute. 

3 Assign the material to the object and adjust the Stencil’s attributes as 
necessary.

To use the Key Masking attribute

1 Turn Key Masking on. Since the Color Key attribute’s default color is 
black as well as the Stencil’s Default Color, Maya masks out only the 
areas containing the most black.

2 Change the Color Key color in the Color Chooser. In the following, 
Maya masks out any color containing red or pink and replaces it with 
the Stencil’s Color Balance Default Color.

Tip: IPR-render to view the result as you adjust attributes.

File texture.

After you turn 
Key Masking on.
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How do I? > Use the Reverse utility
Use the Reverse utility

For a description of the Reverse utility, see ”Reverse” on page 388.

In the following, the color of a Marble texture is reversed. This means that 
0.9 is subtracted from 1, making the color value 0.1. The result can be 
expressed as in the following formula:

Output = 1 - Input

You can enter values for Input to get the effect you want in the Attribute 
Editor. Reverse outputs and accepts single-component values, two-
component values, and all three-component values.

To reverse attributes

1 Map a texture to a material’s attribute, such as Color.

2 In the texture’s Attribute Editor, map Reverse to the attribute you 
want to reverse. 

In this example, Reverse is mapped 
to the Marble texture’s Filler and Vein 
colors.
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3 Following the above example, in the Marble texture’s Attribute Editor, 
click the box next to Filler Color to open the Reverse Attribute Editor 
and change the Input attribute values as necessary. The following 
shows the results.

Use the Sampler Info utility

For a description of the Sampler Info utility, see ”Sampler Info” on 
page 388.

To use the Sampler Info utility

Once you have created and assigned a material and texture to an object, 
create a Sampler Info utility node.

1 Middle-drag the Sampler Info swatch over the texture swatch. 

The Connection Editor appears.

2 Connect a Sampler Info node to any available texture attribute.

3 In the Sampler Info Attribute Editor, change the values for the 
connections to get the desired results. 

In this first example, the SamplerInfo’s Facing Ratio attribute is 
connected to the Marble texture’s Vein Width.

Change these values.

Before Reverse.

After Reverse.
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In the following example, the SamplerInfo’s Point Obj attribute is 
connected to the Marble texture’s Ripple attribute.

Result when 
Facing Ratio is 
connected to 
the Marble’s 
Vein Width.

Hypershade view.
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Use the Set Range utility

For a description of the Set Range utility, see ”Set Range” on page 390.

To set the range using the Set Range utility

1 In a texture’s Attribute Editor, map the Set Range utility to an 
attribute.

The texture attribute changes as soon as you map it to the Set Range 
utility.

Result when 
Point Obj is 
connected to 
the Ripples 
attribute.

Hypershade view.
Shading

353



7 | Render node utilities
How do I? > Use the Vector Product utility
2 Click the box you mapped the attribute to. The Set Range Attribute 
Editor appears. Adjust the values as necessary.

Set Range Attributes

Value

Maya maps this value from the old range (Old Min to Old Max) into 
the new range (Min to Max).

Min/Max

The minimum and maximum value in the new range.

Old Min, Old Max

The minimum and maximum value in old range.

Use the Vector Product utility

For a description of the Vector Product utility, see ”Vector Product” on 
page 390.

To multiply a vector

1 Create a material.

2 In the material’s Attribute Editor, map Vector Product to an attribute, 
such as Color.

3 In the Vector Product’s Attribute Editor, map textures to Input 1 and 
Input 2. 

The following examples show the rendered result when you map 
Input 1 to a Checker texture and Input 2 to a Crater texture.

Default Crater colors.

After connecting 
Set Range to Channel1.
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4 Click the boxes for Input 1 and Input 2 to access the Attribute Editor 
for the textures and adjust the attributes as necessary.

Use Color Utilities

Use the Blend Colors utility

For more information on this utility, see ”Blend Colors” on page 392.

To blend colors using the Blend Color utility

Try the following to get an idea of how this utility works.

1 Create the following—Checker (2D texture), Wood (3D texture), Blend 
Color (Color Utilities), and a Lambert material.

2 Ctrl+middle+drag the Checker swatch over the Blend Color swatch. 

The Connection Editor appears.

3 Click to connect the Checker’s Out Color to the Blend Color’s Color1 
node.

Click to access texture 
Attribute Editors.

Dot Product Operation with 
Normalize Output turned on 
(default attribute settings).

Hypershade panel view.
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4 Ctrl+middle-drag the Wood texture swatch over the Blend Color 
swatch, and in the Connection Editor, connect the Wood’s Out Color 
to Blend Color’s Color2 node.

5 Middle-drag the Blend Color swatch over the Lambert material 
swatch and select color from the pop-up menu.
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The result is a blend between the wood and checker textures. In the 
Blend Color’s Attribute editor, when you adjust the Blender slider 
towards 1, more of the checker texture appears and when you adjust 
the Blender slider towards 0, more of the wood texture appears.

Use the Clamp colors utility

For more information on this utility, see ”Clamp” on page 392.

To clamp colors using the Clamp utility

1 Map a complex texture, such as Marble, to a material’s Color.

2 In the texture’s Attribute Editor, map the Clamp Color Utility to one 
of the texture’s colors.

3 The Clamp utility’s Attribute Editor appears. 

The Min and Max attribute values determine the amount of Red, 
Green, or Blue color appears.

In the following, in the before image the Min and Max values are set 
from 0.0 to 1.0 for all three color channels (R, G, and B). The after 
image Min and Max values are: 

R Min = 0.4, Max = 0.5 

G Min = 0.4, Max = 0.5 

B Min = 0.4, Max = 1.0
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Use the Contrast utility

For more information on this utility, see ”Contrast” on page 392.

To change the contrast using the Contrast utility

1 Map a texture to a material’s color. 

2 Map the colors you want to the Contrast utility. 

For example, map the Crease Color of a Leather texture. To do this, 
click the box next to Crease Color in the Leather texture’s Attribute 
Editor, then select Contrast from the Utilities tab in the Create Render 
Node window.

3 Change the Contrast attribute settings as necessary.

Use the Gamma Correct utility

For more information on this utility, see ”Gamma Correct” on page 393.

To remap colors using the Gamma Correct utility

1 Map a texture to a material’s Color and assign the material to an 
object. 

In this example, map a File texture to a Lambert material.

Before Clamp After Clamp
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2 Map the Gamma Correct utility to the color you want to adjust, such 
as the Ambient Color for the Lambert material. To do this, in the 
Lambert material’s Attribute Editor, click the box next to Ambient 
Color, then select Gamma Correct from the Utilities tab in the Create 
Render Node window that appears.

3 Change the Gamma Correct attribute settings as necessary, as in the 
following.

After you change the Gamma Correct attributes, the Ambient Color 
attribute updates in the Lambert material’s Attribute Editor.

Use the Remap Value, Remap Color, or 
Remap Hsv utilities

For software rendering only.

You can more precisely define how an input value (value, point, color) 
remaps to a new output value. These three color utility nodes have 
gradient attributes that give you far greater control over remapping than 
what Ramp textures provide. 

With these utility nodes, you can (for example): 

• remap and control color values and alpha values separately

R G B

Rendered result.

Hypershade view.
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• perform simple color correction 

• affect the translation of objects

• finetune or totally change the hue, saturation, and luminance of a 
color

To use the Remap Value, Remap Color, or Remap Hsv color 
utility

1 In Hypershade, select > create Maya Nodes > Color Utilities.

2 Select the utility you want to use:

• See ”Remap Value” on page 394 for a description of this utility 
and strategic uses.

• See ”Remap Color” on page 395 for a description of this utility 
and strategic uses.

• See ”Remap HSV” on page 396 for a description of this utility and 
strategic uses.

3 In the utility’s Attribute Editor, adjust the gradient graphs, and set the 
Input and Output ranges.

For descriptions of these range attributes, see ”Input and Output 
ranges” on page 395.

Use Switch utilities

Use the Single Switch utility

Switches single float attributes, like a Bump Value or Bump Depth.

For more information on this utility, see ”Single Switch” on page 397.

To use the Single Switch utility

1 Create a material and assign it to all the objects in the scene. 

2 Map a texture to the material’s Bump Mapping attribute. Adjust the 
texture’s attributes and 3D placement if necessary.

Tip: These three color utilties work well with the test 
range feature. See ”Test textures” on page 97. 

Tip You can IPR Render the scene to see the results. For more 
information on IPR rendering, see ”Interactive Photorealistic 
Rendering (IPR)” on page 67 in the Rendering guide. 
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3 In the Bump 3d’s Attribute Editor, place the cursor over the Bump 
Depth attribute, then right-click Create New Texture from the pop-up 
menu.

4 Select the Single Shading Switch utility from the Utilities tab in the 
Create Render Node window. 

The Single Shading Switch’s Attribute Editor appears.

5 Open the Outliner (Window > Outliner) and middle-select one of the 
objects for which you want object-specific bump mapping. Drag it to 
the inShape column of the Switch Attributes.

6 Click the name displayed in the inShape column then click the Map 
Item button (or right-click over the inSingle column and select Map 
from the pop-up menu). 

Tip: If Alpha Luminance is on in the Color Balance section of the 
texture’s Attribute Editor, the rendered result is much 
smoother. Alpha Luminance is on by default.

Phong Color changed to 
resemble old brass in 
Color Chooser. 

Bump Mapping mapped to 
the Granite 3D texture.

Rendered result.
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The Create Render Node window appears.

7 Select another texture. The Switch Attributes inSingle column now 
displays the new texture. Adjust the texture’s attributes to get the look 
you want. Notice in Render View that only one of the object’s bump 
map changes as you adjust the attributes.

8 Now change the Default attribute in the SingleShading Switch’s 
Attribute Editor. The bump maps on the other objects in the scene 
adjust according to the value you enter.

The following shows how the connections display in Hypershade:

Use the Double Switch utility

Switches double float attributes on a 2D texture, like Repeat UV or 
Translate Frame of a 2D texture placement. 

For more information on this utility, see ”Double Switch” on page 398.

To use the Double Switch utility

1 Create a material and assign it to the objects. 
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2 Map a 2D texture to one of the material’s attributes, such as Color. 
Adjust the texture’s attributes if necessary.

3 A place2dTexture node is created when you map a 2D texture. 
Double-click the texture’s place2dTexture swatch in Hypershade to 
open its Attribute Editor. 

4 Place the cursor over the Repeat UV attribute, and right-click Create 
New Texture from the pop-up menu.

5 Select the Double Shading Switch utility from the Utilities tab in the 
Create Render Node window. Notice that the spheres seem to have 
lost their textures. 

This is when you can apply a Default setting in the Switch Attributes 
Editor. You can either map a new texture, or change the values for U 
and V. In the following the Default value is changed to 1.5 for both U 
and V.

6 Open the Outliner (Window > Outliner) and use the middle mouse 
button to select the spheres for which you want to adjust the UV 
texture placement and drag them to the inShape column of the Switch 
Attributes.

Notice only the spheres you move into the inShape column lose their 
textures. These are the spheres you want to change.
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7 Click to highlight the inShape column then click the “Map Item” 
button. 

8 Select the Place 2d Texture utility from the Utilities tab in the Create 
Render Node window. The Connection Editor appears. Click the 
Repeat UV Output node (in the left column), then the Input[0] In 
Double Input nodes (in the right column).

Only the spheres you mapped in the Double Shading Switch’s 
Attribute Editor update. Click the place2dTexture swatch in 
Hypershade to open its Attribute Editor and adjust the Repeat UV 
values if necessary.

Switch Attributes editor after 
connections are made.
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Use the Triple Switch utility

Lets you map different textures to several objects in a scene. You can 
switch any triple float attribute, such as RGB out colors.

For more information on this utility, see ”Triple Switch” on page 400.

In the following, a Rock texture is initially mapped to the objects (simple 
revolved surfaces that look like bowls) because a grainy texture is 
required. The other textures you map onto the selected objects retain this 
grainy texture while displaying their specific texture attributes.

To use the Triple Switch utility

1 Create a material and assign it to all the objects in the scene.

2 In the material’s Attribute Editor, map a texture to the Color attribute. 

3 In the texture’s Attribute Editor, place the cursor over one of the Color 
attributes then right-click Create New Texture from the pop-up menu.

Click to open the 2D 
Texture Placement 
Attributes Editor and 
adjust the Repeat 
UV values as 
needed.
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4 From the Create Render Node window, select Triple Shading Switch 
from the Utilities > Switch tab. Notice that the bowls lose their initial 
color. You can either map another texture to the objects or change the 
color using the Default attribute in the Switch Attributes Editor.

5 Open the Outliner (Window > Outliner), and middle-drag the objects 
for which you want to display another texture into the inShape 
column. 

Only four of the bowls in the following are to be texture mapped. The 
top bowl retains the Default color setting.

Default color changed.
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6 To map textures to the other objects, click to highlight the revolved 
surfaces in the inShape column then select the “Map Item” button.

7 Select another texture for each object from the Textures tab in the 
Create Render Node window. 

The following shows the four bowls and the textures mapped to them 
in the Switch Attributes editor.

Adjust the textures for each item if necessary. The following gives you 
a better idea of how the textures are mapped to the bowls and how 
the connections display in the Hypershade.
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Reference Nodes

General utilities

Array Mapper

Maps array attributes to the color attributes of texture nodes. Used by 
particle objects to invoke color values from the texture node for each 
particle.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

See ”Particles” on page 19 in the Dynamics guide for more information 
about particle mapping.

Min Value, Max Value

The minimum and maximum limit on the output attribute 
outValuePP.

Default
color

Default color

4

3

2

1
1

2

3

4
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Compute Node

Allows the propagation of any changes to the computeNode’s 
outColor through the arrayMapper and onto the attribute the 
arrayMapper is driving.

Bump 2d

Converts a 2D texture to bump maps. Middle-drag the 2D texture swatch 
over the material swatch and select bump map from the pop-up menu. 
Maya creates the bump2d utility. 

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

To use the Bump 2D utility, see ”Use the Bump 2d utility” on page 343.

Bump Value

The source 2D texture used for the bump map. You can connect the 
output of any shading network to Bump Value to use as the source of 
the bumps.

Bump Depth

Controls how high the bumps display on the surface. Increase Bump 
Depth to make the surface bumpier. Decrease Bump Depth to make 
the surface smoother.

You can achieve almost identical effects by adjusting the Bump Depth 
or the Alpha Gain and Alpha Offset of the texture. The Bump Depth is 
determined by reading the alpha gain value of the texture. Both 
controls can be useful in complex shading networks where there may 
be multiple bumps. The alpha gain attribute lets you individually 
adjust the bump for each texture. 

Change the Bump Depth default value.

Rendered result with 
bump2D default settings 
for a Fractal 2D texture. 

Rendered result with new 
Bump Depth setting.
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Bump Filter

Affects the filtering level performed on a texture used as a bump map. 
Maya calculates the amount of filtering based on how much screen 
space the texture occupies in the final image. The Bump Filter 
attribute is a multiplier of that value. 

Values greater than 1.0 produce more filtering, making the bumps 
smoother. Increase the value if aliasing occurs (jagged staircase 
effects) in final renderings, or if the bump map appears to pop or 
“sizzle” over the course of several frames. 

Values less than 1.0 produce less filtering, making the bumps appear 
sharper. Decrease the value if bumps are too smooth in the final 
rendered images.

Bump Filter Offset

Affects the amount of filtering performed on a texture. 

Unlike the Bump Filter attribute (which is a multiplier), Maya adds 
Bump Filter Offset to calculated filtering values. This increases the 
amount of filtering uniformly. 

This attribute can be used to lock Maya’s filtering values. If you want 
the Bump Filter Offset value to completely determine the amount of 
filtering, set the Bump Filter attribute to 0.

Adjust Edges

Artifacts may display on texture boundaries when you map textures 
with the place2dtexture’s Wrap U and Wrap V attributes turned off. 
Using Adjust Edges removes these artifacts when this happens, but 
has no effect when you turn the Wrap U and Wrap V attributes on.

Bump 3d

Converts a 3D texture to bump maps. You can also cascade bump maps 
on top of one another. 

To use the Bump 3D utility, see ”Use the Bump 3d utility” on page 345.

Bump Value

The source 3D texture used for the bump map. You can connect the 
output of any shading network to Bump Value to use as the source of 
the bumps. 

Bump Depth

Controls how high the bumps appear on the surface. Increase Bump 
Depth to make the surface bumpier. Decrease Bump Depth to make 
the surface smoother.
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Bump Filter

See ”Bump Filter” on page 370.

Bump Filter Offset

See ”Bump Filter Offset” on page 370.

Clear Coat

This utility is a plug-in (clearcoat.mll). You can use this node in 
situations where certain materials, such as car paint, reflect light 
differently depending on the relationship between the viewing direction 
and surface orientation. 

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

To use the Clear Coat utility, see ”Use the Clear Coat utility” on page 345.

Clearcoat is a separate node. In Maya, complex shading networks can be 
built with many smaller nodes, but because Clearcoat is its own node, it 
can be applied to any material (even plug-in materials). You plug the 
output of the Clearcoat node into the Reflectivity of the material.

You can use IPR to tune Clearcoat attributes. This is especially powerful 
when you apply the output of the Clearcoat node into the color of a 
Surface Shader node.

In the following, white shows maximum reflectivity and black shows 
minimum reflectivity. 

When satisfied with the Clearcoat settings, you can plug the output back 
into the material’s Reflectivity attribute and be confident of the result. 

The next image was produced using the Clearcoat plug-in. Notice how the 
hood and top of the car are more reflective than the front and sides of the 
car.
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As well as the generic Caching and Node State operations, Clearcoat 
contains the following attributes:

Index

Describes the refraction properties of the material. 

Scale 

A simple multiplier on the final result.

Bias 

Controls the middle point of the contrast adjustment and is added to 
the final result. Increase Bias to move the middle point upwards 
(more of the texture becomes dark as contrast increases). Decrease 
Bias to move the middle point down (more of the texture becomes 
light as contrast increases).

The computation is:

final result= f(index of refraction) * scale + bias 

Where f(index of refraction) is the clearcoat computation with the 
index of refraction as input.

Condition

Incorporate the Condition utility in shader networks capable of acting one 
way in one set of circumstances and another way in a different set of 
circumstances. For example, you can create a double-sided shaded surface 
(see ”Double-sided shaded surfaces” on page 27). 

For an example of how to use this utility, see ”Use the Condition utility” 
on page 346.

Condition produces a color value depending on the conditions you set. It 
requires one logical operator and two choice values, as shown in the 
following example:

If (A operation B)
Outcolor = Color1
else
Outcolor = Color2

Image by 
Dua Xiong
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Condition compares the value in A with the value in B to find out whether 
the value in A is greater, smaller, equal to, less than, less than or equal to, 
greater than or equal to, or not equal to the value in B. 

Since it is a branching function, it does one thing if a logical expression is 
true and something else if it is false. For example, if the value in A is not 
equal to the value in B, Color If True is chosen in OutColor. If the value in 
A is equal to the value in B, and Color If False is chosen in OutColor. 

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

First Term

Represents the first term of the condition.

Second Term

Represents the second term of the condition.

Operation

Displays a drop-down list from which you can select an operator. The 
operators include: Equal, Not Equal, Greater Than, Greater or Equal, 
Less Than, Less or Equal.

Color If True

The color or texture that is output when the condition is true.

Color If False

The color or texture that is output when the condition is false.

Out Color

The output attribute with the result obtained. Available in the 
Connection Editor only.

The following shows some examples of the Condition utility in use:
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The Condition utility can be something as simple as comparing the values 
in the First Term and the Second Term. The result of this comparison 
makes it possible to change the color or texture of an object. 

For example, if the First Term is less than the Second Term, the resulting 
color of the object (OutColor) is Color If True, and Color If False appears 
when the First Term is not less than the Second Term.

Height Field

This draws a plane that interactively shows the displacement of a Surface 
texture or an Ocean Shader. It is currently for preview or interactive 
display purposes only, and does not appear in a render. Use it to preview 
the displacement effects and then recreate them by mapping the same 
texture displacement to your target shader. 

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

First Term Second Term

Color If True Color If False

The results are 
based on these 
textures.

Equal Not Equal

Greater Than Less Than

Tip: Because you can also map all the input attributes, you can 
switch between two textures, for example, connecting them 
to Color If True and Color If False.
Shading

374



7 | Render node utilities

Reference > Light Info
To use the Height Field utility, see ”Use the Height Field utility” on 
page 346.

Resolution

The number of samples relative to the largest side of the plane. Higher 
values result in a more detailed surface, but slower draw time.

Color

The basic color of the preview surface. This can be mapped with a 
Surface texture or an Ocean Shader; however, only the outColor value 
can be used.

Displacement

The displacement of the plane. This may be mapped with a Surface 
texture or an Ocean Shader; however the outAlpha value is always 
used. This does an optimized evaluation of the texture that ignores 
added shading engine inputs.

Height Scale

Scale factor for input displacement. As the value increases, the 
displacement is more pronounced.

Light Info

Similar to the Sampler Info node, Light info provides light information 
instead of surface property information. You use the Light Info utility 
node to obtain information about the position of a light relative to a 

The Checker texture 
is mapped to the 
Height Field’s 
Displacement 
attribute. The Height 
Scale value is 0.25.

The Checker texture 
is mapped to the 
Height Field’s 
Displacement 
attribute. The Height 
Scale value is zero.
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texture. As each point on the texture is shaded, the attributes of Light Info 
can determine the precise distance from the light to the point being 
shaded.

The Light Info node provides: 

• The position of the light in world space.

• The direction the light is shining (if it is not a point light).

• The distance from the light to the point being shaded. 

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63). To use the Light Info utility, see ”Use the Light 
Info utility” on page 347. 

Light Position

The position of the connected light in world space. The connected 
light is the light (or other object) whose World Matrix attribute is 
connected to the World Matrix attribute of this node.

Light Direction

The direction in which the connected light is shining. Point lights 
shine in all directions.

Sample Distance

The world-space distance between the connected light and the point 
on the surface being shaded.This can be calculated in different ways. 
See Light Direction Only for details.

World Matrix

Connect the output World Matrix attribute of a light or other object to 
this attribute. This must be done before the output of this node is 
usable.

Light Direction Only

Controls how the Sample Distance attribute is calculated. If off, the 
Sample Distance is the world-space distance from the light to the 
point being sampled.

If on, the Sample Distance is the distance along the light direction 
vector to the closest point on that vector to the point being sampled. 

In mathematical terms, it returns the length of the projection of the 
light-to-object vector onto the light-direction vector.
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Multiply Divide

Multiplies or divides input attributes. This utility is divided into three 
parts—two input attributes, an operator you apply to the two input 
attributes, and an output attribute to hold the result of the operation. The 
input and output attributes represent X, Y and Z. Use this node to 
multiply colors or triple-value attributes.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

To use the Multiply Divide utility, see ”Use the Multiply Divide utility” 
on page 347.

Operation

Displays a pop-up menu from which you can select an operator.

No operation 

Copies the value of the Input1 attribute to the output attribute 
without making any changes.

For example, if Input 1 is a Checker texture and Input 2 is a Crater 
texture, when you select No Operation, only the Checker texture’s 
attributes are rendered.

Note The Light Data attributes work with light information in 
camera space, whereas the Light Direction attribute of the 
Light Info utility works with light information in world 
space. 

Shaded point

Sample 
distance

Projected 
sample 
distance

Light 
position

Light direction
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Multiply 

Multiplies the Input1 attribute and the Input2 attribute, as in the 
following formula:

Divide 

Divides the Input1 attribute by the Input2 attribute, as in the 
following formula:

In the following example, the Input 1 texture is divided by the 
changes made to the Input 2 texture. 

Power 

Sets the output to equal Input 1 raised to the power of Input 2. See the 
following example:

It evaluates an expression by raising the value to the power of a 
number you choose or by calculating the square root. Raising a value 
to the power means multiplying a number by itself a given number of 
times as in:

Inputs 1 and 2 
(Checker and Crater)

No Operation means only 
Input 1’s attributes are rendered.

Output Input1 Input2×=

Output
Input1

Input2
-----------------=

Inputs 1 and 2
(Checker and Crater)

Result when Input 1 
is divided by Input 2.

Inputs 1 and 2
(Checker and Crater)

Result when Operation 
is set to Power.
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The command for calculating the square of a number is:

power (value, 2.0)

The mathematical formula is:

The formula for computing the square root is:

If you want to multiply the value of a component twice, you would 
set Input1 to represent the color (possibly mapping it with a texture), 
and then set all the three components of Input2 to 2.0. Because the 
inputs are both colors, you can work on the color of a single-
component value or on all three-component values. 

You can also get the square root of a number by setting Input2 to 0.5 
as shown in the following: 

Output = power (input1, input2)

which, in math terms, would be written like input1^input2.

See also the “Power” operator example.

Input1

The first of two arguments presented to Multiply Divide.

Input2

The second of two arguments presented to Multiply Divide.

Plus Minus Average

Add, subtract, or average values in a list of input attributes. The Plus 
Minus Average utility has three parts—two or more input attributes, an 
operator that you apply to these input attributes, and an output attribute 
that holds the result of the operation.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

To use the Plus Minus Average utility, see ”Use the Plus Minus Average 
utility” on page 348.

2
3

2 2 2××=

Power value
2

=

Power value=
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Operation

Displays a pop-up menu from which you can select an operator

No operation 

Copies the value of the Input1 attribute to the output attribute 
without making any changes.

Sum 

Adds the values in the Input list, as in the following formula:

Subtract 

Calculates the difference between one element in the list and another 
element in the list, as in the following formula: 

For example, if you want to subtract Input3D[1] from Input3D[2] of 
multi-attribute nodes, make the necessary connections using the right 
mouse button in the Connection Editor and then select Subtract. 

Average 

Adds the values in each Input attribute and divides the result by the 
number of input attributes, as in the following formula: 

where N is the number of input attributes.

For example, if there are seven input values in the list, the values for 
each input in the list ranging from one to seven are added and the 
result is divided by seven.

Input1D

A list of elements composed of single-value connections. The values in 
the list can be added, subtracted, or averaged depending on the 
Operation you select.

Input2D

A list of elements composed of two-value connections. The values in 
the list can be added, subtracted, or averaged depending on the 
Operation you select.

Output Input1 Input2 … InputN+ + +=

Output Input3D 1[ ] Input3D 2[ ]–=

Output
Input1 Input2 …+

·
InputN+ +

N
------------------------------------------------------------------------------=
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Input3D

A list of elements composed of three-value connections, such as color. 
The values in the list can be added, subtracted, or averaged 
depending on the Operation you select.

Projection

Turns any 2d texture into a 3d texture you can place on the surface using 
one of the available projection types. Use to adjust the texture placement 
on the surface.

You can find this utility in the Create Bar (see ”Hide, resize or customize 
the Create bar” on page 63).

To use the Projection utility, see ”Use the Projection utility” on page 348.

Interactive Placement

Displays the Projection manipulators in the scene view. 

Tip Give nodes meaningful names to help you remember their 
functions. For example, rename the first Multiply Divide 
node to PowerSquare, the Plus Minus Average node to 
SumComponents, and the second Multiply Divide node to 
PowerSquareRoot.

Tip: Use “Fit To BBox” to center the manipulator around the 
object.

Spherical “Proj Type”
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Using these manipulators in combination with Maya’s transform 
tools, you can orient and position the texture map in three 
dimensions. The manipulators for texture mapping are exactly the 
same as those used for texturing polygons. See the ”Polygons” on 
page 21 in the Polygonal Modeling guide for details.

Fit To BBox

The texture map coincides with the bounding box of the mapped 
object or set. See also ”Interactive Placement” on page 381.

Proj Type

Select a projection type from the drop-down list to display seven 
projection manipulators.

Off Uses no projection type.

Planar Default Proj Type. Places the texture on a planar 
surface and projects it onto the object.

Spherical  Places the texture inside a sphere and projects it 
onto the object.

Note If no place3dtexture node exists, Maya displays the 
following alert box:

Click the Create a placement node button to create the 
place3dtexture node.
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Cylindrical Places the texture inside a cylinder and projects it 
onto the object.

Ball Places the texture inside a ball and projects it onto 
the object. For example, Maya projects the texture as 
if a candy wrapper is pulled around a lollipop. 
There is one pinch point to the mapping at the -z-
pole, as opposed to the two pinch points at the +y 
and -y poles in spherical and cylindrical mapping.

Cubic Defines the projection surface as a box. Maya places 
images on each plane and projects them onto the 
object. 
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Triplanar Extrudes the texture along the axis defined by the 
maximum direction of the surface normal. The 
texture is projected much like fabric pulled around 
an arc. 

Concentric Projects a vertical slice of the texture from the inside 
to the outside edge of the voxel. The vertical slice 
used is randomly chosen for each voxel. A voxel is a 
3D version of a rectangle—a voxel grid is a series of 
3D cubes that line up to form a bigger cube.

Perspective Integrates 3D elements with a background image or 
a live action sequence.

Examples

You have a background sequence with a vase on a table you want to blow 
up. It can be difficult to produce a parametric or solid texture map that 
exactly matches the vase, but if you use the Perspective Proj Type, you can 
project the real image of the vase from the background sequence onto a 
3D vase placed in a matching position. This allows a perfect match of 
textures from the camera’s point of view.

You want to place a 3D flying saucer within an image of a street scene. 
The image of the street scene should accurately reflect onto the flying 
saucer. You could do this with an environment texture, but that would 
require that you have other images available—if you use the Perspective 
Proj Type, you can project the image of the street scene onto stand-in 
geometry. The image projected onto the stand-in geometry accurately 
reflects onto the flying saucer.
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Image

The 2D texture to be used as a map. 

U angle

For spherical and cylindrical mapping only. Changes the U angle.

V angle

For spherical mapping only. Changes the V angle.

Camera Projection Attributes

Control a Projection node when the Proj Type is Perspective.

Link To Camera

The drop-down list contains a list of the perspective cameras in the 
scene. Choose the camera from which you want to project the image.

Fit Type

Controls how the texture fits to the camera when Proj Type is 
Perspective. Select from the following:

None The image is not squeezed or stretched to fit. One of 
its axes (determined by the Fit Fill setting) fits to the 
film gate, and the other resizes appropriately. 

Match Camera Film 

Gate Squeezes the image to fit the film gate. 

Match Camera 

Resolution If you use this to match a backdrop, match these 
settings to the settings in the Image Plane. Usually, 
the image plane is the same size as the rendered 
image. If so, use the Match Camera Resolution 
setting. 

Fit Fill

Only available if Proj Type is Perspective and Fit Type is None. If the 
image plane aspect ratio is not the same as the film gate aspect ratio, 
this attribute decides which axis of the image is fit to the film gate.

Tip: To undo a mapping, in the Attribute Editor, right-click 
while the cursor is over the attribute’s name and select 
Break Connection from the pop-up menu.
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Noise Attributes

Controls the amount of fractal noise added to a Projection node. (Adding 
fractal noise randomizes or blurs the texture).

Amplitude X/Amplitude Y

Scales the amount of fractal noise added to the projection in the X or Y 
direction. When Amplitude X and Amplitude Y are 0, no fractal noise 
is added. 

Ratio

Controls the frequency of fractal noise. Increase this value to increase 
the fineness of detail. 

Ripples

Determines how wavy the projected image is when projected, but 
controls the scale of the frequency of any fractal noise added to the 
texture. If increased in any direction, the fractal detail seems to smear 
out in that direction. 

Recursion Depth

Depth

Controls the amount of calculation done by the texture when Ripples 
are added. Fractal noise such as ripples are created by a mathematical 
process; as the process goes over more levels, it produces a more 
detailed fractal, but takes longer. Normally, the texture chooses a level 
appropriate for the volume rendered. You can use Depth Min and 
Depth Max to control the minimum and maximum amount of 
calculation. 

Stencil

Maps any image input onto an object (such as a shading network, or a file 
texture). You can mask the input image to control how it covers a surface, 
to overlay different textures and control what parts of the texture are 
visible, or to label map a surface.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

To use the Stencil utility, see ”Use the Stencil utility” on page 349.

Image

The texture that is used as a stencil.
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Edge Blend

Controls the sharpness of the texture edges. The default Stencil’s color 
is the color of the edge blend. Increase this value to blend edges softly.

Mask

Represents the Stencil’s transparency. Use to control the overall 
transparency of the entire texture. To control the transparency of 
selected regions of the texture, map another texture to Mask. 

For example, this is what happens when you map a File texture to the 
Mask attribute.

HSV Color Key

Key Masking

Enables or disables Chroma Key masking. When on, Maya selects the 
areas in the texture similar to or equal to the Color Key color and 
masks them out. When off, all other key attributes have no effect. 

Positive Key

Inverts the chroma key mask (only the colors specified in the Color 
Key and HSV Range are displayed). The default setting is off (the 
colors specified in the Color Key and HSV Range are masked).

Marble texture as 
Stencil Image.

Map a File texture to 
the Mask attribute.

Rendered result.

Hypershade panel view 
File texture is mapped to 
the Mask attribute.
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Color Key

The color to be masked in the texture. The default setting is black. To 
mask a range of colors, you must also set the Hue/Sat/Val Range 
parameters.

Hue Range

The range of hues (H) centered on the Color Key color which are also 
masked. The valid range is 0 to 1. The default value is 0.5.

Saturation Range

The range of saturations (S) centered on the Color Key color which are 
also masked. The valid range is 0 to 1. The default value is 0.5.

Value Range

The range of values (V) centered on the Color Key color which are 
also masked. The valid range is 0 to 1. The default value is 0.5. If you 
want to mask out the exact key color, set V to 0.

Threshold

Controls the point at which the color state changes.

Reverse

Reverses node effects. For instance, you can reverse a transparency map if 
the white and black areas are the inverse of what they should be.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

To use the Reverse utility, see ”Use the Reverse utility” on page 350.

Reverse Attribute

Input

Represents the reversed values.

Sampler Info

Provides you with information about each point on a surface as it is being 
sampled, or calculated, for rendering purposes. Sampler Info can give you 
information about a point’s position in space, its orientation and tangency, 
and its location relative to the camera.

Many of the attributes for this node provide values in camera coordinate 
space, the local object space of the camera. Each camera (in its own space) 
is located at the point 0, 0, 0. It looks straight along the negative Z axis, 
and the positive Y axis points up.
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Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

To use the Sampler Info utility, see ”Use the Sampler Info utility” on 
page 351.

Point World

Provides the position currently being sampled relative to the X-,Y-, 
and Z-axis of the world.

Point Obj

Provides the position currently being sampled relative to the X-,Y-, 
and Z-axis of the object. 

Point Camera

Provides the point of the object being shaded. This point is located in 
XYZ camera space. You can connect this surface point in materials for 
the object being shaded to show some interesting effects based on the 
camera view.

Normal Camera

Provides the orientation of a face relative to the camera.

Uv Coord

Provides the UV coordinates of a point to be shaded. The convention 
is that UV coordinates are measured from 0 0 to 1 1.

Ray Direction

Indicates the direction in which the current point is seen from the 
camera. Use this attribute in materials for objects to provide the 
direction towards the camera for every pixel in the object.

Tangent UCamera, Tangent VCamera

Sets the surface tangents in camera space (as opposed to world space 
or object space). For polygons, the tangents are generally not defined. 
NURBS have a well-defined tangent space (as visible in Maya; create a 
NURBS object, display its CVs and notice the NURBS object has a U 
direction and a V direction).

Mathematically, tangents provide an instantaneous direction 
perpendicular to their point of origin on a surface. Their magnitude is 
affected by the rate of change (curvature) of the surface. A good math 
book should have a diagram showing the tangent to a curve, which 
can then be extrapolated to give you an idea of what tangents on a 
surface look like. Tangent U and Tangent V Camera attributes are for 
advanced users only.
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Pixel Center

Provides Pixel Center X and Pixel Center Y. The result depends on the 
image, not on the geometry.

Facing Ratio

Produces a value that varies between 0 and 1 depending on the angle 
between the surface normal and view direction.

Flipped Normal

Turn on or off depending on whether the object is textured differently 
on either side. The flipped normal attribute indicates if the surface 
normal is flipped which also tells you which side of the surface Maya 
is shading.

Set Range

Sets the range within which you want an effect to take place when you 
don’t want to operate on an entire scene. The Set Range utility is used in 
combination with other nodes.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

To use the Set Range utility, see ”Use the Set Range utility” on page 353.

Value

Maya maps this value from the old range (Old Min to Old Max) into 
the new range (Min to Max).

Min/Max

The minimum and maximum value in the new range.

Old Min, Old Max

The minimum and maximum value in old range.

Vector Product

Multiplies a vector by another vector or by a matrix. The Vector Product 
node has three parts—two input attributes, an operator that you apply to 
the two input attributes, and an output attribute that holds the result. 

• A vector is the quantity of an attribute (such as color) which has 
direction (X, Y, and Z) as well as magnitude.

• A matrix is an array of interconnected attributes. These attributes are 
combined to create one single entity.
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Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

To use the Vector Product utility, see ”Use the Vector Product utility” on 
page 354.

Operation

Displays a pop-up menu from which you can select an operator. The 
following examples are based on Input 1 as a Bulge texture and Input 
2 as a Marble texture.

No operation 

Copies the value of the Input1 attribute to the output without making 
any changes.

Dot Product 

A single-component value produced by the dot product of the two 
input vectors. The value of the dot product is copied to the three 
components of the vector produced. 

Cross Product 

The result of two input vectors. 

Vector Matrix Product 

Produces a vector by multiplying the Input1 attribute and the Matrix 
attribute, as in the following formula: 

Outvector = Input x Matrix

Point Matrix Product 

Produces a point by multiplying the Input1 attribute and the Matrix 
attribute as in the following formula:

Output = Input x Matrix
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Color utilities

Blend Colors

To use this utility, see ”Use the Blend Colors utility” on page 355.

Blends two input values using a mixer. You use a mask to determine 
where to put two materials placed on an object. 

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

Blender

Controls how much of each of the input colors mixes into the final 
Output. As the value increases, you see more of Color 1 and less of 
Color 2. As it decreases, you see more of Color 2 and less of Color 1.

Color1/Color2

Color1 and Color2 are the first and second input colors (or textures). 
Click to access the mapped node’s attributes.

Clamp

To use this utility, see ”Use the Clamp colors utility” on page 357.

Isolates colors within a relatively complex texture.This is helpful when 
you create complex shader networks.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

Min

The minimum values for the color channels.

Max

The maximum values for the color channels.

Input

The input color or texture that Maya clamps.

Contrast

To use this utility, see ”Use the Contrast utility” on page 358.

Use to increase or decrease the contrast in a texture. You can control the 
contrast of each of the R, G, and B channels individually. 
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When you increase Contrast, light colors become lighter and dark colors 
darker. When you decrease contrast, you bring all the colors closer to the 
middle range. The Bias attribute controls the center of this range.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

Value

The input color or texture to adjust.

Contrast

Controls the amount of contrast adjustment. You can adjust the 
contrast of the R, G, and B components individually. Increase Contrast 
to make light colors lighter, and dark colors darker. Decrease Contrast 
to make everything gray.

Bias

Controls the middle point of the contrast adjustment. Increase Bias to 
move the middle point upwards (more of the texture becomes dark as 
contrast increases). Decrease Bias to move the middle point down 
(more of the texture becomes light as contrast increases).

Gamma Correct

To use this utility, see ”Use the Gamma Correct utility” on page 358.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

Converts an HSV (Hue-Saturation-Value) color into an RGB (Red-Green-
Blue) color. This is useful when you want to control a color using HSV 
values. For example, you can animate a material to run through all the 
rainbow colors. (This is the same as animating the Hue of an HSV color). 

To animate a material, create an HSV to RGB node, connect the Out Rgb 
attribute to the material’s color, then animate the first channel of InHsv. 

Use Gamma Correction to smoothly remap the colors in an image. 
Extreme values (very light or very dark) do not change much, but you can 
make mid-range tones brighter or darker.

This utility lets you specify different gamma values for the three channels 
of the input. The typical formula for calculating gamma is: 

new == old ** (1.0/Gamma)

Value

The input color or texture to gamma-correct.
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Gamma

Controls the amount of gamma correction applied to each channel. A 
value of 1 means that the color is not adjusted. Increase Gamma to 
make the mid-range tones brighter. Decrease Gamma to make them 
darker.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

In Hsv

The input color (represented as Hue, Saturation, and Value) converted 
to an RGB color.

Out Rgb

The output RGB color calculated.

Luminance

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

Converts color to grayscale. The luminance derives from a color value. 
Maya uses the following formula to calculate the luminance by adding the 
following amounts of red, green, and blue.

Luminance = 0.3 red + 0.59 green + 0.11 blue 

Value

The input color or texture.

Remap Value

To use this utility, see ”Use the Remap Value, Remap Color, or Remap 
Hsv utilities” on page 359.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

Remaps a scalar input to both scalar and color outputs. The scalar output 
is remapped with a scalar gradient, and the color output is remapped 
using a color gradient. 

You can remap color and alpha values and control each of them 
separately. So, for example, you can define mappings where the alpha is 
the inverse of the color, or where they have different ranges. 

Usage

How you use Remap Value depends on what you want to remap. 
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For example you can vary reflectivity based on the facingRatio in either of 
the following ways: 

• Connect a samplerInfo facingRatio to the inputValue, and connect 
the outValue to your shader's reflectivity.

• Connect the outColor the shader specularColor.

Initially the part of the surface facing the view will be more reflective, but 
you can reverse this by reversing the gradient (make the value gradient go 
down to the right, or if you mapped the outColor make the color gradient 
become darker to the right).

Input and Output ranges

The input attributes index into the gradient controls, which define a new 
output value. Usually, you connect a varying attribute of some sort (such 
as values from the sampler info node, texture/shader outColors, or object 
position) to the input connection. 

inputMin, inputMax

Define the values that remap into the left and the right of the gradient 
controls. 

For example, if your input attribute varied between -1 and 1 you can 
set the inputMin to -1 and the inputMax to 1. This way your 
minimum values result in the values defined at the left of the ramp 
and the maximum map to the right. Values outside the min/max 
range will be clipped to the value at the edges of the gradient. 

outputMin, outputMax

Determine the range of the output attribute. These attributes represent 
the top (max) and bottom (min) values of the gradients, or (in the case 
of a color gradient control) the displayed white (max) and black (min) 
output. 

In some cases, you may want the outputMin/Max to match the 
inputMin/Max. For example if you are remapping the 
cameraNormalY to object color using a remapValue node, because the 
camera normal varies between -1 and 1, the inputMin/Max would be 
set to these values. However we do not want black to be -1,-1,-1, so it 
would make sense for the outputMin/Max to be 0 to 1.

Remap Color

To use this utility, see ”Use the Remap Value, Remap Color, or Remap 
Hsv utilities” on page 359.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).
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Lets you remap a three-channel input (such as RGB color) to another 
three-channel output with three gradient controls for more precise 
shading. 

You can also use this utility for non-shading purposes, however. For 
example, you could connect the translate of one object to 
remapColor.color, then connect remapColor.outColor to the translate of a 
second object, which effectively maps the position of one object onto the 
other. In this particular case, the second object initially follows the first 
then stops outside a zero to 1 bounding box. (To increase the size of this 
bounding range, increase both the input and output Min/Max settings.) If 
you reverse the gradients, the second object moves in the opposite 
direction. And if the graphs are wiggly, the motion of the second object 
would also be wiggly. 

For descriptions of the utility’s input and output ranges, see  ”Input and 
Output ranges” on page 395.

Remap HSV

To use this utility, see ”Use the Remap Value, Remap Color, or Remap 
Hsv utilities” on page 359.

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

Lets you adjust the color output of nodes. It converts an RGB input to 
HSV, remaps using separate HSV gradients, then converts the result to a 
color output.

With this utility, you can fine-tune or completely change the hue, 
saturation, and luminance of a color with the provided gradients. For 
example, you could connect the outColor of a file texture to the color 
(input) attribute on remapHsv, then connect the remapHsv outColor to 
your shader color. By editing the gradients you could then modify the 
brightness range or hue of the file texture with a great deal of control:

• You can make the image black and white make the saturation graph 
all zero.

• You can invert the brightness for an x-ray effect make the value graph 
1 at the left and zero at the right. 

You can also remap the color of a shader by connecting the outColor of 
the shader into remapHsv.color then connecting remapHsv.outColor the 
outColor of a surface shader node. The surface shader then becomes a 
color correctable version of the original shader.
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For descriptions of the utility’s input and output ranges, see  ”Input and 
Output ranges” on page 395.

RGB to HSV

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

Converts an RGB (Red-Green-Blue) color into an HSV (Hue-Saturation-
Value) color.

Some effects are easier to calculate using HSV values than RGB values. 
You can convert the output of any shading network into HSV values.

In Rgb

The color converted into HSV values.

Out Hsv

The output HSV values.

Surf. Luminance

Returns the part of a lit surface and the degree of light it receives from 
lights in the scene. 

Where the object is lit by light sources, the textures appear.

Where the object is not lit, such as polygons facing away from the light 
sources or in the shadow, the textures do not appear.

Switch Utilities

Single Switch

To use the single switch utility, see ”Use the Single Switch utility” on 
page 360.

You can find this utility in the Create Bar (see ”Hide, resize or customize 
the Create bar” on page 63).

You use the three buttons in the Triple Shading Switch Attribute Editor to 
add, remove, and map textures to objects. 

Note: The surface shader performs no calculations 
directly, it is simply a placeholder for a shading 
outColor attribute.
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The inShape column contains the objects to which you want to map the 
utility. 

The inSingle column contains the texture, file, or placement node you 
want to map to the object.

Add Surfaces

Click to determine to which shading groups the Single Shading 
Switch utility is connected and connect all the surfaces in those 
shading groups to the Single Shading Switch utility.

inShape

Contains the name of the shape (the object) you want to connect to the 
Single Shading Switch utility. You can add as many objects as you 
want to this column.

When one of the objects in this column is rendered, Maya sets Output 
to its corresponding value. When none of the objects are rendered, 
Maya sets Output to equal the Default setting.

inSingle

Contains the texture, file, or placement node that you want to map to 
the object. See also “Map Item”.

Remove Item

Removes the currently selected row in the Switch table.

Map Item

You highlight the InShape column then click the Map Item button to 
select a texture, file, or placement node to map it to the object.

Default

For Single switches, the Default attribute represents the value of a 
single float (such as the Bump Depth for a material’s bump mapping 
attribute). When a surface is shaded, if it is not in the inShape column, 
this value is used. Shading nodes can also be mapped to the Default.

Double Switch

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

Tip: You can also place the cursor over the column, then right-
click Map from the pop-up menu.
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To use the Double Switch utility, see ”Use the Double Switch utility” on 
page 362.

You use the three buttons in the Double Shading Switch Attribute Editor 
to add, remove, and map textures to objects. 

The inShape column contains the objects you want to map the utility to. 

The inDouble column contains the texture, file, or placement node you 
want to map to the object.

Add Surfaces

Click to determine to which shading groups the Double Shading Switch 
utility is connected and connect all the surfaces in those shading groups to 
the Double Shading Switch utility.

inShape

Contains the name of the shape (the object) you want to connect to the 
Double Shading Switch utility. You can add as many objects as you 
want to this column.

When one of the objects in this column is rendered, Maya sets Output 
to its corresponding value. When none of the objects are rendered, 
Maya sets Output to equal the “Default” setting.

inDouble

Contains the texture, file, or placement node you want to map to the 
object. See also “Map Item”.

Remove Item

Removes the currently selected row in the Switch table.

Map Item

Highlight the InShape column then click the Map Item button to select 
a texture, file, or placement node to map to the object.

Default

For Double switches, the Default values represents two float values 
(such as the Translate Frame or Repeat UV values of a place2dTexture 
utility). 

Tip You can right-click the column, then select Map from the 
pop-up menu.
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Triple Switch

Find this utility in the Create Bar (see ”Hide, resize or customize the 
Create bar” on page 63).

To use the Triple Switch utility, see ”Triple Switch” on page 400.

You use the three buttons in the Triple Shading Switch Attribute Editor to 
add, remove, and map textures to objects. The inShape column contains 
the objects you want to map the utility to. The inTriple column contains 
the texture, file, or placement node you want to map to the object.

Add Surfaces

Click to determine to which shading groups the Triple Shading Switch 
utility is connected and connect all the surfaces in those shading 
groups to the Triple Shading Switch utility.

inShape

Contains name of the shape (the object) you want to connect to the 
Triple Shading Switch utility. You can add as many objects as you 
want to this column.

When one of the objects in this column is rendered, Maya sets Output 
to its corresponding value. When none of the objects are rendered, 
Maya sets Output to equal the Default setting.

inTriple

Contains the texture, file, or placement node that you want to map to 
the object. See also “Map Item”.

Remove Item

Removes the currently selected row in the Switch table.

Map Item

You highlight the InShape column then click the Map Item button to 
select a texture, file, or placement node to map it to the object.

Default

For Triple switches, the Default attribute represents the RGB channels 
of a color. 
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